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Chapter 1

About this Guide

This User Guide describes the features supported by AOS-W Instant and provides detailed instructions for setting up
and configuring the AOS-W Instant network.

Intended Audience

This guide is intended for customers who configure and use AOS-W Instant.

Related Documents

In addition to this document, the AOS-W Instant product documentation includes the following:
o AOS-W Instant Installation Guides

e AOS-W Instant 6.4.0.2-4.1 Quick Start Guide

o AOS-W Instant 6.4.0.2-4.1 CLI Reference Guide

o AOS-W Instant 6.4.0.2-4.1 MIB Reference Guide

o AOS-W Instant 6.4.0.2-4.1 Syslog Messages Reference Guide

o AOS-W Instant 6.4.0.2-4.1 Release Notes

Conventions

The following conventions are used throughout this manual to emphasize important concepts:

Table 1: Typographical Conventions

Type Style Description

ltalics This style is used to emphasize important terms and to mark the titles of books.

System items This fixed-width font depicts the following:

e Sample screen output

e System prompts

o Filenames, software devices, and specific commands when mentioned in the text.

Commands In the command examples, this style depicts the keywords that must be typed exactly as
shown.
<Arguments> In the command examples, italicized text within angle brackets represents items that you

should replace with information appropriate to your specific situation. For example:

# send <text message>

In this example, you would type “send” at the system prompt exactly as shown, followed by
the text of the message you wish to send. Do not type the angle brackets.

[Optional] Command examples enclosed in brackets are optional. Do not type the brackets.
{Item A | In the command examples, items within curled braces and separated by a vertical bar
Ttem B} represent the available choices. Enter only one choice. Do not type the braces or bars.
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The following informational icons are used throughout this guide:

E Indicates helpful suggestions, pertinent information, and important things to remember.
NOTE

Indicates a risk of damage to your hardware or loss of data.
GAUTION

Indicates arisk of personal injury or death.

Contacting Support

Table 2: Support Information

Contact Center Online

e Main Site http://www.alcatel-lucent.com/enterprise

e Support Site https://service.esd.alcatel-lucent.com

o Email esd.support@alcatel-lucent.com

o North America 1-800-995-2696

e Latin America 1-877-919-9526

o EMEA +800 00200100 (Toll Free) or +1(650)385-2193
e Asia Pacific +65 6240 8484

o Worldwide 1-818-878-4507
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Chapter 2

About AOS-W Instant

This chapter provides the following information:

e AOS-W Instant Overview
e Whatis New in AOS-W Instant 6.4.0.2-4.1

AOS-W Instant Overview

AOS-W Instant virtualizes Alcatel-Lucent OmniAccess WLAN Switch capabilities on 802.11 access points (APs),
creating a feature-rich enterprise-grade wireless LAN (WLAN) that combines affordability and configuration
simplicity.

AOS-W Instant is a simple, easy to deploy turn-key WLAN solution consisting of one or more APs. An Ethernet port
with routable connectivity to the Internet or a self-enclosed network is used for deploying an Instant Wireless
Network. An Instant Access Point (OAW-IAP) can be installed at a single site or deployed across multiple
geographically-dispersed locations. Designed specifically for easy deployment, and proactive management of
networks, AOS-W Instant is ideal for small customers or remote locations without any on-site IT administrator.

AOS-W Instant consists of an OAW-IAP and a Virtual Controller. The Virtual Controller resides within one of the
APs. Inan AOS-W Instant deployment scenario, only the first OAW-IAP needs to be configured. After the first
OAW-IAP is configured, the other OAW-IAPs inherit all the required configuration information from the Virtual
Controller. AOS-W Instant continually monitors the network to determine the OAW-IAP that should function as the
Virtual Controller at any time, and the Virtual Controller will move from one OAW-IAP to another as necessary
without impacting network performance.

Supported Devices
The following devices are supported in the current release of AOS-W Instant:

o OAW-IAP103

o OAW-IAP104/ 105

o OAW-IAP114/115

o OAW-IAP134/135

e |AP-175P/175AC

o OAW-RAP3WN/3WNP
o OAW-RAP108/1090

o OAW-RAP155/155P

o OAW-1AP224/225

o OAW-IAP274/275

HOTE

As of AOS-W Instant 4.1 release, it is recommended that networks with more than 128 APs should be designed as
multiple, smaller virtual-controller networks with Layer-3 mobility enabled between them.

The following table provides the variants supported for each IAP model:
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Table 3: Supported OAW-IAP Variants

OAW- OAW-IAP- OAW-IAP-###

OAW-IAP- _IAP- _IAP-
IAP Model e OAW-IAP OAW-IAP H#H#4-RW

###-JP (Japan #H-1L (Worldwide

only) (Israelonly) | (Worldwide = exceptUS, JP,
Sl except US) and IL)

(Reg
Domain)

OAW-IAP103 Yes No No Yes No
OAW-IAP104/ | Yes Yes Yes No Yes
105

OAW- Yes No No Yes No
IAP114/115

OAW- Yes Yes Yes No Yes
IAP134/135

IAP-175P/175 | Yes Yes Yes No Yes
AC

OAW- Yes Yes Yes No Yes
RAP3WN/3W

NP

OAW- Yes Yes Yes No Yes
RAP108/109

OAW- Yes Yes Yes No Yes
RAP155/155

P

OAW- Yes No No Yes No
1AP224/225

OAW- Yes No No Yes No
IAP274/275

For information on regulatory domains and the list of countries supported by the OAW-IAP-RW type, see Country
Code on page 38.

AOS-W Instant Ul

The AOS-W Instant User Interface (Ul) provides a standard Web-based interface that allows you to configure and
monitor a Wi-Fi network. AOS-W Instant is accessible through a standard Web browser from a remote management
console or workstation and can be launched using the following browsers:

o Internet Explorer 10 or lower

e Safari 6.0 or later

e Google Chrome 23.0.1271.95 or later

e Mozilla Firefox 17.0 or later
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If the AOS-W Instant Ul is launched through an unsupported browser, a warning message is displayed along with a
list of recommended browsers. However, the users are allowed to login using the Continue login link on the Login

page.

To view the AOS-W Instant Ul, ensure that the JavaScript is enabled on the Web browser.

HOTE The AOS-W Instant Ul logs out automatically if the window is inactive for 15 minutes.

AOS-W Instant CLI

The AOS-W Instant Command Line Interface (CLI) is a text-based interface accessible through a Secure Shell
(SSH) session.

SSH access requires that you configure an |IP address and a default gateway on the OAW-IAP and connect the
OAW-IAP to your network. This is typically performed when the AOS-W Instant network on an OAW-IAP is set up.
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What is New in AOS-W Instant 6.4.0.2-4.1

The following features are added in the AOS-W Instant 6.4.0.2-4.1 release:

Table 4: New Features in 6.4.0.2-4. 1

Feature Description

Support for AppRF

In this release, AOS-W Instant supports AppRF comprising of two feature sets: On-board
Deep Packet Inspection (DPI) and Web Policy Enforcement (WPE). As part of the AppRF
feature support, AOS-W Instant supports the following :

e Access control based on application and application categories
e Access control based on web categories and security ratings assigned to the
websites

Support for new 4G
modems

AOS-W Instant now supports the following 4G modems:
o Netgear Aircard 341u

e Pantech UML295

e Franklin Wireless u770

e Huawei 3276s-150

AirGroup Enhancements

AOS-W Instant supports Universal Plug and Play (UPnP) and DLNA (Digital Living
Network Alliance) enabled devices. DLNA is a network standard derived from UPnP,
which enables devices to discover the services available in a network.

DSCP Mapping for WMM
Access Categories

AOS-W Instant supports customization of Wi-Fi Multimedia to DSCP mapping
configuration for upstream and downstream ftraffic.

Fastroaming
enhancements

AOS-W Instant supports 802.11k (Radio Resource Management) and 802.11v (BSS
Transition Management) standards to improve Quality of Service (QoS) and seamless
connectivity.

Authentication
survivability with EAP-
TLS

AOS-W Instant supports the authentication survivability feature with the EAP-TLS
authentication protocol. The authentication survivability feature supports a survivable
authentication framework against the remote link failure when working with the external
authentication servers.

Support for AP zone
configuration

You can configure zone settings on an OAW-IAP and an SSID, so that the SSID is
created on s specific OAW-IAP in the cluster.

Configurable port for
communication between
OAW-IAP and OmniVista
management server
communication

You can customize the port number of the OmniVista management server through the
server_host:server_port format, for example, amp.aruba.com:4343.

Client match
visualization

The AOS-W Instant Ul provides a graphical representation of the client distribution on an
AP, the RSSI details, and the channel availability and utilization metrics.

Console access to OAW-
IAP

In this release, you can allow or restrict access to an OAW-IAP console through the serial
port. By default, the console access to an IAP is enabled.

Backup RADIUS server
with EAP termination

AOS-W Instant supports the configuration of the primary and backup RADIUS servers in
an enterprise WLAN SSID that has EAP termination enabled.

Support for
TACACS+ Server

In this release, a new external server type called TACACS+ Server is added to support
authentication and accounting privileges for management users.
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Table 4: New Features in 6.4.0.2-4. 1

Feature Description

firewall rules
configuration

XML API Integration The AOS-W Instant Ul allows users to integrate an XML API Interface with an OAW-IAP.
The users can use the XML APl interface to add, delete, authenticate, or query a useror a
client.

Support for inbound You can configure firewall rules based on the source subnet for the inbound traffic

coming through the uplink ports of an OAW-IAP.

Full tunnel support

For Centralized-L2 mode SSID, you can disable split-tunnel to tunnel all packets on the
SSID through the VPN tunnel. This overrides any global routing profiles and sends all
traffic from the client including DNS packets into the VPN tunnel.

Table 5: New Hardware Platforms introduced in this release

OAW-IAP
Platform

Description

OAW-IAP270 The OAW-IAP274 and OAW-IAP275 are environmentally hardened, outdoor rated, dual-radio IEEE

Series 802.11ac wireless access points. These access points use MIMO (Multiple-in, Multiple-out)
technology and other high-throughput mode techniques to deliver high-performance, 802.11ac 2.4
GHz and 5 GHz functionality while simultaneously supporting existing 802.11a/b/g/n wireless
services. For more information about this product, visit https:/service.esd.alcatel-lucent.com.

OAW-IAP103 The OAW-IAP103 wireless access point supports the IEEE 802.11n standard for high-performance

WLAN. This access point uses MIMO (Multiple-in, Multiple-out) technology and other high-
throughput mode techniques to deliver high performance, 802.11n 2.4 GHz or 5 GHz functionality
while simultaneously supporting existing 802.11a/b/g wireless services. For more information about
this product, visit https://service.esd.alcatel-lucent.com.
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Chapter 3

Setting up an OAW-|AP

This chapter describes the following procedures:

e Setting up AOS-W Instant Network on page 35
e Loggingintothe AOS-W Instant Ul on page 37
e Accessing the AOS-W Instant CLI on page 42

Setting up AOS-W Instant Network

Before installing an OAW-IAP:
o Ensure that you have an Ethernet cable of the required length to connect an OAW-IAP to the home router.
e Ensure that you have one of the following power sources:

» |EEE 802.3af/at-compliant Power over Ethemet (PoE) source. The PoE source can be any power source
equipment (PSE) switch or a midspan PSE device.

= OAW-IAP power adapter kit.
Perform the following procedures to set up the AOS-W Instant network:
1. Connecting an OAW-IAP on page 35
2. Assigning an IP address to the OAW-IAP on page 35

3. Connecting to a Provisioning Wi-Fi Network on page 36

Connecting an OAW-IAP

Based on the type of the power source used, perform one of the following steps to connect an OAW-IAP to the power
source:

o PoE switch— Connect the ENET 0 port of the OAW-IAP to the appropriate port on the PoE switch.
e PoE midspan— Connect the ENET 0 port of the OAW-IAP to the appropriate port on the PoE midspan.
e AC to DC power adapter— Connect the 12V DC power jack socket to the AC to DC power adapter.

OAW-RAP155P supports PSE for 802.3at powered device (class 0-4) on one port (E1 or E2), or 802.3af powered
DC IN (Power Socket) on two ports (E1 and E2).

Assigning an IP address to the OAW-IAP

The OAW-IAP needs an IP address for network connectivity. When you connect an OAW-IAP to a network, it
receives an IP address from a DHCP server.

To obtain an IP address for an OAW-IAP:
1. Ensure that the DHCP service is enabled on the network.

2. Connect the ENET 0 port of OAW-IAP to a switch or router using an Ethernet cable.

3. Connect the OAW-IAP to a power source. The OAW-IAP receives an IP address provided by the switch or
router.

If there is no DHCP service on the network, the OAW-IAP can be assigned a static IP address. If a static IP is not
assigned, the OAW-IAP obtains an IP automatically within the 169.254 subnet.
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Assigning a Static IP
To assign a static IP to an OAW-IAP:

1. Connect a terminal, PC, or workstation running a terminal emulation program to the Console port on the OAW-
IAP.

2. Power on the OAW-IAP. An autoboot countdown prompt that allows you to interrupt the normal startup process
and access apboot is displayed.

3. Click Enter before the timer expires. The OAW-IAP goes into the apboot mode.

In the apboot mode, use the following commands to assign a static IP to the OAW-IAP.

Hit <Enter> to stop autoboot: 0
apboot>
apboot> setenv ipaddr 192.0.2.0
apboot> setenv netmask 255.255.255.0
apboot> setenv gatewayip 192.0.2.2
apboot> save
Saving Environment to Flash...
Un-Protected 1 sectors
.done
Erased 1 sectors
Writing

5. Usetheprintenv command to view the configuration.

apboot> printenv

Connecting to a Provisioning Wi-Fi Network

The OAW-IAPs boot with factory default configuration and try to provision automatically. If the automatic
provisioning is successful, the instant SSID will not be available. If OmniVista and Activate are not reachable and
the automatic provisioning fails, the instant SSID becomes available and the users can connect to a provisioning
network by using the instant SSID.

To connect to a provisioning Wi-Fi network:

Ensure that the client is not connected to any wired network.
2. Connect a wireless enabled client to a provisioning Wi-Fi network: for example, instant.
3. If the Windows OS system is used:
a. Click the wireless network connection icon in the system tray. The Wireless Network Connection window
is displayed.
b. Click onthe instant network and then click Connect.
4. If the Mac OS system is used:
a. Click the AirPort icon. A list of available Wi-Fi networks is displayed.
b. Click on the instant network.

The instant SSIDs are broadcast in 2.4 GHz only.

HOTE
OAW-IAP Cluster
OAW-IAPs in the same VLAN automatically find each other and form a single functioning network managed by a
Virtual Controller.
Moving an OAW-IAP from one cluster to another requires a factory reset of the OAW-IAP.
HOTE
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Disabling the Provisioning Wi-Fi Network

The provisioning network is enabled by default. AOS-W Instant provides the option to disable the provisioning
network through the console port. Use this option only when you do not want the default SSID instant to be
broadcast in your network.

To disable the provisioning network:

1. Connect a terminal or PC/workstation running a terminal emulation program to the Console port on the OAW-
IAP.

2. Configure the terminal or terminal emulation program to use the following communication settings:

Table 6: Terminal Communication Settings

Baud Rate Data Bits Parity Stop Bits Flow Control

9600 8 None 1 None

3. Poweronthe OAW-IAP. An autoboot countdown prompt that allows you to interrupt the normal startup process
and access apboot is displayed.

4. Click Enter before the timer expires. The OAW-IAP goes into the apboot mode through console.

In the apboot mode, use the following commands to disable the provisioning network:
m  apboot> factory reset

m  apboot> setenv disable prov ssid 1

B apboot> saveenv

®  apboot> reset

Logging in to the AOS-W Instant Ul

Launch a Web browser and enter http://instant. Alcatel-Lucentnetworks.com. In the login screen, enter the following
credentials:

o Username— admin
e Password—admin

The following figure shows the Login screen:

Figure 1 Login Screen

Welcome to Instant

Alcatel-Lucent @ ' i'_

Wirtual Contraller

Username: |[2dmin

Password: |[sesse

Logln
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http://instant.alcatel-lucentnetworks.com/

When you use a provisioning Wi-Fi network to connect to the Internet, all browser requests are directed to the AOS-
W Instant Ul. For example, if you enter www.example.com in the address field, you are directed to the AOS-W
Instant Ul. You can change the default login credentials after the first login.

Regulatory Domains

The IEEE 802.11/b/g/n Wi-Fi networks operate in the 2.4 GHz spectrum and IEEE 802.11a/n operates in the 5.0
GHz spectrum. The spectrum is divided into channels. The 2.4 GHz spectrum is divided into 14 overlapping,
staggered 20 MHz wireless carrier channels. These channels are spaced 5 MHz apart. The 5 GHz spectrum is
divided into more channels. The channels that can be used in a particular country differ based on the regulations of
that country.

The initial Wi-Fi setup requires you to specify the country code for the country in which the AOS-W Instant operates.
This configuration sets the regulatory domain for the radio frequencies that the OAW-IAPs use. Within the regulated
transmission spectrum, a high-throughput 802.11ac, 802.11a, 802.11b/g, or 802.11n radio setting can be configured.
The available 20 MHz, 40 MHz, or 80MHz channels are dependent on the specified country code.

You cannot change the country code for the OAW-IAPs in the restricted regulatory domains such as US, Japan, and
Israel for most of the OAW-IAP models. Improper country code assignments can disrupt wireless transmissions.
Most countries impose penalties and sanctions on operators of wireless networks with devices set to improper
country codes.

Country Code

The following table provides a list of supported country codes:

Table 7: Country Codes List

Code Country Name

AE United Arab Emirates
AR Argentina
AT Austria

AU Australia
BG Bulgaria
BH Bahrain

BM Bermuda
BO Bolivia

BR Brazil

CA Canada

CH Switzerland
CL Chile

CN China

CO Colombia
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Code Country Name

CR Costa Rica

CS Serbia and Montenegro
CY Cyprus

Cz Czech Republic
DE Germany

DK Denmark

DO Dominican Republic
Dz Algeria

EC Ecuador

EE Estonia

EG Egypt

ES Spain

Fl Finland

FR France

GB United Kingdom
GR Greece

GT Guatemala

HK Hong Kong

HN Honduras

ID Indonesia

IE Ireland

IL Israel

IN India

IS Iceland

IT ltaly

JM Jamaica

JO Jordan

JP Japan
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Code Country Name

KE Kenya

KR Republic of Korea (South
Korea)

KW Kuwait

LB Lebanon

LI Liechtenstein

LI Liechtenstein

LK Sri Lanka

LT Lithuania

LU Luxembourg

MA Morocco

MU Mauritius

MX Mexico

NL Netherlands

NO Norway

Nz New Zealand

OM Oman

PA Panama

PE Peru

PH Philippines

PK Islamic Republic of Pakistan

PL Poland

PR Puerto Rico

PT Portugal

QA Qatar

RO Romania

RU Russia

SA Saudi Arabia

SG Singapore
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Code Country Name

Sl Slovenia

SK Slovak Republic

SV El Salvador

TH Thailand

TN Tunisia

TR Turkey

TT Trinidad and Tobago

T™W Taiwan

UA Ukraine

us United States

uy Uruguay

VE Venezuela

VN Vietnam

ZA South Africa
Specifying Country Code

| d This procedure is applicable to the OAW-IAP-RoW (Rest of World) variants only. Skip this step if you are installing
OAW-IAP in the United States, Japan, or Israel.

The Country Code window is displayed for the OAW-IAP-RoW (Rest of World) variants when you log in to the Ul
for the first time. You can specify a country code by selecting an appropriate option from the Please Specify the
Country Code drop-down list.

Figure 2 Specifying a Country Code

Welcome to Instant

Please specify the Country Code:

-- Select a country code - -

For the complete list of the country codes supported by the OAW-IAP-ROW variant type, see Country Code on page
38.
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AOS-W Instant supports the use of Command Line Interface (CLI) for scripting purposes. When you make
configuration changes on a master OAW-IAP in the CLI, all associated OAW-IAPs in the cluster inherit these
changes and subsequently update their configurations. By default, you can access the CLI from the serial port or

from an SSH session. You must explicitly enable Telnet access on the OAW-IAP to access the CLI through a Telnet
session.

For information on enabling SSH and Telnet access to the OAW-IAP CLI, see Configuring Terminal Access on page
80.

Connecting to a CLI Session

On connecting to a CLI session, the system displays its host name followed by the login prompt. Use the
administrator credentials to start a CLI session. For example:

(Instant AP)

User: admin

If the login is successful, the privileged command mode is enabled and a command prompt is displayed. For
example:

(Instant AP)#
The privileged mode provides access to show, clear, ping, traceroute, and commit commands. The configuration

commands are available in config mode. To move from privileged mode to the configuration mode, enter the
following command at the command prompt:

(Instant AP)# configure terminal

The configure terminal command allows you to enter the basic configuration mode and the command prompt is
displayed as follows:
(Instant AP) (config)#

The AOS-W Instant CLI allows CLI scripting in several other sub-command modes to allow the users to configure
individual interfaces, SSIDs, access rules, and security settings.

You can use the question mark (?) to view the commands available in a privileged mode, configuration mode, or sub-
mode.

NOTE

Although automatic completion is supported for some commands such as configure terminal, the complete exit
and end commands must be entered at command prompt.

Applying Configuration Changes

Each command processed by the Virtual Controller is applied on all the slaves in a cluster. The changes configured
in a CLI session are saved in the CLI context. The CLI does not support the configuration data exceeding the 4K
buffer size in a CLI session. Therefore, Alcatel-Lucent recommends that you configure fewer changes at a time and
apply the changes at regular intervals.

To apply and save the configuration changes at regular intervals, use the following command in the privileged mode:
(Instant AP)# commit apply

To apply the configuration changes to the cluster without saving the configuration, use the following command in the
privileged mode:

(Instant AP)# commit apply no-save

To view the changes that are yet to be applied, use the following command in the privileged mode:

(Instant AP)# show uncommitted-config

To revert to the earlier configuration, use the following command in the privileged mode.
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(Instant AP)# commit revert

Example:

(Instant AP) (config)# rf dotlla-radio-profile

(Instant AP) (RF dotlla Radio Profile)# beacon-interval 200

(Instant AP) (RF dotlla Radio Profile)# no legacy-mode

(Instant AP) (RF dotlla Radio Profile)# dotllh
(
(
(
(

F
F
F
(Instant AP) (RF dotlla Radio Profile)# interference-immunity 3
F
F
F

(Instant AP) (RF dotlla Radio Profile)# csa-count 2
(Instant AP) (RF dotlla Radio Profile)# spectrum-monitor
(Instant AP) (RF dotlla Radio Profile)# end

(Instant AP)# show uncommitted-config
rf dotlla-radio-profile
no legacy-mode
beacon-interval 200
no dotllh
interference-immunity 3
csa-count 1
no spectrum-monitor

Instant Access Point# commit apply

Using Sequence Sensitive Commands

The AOS-W Instant CLI does not support positioning or precedence of sequence-sensitive commands. Therefore,
Alcatel-Lucent recommends that you remove the existing configuration before adding or modifying the configuration
details for sequence-sensitive commands. You can either delete an existing profile or remove a specific
configuration by using the no... commands.

The following table lists the sequence-sensitive commands and the corresponding ho command to remove the
configuration.

Table 8: Sequence-Sensitive Commands

Sequence-Sensitive Command Corresponding no command

opendns <username <password> no opendns

rule <dest> <mask> <match> <protocol> <start-port> no rule <dest> <:mask> <match>

<end-port> {permit |deny | src-nat | dst-nat {<IP- <protocol> <start-port> <end-port>

address> <port>| <port>}}[<optionl....option9>] {permit | deny | src-nat | dst-nat}

mgmt-auth-server <auth-profile-name> no mgmt-auth-server <auth-profile-
name>

set-role <attribute>{{equals| not-equals| starts- no set-role <attribute>{{equals]

with| ends-with| contains} <operator> <role>| value- not-equals| starts-with| ends-with|

of} contains} <operator>| value-of}

no set-role

set-vlan <attribute>{{equals| not-equals| starts- no set-vlan <attribute>{{equals]|
with| ends-with| contains} <operator> <VLAN-ID>| not-equals| starts-with| ends-with]
value-of} contains} <operator>| value-of}

no set-vlan

auth-server <name> no auth-server <name>

AOS-W Instant6.4.0.2-4.1 | User Guide Setting up an OAW-IAP | 43



Chapter 4

AOS-W Instant User Interface

This chapter describes the following AOS-W Instant Ul elements:

e Login Screen

e Main Window

Login Screen
The AOS-W Instant login page allows you to:
e Logintothe AOS-W Instant Ul.

e View AOS-W Instant Network Connectivity summary
o View the AOS-W Instant Ul in a specific language

Logging into the AOS-W Instant Ul
Tolog in to the AOS-W Instant Ul, enter the following credentials:

o Username—admin

e Password—admin

The AOS-W Instant Ul main window is displayed.

Viewing Connectivity Summary

The Login page also displays the connectivity status to the AOS-W Instant network. The users can view a summary
that indicates the status of the Internet availability, uplink, cellular modem and signal strength, VPN, and OmniVista
configuration details before logging in to the AOS-W Instant Ul.

The following figure shows the information displayed in the connectivity summary:

Figure 3 Connectivity Summary

Internet: Reachable

Active uplink: etho

Cellular Provider: No modem installed
cellular Signal: No modem installed
Primary VPN: Down

Secondary VPN: Down

AirWave: Not configured

The Internet status is available only if the Internet failover feature (System > Show advanced option > uplink >
G Internet failover) is enabled.
NOTE The cellular provider and cellular strength information is only available when a 3G or 4G modem is in use.
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Language

The Language drop-down lists the languages and allows users to select their preferred language before logging in to
the AOS-W Instant Ul. A default language is selected based on the language preferences in the client desktop
operating system or browser. If AOS-W Instant cannot detect the language, then English is used as the default
language.

You can also select the required language option from the Languages drop-down located at the bottom left corner of
the AOS-W Instant main window.

On logging into Instant, the Instant Ul Main Window is displayed. The following figure shows the AOS-W Instant
main window:

Figure 4 AOS-W Instant Main Window

Links<€—5vsiem _RF_Securty Maitenance | More- | Relp Logout ]
it tocent @) | Vi | -Ca:42:08 [—> Banner S  —
@ 5= | 1nstant-c4:42:98 Tabs
& 1 Network i) 1 Access Point B o Clients
Nam Clients Name Clients Name 1P Address Network Access Point
test 0 d8:c7:c8:c4:42:98 0
Ne
= Instani-C4:42:98 Links€—] onitoring DS Configuration _ AirGroup

All cients ] a Al access points = = =

Throughput (bps)

English A frubs Central .

The main window consists of the following elements:

Banner
Search
Tabs
Links

Views

Banner

The banner is a horizontal rectangle that appears at the top left corner of the AOS-W Instant main window. It displays
the company name, logo, and Virtual Controller's name.

Search

Administrators can search for an OAW-IAP, client, or a network in the Search text box. When you type a search
text, the search function suggests matching keywords and allows you to automatically complete the search text
entry.

Tabs

The AOS-W Instant main window consists of the following tabs:
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Networks Tab— Provides information about the network profiles configured in the Instant network.
Access Points Tab— Provides information about the OAW-IAPs configured in the Instant network.
Clients Tab— Provides information about the clients in the Instant network.
Each tab appears in a compressed view by default. The number of networks, OAW-IAPs, or clients in the network

precedes the tab names. The individual tabs can be expanded or collapsed by clicking on the tabs. The list items in
each tab can be sorted by clicking the triangle icon next to the heading labels.

Networks Tab

This tab displays a list of Wi-Fi networks that are configured in the Instant network. The network names are
displayed as links. The expanded view displays the following information about each WLAN SSID:

Name (SSID) — Name of the network.

Clients — Number of clients that are connected to the network.

Type — Type of network type such as Employee, Guest, or Voice.

Band — Band in which the network is broadcast: 2.4 GHz band, 5 GHz band, or both.

Authentication Method — Authentication method required to connect to the network.

Key Management — Authentication key type.

IP Assighment— Source of |P address for the client.

Zone—AP zone configured on the SSID.

To add a wireless network profile, click the New link in the Networks tab. To edit, click the edit link that is displayed
on clicking the network name in the Networks tab. To delete a network, click on the link Xx.

For more information on the procedure to add or modify a wireless network, see Wireless Network Profiles on page
93.

Access Points Tab

If the Auto Join Mode feature is enabled, a list of enabled and active OAW-IAPs in the AOS-W Instant network is
displayed in the Access Points tab. The OAW-IAP names are displayed as links. If the Auto Join Mode feature is
disabled, the New link is displayed. Click this link to add a new OAW-IAP to the network. If an OAW-IAP is
configured and not active, its MAC Address is displayed in red.

The expanded view of the Access Points tab displays the following information about each OAW-IAP:
Name — Name of the OAW-IAP. If the OAW-IAP functions as a master OAW-IAP in the network, the asterisk
sign "*" is displayed next to the OAW-IAP.
IP Address — IP address of the OAW-IAP.
Mode — Mode of the OAW-IAP.

Access — In this mode, the AP serves clients and scans the home channel for spectrum analysis while
monitoring channels for rogue APs in the background.

Monitor — In this mode, the AP acts as a dedicated Air Monitor (AM), scanning all channels for rogue APs and
clients.

Spectrum— When enabled, the AP functions as a dedicated full-spectrum RF monitor, scanning all channels to
detect interference from neighboring APs or non-Wi-Fi devices such as microwaves and cordless phones. When
Spectrum is enabled, the AP does not provide access services to clients.

Clients — Number of clients that are currently associated to the OAW-IAP.
Type — Model number of the OAW-IAP.

Mesh Role — Role of the OAW-IAP as a mesh portal or mesh point.
Zone—AP zone.

Channel — Channel on which the OAW-IAP is currently broadcast.
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Power (dB) — Maximum transmission EIRP of the radio.
Utilization (%) — Percentage of time that the channel is utilized.
Noise (dBm) — Noise floor of the channel.

An edit link is displayed on clicking the OAW-IAP name. For details about editing OAW-IAP settings see
Customizing OAW-IAP Settings on page 84.

Clients Tab

This tab displays a list of clients that are connected to the AOS-W Instant network. The client names are displayed
as links. The expanded view displays the following information about each client:

Name — User name of the client or guest users if available.

IP Address — IP address of the client.

MAC Address — MAC address of the client.

OS — Operating system that runs on the client.

Network — The network to which the client is connected.

Access Point — OAW-IAP to which the client is connected.

Channel — The client operating channel.

Type — Type of the Wi-Fi client: A, G, AN, or GN.

Role — Role assigned to the client.

Signal — Current signal strength of the client, as detected by the AP.

Speed (mbps) — Current speed at which data is transmitted. When the client is associated with an AP, it
constantly negotiates the speed of data transfer. A value of 0 means that the AP has not heard from the client for
some time.

Links

The following links allow you to configure various features for the AOS-W Instant network:
New Version Available
System

RF

Security

Maintenance

More

Help

Logout

Monitoring

Client Match

AppRF

Spectrum

Alerts

IDS

Configuration
AirGroup

OmniVista Setup
Pause/Resume
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HNOTE

Each of these links is explained in the subsequent sections.

New Version Available

This link is displayed in the top right corner of the AOS-W Instant main window only if a new image version is
available on the image server and OmniVista is not configured. For more information about the New version
available link and its functions, see Upgrading an OAW-IAP on page 320.

System

This link displays the System window. The System window consists of the following tabs:

Use the Show/Hide Advanced option at the bottom of the System window to view or hide the advanced options.

General- Allows you to configure, view or edit the Name, IP address, NTP Server, and other OAW-IAP settings
for the Virtual Controller. For more information on the basic and additional configuration settings that can be
performed on this tab, see Basic Configuration Tasks on page 74 and Additional Configuration Tasks on page 78.

Admin — Allows you to configure administrator credentials for access to the Virtual Controller Management User
Interface. You can also configure OmniVista in this tab. For more information on management interface and
OmniVista configuration, see Managing OAW-IAP Users on page 141 and Managing an OAW-IAP from
OmniVista on page 277 respectively.

Uplink — Allows you to view or configure uplink settings. See Uplink Configuration on page 287 for more
information.

L3 Mobility — Allows you to view or configure the Layer-3 mobility settings. See Configuring L3-Mobility on page
310 for more information.

Enterprise Domains — Allows you to view or configure the DNS domain names that are valid in the enterprise
network. See Configuring Enterprise Domains on page 190 for more information.

Monitoring — Allows you to view or configure the following details:

= Syslog — Allows you to view or configure Syslog Server details for sending syslog messages to the external
servers. See Configuring a Syslog Server on page 333 for more information.

=  TFTP Dump — Allows you to view or configure a TFTP dump server for core dump files. See Configuring
TFTP Dump Server on page 335 for more information.

=  SNMP — Allows you to view or configure SNMP agent settings. See Configuring SNMP on page 330 for more
information.

WISPr — Allows you to view or configure the WISPr settings. See Configuring WISPr Authentication on page 171
for more information.

Proxy — Allows you to configure HTTP proxy on an OAW-IAP. See Configuring HTTP Proxy on an OAW-IAP on
page 320 for more information.

The following figure provides a view of the System window with the advanced options.
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Figure 5 System Window
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RF

The RF link displays a window for configuring Adaptive Radio Management (ARM) and Radio features.

o ARM - Allows you to view or configure channel and power settings for all the OAW-IAPs in the network. For

information about ARM configuration, see ARM Overview on page 234.

o Radio — Allows you to view or configure radio settings for 2.4 GHz and the 5 GHz radio profiles. For information

about Radio, see Configuring Radio Settings for an OAW-IAP on page 240.

The following figure provides a view of the RF window with the advanced options for ARM configuration:
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Figure 6 RF Window
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Security

The Security link displays a window with the following tabs:

Authentication Servers— Use this tab to configure an external RADIUS server for a wireless network. For more
information, see Configuring an External Server for Authentication on page 158.

Users for Internal Server— Use this tab to populate the system’s internal authentication server with users. This
list is used by networks for which per-user authorization is specified using the Virtual Controller's internal
authentication server. For more information about users, see Managing OAW-IAP Users on page 141.

Roles— Use this tab to view the roles defined for all the Networks. The Access Rules part allows you to configure
permissions for each role. For more information, see Configuring User Roles on page 192 and Configuring
Access Rules for Network Services on page 179.

Blacklisting— Use this tab to blacklist clients. For more information, see Blacklisting Clients on page 172.

Firewall Settings— Use this tab to enable or disable Application Layer Gateway (ALG) supporting address and
port translation for various protocols and to configure protection against wired attacks. For more information, see
Configuring ALG Protocols on page 183 and Configuring Firewall Settings for Protection from ARP Attacks on
page 183

Inbound Firewall- Use this tab to enhance the inbound firewall by allowing configuration of inbound firewall
rules, management subnets, and restricted corporate access through an uplink switch. For more information, see
Managing Inbound Traffic on page 185.

Walled Garden—Use this window to allow or prevent access to a selected list of websites. For more information,
see Configuring Walled Garden Access on page 139.

External Captive Portal— Use this window to configure external captive portal profiles. For more information,
see Configuring External Captive Portal for a Guest Network on page 130.

The following figure shows the default view of the Security window:
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Figure 7 Security Window - Default View
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Maintenance

The Maintenance link displays a window that allows you to maintain the Wi-Fi network. The Maintenance window
consists of the following tabs:

e About-Displays the name of the product, build time, OAW-IAP model name, the AOS-W Instant version,
website address of Alcatel-Lucent, and Copyright information.

o Configuration— Displays the following details:
= Current Configuration — Displays the current configuration details.
= Clear Configuration —Allows you to clear the current configuration details of the network.

= Backup Configuration — Allows you to back up local configuration details. The backed up configuration data
is saved in the file named instant.cfg.

= Restore Configuration — Allows you to restore the backed up configuration. The OAW-IAP must be rebooted
after restoring the configuration for the changes to affect.

o Certificates — Displays information about the certificates installed on the OAW-IAP. You can also upload new
certificates and set a passphrase for the certificates. For more information, see Uploading Certificates on page
174.

o Firmware — Displays the current firmware version and provides various options to upgrade to a new firmware
version. For more information, see Upgrading an OAW-IAP on page 320.

e Reboot - Displays the OAW-IAPs in the network and provides an option to reboot the required access point or all
access points. For more information, see Upgrading an OAW-IAP on page 320.

e Convert— Provides an option to convert an OAW-IAP to a OmniAccess WLAN Switch managed Remote AP or
Campus AP, or to the default Virtual Controller mode. For more information, see Converting an OAW-IAP to a
Remote AP and Campus AP on page 323.

The following figure shows the default view of the Maintenance window:
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Figure 8 Maintenance Window - Default View

Maintenance Help
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Close
More

The More link allows you to select the following options:
e VPN

e IDS

e Wired

e Services

e DHCP Server

e Support

VPN

The VPN window allows you to define communication settings with a remote Switch. See VPN Configuration on
page 212 for more information. The following figure shows an example of the IPSec configuration options available in
the VPN window:
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Figure 9 VPN window for IPSec Configuration
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IDS

The IDS window allows you to configure wireless intrusion detection and protection levels. The following figures

show the IDS window:

Figure 10 /DS Window: Intrusion Detection
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Wireless Intrusion Protection (WIP)
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Figure 11 /DS Window: Intrusion Protection
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For more information on wireless intrusion detection and protection, see Detecting and Classifying Rogue APs on

page 299.
Wired

The Wired window allows you to configure a wired network profile. See Wired Profiles on page 113 for more
information. The following figure shows the Wired window:
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Figure 12 Wired Window
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Services

The Services window allows you to configure services such as AirGroup, RTLS, and OpenDNS. The Services
window consists of the following tabs:

AirGroup — Allows you to configure the AirGroup and AirGroup services. For more information, see AirGroup
Configuration on page 257.

RTLS — Allows you to integrate OmniVista Management platform or third-party Real Time Location Server such
as Aeroscout Real Time Location Server with AOS-W Instant. For more information, see Configuring an OAW-
IAP for RTLS Support on page 265.

The RTLS tab also allows you to integrate OAW-IAP with the Analytics and Location Engine (ALE). For more
information about configuring an OAW-IAP for ALE integration, see Configuring an OAW-IAP for Analytics and
Location Engine Support on page 267.

OpenDNS- Allows you to configure support for OpenDNS business solutions, which require an OpenDNS
(www.opendns.com) account. The OpenDNS credentials are used by AOS-W Instant and OmniVista to filter
content at the enterprise level. For more information, see Configuring OpenDNS Credentials on page 268.

CALEA-Allows you configure support for Communications Assistance for Law Enforcement Act (CALEA)
server integration, thereby ensuring compliance with Lawful Intercept and CALEA specifications. For more
information, see CALEA Integration and Lawful Intercept Compliance on page 272.

Network Integration—Allows you to configure an OAW-IAP for integration with Palo Alto Networks (PAN)
Firewall and XML API server. For more information about OAW-IAP integration with PAN, see Integrating an
OAW-IAP with Palo Alto Networks Firewall on page 269and Integrating an OAW-IAP with an XML API interface
on page 270.

The following figure shows the default view of the Services window:
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Figure 13 Services Window: Default View
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DHCP Server

The DHCP Servers window allows you to configure various DHCP modes. The following figure shows the contents
of the DHCP Servers window:

Figure 14 DHCP Servers Window

For more information, see DHCP Configuration on page 203.

Support

The Support consists of the following fields:

Command- Allows you to select a support command for execution.
Target—Displays a list of OAW-IAPs in the network.
Run-— Allows you to execute the selected command for a specific OAW-IAP or all OAW-IAPs and view logs.

Auto Run— Allows you to configure a schedule for automatic execution of a support command for a specific
OAW-IAP or all OAW-IAPs.

Filter—Allows you to filter the contents of a command output.
Clear—Clears the command output displayed after a command is executed.
Save— Allows you to save the support command logs as an HTML or text file.

For more information on support commands, see Running Debug Commands from the Ul on page 336. The following
figure shows the Support window:
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Figure 15 Support Window
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The Help link allows you to view a short description or definition of selected terms and fields in the Ul windows or
dialogs.

To activate the context-sensitive help:

1.
2.

Click the Help link at the top right corner of AOS-W Instant main window.
Click any text or term displayed in green italics to view its description or definition.

3. Todisable the help mode, click Done.

Logout

The Logout link allows you to log out of the AOS-W Instant Ul.

Monitoring

The Monitoring link displays the Monitoring pane for the AOS-W Instant network. Use the down arrow located
to the right side of these links to compress or expand the monitoring pane.

The monitoring pane consists of the following sections:

Info

RF Dashboard
RF Trends
Usage Trends
Mobility Trail

Info

The Info section displays the configuration information of the Virtual Controller by default. On selecting the Network
View tab, the monitoring pane displays configuration information of the selected network. Similarly in the Access
Point or the Client view, this section displays the configuration information of the selected OAW-IAP or the client.
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Table 9: Contents of the Info Section in the AOS-W Instant Main Window

Name Description

Info section in Virtual The Info section in the Virtual Controller view displays the following information:
Controller view Name— Displays the Virtual Controller name.

Country Code— Displays the Country in which the Virtual Controller is operating.
Virtual Controller IP address— Displays the IP address of the Virtual Controller.
Management: Indicates if the OAW-IAP is managed locally or through OmniVista.
Master— Displays the IP address of the Access Point acting as Virtual Controller.
OpenDNS Status— Displays the OpenDNS status. If the OpenDNS status
indicates Not Connected, ensure that the network connection is up and
appropriate credentials are configured for OpenDNS.

MAS integration— Displays the status of the MAS integration feature.

Uplink type — Displays the type of uplink configured on the OAW-IAP, for
example, Ethernet or 3G.

Uplink status — Indicates the uplink status.

Blacklisted clients — Displays the number of blacklisted clients.

Internal RADIUS Users — Displays the number of internal RADIUS users.
Internal Guest Users — Displays the number of internal guest users.

Internal User Open Slots— Displays the available slots for user configuration as
supported by the OAW-IAP model.

Info section in Network view The Info section in the Network view displays the following information:

Name — Displays the name of the network.

Status — Displays the status of the network.

Type — Displays the type of network, for example, Employee, Guest, or Voice.
IP Assignment— Indicates if the OAW-IAP clients are assigned IP address from
the network that the Virtual Controller is connected to, or from an internal auto-
generated IP scope from the Virtual Controller.

Access— Indicates the level of access control configured for the network.
WMM DSCP-Displays WMM DSCP mapping details.

Security level- Indicates the type of user authentication and data encryption
configured for the network.

The info section for WLAN SSIDs also indicates status of Captive Portal and CALEA
ACLs and provides a link to upload certificates for internal server. For more
information, see Uploading Certificates on page 174.

Info section in Access Point The Info section in the Access Point view displays the following information:
view Name — Displays the name of the selected OAW-IAP.

IP Address — Displays the IP address of the OAW-IAP.

Mode — Displays the mode in which the AP is configured to operate:

In Access mode, the OAW-IAP serves clients, while also
monitoring for rogue APs in the background.

In Monitor mode, the OAW-IAP acts as a dedicated monitor,
scanning all channels for rogue APs and clients.

Spectrum — Displays the status of the spectrum monitor.

Clients — Number of clients associated with the OAW-IAP.

Type — Displays the model number of the OAW-IAP.

Zone — Displays AP zone details.

CPU Utilization — Displays the CPU utilization in percentage.

Memory Free — Displays the memory availability of the OAW-IAP in MB.
Serial number — Displays the serial number of the OAW-IAP.

MAC- Displays the MAC address.

From Port— Displays the port from where the slave OAW-IAP is learned in
hierarchy mode.

Info section in Client view The Info section in the Client view displays the following information:
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Table 9: Contents of the Info Section in the AOS-W Instant Main Window

Name Description

Name— Displays the name of the client.

IP Address— Displays IP address of the client.

MAC Address— Displays MAC Address of the client.

OS- Displays the Operating System that is running on the client.
Network— Indicates the network to which the client is connected.
Access Point— Indicates the OAW-IAP to which the client is connected.
Channel- Indicates the channel thatis currently used by the client.
Type— Displays the channel type on which client is broadcasting.
Role—Displays the role assigned to the client.

RF Dashboard

The RF Dashboard section lists the OAW-IAPs that exceed the utilization, noise, or error threshold. It also shows
the clients with low speed or signal strength in the network and the RF information for the OAW-IAP to which the
client is connected.

The OAW-IAP names are displayed as links. When an OAW-IAP is clicked, the OAW-IAP configuration information
is displayed in the Info section and the RF Dashboard section is displayed at the bottom left corner of the AOS-W
Instant main window.

The following figure shows an example of the RF dashboard with Utilization, Band frames, Noise Floor, and Errors
details:

Figure 16 RF Dashboard in the Monitoring Pane
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The following table describes the icons available on the RF Dashboard pane:
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Table 10: RF Dashboard Icons

Icon

1

Name

Signal
Icon

Description

Displays the signal strength of the client. Depending on the signal strength of the client, the color
of the lines on the Signal bar changes from Green > Orange > Red.

o Green- Signal strength is more than 20 decibels.

e Orange- Signal strength is between 15-20 decibels.

e Red- Signal strength is less than 15 decibels.

To view the signal graph for a client, click on the signal icon next to the clientin the Signal
column.

Speed
icon

Displays the data transfer speed of the client. Depending on the data transfer speed of the client,

the color of the Signal bar changes from Green > Orange > Red.

e Green— Data transfer speed is more than 50 percent of the maximum speed supported by
the client.

o Orange— Data transfer speed is between 25-50 percent of the maximum speed supported by
the client.

o Red- Data transfer speed is less than 25 percent of the maximum speed supported by the
client.

To view the data transfer speed graph of a client, click on the speed icon against the clientin the

Speed column.

Utilization
icon

Displays the radio utilization rate of the OAW-IAPs. Depending on the percentage of utilization,
the color of the lines on the Utilization icon changes from Green > Orange > Red.

e Green- Utilization is less than 50 percent.

e Orange-— Utilization is between 50-75 percent.

o Red- Utilization is more than 75 percent.

To view the utilization graph of an OAW-IAP, click the Utilization icon next to the OAW-IAP in the
Utilization column.

Noise icon

Displays the noise floor details for the OAW-IAPs. Noise is measured in decibels/meter.
Depending on the noise floor, the color of the lines on the Noise icon changes from Green >
Orange > Red.

o Green— Noise floor is more than 87 dBm.

e Orange— Noise floor is between 80 dBm-87 dBm.

o Red- Noise floor is less than 80 dBm.

To view the noise floor graph of an OAW-IAP, click the noise icon next to the OAW-IAP in the
Noise column.

Errors
icon

Displays the errors for the OAW-IAPs. Depending on the errors, color of the lines on the Errors
icon changes from Green > Yellow > Red.

o Green-— Errors are less than 5000 frames per second.

e Orange-— Errors are between 5000-10000 frames per second.

o Red- Errors are more than 10000 frames per second.

To view the errors graph of an OAW-IAP, click the Errors icon next to the OAW-IAP in the Errors
column.

RF Trends

The RF Trends section displays the following graphs for the selected AP and the client. To view the details on the
graphs, click the graphs and hover the mouse on a data point:
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Figure 17 RF Trends for Access Point
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Figure 18 RF Trends for Clients
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Usage Trends
The Usage Trends displays the following graphs:

e Clients — In the default view, the Clients graph displays the number of clients that were associated with the
Virtual Controller in the last 15 minutes. In Network or Access Points view, this graph displays the number of
clients that were associated with the selected network or OAW-IAP in the last 15 minutes.

o Throughput— In the default view, the Throughput graph displays the incoming and outgoing throughput traffic for
the Virtual Controller in the last 15 minutes. In the Network or Access Points view, this graph displays the
incoming and outgoing throughput traffic for the selected network or OAW-IAP in the last 15 minutes.

Figure 19 Usage Trends Graphs in the Default View
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The following table describes the graphs displayed in the Network view:

Table 11: Network View — Graphs and Monitoring Procedures

Graph Name Description Monitoring Procedure
Clients The Clients graph shows the number of clients To check the number of clients associated
associated with the network for the last 15 with the network for the last 15 minutes,
minutes. 1. Log in to the AOS-W Instant Ul. The
To see an enlarged view, click the graph. Virtual Controller view appears. This is
e The enlarged view provides Last, Minimum, the default view.
Maximum, and Average statistics for the 2. In the Networks tab, click the network for
number of clients associated with the Virtual which you want to check the client
Controller for the last 15 minutes. association. The Network view is
e To see the exact number of clients in the AOS- displayed.
W Instant network at a particular time, move 3. Study the Clients graph in the Usage
the cursor over the graph line. Trends pane. For example, the graph
shows that one client is associated with
the selected network at 12:00 hours.
Throughput The Throughput graph shows the throughput of To check the throughput of the selected

the selected network for the last 15 minutes.

e Outgoing traffic — Throughput for outgoing
traffic is displayed in green. Outgoing traffic is
shown above the median line.

e Incoming traffic — Throughput for incoming
traffic is displayed in blue. Incoming traffic is
shown below the median line.

To see an enlarged view, click the graph.

e The enlarged view provides Last, Minimum,
Maximum, and Average statistics for the
incoming and outgoing traffic throughput of the
network for the last 15 minutes.

To see the exact throughput of the selected

network at a particular time, move the cursor over

the graph line.

network for the last 15 minutes,

1. Log in to the AOS-W Instant Ul. The
Virtual Controller view is displayed. This
is the default view.

2. In the Networks tab, click the network for
which you want to check the client
association. The Network view is
displayed.

3. Study the Throughput graph in the Usage
Trends pane. For example, the graph
shows 22.0 Kbps incoming traffic
throughput for the selected network at
12:03 hours.
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The following table describes the graphs displayed in the Access Point view:

Table 12: Access Point View — Usage Trends and Monitoring Procedures

Description

Monitoring Procedure

Neighboring The Neighboring APs graph shows the To check the neighboring APs detected by the OAW-
APs number of APs heard by the selected IAP for the last 15 minutes,

OAW-IAP: 1. Log in to the AOS-W Instant Ul. The Virtual

o Valid APs: An AP that is part of the Controller view is displayed. This is the default
enterprise providing WLAN service. view.

o Interfering APs: An AP thatis seen in 2. In the Access Points tab, click the OAW-IAP for
the RF environment but is not which you want to monitor the client association.
connected to the network. The OAW-IAP view is displayed.

o Rogue APs: An unauthorized AP thatis | 3. Study the Neighboring APs graph in the Overview
plugged into the wired side of the section. For example, the graph shows that 148
network. interfering APs are detected by the OAW-IAP at

To see the number of different types of 12:04 hours.

neighboring APs for the last 15 minutes,

move the cursor over the respective graph

lines.

CPU The CPU Utilization graph displays the To check the CPU utilization of the OAW-IAP for the
Utilization utilization of CPU for the selected OAW- last 15 minutes,

IAP. 1. Log in to the AOS-W Instant Ul. The Virtual

To see the CPU utilization of the OAW-IAP, Controller view is displayed. This is the default

move the cursor over the graph line. view.

2. In the Access Points tab, click the OAW-IAP for
which you want to monitor the client association.
The OAW-IAP view is displayed.

3. Study the CPU Utilization graph in the Overview
pane. For example, the graph shows that the CPU
utilization of the OAW-IAP is 30% at 12:09 hours.

Neighboring The Neighboring Clients graph shows the To check the neighboring clients detected by the OAW-
Clients number of clients not connected to the IAP for the last 15 minutes,

selected AP, but heard by it. 1. Log in to the AOS-W Instant Ul. The Virtual

e Any client that successfully Controller view is displayed. This is the default
authenticates with a valid AP and view.
passes encrypted traffic is classified as | 2. In the Access Points tab, click the OAW-IAP for
a valid client. which you want to monitor the client association.

e Interfering: A client associated to any The OAW-IAP view is displayed.

AP and is not valid is classified as an 3. Study the Neighboring Clients graph in the
interfering client. Overview pane. For example, the graph shows that

To see the number of different types of 20 interfering clients were detected by the OAW-

neighboring clients for the last 15 minutes, IAP at 12:15 hours.

move the cursor over the respective graph

lines.
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Table 12: Access Point View — Usage Trends and Monitoring Procedures

Description Monitoring Procedure
Memory free The memory free graph displays the To check the free memory of the OAW-IAP for the last
(MB) memory availability of the OAW-IAP in MB. | 15 minutes,
To see the free memory of the OAW-IAP, 1. Log in to the AOS-W Instant Ul. The Virtual
move the cursor over the graph line. Controller view is displayed. This is the default
view.

2. In the Access Points tab, click the OAW-IAP for
which you want to monitor the client association.
The OAW-IAP view is displayed.

3. Study the Memory free graph in the Overview pane.
For example, the graph shows that the free memory
of the OAW-IAP is 64 MB at 12:13 hours.

Clients The Clients graph shows the number of To check the number of clients associated with the

clients associated with the selected OAW- OAW-IAP for the last 15 minutes,

IAP for the last 15 minutes. 1. Log in to the AOS-W Instant Ul. The Virtual

To see an enlarged view, click the graph. Controller view is displayed. This is the default

The enlarged view provides Last, view.

Minimum, Maximum, and Average 2. In the Access Points tab, click the OAW-IAP for

statistics for the number of clients which you want to monitor the client association.

associated with the OAW-IAP for the last The OAW-IAP view is displayed.

15 minutes. 3. Study the Clients graph. For example, the graph

To see the exact number of clients shows that six clients are associated with the OAW-

associated with the selected OAW-IAP at a IAP at 12:11 hours.

particular time, move the cursor over the

graph line.

Throughput The Throughput graph shows the To check the throughput of the selected OAW-IAP for

throughput for the selected OAW-IAP for the last 15 minutes,

the last 15 minutes. 1. Log in to the AOS-W Instant Ul. The Virtual

e Outgoing traffic — Throughput for Controller view is displayed. This is the default
outgoing traffic is displayed in green. view.
Outgoing traffic is shown about the 2. In the Access Points tab, click the OAW-IAP for
median line. which you want to monitor the throughput. The

e Incoming traffic — Throughput for OAW-IAP view is displayed.
incoming traffic is displayed in blue. 3. Study the Throughput graph. For example, the
Incoming traffic is shown below the graph shows 44.03 Kbps incoming traffic
median line. throughput at 12:08 hours.

To see an enlarged view, click the graph.

o The enlarged view provides Last,
Minimum, Maximum, and Average
statistics for the incoming and outgoing
traffic throughput of the OAW-IAP for
the last 15 minutes.

To see the exact throughput of the selected

OAW-IAP at a particular time, move the

cursor over the graph line.
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The following table describes the RF trends graphs available in the client view:

Table 13: Client View — RF Trends Graphs and Monitoring Procedures

Description

Monitoring Procedure

Signal The Signal graph shows the signal To monitor the signal strength of the selected client for
strength of the client for the last 15 minutes. | the last 15 minutes,
Itis measured in decibels. 1. Login to the AOS-W Instant Ul. The Virtual
To see an enlarged view, click the graph. Controller view is displayed. This is the default view.
The enlarged view provides Last, 2. In the Clients tab, click the IP address of the client
Minimum, Maximum, and Average signal for which you want to monitor the signal strength.
statistics of the client for the last 15 The client view is displayed.
minutes. 3. Study the Signal graph in the RF Trends pane. For
To see the exact signal strength ata example, the graph shows that signal strength for
particular time, move the cursor over the the clientis 54.0 dB at 12:23 hours.
graph line.
Frames The Frames Graph shows the In and Out To monitor the In and Out frame rate per second and
frame rate per second of the client for the retry frames for the In and Out traffic, for the last 15
last 15 minutes. It also shows data for the minutes,
Retry In and Retry Out frames. 1. Login to the AOS-W Instant Ul. The Virtual
e Outgoing frames — Outgoing frame Controller view is displayed. This is the default view.
traffic is displayed in green. It is shown 2. Inthe Clients tab, click the IP address of the client
above the median line. for which you want to monitor the frames. The client
e Incoming frames — Incoming frame view is displayed.
traffic is displayed in blue. Itis shown 3. Study the Frames graph in the RF Trends pane. For
below the median line. example, the graph shows 4.0 frames per second
o Retry Out— Retries for the outgoing for the clientat 12:27 hours.
frames are displayed above the median
line in black .
o Retry In — Retries for the incoming
frames are displayed below the median
line in red.
To see an enlarged view, click the graph.
The enlarged view provides Last,
Minimum, Maximum, and Average statistics
for the In, Out, Retries In, and Retries Out
frames.
To see the exact frames at a particular time
move the cursor over the graph line.
Speed The Speed graph shows the data transfer To monitor the speed for the client for the last 15
speed for the client. Data transfer is minutes,
measured in Mbps. 1. Log in to the AOS-W Instant Ul. The Virtual
To see an enlarged view, click the graph. Controller view is displayed. This is the default view.
The enlarged view shows Last, Minimum, 2. Inthe Clients tab, click the IP address of the client
Maximum, and Average statistics of the for which you want to monitor the speed. The client
client for the last 15 minutes. view is displayed.
To see the exact speed at a particulartime, | 3. Study the Speed graph in the RF Trends pane. For
move the cursor over the graph line. example, the graph shows that the data transfer
speed at 12:26 hours is 240 Mbps.
Throughput The Throughput Graph shows the To monitor the errors for the client for the last 15
throughput of the selected client for the last | minutes,
15 minutes. 1. Log in to the AOS-W Instant Ul. The Virtual
e Outgoing traffic — Throughput for Controller view is displayed. This is the default view.
outgoing traffic is displayed in green. 2. Inthe Clients tab, click the IP address of the client
Outgoing traffic is shown above the for which you want to monitor the throughput. The
median line. clientview is displayed.
e Incoming traffic — Throughput for 3. Study the Throughput graph in the RF Trends pane.
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Table 13: Client View — RF Trends Graphs and Monitoring Procedures

Description

Monitoring Procedure

incoming traffic is displayed in blue.
Incoming traffic is shown below the

For example, the graph shows 1.0 Kbps outgoing
traffic throughput for the client at 12:30 hours.

median line.
To see an enlarged view, click the graph.
The enlarged view shows Last, Minimum,
Maximum, and Average statistics for the
incoming and outgoing traffic throughput of
the client for the last 15 minutes.
To see the exact throughput at a particular
time, move the cursor over the graph line.

Mobility Trail
The Mobility Trail section displays the following mobility trail information for the selected client:

o Association Time— The time at which the selected client was associated with a particular OAW-IAP.
The AOS-W Instant Ul shows the client and OAW-IAP association over the last 15 minutes.

o Access Point— The OAW-IAP name with which the client was associated.

Mobility information about the client is reset each time it roams from one OAW-IAP to another.

HNOTE

Client Match

If client match is enabled, the Client Match link provides a graphical representation of radio map view of an AP and
the client distribution on an AP radio.

On clicking an access point in the Access Points tab and the Client Match link, a stations map view is displayed
and a graph is drawn with real-time data points for the AP radio. If the AP supports dual band, you can toggle
between 2.4GHz and 5 GHz links in the client match graph area to view the data. When you hover the mouse on the
graph, details such as RSSI, client match status, and the client distribution on channels are displayed.

The following figure shows the client distribution details for an AP radio.

Figure 20 Client Distribution on AP Radio
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On clicking a client in the Clients tab and the Client Match link, a graph is drawn with real-time data points for an AP
radio map. When you hover the mouse on the graph, details such as RSSI, channel utilization details, and client
count on each channel are displayed.

AOS-W Instant 6.4.0.2-4.1 | User Guide AOS-W Instant User Interface | 66



The following figure shows the client view heatmap for an AP radio:

Figure 21 Channel Availability Map for Clients
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AppRF

The AppREF link displays the application traffic summary for OAW-IAPs and client devices. The AppRF link in the
activity panel is displayed only if AppRF visibility is enabled in the System window. For more information on
application visibility and AppRF charts, see Application Visibility on page 244.

Spectrum
The spectrum link (in the Access Point view) displays the spectrum data that is collected by a hybrid AP or by an
OAW-IAP that has enabled spectrum monitor. The spectrum data is not reported to the Virtual Controller.
The spectrum link displays the following:
Device list - The device list display consists of a device summary table and channel information for active non
Wi-Fi devices currently seen by a spectrum monitor or hybrid AP radio.

Channel Utilization and Monitoring - This chart provides an overview of channel quality across the spectrum. It
shows channel utilization information such as channel quality, availability, and utilization metrics as seen by a
spectrum monitor for the 2.4 GHz and 5 GHz radio bands. The first bar for each channel represents the
percentage of air time used by non Wi-Fi interference and Wi-Fi devices. The second bar indicates the channel
quality. A higher percentage value indicates better quality.

Channel Details - When you move your mouse over a channel, the channel details or the summary of the 5 GHz
and 2.4 GHz channels as detected by a spectrum monitor are displayed. You can view the aggregate data for
each channel seen by the spectrum monitor radio, including the maximum AP power, interference and the Signal-
to-Noise and Interference Ratio (SNIR). Spectrum monitors display spectrum analysis data seen on all channels
in the selected band, and hybrid OAW-IAPs display data from the one channel they are monitoring.

For more information on spectrum monitoring, see Spectrum Monitor on page 312.

Alerts

Alerts are generated when a user encounters problems while accessing or connecting to a network. The alerts that
are generated can be categorized as follows:

802.11 related association and authentication failure alerts
802.1X related mode and key mismatch, server, and client time-out failure alerts
IP address related failures - Static |IP address or DHCP related alerts.

The following figure shows the contents of details displayed on clicking the Alerts link:
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Figure 22 Alerts Link
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The Alerts link displays the following types of alerts:

o Client Alerts
o Active Faults
o Fault History

Table 14: Types of Alerts

Type of Alert | Description Information Displayed

Client Alerts The Client alerts occur when A client alert displays the following fields:
clients are connected to the o Timestamp— Displays the time at which the client alert was
AOS-W Instant network. recorded.

e MAC address— Displays the MAC address of the client that
caused the alert.
Description— Provides a short description of the alert.
Access Points— Displays the IP address of the OAW-IAP to
which the clientis connected.

o Details— Provides complete details of the alert.

Active Faults The Active Faults occur in the An Active Faults consists of the following fields:

event of a system fault. o Time— Displays the system time when an event occurs.
o Number- Indicates the number of sequence.

o Description— Displays the event details.

Fault History The Fault History alerts occur in The Fault History displays the following information:

the event of a system fault. o Time— Displays the system time when an event occurs.

e Number- Indicates the number of sequence.

e Cleared by- Displays the module which cleared this fault.
o Description— Displays the event details.

The following figures show the client alerts, fault history, and active faults:
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Figure 23 Client Alerts
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The following table displays a list of alerts that are generated in the OAW-IAP network:
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Table 15: Alerts list

Description

Details

Corrective Actions

100101

Internal error

The OAW-IAP has
encountered an internal error
for this client.

Contact the Alcatel-Lucent customer
support team.

100102

Unknown SSID in
association request

The OAW-IAP cannot allow
this client to associate,
because the association
request received contains an
unknown SSID.

Identify the client and check its Wi-Fi
driver and manager software.

100103

Mismatched
authentication/encryption
setting

The OAW-IAP cannot allow
this client to associate,
because its authentication or
encryption settings do not
match OAW-IAP's
configuration.

Ascertain the correct authentication or
encryption settings and try to associate
again.

100104

Unsupported 802.11 rate

The OAW-IAP cannot allow
this client to associate
because it does not support
the 802.11 rate requested by
this client.

Check the configuration on the OAW-
IAP to see if the desired rate can be
supported; if not, consider replacing
the OAW-IAP with another model that
can support the rate.

100105

Maximum capacity reached
on OAW-IAP

The OAW-IAP has reached
maximum capacity and cannot
accommodate any more
clients.

Consider expanding capacity by
installing additional OAW-IAPs or
balance load by relocating OAW-IAPs.

100206

Invalid MAC Address

The OAW-IAP cannot
authenticate this client
because the client's MAC
address is not valid.

This condition may be indicative of a
misbehaving client. Try to locate the
client device and check its hardware
and software.

100307

Client blocked due to
repeated authentication
failures

The OAW-IAP is temporarily
blocking the 802.1X
authentication request from
this client, because the
credentials provided are
rejected by the RADIUS server
too many times.

Identify the clientand check its 802.1X
credentials.

100308

RADIUS server connection
failure

The OAW-IAP cannot
authenticate this client using
802.1X, because the RADIUS
server did not respond to the
authentication request.

If the OAW-IAP is using the internal
RADIUS server, Alcatel-Lucent
recommends checking the related
configuration as well as the installed
certificate and passphrase.

If the OAW-IAP is using an external
RADIUS server, check if there are any
issues with the RADIUS server and try
connecting again.
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Table 15: Alerts list

Description Details Corrective Actions
100309 RADIUS server The OAW-IAP cannot Ascertain the correct authentication
authentication failure authenticate this client using credentials and log in again.

802.1X, because the RADIUS
server rejected the
authentication credentials
(password and so on)
provided by the client.

100410 Integrity check failure in The OAW-IAP cannot receive Check the encryption setting on the
encrypted message data from this client, because clientand on the OAW-IAP.

the integrity check of the
received message (MIC) has

failed.

100511 DHCP request timed out This client did not receive a Check the status of the DHCP server in
response to its DHCP request the network.
in time.

IDS

The IDS link displays a list of foreign APs and foreign clients that are detected in the network. It consists of the
following sections:

o Foreign Access Points Detected— Lists the APs that are not controlled by the Virtual Controller. The following
information is displayed for each foreign AP:
» MAC address— Displays the MAC address of the foreign AP.
= Network— Displays the name of the network to which the foreign AP is connected.

» Classification— Displays the classification of the foreign AP, for example, Interfering OAW-IAP or Rogue
OAW-IAP.

» Channel- Displays the channel in which the foreign AP is operating.
= Type— Displays the Wi-Fi type of the foreign AP.
= Last seen— Displays the time when the foreign AP was last detected in the network.

= Where— Provides information about the OAW-IAP that detected the foreign AP. Click the pushpin icon to view
the information.

o Foreign Clients Detected- Lists the clients that are not controlled by the Virtual Controller. The following
information is displayed for each foreign client:

» MAC address— Displays the MAC address of the foreign client.

= Network— Displays the name of the network to which the foreign client is connected.

= Classification— Displays the classification of the foreign client: Interfering client.

= Channel- Displays the channel in which the foreign client is operating.

= Type— Displays the Wi-Fi type of the foreign client.

m Last seen— Displays the time when the foreign client was last detected in the network.

= Where— Provides information about the OAW-IAP that detected the foreign client. Click the pushpin icon to
view the information.

The following figure shows an example for the intrusion detection log.
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Figure 26 Intrusion Detection

& instant-rp Monitoring IDS  Configuration  AirGroup
Foreign Access Points Detected Foreign Clients Detected
MAC address Netwark Classification  Chan.  Type Lost Seen-  Where s Network Classification  Chan.  Type Last Seen.  Where
00:24:6¢:82:48:72  docomo Interfering 1 G 11:31:07 ? 2 ethersphere-voip Interfering 1 GN 20MZ ?
00:0b:86:b6:29:31  NTT-SPOT Interfering 1 G 11:31:07 ? = re-wpa2 Interfering 1 GN 20MZ 13
00:24:6c:80:ad:b2  docomo Interfering 1 <] 11:31:07 ? = re-wpa2 Interfering 1 GN 20MZ .
00:24:6c:0f:9d:42  docomo Interfering 1 <] 11:31:07 . U1_Dashboard Interfering 1 G .
246 docomo Interfering 1 G 11:31:07 ’ ethersphere-wpa2 Interfering 1 GN 20MZ 4
aruba-ap Interfering 1 GN20MZ  11:31:07 4 - Interfering 1 GN 20M2 ’
2 docomo Interfering 1 G 11:31:07 * Interfering 1 GN 20M2Z ¢
docoma Interfering 1 G 11:31:07 ? Interfering 1 GN 20MZ 14
NTT-SPOT Interfering 1 G 11:31:07 ? Interfering 1 G ?
hotspot_sach Interfering 157 AN 40MZ 11:31:07 ? Interfering 1 GN 20MZ ?
Interfering 1 [ 11:31:07 ? Interfering 1 B ?
Interfering 1 GN 20MZ 11:31:07 ? mdns-roaming Interfering 11 GN 20MZ .
Interfering 11 GN 20MZ 11:31:07 . ethersphere-voip Interfering 11 GN 20MZ 4
Interfering 1 GN20MZ  11:31:07 ’ ipv6-alpha Interfering 1 GN 20MZ ’
Interfering 1 GN20MZ  11:31:07 ¢ - Interfering 1 BN 20MZ ¢
ARUBA-VISITOR Interfering 1 GN20MZ  11:31:07 ¢ Interfering 1 B ¢
san-mdns-psk Interfering 1 GN 20MZ 11:31:07 ? Interfering 6 G 8 13
Milford_staff Interfering 1 GN 20MZ 11:31:07 ? ad Interfering 5 GN 20MZ 11:18:18 ?

For more information on the intrusion detection feature, see Intrusion Detection on page 299.

AirGroup

This AirGroup link provides an overall view of your AirGroup configuration. Click each field to view or edit the

settings.

MAC — Displays the MAC address of the AirGroup servers.

IP — Displays the IP address of the AirGroup servers.

Host Name — Displays the machine name or hostname of the AirGroup servers.
Service— Displays the type of the services such as AirPlay or AirPrint.

VLAN- Displays VLAN details of the AirGroup servers.

Wired/Wireless — Displays if the AirGroup server is connected via wired or wireless interface.

Role—Displays the user role if the server is connected through 802.1X authentication. If the serveris connected

through PSK or open authentication, this field is blank.
Group—Displays the group.

CPPM- By clicking on this, you get details of the registered rules in ClearPass Policy Manager (CPPM) for this

server.
MDNS Cache— By clicking on this, you receive MDNS record details of a particular server.

The following figure shows the AirGroup server details available on clicking the AirGroup link:

Figure 27 AirGroup Link

Instant-CB:DA:1E Mon

Configuration

The Configuration link provides an overall view of your Virtual Controller, Access Points, and WLAN
SSID configuration. The following figure shows the Virtual Controller configuration details displayed on clicking the

Configuration link.

Figure 28 Configuration Link

Virtual Contreller Configuration

Virtual Controller 1P:

Dynamic RADIUS proxy:

Mobility Access Switch integration:
NTP server:

Timezone:

Hide advanced options

0.0.0.0
Disabled
Disabled

None

Virtual Controller Gateway: 0.0.0.0

Virtual Controller VLAN: 0

Preferred band: All

Auto join mode: Enabled
Terminal access: Enabled
Console access: Enabled
LED display: Enabled
Extended SSI1D: Disabled
Deny inter user bridging:  Disabled
Deny local routing: Disabled

Dynamic CPU management: Automatic

System  RF ecurity VPN IDS Wired Services DHCP Server General  Admin L3 Mobility ~ Enterprise Domair
Basic Advanced
Name: Instant-C4:42:98 Virtual Controller Netmask: 0.0.0.0

Monitoring
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OmniVista 3600 Setup

OmniVista is a solution for managing rapidly changing wireless networks. When enabled, OmniVista allows you to
manage the AOS-W Instant network. For more information on OmniVista, see Managing an OAW-IAP from
OmniVista on page 277. The OmniVista status is displayed at the bottom of the AOS-W Instant main window. If the
OmniVista status is Not Set Up, click the Set Up Now link to configure OmniVista. The System window is
displayed with Admin tab selected.

Pause/Resume
The Pause/Resume link is located at the bottom right corner of the AOS-W Instant main window.

Click the Pause link to pause the automatic refreshing of the AOS-W Instant U after every 15 seconds by default.
The AOS-W Instant Ul is automatically refreshed after every 15 seconds by default. When the automatic refreshing
is paused, the Pause link changes to Resume. Click the Resume link to resume automatic refreshing.

Automatic refreshing allows you to get the latest information about the network and network elements. You can use
the Pause link when you want to analyze or monitor the network or a network element, and therefore do not want the
user interface to refresh.

Views

Depending on the link or tab that is clicked, the AOS-W Instant displays information about the Virtual Controller, Wi-
Fi networks, OAW-IAPs, or the clients in the Info section. The views on the AOS-W Instant main window are
classified as follows:

Virtual Controller view— The Virtual Controller view is the default view. This view allows you to monitor the AOS-
W Instant network. This view allows you to monitor the AOS-W Instant network.

The following AOS-W Instant Ul elements are available in this view:
Tabs— Networks, Access Points, and Clients. For detailed information about the tabs, see Tabs on page 45.

Links— Monitoring, Client Alerts, and IDS. The Spectrum link is visible if you have configured the OAW-IAP
as a spectrum monitor. These links allow you to monitor the AOS-W Instant network. For more information

about these links, see Monitoring on page 57, IDS on page 71, Alerts on page 67, and Spectrum Monitor on

page 312.

Network view— The Network view provides information that is necessary to monitor a selected wireless network.
All Wi-Fi networks in the AOS-W Instant network are listed in the Networks tab. Click the name of the network
that you want to monitor. Network view for the selected network is displayed.

AOS-W Instant Access Point view— The AOS-W Instant Access Point view provides information that is
necessary to monitor a selected OAW-IAP. All OAW-IAPs in the AOS-W Instant network are listed in the
Access Points tab. Click the name of the OAW-IAP that you want to monitor. Access Point view for that OAW-
IAP is displayed.

Client view— The Client view provides information that is necessary to monitor a selected client. In the Client
view, all the clients in the AOS-W Instant network are listed in the Clients tab. Click the IP address of the client
that you want to monitor. Client view for that client is displayed.

For more information on the graphs and the views, see Monitoring on page 57.
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Chapter 5

Initial Configuration Tasks

This chapter describes the general configuration tasks to perform when an OAW-IAP is set up.

e Basic Configuration Tasks on page 74
e Additional Configuration Tasks on page 78

Basic Configuration Tasks

This section describes the following basic configuration tasks that can be performed in the System>General tab
afteran OAW-IAP is set up:

e Modifying the OAW-IAP Name on page 74

e Updating Location Details of an OAW-IAP on page 75

e Configuring Virtual Controller IP Address on page 76

e Configuring Timezone on page 76

e Configuring a Preferred Band on page 75

e Configuringan NTP Server on page 76

e Enabling AppRF Visibility on page 77

The following figure shows an example for the basic configuration settings under the System>General tab:

General | Admin

Name: iyer-home

System location:

Virtual Controller IP: 0.0.0.0

Dynamic RADIUS proxy: | Disabled v
MAS integration: :3|sabled v
NTP server: 120.88.46.10

Timezone: Pacific-Time UTC-08 ¥

Daylight Saving Time:

Preferred band: All v
AppRF visibility: Enabled v
Show advanced options oK Cance!

For information on Dynamic RADIUS proxy configuration, see Configuring Authentication Servers on page 158.

Modifying the OAW-IAP Name
You can change the name of an OAW-IAP by using the AOS-W Instant Ul or CLI.
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In the AOS-W Instant Ul

1. Navigate to System>General.
2. Specify the name of OAW-IAP in the Name text box.
3. Click OK.

In the CLI

To change the name:

(Instant AP)# name <name>

Updating Location Details of an OAW-IAP

You can update the physical location details of an OAW-IAP by using the AOS-W Instant Ul or CLI. The system
location details are used for retrieving information through the SNMP sysLocation MIB object.

In the AOS-W Instant Ul
To update location details:

1. Navigate to System>General.
2. Specify the location of an OAW-IAP in the System location text box.
3. Click OK.

In the CLI
To update location details of an OAW-IAP:

(Instant AP) (config)# syslocation <location-name>
(Instant AP) (config)# end
(Instant AP)# commit apply

Configuring a Preferred Band
You can configure a preferred band for an OAW-IAP by using the AOS-W Instant Ul or the CLI.

In the AOS-W Instant Ul

1. Navigate to System>General.
2. Select 2.4 GHz, 5 GHz or All from the Preferred band drop-down list for single-radio access points.

3. Click OK.

Reboot the OAW-IAP after configuring the radio profile for the changes to affect.

HOTE

In the CLI

To configure a preferred band:

(Instant AP) (config)# rf-band <band>
(Instant AP) (config)# end
(Instant AP)# commit apply
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Configuring Virtual Controller IP Address

You can specify a single static IP address that can be used to manage a multi-AP AOS-W Instant network. This IP
address is automatically provisioned on a shadow interface on the OAW-IAP that takes the role of a Virtual
Controller. When an OAW-IAP becomes a Virtual Controller, it sends three Address Resolution Protocol (ARP)
messages with the static IP address and its MAC address to update the network ARP cache.

You can configure the Virtual Controller name and IP address using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Navigate to System>General.
2. Enterthe IP address in Virtual Controller IP.
3. Click OK.

In the CLI

To configure the Virtual Controller Name and IP address:

(Instant AP) (config)# virtual-controller-ip <IP-address>
(Instant AP) (config)# end
(Instant AP)# commit apply

Configuring Timezone
You can configure time zone in which the OAW-IAP must operate by using the AOS-W Instant or the CLI.

In the AOS-W Instant Ul
To configure time zone:

1. Navigate to System>General.
2. Select a time zone from the Timezone drop-down list.

You can enable daylight saving time (DST) on OAW-IAPs if the time zone you selected supports the
daylight saving time. If the Time Zone selected does not support DST, the Daylight Saving Time
option is not displayed. When enabled, the Daylight saving time ensures that the OAW-IAPs reflect the
seasonal time changes in the region they serve.

NOTE

3. Toenable daylight saving time, select the Daylight Saving Time checkbox.
4. Click OK.

In the CLI

To configure time zone:

(Instant AP) (config)# clock timezone <name> <hour-offset> <minute-offset>

(Instant AP) (config)# clock summer-time <timezone> recurring <start-week> <start-day> <start-
month> <start-hour> <end-week> <end-day> <end-month> <end-hour>

(Instant AP) (config)# end

(Instant AP)# commit apply

Configuring an NTP Server

To facilitate communication between various elements in a network, time synchronization between the elements and
across the network is critical. Time synchronization allows you to:

Trace and track security gaps, network usage, and troubleshoot network issues.
Validate certificates
Map an event on one network element to a corresponding event on another.
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Maintain accurate time for billing services and similar.

The Network Time Protocol (NTP) helps obtain the precise time from a server and regulate the local time in each
network element. Connectivity to a valid NTP server is required to synchronize the OAW-IAP clock to set the correct
time. If NTP server is not configured in the OAW-IAP network, an OAW-IAP reboot may lead to variation in time
data.

By default, the OAW-IAP tries to connect to pool.ntp.org to synchronize time. A different NTP server can be
configured either from the UI. It can also be provisioned through the DHCP option 42. If the NTP server is

configured, it takes precedence over the DHCP option 42 provisioned value. The NTP server provisioned through the
DHCP option 42 is used if no server is configured. The default server pool.ntp.org is used if no NTP serveris
configured or provisioned through DHCP option 42.

Reboot the AP to apply the NTP server configuration.

You can configure an NTP server by using the AOS-W Instant Ul or the CLI.

In the AOS-W Instant Ul

To configure an NTP server:

1. Navigate to System>General.

2. Enterthe IP address or the URL (domain name) of the NTP server in the NTP Server text box.

3. Click OK.
4. Reboot the OAW-IAP.

In the CLI

To configure an NTP server:

(Instant AP) (config)# ntp-server <name>
(Instant AP) (config)# end
(Instant AP)# commit apply

To check the NTP status and association, run the show clock and show process commands.

Enabling AppRF Visibility

If your OAW-IAP supports the AppRF feature, you can enable AppRF visibility to view the AppRF statistics for an
OAW-IAP or the clients associated with an OAW-IAP. For more information on the procedure for enabling AppRF
visualization, see Enabling Application Visibility on page 243.

Changing Password
You can update your password details by using the AOS-W Instant Ul or the CLI.

In the AOS-W Instant Ul

1. Navigate to System>Admin.
2. Under Local, provide a new password that you would like the admin users to use.
3. Click OK.

In the CLI

To change password for the admin user:

(Instant AP) (config)# mgmt-user <username> [password]
(Instant AP) (config)# end

| Initial Configuration Tasks AOS-W Instant 6.4.0.2-4.1 | User Guide



(Instant AP)# commit apply

Additional Configuration Tasks

This section describes the following additional tasks that can be performed after an OAW-IAP is set up:

Configuring Virtual Controller VLAN on page 78

Configuring Auto Join Mode on page 79

Configuring Terminal Access on page 80

Configuring Console Access on page 80

Configuring LED Display on page 81

Configuring Additional WLAN SSIDs on page 81

Preventing Inter-user Bridging on page 82

Preventing Local Routing between Clients on page 82
Enabling Dynamic CPU Management on page 83

The following figure shows the additional configuration options available under the System>General tab:

General | Admin | DHCP | Uplink | L3 Mobility | Enterprise Domains | Monitoring | WISPr | Proxy

Mame:

System location:

Virtual Controller IP:
Dynamic RADIUS proxy:
MAS integration:

NTF server:

Timezene:

Preferred band:

Virtual Controller Netmask:

Virtual Controller Gateway:

Virtual Controller VLAN:
Auto join mode:
Terminal access:

Telnet server:

LED display:

Extended S51D:

Deny inter user bridging:

Deny local routing:

Dynamic CPU management: :Automatuc

Hide advanced options

Instant-C4:42:98

0.0.0.0

| Disabled

| Disabled

International-Date-Line

All

[255.255.255.255

Disabled

| Enabled

| Disabled
|Enabled

Disabled

Disabled

| Disabled

BIETE] A EEIEIET L E BT

oK

-

Cancel

Configuring Virtual Controller VLAN

The IP configured for the Virtual Controller can be in the same subnet as OAW-IAP orcanbeina
different subnet. Ensure that you configure the Virtual Controller VLAN, gateway, and subnet mask

details only if the Virtual Controller IP is in a different subnet.
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You can configure the Virtual Controller VLAN by using AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Navigate to System>General> Show advanced options. The advanced options are displayed.
2. Enter subnet mask details in Virtual Controller Netmask.

3. Enter a gateway address in Virtual Controller Gateway.

4. Enter Virtual Controller VLAN in Virtual Controller VLAN.

Ensure that Virtual Controller VLAN is not the same as native VLAN of the OAW-IAP.

NOTE
5. Click OK.

In the CLI

To configure the Virtual Controller Name and IP address:

(Instant AP) (config)# virtual-controller-vlan <vcvlan> <vcmask> <vcgw>
(Instant AP) (config)# end
(Instant AP)# commit apply

Configuring Auto Join Mode

The auto join mode feature allows OAW-IAPs to automatically discover the Virtual Controller and join the network.

The Auto Join Mode feature is enabled by default. If the auto join mode feature is disabled, a New link is displayed
in the Access Points tab. Click this link to add OAW-IAPs to the network. If this feature is disabled, the inactive
OAW-IAPs are displayed in red as shown in the following figure:

Figure 29 Inactive OAW-IAPs

i 3 Access Points

d3:ch:cd:c9:62:81 --
d8:c7:cB:c4:42:98 0
d8:c7:cB8:c7:51:99 --

Enabling or Disabling Auto Join Mode

You can enable or disable auto join mode by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To enable or disable auto join mode:

1. Navigate to System>General>Show advanced options.
2. Select Disabled or Enabled from the Auto join mode drop-down list to deny or allow APs to join the network.
3. Click OK.

In the CLI

To disable auto join mode:

(Instant AP) (config)# no allow-new-aps
(Instant AP) (config)# end
(Instant AP)# commit apply
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To enable auto join mode:

(Instant AP) (config)# allow-new-aps
(Instant AP) (config)# end
(Instant AP)# commit apply

Configuring Terminal Access

When terminal access is enabled, you can access the AOS-W Instant CLI through SSH or Telnet server. The
terminal access is enabled by default.

You can enable or disable terminal access to an OAW-IAP by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Navigate to System>General>Show advanced options.

2. Select Disabled or Enabled from the Terminal access drop-down list.

3. Toenable Telnet server based access, select Enabled from the Telnet server drop-down list.
4. Click OK.

In the CLI

To enable terminal access:

(Instant AP) (config)# terminal-access
(Instant AP) (config)# end
(Instant AP)# commit apply

To enable access to the Instant CLI through Telnet:

(Instant AP) (config) # telnet-server
(Instant AP) (config)# end
(Instant AP)# commit apply

Configuring Console Access

You can access an OAW-IAP console through a serial port to configure or debug system errors. You can enable or
disable console access to an OAW-IAP through the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Navigate to System>General>Show advanced options.

2. Select Disabled or Enabled from the Console access drop-down list. By default, the console access is
enabled. When disabled, the OAW-IAP console cannot be accessed through the serial port.

3. Click OK.

In the CLI

To enable console access:

(Instant AP) (config)# console
(Instant AP) (console) # enable
(Instant AP) (console)# end
(Instant AP)# commit apply

To disable console access:

Instant AP) (config)# console
Instant AP) (console)# disable
Instant AP) (console)# end

(
(
(
(Instant AP)# commit apply
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To view the console settings:

(Instant AP)# show console-settings

Configuring LED Display

The LED display is always in the Enabled mode during the an OAW-IAP reboot.

NOTE
You can enable or disable LED Display for an OAW-IAP using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To enable or disable LED display for all OAW-IAPs in a cluster, perform the following steps:

1. Navigate to System > General > Show advanced options.

2. From the LED Display drop-down list, select Enabled to enable LED display or Disabled to turn off the LED
display.

3. Click OK.

In the CLI
To enable LED display:

(Instant AP) (config)# led-off
(Instant AP) (config)# end
(Instant AP)# commit apply

To disable LED display:

(Instant AP) (config)# no led-off
(Instant AP) (config)# end
(Instant AP)# commit apply

Configuring Additional WLAN SSIDs

The number of SSIDs allowed on each OAW-IAP depends on the OAW-IAP platform. The following table describes
the number of SSIDs supported on each platform:

No. of SSIDs supported No. of SSIDs supported
OAW-IAP Platform with Extended SSID with Extended SSID
disabled enabled
IAP-175P/175AC, OAW-IAP104/105, and OAW- 6 8
RAP108/109
All other OAW-IAPs (excluding IAP-175P/175AC, | 14 16
OAW-IAP104/105, and OAW-RAP108/109)

Enabling the Extended SSID

Extended SSID is enabled by default in the factory default settings of APs. This disables mesh in the factory default
settings.

You can configure additional SSIDs by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Navigate to System>General>Show advanced options link.
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Inthe General tab, select Enabled from the Extended SSID drop-down list.
3. Click OK.

4. Reboot the OAW-IAP to apply the changes. After you enable the option and reboot the OAW-IAP, the Wi-Fi and
mesh links are disabled automatically.

In the CLI
To enable the extended SSIDs:

(Instant AP) (config)# extended-ssid
(Instant AP) (config)# end
(Instant AP)# commit apply

Preventing Inter-user Bridging

If you have security and traffic management policies defined in upstream devices, you can disable bridging traffic
between two clients connected to the same AP on the same VLAN. When inter-user bridging is denied, the clients
can connect to the Internet but cannot communicate with each other, and the bridging traffic between the clients is
sent to the upstream device to make the forwarding decision.

You can disable inter-user bridging through the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To prevent inter-user bridging:

Navigate to System>General>Show advanced options.

2. From the Deny inter user bridging drop-down list, select Enabled to prevent traffic between two clients
connected to an OAW-IAP on the same VLANSs.

3. Click OK.

In the CLI
To deny inter-user bridging:

(Instant AP) (config)# deny-inter-user-bridging
(Instant AP) (config)# end
(Instant AP)# commit apply

To deny inter-user bridging for the WLAN SSID clients:

(Instant AP) (config)# wlan ssid-profile <ssid-profile>

(Instant AP) (SSID Profile <ssid-profile>)# deny-inter-user-bridging
(Instant AP) (SSID Profile <ssid-profile>)# end

(Instant AP)# commit apply

Preventing Local Routing between Clients

If you have security and traffic management policies defined in upstream devices, you can disable routing traffic
between two clients connected to the same OAW-IAP on different VLANs. When local routing is disabled, the
clients can connect to the Internet but cannot communicate with each other, and the routing traffic between the
clients is sent to the upstream device to make the forwarding decision.

You can disable local routing through the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To disable local routing:

1. Navigate to System>General>Show advanced options.
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2. From the Deny local routing drop-down list, select Enabled to prevent local routing traffic between two clients
connected to an OAW-IAP on different VLANSs.

3. Click OK.

In the CLI

To disable local routing:

(Instant AP) (config)# deny-local-routing
(Instant AP) (config)# end
(Instant AP)# commit apply

To deny local routing for the WLAN SSID clients:

(Instant AP) (config)# wlan ssid-profile <ssid-profile>
(Instant AP) (SSID Profile <ssid-profile>)# deny-local-routing
(Instant AP) (SSID Profile <ssid-profile>)# end

(Instant AP)# commit apply

Enabling Dynamic CPU Management

OAW-IAPs perform various functions such as wireless client connectivity and traffic flows, wired client connectivity
and traffic flows, wireless security, network management, and location tracking. Like with any network element, an
OAW-IAP can be subject to heavy loads. In such a scenario, it is important to prioritize the platform resources
across different functions. Typically, the OAW-IAPs manage resources automatically in real-time. However, under
special circumstances, if dynamic resource management needs to be enforced or disabled altogether, the dynamic
CPU management feature settings can be modified.

You can configure the dynamic CPU management feature by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To enable or disable the management plane protection:

1. Click System > General>Show Advanced Options.
2. Select any of the following options from the Dynamic CPU Management drop-down list.

Automatic — When selected, the CPU management is enabled or disabled automatically during run-time. This
decision is based on real-time load calculations taking into account all different functions that the CPU needs
to perform. This is the default and recommended option.

Always disabled on all APs — When selected, this setting manually disables CPU management on all APs,
typically for small networks. This setting protects user experience.

Always enabled on APs — When selected, the client and network management functions are protected. This
setting helps in large networks with high client density.

3. Click OK.

In the CLI

(Instant AP) (config)# dynamic-cpu-mgmt {auto| enable| disable}

| Initial Configuration Tasks AOS-W Instant 6.4.0.2-4.1 | User Guide



Chapter 6

Customizing OAW-IAP Settings

This chapter describes the procedures for configuring settings that are specific to an OAW-IAP in the cluster.
e Modifying the OAW-IAP Hostname on page 84

e Configuring Zone Settings on an OAW-IAP on page 84

e Specifying a Method for Obtaining IP Address on page 85

e Configuring External Antenna on page 86

e Configuring Radio Profiles for an OAW-IAP on page 87

e Configuring Uplink VLAN for an OAW-IAP on page 88

e Master Election and Virtual Controller on page 89

e Adding an OAW-IAP to the Network on page 91

e Removing an OAW-IAP from the Network on page 91

Modifying the OAW-IAP Hostname

You can change the hosthame of an OAW-IAP through the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Inthe Access Points tab, click the OAW-IAP you want to rename. The edit link is displayed.
2. Click the edit link. The edit window for modifying OAW-IAP details is displayed.

3. Edit the OAW-IAP name in Name. You can specify a name of up to 32 ASCII characters.

4. Click OK.

In the CLI

To change the name:

(Instant AP)# hostname <name>

Configuring Zone Settings on an OAW-IAP

All APs in a cluster use the same SSID configuration including master and slave OAW-IAPs. However, if you want
to assign an SSID to a specific OAW-IAP, you can configure zone settings for an OAW-IAP.

The following constraints apply to the AP zone configuration:

e An OAW-IAP can belong to only one zone and only one zone can be configured on an SSID.

e Ifan SSID belongs to a zone, all OAW-IAPs in this zone can broadcast this SSID. If no OAW-IAP belongs to the
zone configured on the SSID, the SSID is not broadcast.

e If an SSID does not belong to any zone, all OAW-IAPs can broadcast this SSID.
You can add an AP zone by through the Ul or CLI.

For the SSID to be assigned to an OAW-IAP, the same zone details must be configured on the SSID. For more
information on SSID configuration, see Configuring WLAN Settings for an SSID Profile on page 93.
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In the AOS-W Instant Ul

1. Inthe Access Points tab, click the OAW-IAP for which you want to set the zone. The edit link is displayed.
2. Click the edit link. The edit window for modifying OAW-IAP details is displayed.

3. Specify the AP zone in Zone.

4. Click OK.

In the CLI

To change the name:

(Instant AP)# zone <name>

Specifying a Method for Obtaining IP Address

You can either specify a static IP address or allow the OAW-IAP to obtain an IP address from the DHCP server. By
default, the OAW-IAPs obtain IP address from the DHCP server. You can specify a static IP address for the OAW-
IAP by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Inthe Access Points tab, click the OAW-IAP to modify. The edit link is displayed.
2. Click the edit link. The edit window for modifying the OAW-IAP details is displayed.

Figure 30 Configuring OAW-IAP Settings

Edit Access Point d8:c7:c8:c4:00:ef

General | Radio | Uplink

Mame:
Preferred master: | Disabled (w]
IP address for Access Point:

@ Get IF address from DHCP server

i7) Specify statically

oK Cancel

3. Select Specify statically option to specify a static IP address. The following fields are displayed:
a. Enterthe new IP address for the OAW-IAP in the IP address text box.
b. Enterthe subnet mask of the network in the Netmask text box.
c. Enterthe IP address of the default gateway in the Default gateway text box.
d. Enterthe IP address of the DNS serverin the DNS server text box.
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e. Enterthe domain name in the Domain name text box.
4. Click OK and reboot the OAW-IAP.

In the CLI

To configure a static IP address:

(Instant AP)# ip-address <IP-address> <subnet-mask> <NextHop-IP> <DNS-IP-address> <domain-
name>

Configuring External Antenna

If your OAW-IAP has external antenna connectors, you need to configure the transmit power of the system. The
configuration must ensure that the system’s Equivalent Isotropically Radiated Power (EIRP) is in compliance with
the limit specified by the regulatory authority of the country in which the OAW-IAP is deployed. You can also
measure or calculate additional attenuation between the device and antenna before configuring the antenna gain. To
know if your AP device supports external antenna connectors, see the Install Guide that is shipped along with the AP
device.

EIRP and Antenna Gain

The following formula can be used to calculate the EIRP limit related RF power based on selected antennas
(antenna gain) and feeder (Coaxial Cable loss):

EIRP = Tx RF Power (dBm)+GA (dB) - FL (dB)

The following table describes this formula:

Table 16: Formula Variable Definitions

Formula Element Description

EIRP Limit specific for each country of deployment
Tx RF Power RF power measured at RF connector of the unit
GA Antenna gain
FL Feeder loss

Example

For example, the maximum gain that can be configured on an OAW-IAP 134 with AP-ANT-1F dual-band and omni-
directional antenna is as follows:

Table 17: Maximum Antenna Gains

Frequency Band Gain (dBi)
2.4-25GHz 2.0dBi
4.9-5.875GHz 5.0dBi

For information on antenna gain recommended by the manufacturer, see .
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Configuring Antenna Gain

You can configure antenna gain for APs with external connectors using AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Navigate to the Access Point tab, select the access point to configure and then click edit.

2. Inthe Edit Access Point window, select External Antenna to configure the antenna gain value. This option is
available only for access points that support external antennas, for example, OAW-IAP134.

3. Enter the antenna gain values in dBm for the 2.4GHz and 5GHz bands.
4. Click OK.

In the CLI

To configure external antenna for 5 GHz frequency:
(Instant AP)# a-external-antenna <dBi>

To configure external antenna for 2,4 GHz frequency:

(Instant AP)# g-external-antenna <dBi>

Configuring Radio Profiles for an OAW-IAP

You can configure a radio profile on an OAW-IAP either manually or by using the Adaptive Radio Management
(ARM) feature.

Adaptive Radio Management (ARM) is enabled on AOS-W Instant by default. It automatically assigns appropriate
channel and power settings for the OAW-IAPs. For more information on ARM, see Adaptive Radio Management on
page 234.

Configuring ARM Assigned Radio Profiles for an OAW-IAP
To enable ARM assigned radio profiles:

In the Access Points tab, click the OAW-IAP to modify. The edit link is displayed.
Click the edit link. The edit window for modifying OAW-IAP details is displayed.
Click the Radio tab. The Radio tab details are displayed.

Ensure that an appropriate mode is selected.

a M D=

Select the Adaptive radio management assigned option under the bands that are applicable to the OAW-IAP
configuration.

6. Click OK.

Configuring Radio Profiles Manually for OAW-IAP

When radio settings are assigned manually by the administrator, the ARM is disabled.

HNOTE

To manually configure radio settings:

Inthe Access Points tab, click the AP for which you want to enable ARM. The edit link is displayed.
Click the edit link. The Edit Access Point window is displayed.

Click the Radio tab.

Ensure that an appropriate mode is selected.

> e D~
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By default the channel and power for an AP are optimized dynamically using Adaptive Radio Management
(ARM). You can override ARM on the 2.4 GHz and 5 GHz bands and set the channel and power manually if
desired. The following table describes various configuration modes for an AP:

Table 18: OAW-IAP Radio Modes

Mode Description

Access In Access mode, the AP serves clients, while also monitoring for rogue APs in the
background.

If the Access mode is selected, perform the following actions:

1. Select Administrator assigned in 2.4 GHz and 5 GHz band sections.

2. Select appropriate channel number from the Channel drop-down list for both 2.4
GHz and 5 GHz band sections.

3. Enter appropriate transmit power value in the Transmit power text box in 2.4 GHz
and 5 GHz band sections.

Monitor In Monitor mode, the AP acts as a dedicated monitor, scanning all channels for rogue
APs and clients. You can set one radio on the Monitor mode and the other radio on
access mode, so that the clients can use one radio when the other one is in the Air
Monitor mode.

Spectrum Monitor In Spectrum Monitor mode, the AP functions as a dedicated full-spectrum RF monitor,
scanning all channels to detect interference, whether from the neighboring APs or from
non-WiFi devices such as microwaves and cordless phones.

In the Spectrum Monitor mode, the APs do not provide access services to clients.

NOTE
4. Click OK.

In the CLI

To configure a radio profile:

(Instant AP)# wifiO-mode {<access>|<monitor>|<spectrum-monitor>}
(Instant AP)# wifil-mode {<access>|<monitor>|<spectrum-monitor>}

If the access mode is configured, you can configure the channel and transmission power by running the following
commands:

(Instant AP)# a-channel <channel> <tx-power>
(Instant AP)# g-channel <channel> <tx-power>

Configuring Uplink VLAN for an OAW-IAP

AOS-W Instant supports a management VLAN for the uplink traffic on an OAW-IAP. You can configure an uplink
VLAN when an OAW-IAP needs to be managed from a non-native VLAN. After an OAW-IAP is provisioned with the
uplink management VLAN, all management traffic sent from the OAW-IAP is tagged with the management VLAN.

Ensure that the native VLAN of the OAW-IAP and uplink are not the same.

HNOTE

You can configure the uplink management VLAN on an OAW-IAP by using the AOS-W Instant Ul or CLI.
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In the AOS-W Instant Ul
To configure uplink management VLAN:

In the Access Points tab, click the OAW-IAP to modify. The edit link is displayed.
Click the edit link. The edit window for modifying OAW-IAP details is displayed.
Click the Uplink tab.

Specify the VLAN in the Uplink Management VLAN field.

Click OK.

Reboot the OAW-IAP.

o g A~ wDd =

In the CLI
To configure uplink VLAN:

(Instant AP)# uplink-vlan <VLAN-ID>

To view the uplink VLAN status:

(Instant AP)# show uplink-vlan
Uplink Vlan Current :0
Uplink Vlan Provisioned :1

AOS-W Instant does not require an external to regulate and manage the Wi-Fi network. Instead, one OAW-IAP in
every network assumes the role of Virtual Controller. It coordinates, stores, and distributes the settings required to
provide a centralized functionality to regulate and manage the Wi-Fi network. The Virtual Controller is the single point
of configuration and firmware management. When configured, the Virtual Controller sets up and manages the VPN
tunnel to a in the data center.

The Virtual Controller also functions like any other AP with full RF scalability. It also acts as a node, coordinating
DHCP address allocation for network address translated clients ensuring mobility of the clients when they roam
between different OAW-IAPs.

Master Election Protocol

The Master Election Protocol enables the AOS-W Instant network to dynamically elect an OAW-IAP to take on a
Virtual Controller role and allow graceful failover to a new Virtual Controller when the existing Virtual Controller is not
available. This protocol ensures stability of the network during initial startup or when the Virtual Controller goes down
by allowing only one OAW-IAP to self-elect as a Virtual Controller.

Preference to an OAW-IAP with 3G/4G Card

The Master Election Protocol prefers the OAW-IAP with a 3G/4G card, when electing a Virtual Controller for the
AOS-W Instant network during the initial setup. The Virtual Controller is selected based on the following criteria:

If there is more than one OAW-IAP with 3G/4G cards, one of these OAW-IAPs is dynamically elected as the
Virtual Controller.

When an OAW-IAP without 3G/4G card is elected as the Virtual Controller but is up for less than 5 minutes,
another OAW-IAP with 3G/4G card in the network is elected as the Virtual Controller to replace it and the
previous Virtual Controller reboots.

When an OAW-IAP without 3G/4G card is already elected as the Virtual Controller and is up for more than 5
minutes, the Virtual Controller will not be replaced until it goes down.

D OAW-IAP135 is preferred over OAW-IAP 105 when a Virtual Controller is elected.
HOTE
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Preference to an OAW-IAP with Non-Default IP

The Master Election Protocol prefers an OAW-IAP with non-default IP, when electing a Virtual Controller for the
AOS-W Instant network during initial startup. If there are more than one OAW-IAP with non-default IPs in the
network, all OAW-IAPs with default IP will automatically reboot and the DHCP process is used to assign new IP

addresses.

Viewing Master Election Details
To verify the status of an OAW-IAP and master election details, use the following commands:

(Instant AP)# show election statistics
(Instant AP)# show summary support

Manual Provisioning of Master OAW-IAP

In most cases, the master election process automatically determines the best OAW-IAP that can perform the role of
Virtual Controller, which will apply its image and configuration to all other OAW-IAPs in the same AP management
VLAN. When the Virtual Controller goes down, a new Virtual Controller is elected.

Provisioning an OAW-IAP as a Master OAW-IAP
You can provision an OAW-IAP as a master OAW-IAP by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Inthe Access Points tab, click the OAW-IAP to modify. The edit link is displayed.

2. Click the edit link. The edit window for modifying OAW-IAP details is displayed.

3. Select Enabled from Preferred master drop-down. This option is disabled by default.

Figure 31 OAW-IAP Settings—Provisioning Master OAW-IAP

Edit Access Point d8:c7:c8:c4:00:ef

General | Radio | Uplink

Name: |c|8:c:?:c:8:c:4:0l2l:ef

Preferred master: | Enabled [=]
1P address for Access Point:

@ Get IP address from DHCP server

©) Specify statically

oK Cancel

4. Click OK.

In the CLI
To provision an OAW-IAP as a master OAW-IAP:
(Instant AP)# iap-master

To verify if the OAW-IAP is provisioned as master IAP:

(Instant AP)# show ap-env
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Antenna Type:Internal
Iap master:1

Adding an OAW-IAP to the Network

To add an OAW-IAP to the Instant network, assign an IP address. For more information, see Assigning an |P
address to the OAW-IAP on page 35.

After an OAW-IAP is connected to the network, if the Auto Join Mode feature is enabled, the OAW-IAP inherits the
configuration from the Virtual Controller and is listed in the Access Points tab.

If the Auto Join Mode is disabled, perform the following steps to add an OAW-IAP to the network:

1. Inthe Access Points tab, click the New link. The New Access Point window is displayed.
2. Inthe New Access Point window, enter the MAC address for the new OAW-IAP.
3. Click OK.

Removing an OAW-IAP from the Network

You can remove an OAW-IAP from the network only if the Auto Join Mode feature is disabled. To remove an OAW-
IAP from the network:

1. Inthe Access Points tab, click the OAW-IAP to delete. The x icon is displayed against the OAW-IAP.
2. Click x to confirm the deletion.

| i The deleted OAW-IAPs cannot join the Instant network anymore and no longer are displayed in the AOS-W Instant

o~ Ul. However, the master OAW-IAP details cannot be deleted from the Virtual Controller database.
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Chapter 7

VLAN Configuration

VLAN configuration is required for networks with more devices and broadcast traffic on a WLAN SSID or wired

profile. Based on the network type and its requirements, you can configure the VLANs for a WLAN SSID or wired
port profile.

For more information on VLAN configuration fora WLAN SSID and wired port profile, see Configuring VLAN Settings
fora WLAN SSID Profile on page 97 and Configuring VLAN for a Wired Profile on page 115.

VLAN Pooling

In a single OAW-IAP cluster, a large number of clients can be assigned to the same VLAN. Using the same VLAN
for multiple clients can lead to a high level of broadcasts in the same subnet. To manage the broadcast traffic, you
can partition the network into different subnets and use L3-mobility between those subnets when clients roam.
However, if a large number of clients need to be in the same subnet, you can configure VLAN pooling, in which each
client is randomly assigned a VLAN from a pool of VLANs on the same SSID. Thus, VLAN pooling allows automatic
partitioning of a single broadcast domain of clients into multiple VLANSs.

Uplink VLAN Monitoring and Detection on Upstream Devices

If a client connects to an SSID or wired interface with a VLAN that is not allowed on the upstream device, the client
will not be assigned an IP address and thus cannot connect to the Internet. When a client connects to an SSID or a
wired interface with VLAN that is not allowed on the upstream device, the AOS-W Instant Ul now displays the
following alert message:

Figure 32 Uplink VLAN Detection

= Instant-CC:42:39 Alert Details x

Client Alerts VLAN mismatch between IAP and upstream device.
Upstream device can be upstream switch or radius

Timestamp MAC address Description A Server.

2013/11/11 11:50:30 b4:b6:76:42:6d:05 Wrong Client WLAN 6c:t3: /ricdid2:ce more

2013/11/11 11:50:30 b4:b6:76:42:6d:05 DHCP request timed out 6c:f3:7f:c4:42:ce more

Toresolve this issue, ensure that there is no mismatch in the VLAN configuration.
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Chapter 8

Wireless Network Profiles

This chapter provides the following information:

e Configuring Wireless Network Profiles on page 93

e Configuring Fast Roaming for Wireless Clients on page 107
e Editing Status of a WLAN SSID Profile on page 111

e Editinga WLAN SSID Profile on page 111

e Deletinga WLAN SSID Profile on page 112

Configuring Wireless Network Profiles

During start up, a wireless client searches for radio signals or beacon frames that originate from the nearest OAW-
IAP. After locating the OAW-IAP, the following transactions take place between the client and the OAW-IAP:

1. Authentication — The OAW-IAP communicates with a RADIUS server to validate or authenticate the client.
2. Connection — After successful authentication, the client establishes a connection with the OAW-1AP.

Network Types
AOS-W Instant wireless networks are categorized as:

o Employee network — An Employee network is a classic Wi-Fi network. This network type is used by the
employees in an organization and it supports passphrase-based or 802.1X based authentication methods.
Employees can access the protected data of an enterprise through the employee network after successful
authentication. The employee network is selected by default during a network profile configuration.

o Voice network —This Voice network type allows you to configure a network profile for devices that provide only
voice services such as handsets or applications that require voice traffic prioritization.

o Guest network —The Guest wireless network is created for guests, visitors, contractors, and any non-employee
users who use the enterprise Wi-Fi network. The Virtual Controller assigns the IP address for the guest clients.
captive portal or passphrase based authentication methods can be set for this wireless network. Typically, a
guest network is an un-encrypted network. However, you can specify the encryption settings when configuring a
guest network.

When a client is associated to the Voice network, all data traffic is marked and placed into the high priority queue in
QoS (Quality of Service).

HOTE

To configure a new wireless network profile, complete the following procedures:
Configuring WLAN Settings

Configuring VLAN Settings

Configuring Security Settings

D=

Configuring Access Rules for a Network

Configuring WLAN Settings for an SSID Profile
You can configure WLAN settings using the AOS-W Instant Ul or CLI.
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In the AOS-W Instant Ul

To configure WLAN settings:

1. Inthe Networks tab of the AOS-W Instant main window, click the New link. The New WLAN window is
displayed. The following figure shows the contents of the WLAN Settings tab:

Figure 33 WLAN Settings Tab
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2. Enter a name that uniquely identifies a wireless network in the Name (SSID) text box.

Based on the type of network profile, select any of the following options under Primary usage:

o Employee
o Voice
o Guest

4. Click the Show advanced options link. The advanced options for configuration are displayed. Specify the
following parameters as required.

94 | Wireless Network Profiles
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Table 19: WLAN Configuration Parameters

Parameter Description

Broadcast filtering Select any of the following values:
All-When set to All, the OAW-IAP drops all broadcast and multicast frames except DHCP
and ARP.

ARP—-When set to ARP, the OAW-IAP converts ARP requests to unicast and send frames
directly to the associated client.
Disabled— When set to Disabled, all broadcast and multicast traffic is forwarded.

DTIM interval The DTIM interval indicates the delivery traffic indication message (DTIM) period in beacons,
which can be configured for every WLAN SSID profile. The DTIM interval determines how
often the OAW-IAP should deliver the buffered broadcast and multicast frames to associated
clients in the powersave mode. The default value is 1, which means the client checks for
buffered data on the OAW-IAP at every beacon. You can also configure a higher DTIM value
for power saving.

Multicast transmission | Select Enabled if you want the OAW-IAP to select the optimal rate for sending broadcast and
optimization multicast frames based on the lowest of unicast rates across all associated clients. When this
option is enabled, multicast traffic can be sent at up to 24 Mbps. The default rate for sending
frames for 2.4 GHz is 1 Mbps and 5.0 GHz is 6 Mbps. This option is disabled by default.

Dynamic multicast Select Enabled to allow OAW-IAP to convert multicast streams into unicast streams over the

optimization wireless link. Enabling Dynamic Multicast Optimization (DMO) enhances the quality and
reliability of streaming video, while preserving the bandwidth available to the non-video
clients.

NOTE: When you enable DMO on multicast SSID profiles, ensure that the DMO feature is
enabled on all SSIDs configured in the same VLAN.

DMO channel Specify a value to set a threshold for DMO channel utilization. With DMO, the OAW-IAP
utilization threshold converts multicast streams into unicast streams as long as the channel utilization does not
exceed this threshold. The default value is 90% and the maximum threshold value is 100%.
When the threshold is reached or exceeds the maximum value, the OAW-IAP sends multicast
traffic over the wireless link.

Transmit Rates Specify the following parameters:

2.4 GHz-If the 2.4 GHz band is configured on the OAW-IAP, specify the minimum and
maximum transmission rate. The default value for minimum transmission rate is 1 Mbps
and maximum transmission rate is 54 Mbps.

5 GHz-If the 5 GHz band is configured on the OAW-IAP, specify the minimum and
maximum transmission rate. The default value for minimum transmission rate is 6 Mbps
and maximum transmission rate is 54 Mbps.

Zone Specify the zone for the SSID. When the zone is defined in SSID profile and if the same zone
is defined on an OAW-IAP, the SSID is created on that OAW-IAP. For more information on
configuring zone details on an IAP, see Configuring Zone Settings on an OAW-IAP on page
84.
The following constraints apply to the zone configuration:
An OAW-IAP can belong to only one zone and only one zone can be configured on an
SSID.
If an SSID belongs to a zone, all OAW-IAPs in this zone can broadcast this SSID. If no
OAW-IAP belongs to the zone configured on the SSID, the SSID is not broadcast.
If an SSID does not belong to any zone, all OAW-IAPs can broadcast this SSID.

Bandwidth Limits Under Bandwidth Limits:

Airtime—Select this checkbox to specify an aggregate amount of airtime that all clients in
this network can use for sending and receiving data. Specify the airtime percentage.
Each radio— Select this checkbox to specify an aggregate amount of throughput that each
radio is allowed to provide for the connected clients.

Downstream and Upstream—Specify the downstream and upstream rates within a range
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Table 19: WLAN Configuration Parameters

Parameter Description

of 1 to 65535 Kbps for the SSID users. If the assignment is specific for each user, select
the Peruser checkbox.

Wi-Fi Multimedia Configure the following options for WMM traffic management. WMM supports voice, video,
(WMM) traffic best effort, and background access categories. To allocate bandwidth for the following types
management of traffic, specify a percentage value under Share. To configure DSCP mapping, specify a

value under DSCP Mapping.
o Background WMM: For background traffic such as file downloads or print jobs.
o Best effort WMM — For best effort traffic such as traffic from legacy devices or traffic from
applications or devices that do not support QoS.
Video WMM - For video traffic generated from video streaming.
Voice WMM- For voice traffic generated from the incoming and outgoing voice
communication.
For more information on WMM traffic and DSCP mapping, see Wi-Fi Multimedia Traffic
Management on page 253

Content filtering Select Enabled to route all DNS requests for the non-corporate domains to OpenDNS on this
network.
Band Select a value to specify the band at which the network transmits radio signals. You can set

the band to 2.4 GHz, 5 GHz, or All. The All option is selected by default.

Inactivity timeout Specify an interval for session timeout in seconds, minutes or hours. If a client session is
inactive for the specified duration, the session expires and the users are required to log in
again. You can specify a value within the range of 60-86400 seconds or up to 24 hours for a
client session. The default value is 1000 seconds.

Hide SSID Select this checkbox if you do not want the SSID (network name) to be visible to users.

Disable SSID Select this checkbox if you want to disable the SSID. On selecting this, the SSID will be
disabled, but will not be removed from the network. By default, all SSIDs are enabled.

Can be used without Select the checkbox if you do not want to SSID profile to use uplink.

Uplink

Max clients threshold Specify the maximum number of clients that can be configured for each BSSID on a WLAN.
You can specify a value within the range of 0 to 255. The default value is 64.

Local probe request Specify a threshold value to limit the number of incoming probe requests. When a client
threshold sends a broadcast probe request frame to search for all available SSIDs, this option controls
system response for this network profile and ignores probe requests if required. You can
specify a Received signal strength indication (RSSI) value within range of 0 to 100 dB.

5. Click Next to configure VLAN settings. For more information, see Configuring VLAN Settings fora WLAN SSID
Profile on page 97.

In the CLI
To configure WLAN settings for an SSID profile:

(Instant AP
(Instant AP

) (config)# wlan ssid-profile <name>
) (SSID Profile <name>)# essid <ESSID-name>

(Instant AP) (SSID Profile <name>)# type {<Employee>|<Voice>| <Guest>}

(Instant AP) (SSID Profile <name> broadcast-filter <type>

(Instant AP) (SSID Profile <name>
) (
) (
) (
) (

)

)

) # dtim-period <number-of-beacons>
(Instant AP) (SSID Profile <name>)

)

)

)

multicast-rate-optimization
(Instant AP) (SSID Profile <name>
(Instant AP) (SSID Profile <name>
(Instant AP) (SSID Profile <name>

dmo-channel-utilization-threshold

#
#
#
# dynamic-multicast-optimization
#
# a-max-tx-rate <rate>
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AP)# commit apply

a-min-tx-rate <rate>
g-max-tx-rate <rate>
g-min-tx-rate <rate>

zone <zone>

bandwidth-limit <limit>
per-user-bandwidth-1limit <limit>
air-time-limit <limit>
wmm-background-dscp <dscp>
wmm-background-share <share>
wmm-best-effort-dscp <dscp>
wmm-best-effort-share <share>
wmm-video-dscp <dscp>
wmm-video-share <share>
wmm-voice-dscp <dscp>
wmm-voice-share <share>
rf-band {<2.4>|<5.0>|<all>}
content-filtering

hide-ssid

inactivity-timeout <interval>
work-without-uplink
local-probe-reg-thresh <threshold>

max-clients-threshold <number-of-clients>

end

Configuring VLAN Settings for a WLAN SSID Profile

If you are creating a new SSID profile, complete the WLAN Settings procedure before configuring VLAN. For more
information, see Configuring WLAN Settings for an SSID Profile on page 93.

You can configure VLAN settings for an SSID profile using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To configure VLAN settings for an SSID:

1. Inthe VLAN tab of the New WLAN window. The VLAN tab contents are displayed.
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Figure 34 VLAN Tab

New WLAN
8 WLAN Settings 2 M.

Client IP & VLAN Assignment

Client IP assignment: () Virtual Controller assigned

@ Metwork assigned

Client VLAN assignment: &) Default
™) Static
@ Dynamic

VLAN Assignment Rules
Default VLAN: 1

New

Back

Next Cancel

2. Select any for the following options for Client IP assignment:

« Virtual Controller assigned—On selecting this option, the client obtains the IP address from the Virtual

Controller.

» Network assigned—On selecting this option, the IP address is obtained from the network.
3. Based on the type client IP assignment mode selected, you can configure the VLAN assignment for clients as

described in the following table:
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Table 20: /P and VLAN Assignment for WLAN SSID Clients

Client IP Assignment Client VLAN Assignment

Virtual Controller assigned | [f the Virtual Controller assigned is selected for client IP assignment, the Virtual
Controller creates a private subnetand VLAN on the OAW-IAP for the wireless clients.
The network address translation for all client traffic that goes out of this interface is
carried out at the source. This setup eliminates the need for complex VLAN and IP
address management for a multi-site wireless network.

On selecting this option, the following client VLAN assignment options are displayed:

o Default: When selected, the default VLAN as determined by the Virtual Controller is
assigned for clients.

e Custom: When selected, you can specify a custom VLAN assignment option. You can
select an existing DHCP scope for client IP and VLAN assignment or you can create
a new DHCP scope by selecting New. For more information on DHCP scopes, see
Configuring DHCP Scopes on page 203.

Network assigned If the Network assigned is selected, you can specify any of the following options for the

Client VLAN assignment.

o Default— On selecting this option, the client obtains the IP address in the same
subnet as the OAW-IAPs. By default, the client VLAN is assigned to the native VLAN
on the wired network.

o Static— On selecting this option, you need to specify a single VLAN, a comma
separated list of VLANS, or a range of VLANSs for all clients on this network. Select
this option for configuring VLAN pooling.

o Dynamic— On selecting this option, you can assign the VLANs dynamically from a
Dynamic Host Configuration Protocol (DHCP) server. To create VLAN assignment
rules, click New to assign the user to a VLAN. In the New VLAN Assignment Rule
window, enter the following information:

o Attribute— Select an attribute returned by the RADIUS server during
authentication.
Operator— Select an operator for matching the string.
String— Enter the string to match

e VLAN- Enter the VLAN to be assigned.

4. Click Next to configure security settings for the employee network. For more information, see Configuring
Security Settings fora WLAN SSID Profile on page 100.

In the CLI
To manually assign VLANs for WLAN SSID users:

(Instant AP) (config)# wlan ssid-profile <name>
(Instant AP) (SSID Profile <name>)# vlan <vlan-ID>
(Instant AP) (SSID Profile <name>)# end

(Instant AP)# commit apply

To enforce DHCP-based VLAN assignment:

(Instant AP) (config)# wlan ssid-profile <name>
(Instant AP) (SSID Profile <name>)# enforce-dhcp
(Instant AP) (SSID Profile <name>)# end

(Instant AP)# commit apply

To create a new VLAN assignment rule:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# set-vlan <attribute> {{contains|ends-with|equals|matches-
regular-expression|not-equals|starts-with} <operand> <vlan>|value-of}

(Instant AP) (SSID Profile <name>)# end

(Instant AP)# commit apply
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Configuring Security Settings for a WLAN SSID Profile
The following procedures are described in this section:
e Configuring Security Settings for an Employee or Voice Network on page 100

For information on guest network configuration, see Captive Portal for Guest Access.

For more information, see Configuring WLAN Settings for an SSID Profile on page 93 and Configuring VLAN
NOTE Settings fora WLAN SSID Profile on page 97.

G If you are creating a new SSID profile, configure the WLAN and VLAN settings before defining security settings.

Configuring Security Settings for an Employee or Voice Network

You can configure security settings for an employee or voice network by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To configure security settings for an employee or voice network:

1. Inthe Security tab, specify any of the following types of security levels by moving the slider to a desired level:

o Enterprise—On selecting enterprise security level, the authentication options applicable to the enterprise
network are displayed.

o Personal — On selecting personal security level, the authentication options applicable to the personalized
network are displayed.

o Open-On selecting Open security level, the authentication options applicable to an open network are
displayed:

The default security setting for a network profile is Personal.

The following figures show the configuration options for Enterprise, Personal, and Open security settings:

Figure 35 Security Tab: Enterprise

New WLAN Help
7l WLAN Settings 2 3
Security Level
More Key management: [wPa-2 Enterprise v
Secure
Termination: Disabled v
L - Authentication server 1: InternalServer v
- Enterprise

Reauth interval o min v

MAC authentication: Perform MAC authentication before 802.1X
MAC authentication fail-thru
No users Users

Default certificate Uploa

Personal

Open

w
-
LR
@

Fast Roaming
Opportunistic Key Caching(OKC): [«
802.11r!
802.11k:
802.11v:

Back Next Cancel
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Figure 36 Security Tab: Personal

New WLAN
WLAN Settings VLAN

Security Level

More Key management: [wePa-2 Personal v |
Secure
Passphrase format: | 8-63 chars v |
Entespeise: Passphrase: oo ]
Retype  |eessssss |
- Personal
MAC authentication: Disabled hd |
Open Blacklisting: | Disabled v
Fast Roaming
802.11r:
Lass .
T 802.11k:
802.11v:

Back MNext

3 BRI

Figure 37 Security Tab: Open

New WLAN
WLAN Settings VLAN

Security Level

EY security [ Access

More

Secure Encryption: None
MAC authentication: | Disabled ]
Enterprise Blacklisting: | Disabled r |
Fast Roaming
Personal 802.11r: =
802.11k: o
- Open
B02.11w:
Less
Secure

Back Next

2. Based on the security level specified, specify the following parameters:

AOS-W Instant 6.4.0.2-4.1 | User Guide

Wireless Network Profiles | 101



Parameter

Key
Management

Table 21: Configuration Parameters for WLAN Security Settings in an Employee or Voice Network

Description

For Enterprise security level, select any of the following options from the

Key management drop-down list:

o WPA-2 Enterprise

e Both (WPA-2 & WPA)

o WPA Enterprise

e Dynamic WEP with 802.1X — If you do not want to use a session key
from the RADIUS Server to derive pair wise unicast keys, set Session
Key for LEAP to Enabled. This is required for old printers that use
dynamic WEP through Lightweight Extensible Authentication Protocol
(LEAP) authentication. The Session Key for LEAP feature is Disabled
by default.

For Personal security level, select an encryption key from the Key

management drop-down list.

e For WPA-2 Personal, WPA Personal, and Both (WPA-2&WPA) keys,
specify the following parameters:

1. Passphrase format: Select a passphrase format from the
Passphrase format drop-down list. The options are
available are 8-63 alphanumeric characters and 64
hexadecimal characters.

2. Enter a passphrase in the Passphrase text box and
reconfirm.

e For Static WEP, specify the following parameters:

1. Selectan appropriate value for WEP key size from the
WEP key size drop-down list. You can specify 64-bit or
128-bit .

2. Selectan appropriate value for Tx key from the Tx Key
drop-down list. You can specify 1,2, 3, or 4.

3. Enter an appropriate WEP key and reconfirm.

Security Level

Type

Applicable to
Enterprise and
Personal security
levels only.

For the Open
security level, no
encryption settings
are required.

Termination

To terminate the EAP portion of 802.1X authentication on the OAW-IAP
instead of the RADIUS server, set Termination to Enabled.

Enabling Termination can reduce network traffic to the external RADIUS
server by terminating the authorization protocol on the OAW-IAP. By
default, for 802.1X authorization, the client conducts an EAP exchange with
the RADIUS server, and the OAW-IAP acts as a relay for this exchange.
When Termination is enabled, the OAW-IAP by itself acts as an
authentication server and terminates the outer layers of the EAP protocol,
only relaying the innermost layer to the external RADIUS server. It can also
reduce the number of exchange packets between the OAW-IAP and
authentication server.

NOTE: AOS-W Instant supports the configuration of primary and backup
authentication servers in an EAP termination enabled SSID.

NOTE: If you are using LDAP for authentication, ensure that AP termination
is configured to support EAP.

Enterprise security
level

Authentication
server 1 and
Authentication
server 2

Select any of the following options from the Authentication server 1 drop-

down list:

o Selectan authentication server from the list if an external servers are
already configured.

o Select New to configure any of the following servers as an external
server:

o RADIUS Server
LDAP Server

Enterprise,
Personal, and Open
security levels.
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Parameter

Table 21: Configuration Parameters for WLAN Security Settings in an Employee or Voice Network

Description

e CPPM Server for AirGroup CoA

For information on configuring external servers, see Configuring an
External Server for Authentication on page 158.

e To use an internal server, select Internal server and add the clients that
are required to authenticate with the internal RADIUS server. Click the
Users link to add the users. For information on adding a user, see
Managing OAW-IAP Users on page 141.

If an external server is selected, you can also configure another

authentication server.

Security Level

Type

Load balancing

Set this to Enabled if you are using two RADIUS authentication servers, so
that the load across the two RADIUS servers is balanced. For more
information on the dynamic load balancing mechanism, see Dynamic Load
Balancing between Two Authentication Servers on page 155.

Enterprise,
Personal, and Open
security levels.

Reauth interval

Specify a value for Reauth interval. When set to a value greater than zero,
APs periodically reauthenticate all associated and authenticated clients.

Enterprise,
Personal, and Open
security levels.

On setting this option to Enabled, APs post accounting information to the
RADIUS server at the specified Accounting interval.

Blacklisting To enable blacklisting of the clients with a specific number of authentication | Enterprise,
failures, select Enabled from the Blacklisting drop-down list and specify a Personal, and Open
value for Max authentication failures. The users who fail to authenticate the | security levels.
number of times specified in Max authentication failures field are
dynamically blacklisted.

Accounting To enable accounting, select Enabled from the Accounting drop-down list. Enterprise,

Personal, and Open
security levels.

Authentication
survivability

To enable authentication survivability, set Authentication survivability to
Enabled. Specify a value in hours for Cache timeout (global) to set the
duration after which the authenticated credentials in the cache must expire.
When the cache expires, the clients are required to authenticate again. You
can specify a value within range of 1 to 99 hours and the default value is 24
hours.

NOTE: The authentication survivability feature requires ClearPass Policy
Manager 6.0.2 or later, and is available only when the New server option is
selected authentication. On setting this parameter to Enabled, AOS-W
Instant authenticates the previously connected clients using EAP-PEAP
authentication even when connectivity to ClearPass Policy Manager is
temporarily lost. The Authentication survivability feature is not applicable
when a RADIUS server is configured as an internal server.

Enterprise security
level

MAC
authentication

To enable MAC address based authentication for Personal and Open

security levels, set MAC authentication to Enabled.

For Enterprise security level, the following options are available:

o Perform MAC authentication before 802.1X — Select this checkbox to
use 802.1X authentication only when the MAC authentication is
successful.

o MAC authentication fail-thru — On selecting this checkbox, the 802.1X
authentication is attempted when the MAC authentication fails.

Enterprise,
Personal, and Open
security levels.

Delimiter
character

Specify a character ( for example, colon or dash) as a delimiter for the MAC
address string. When configured, the OAW-IAP will use the delimiter in the

Enterprise,
Personal, and Open
security levels.
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Table 21: Configuration Parameters for WLAN Security Settings in an Employee or Voice Network

Parameter Description S L

Type

MAC authentication request. For example, if you specify the colon as a
delimiter, MAC addresses in the xx:xx:xx:xx:xx:xx format are used. If the
delimiter is not specified, the MAC address in the xxxxxxxxxxxx format is
used.

This option is available only when MAC authentication is enabled.

Uppercase Set to Enabled to allow the OAW-IAP to use uppercase letters in MAC Enterprise,
support address string for MAC authentication. Personal, and Open

security levels.
This option is available only if MAC authentication is enabled. b4

Upload Click Upload Certificate and browse to upload a certificate file for the Enterprise,

Certificate internal server. For more information on certificates, see Uploading Personal, and Open
Certificates on page 174. security levels

Fast Roaming You can configure the following fast roaming options for the WLAN SSID: Enterprise,

Personal, and Open
e Opportunistic Key Caching: When WPA-2 Enterprise and Both (WPA2- | security levels.

WPA) encryption types are selected and if 802.1x authentication NOTE: OKC
method is configured, the Opportunistic Key Caching (OKC) is enabled | roaming can be

by default. If OKC is enabled, a cached pairwise master key (PMK) is configured only for
used when the clientroams to a new AP. This allows faster roaming of the Enterprise
clients without the need for a complete 802.1x authentication. security level.

o 802.11r: Selecting this checkbox enables fast BSS transition. The Fast
BSS Transition mechanism minimizes the delay when a client
transitions from one BSS to another within the same cluster.

o 802.11k: Selecting this checkbox enables 802.11k roaming on the SSID
profile. The 802.11k protocol enables OAW-IAPs and clients to
dynamically measure the available radio resources. When 802.11k is
enabled, OAW-IAPs and clients send neighbor reports, beacon reports,
and link measurement reports to each other.

o 802.11v: Selecting this checkbox enables 802.11v based BSS
transition.802.11v standard defines mechanisms for wireless network
management enhancements and BSS transition management. It allows
the client devices to exchange information about the network topology
and RF environment. The BSS transition management mechanism
enables an AP to request a voice client to transition to a specific AP, or
suggest a set of preferred APs to a voice client, due to network load
balancing or BSS termination. It also helps the voice client identify the
best AP to transition to as they roam.

4. Click Next to configure access rules. For more information, see Configuring Access Rules fora WLAN SSID
Profile on page 105.

In the CLI

To configure enterprise security settings for the employee and voice users of a WLAN SSID profile:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# opmode {wpaZ-aes|wpa-tkip,wpa2-aes|wpa-psk-tkip,wpa2-psk-
aes|dynamic-wep}

(Instant AP) (SSID Profile <name>
(Instant AP) (SSID Profile <name>
(Instant AP) (SSID Profile <name>

) # leap-use-session-key
( ) #
( ) #
(Instant AP) (SSID Profile <name>)# external-server
( ) #
( ) #
( ) #

termination
auth-server <server-name>

)
(Instant AP) (SSID Profile <name>
(Instant AP) (SSID Profile <name>
(Instant AP) (SSID Profile <name>

server-load-balancing
blacklist
mac-authentication
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(Instant AP) (SSID Profile <name>)# 1l2-auth-failthrough

(Instant AP) (SSID Profile <name>)# auth-survivability

(Instant AP) (SSID Profile <name>)# radius-accounting

(Instant AP) (SSID Profile <name>)# radius-accounting-mode {user-association| user-
authentication}

(Instant AP) (SSID Profile <name>)# radius-interim-accounting-interval <minutes>
(Instant AP) (SSID Profile <name>)# radius-reauth-interval <minutes>

(Instant AP) (SSID Profile <name>)# max-authentication-failures <number>
(Instant AP) (SSID Profile <name>)# no okc-disable

(Instant AP) (SSID Profile <name>)# dotllr

(Instant AP) (SSID Profile <name>)# dotllk

(Instant AP) (SSID Profile <name>)# dotllv

(Instant AP) (SSID Profile <name>)# exit

(Instant AP) (config)# auth-survivability cache-time-out

(Instant AP) (config)# end

(Instant

AP) # commit apply

To configure personal security settings for the employee and voice users of a WLAN SSID profile:

(Instant
(Instant

tkip,wpa2-psk-aes|

(Instant
(Instant
(Instant
(Instant
(Instant
(Instant
(Instant
(Instant

AP) (config)# wlan ssid-profile <name>
AP) (SSID Profile <name>)# opmode {wpa2-psk-aes|wpa-tkip]|
static-wep}

wpa-psk-tkip|wpa-psk-

authentication}

(Instant AP) (SSID
(Instant AP) (SSID
(Instant AP) (SSID

(Instant AP)# commit apply

AP) (SSID Profile <name>)# mac-authentication

AP) (SSID Profile <name>)# auth-server <server-name>

AP) (SSID Profile <name>)# external-server

AP) (SSID Profile <name>)# server-load-balancing

AP) (SSID Profile <name>)# blacklist

AP) (SSID Profile <name>)# max-authentication-failures <number>

AP) (SSID Profile <name>)# radius-accounting

AP) (SSID Profile <name>)# radius-accounting-mode {user-association|user-
Profile <name>)# radius-interim-accounting-interval <minutes>
Profile <name>)# radius-reauth-interval <minutes>
Profile <name>)# end

To configure open security settings for employee and voice users of a WLAN SSID profile:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# opmode opensystem

(Instant AP) (SSID Profile <name>)# mac-authentication

(Instant AP) (SSID Profile <name># auth-server <server-name>

(Instant AP) (SSID Profile <name># external-server

(Instant AP) (SSID Profile <name># server-load-balancing

(Instant AP) (SSID Profile <name># blacklist

(Instant AP) (SSID Profile <name># max—-authentication-failures <number>
(Instant AP) (SSID Profile <name># radius-accounting

(Instant AP) (SSID Profile <name># radius-accounting-mode {user-association|user-
authentication}

(Instant AP) (SSID Profile <name># radius-interim-accounting-interval <minutes>
(Instant AP) (SSID Profile <name># radius-reauth-interval <minutes>

(Instant AP) (SSID Profile <name># end

(Instant

AP)# commit apply

Configuring Access Rules for a WLAN SSID Profile

This section describes the procedure for configuring security settings for employee and voice network only. For
information on guest network configuration, see Captive Portal for Guest Access.

If you are creating a new SSID profile, complete the WLAN Settings and configure VLAN and security parameters,

before defining access rules. For more information, see Configuring WLAN Settings for an SSID Profile on page 93,
Configuring VLAN Settings fora WLAN SSID Profile on page 97, and Configuring Security Settings fora WLAN

SSID Profile on page 100.
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You can configure up to 128 access rules for an employee, voice , or guest network using the AOS-W Instant Ul or
CLL.

In the AOS-W Instant Ul
To configure access rules for an employee or voice network:

1. Inthe Access Rules tab, set slider to any of the following types of access control:
Unrestricted— Select this to set unrestricted access to the network.

Network-based— Set the slider to Network-based to set common rules for all users in a network. The Allow
any to all destinations access rule is enabled by default. This rule allows traffic to all destinations. To define
an access rule:

a. Click New.
b. Select appropriate options in the New Rule window.
c. Click OK.

Role-based— Select Role-based to enable access based on user roles. For role-based access control:
Create a user role if required. For more information, see Configuring User Roles.

Create access rules for a specific user role. For more information, see Configuring Access Rules for
Network Services on page 179. You can also configure an access rule to enforce captive portal
authentication for an SSID that is configured to use 802.1X authentication method. For more information,
see Configuring Captive Portal Roles for an SSID on page 136.

Create a role assignment rule. For more information, see Configuring Derivation Rules on page 194.
2. Click Finish.

In the CLI

To configure access control rules fora WLAN SSID:

(Instant AP) (config)# wlan access-rule <name>

(Instant AP) (Access Rule <name>)# rule <dest> <mask> <match> {<protocol> <start-port> <end-
port> {permit|deny|src-nat|dst-nat{<IP-address> <port>| <port>}}| app <app> {permit| deny} |
appcategory <appgrp>| webcategory <webgrp> {permit| deny}| webreputation <webrep>
[<optionl....option9>]

(Instant AP) (Access Rule <name>)# end

(Instant AP)# commit apply

To configure access control based on the SSID:

(Instant AP) (config)# wlan ssid-profile <name>
(Instant AP) (SSID Profile <name>)# set-role-by-ssid
(Instant AP) (SSID Profile <name>)# end

(Instant AP)# commit apply

To configure role assignment rules:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# set-role <attribute>{{equals|not-equals|starts-with|ends-
with|contains|matches-regular-expression}<operator><role>|value-of}

(Instant AP) (SSID Profile <name>)# end

(Instant AP)# commit apply

To configure a pre-authentication role:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# set-role-pre-auth <pre-authentication-role>
(Instant AP) (SSID Profile <name>)# end

(Instant AP)# commit apply

To configure machine and user authentication roles
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(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# set-role-machine-auth <machine-authentication-only> <user-
authentication-only>

(Instant AP) (SSID Profile <name>)# end

(Instant AP)# commit apply

To configure unrestricted access:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# set-role-unrestricted
(Instant AP) (SSID Profile <name>)# end

(Instant AP)# commit apply

Example

The following example configures access rules for the wireless network:

(Instant AP) (config)# wlan access-rule WirelessRule

(Instant AP) (Access Rule "WirelessRule")# rule 192.0.2.2 255.255.255.0 match 6 4343 4343 log
classify-media

(Instant AP) (Access Rule "WirelessRule")# rule any any match app deny throttle-downstream 256
throttle-up 256

(Instant AP) (Access Rule "WirelessRule")# rule any any match appcategory collaboration permit
(Instant AP) (Access Rule "WirelessRule")# rule any any match webcategory gambling deny
(Instant AP) (Access Rule "WirelessRule")# rule any any match webcategory training-and-tools
permit

(Instant AP) (Access Rule "WirelessRule")# rule any any match webreputation well-known-sites
permit

(Instant AP) (Access Rule "WirelessRule")# rule any any match webreputation safe-sites permit
(Instant AP) (Access Rule "WirelessRule")# rule any any match webreputation benign-sites permit
(Instant AP) (Access Rule "WirelessRule")# rule any any match webreputation suspicious-sites
deny

(Instant AP) (Access Rule "WirelessRule")# rule any any match webreputation high-risk-sites
deny

(Instant AP) (Access Rule "WirelessRule")# end

(Instant AP)# commit apply

Configuring Fast Roaming for Wireless Clients
AOS-W Instant supports the following features that enable fast roaming of clients:
e Opportunistic Key Caching

e Fast BSS Transition (802.11r Roaming)

e Radio Resource Management (802.11k)

e BSS Transition Management (802.11v)

Opportunistic Key Caching

AOS-W Instant now supports opportunistic key caching (OKC) based roaming. In the OKC based roaming, the AP
stores one pairwise master key (PMK) per client, which is derived from last 802.1x authentication completed by the
client in the network. The cached PMK is used when a client roams to a new AP. This allows faster roaming of
clients between the OAW-IAPs in a cluster, without requiring a complete 802.1X authentication.

OKC roaming (when configured in the 802.1x Authentication profile) is supported on WPAZ2 clients. If the wireless
client (the 802.1X supplicant) does not support this feature, a complete 802.1X authentication is required
whenever a client roams to a new AP.

Configuring an OAW-IAP for OKC Roaming
You can enable OKC roaming for WLAN SSID by using AOS-W Instant Ul or CLI.
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In the AOS-W Instant Ul

Navigate to the WLAN wizard (click Network>New or Network> Select the WLAN SSID>edit).

2. Click the Security tab.

3. Slide to Enterprise security level. On selecting a security level, the authentication options applicable to

Enterprise network are displayed.

New WLAN
| WLAN Settings 2 3
Security Level
More Key management: | WPA-2 Enterprise -
Secure
Termination: [ Disabled .
. Authentication server 1: |Interna|§e"\.'er v
- Enterprise
Reauth interval: |0 min. hd
Personal
MAC authentication: Perform MAC authentication before 802.1X
MAC authentication fail-thru
Open
Internal server: No users Users
Internal server: Default certificate Upload certificate
Less Blacklisting: [ Cisabled M

Secure
Fast Roaming

B02.11r:
B802.11k:
802.11wv:

Opportunistic Key Caching(OKC): [«

Back

Next Cancel

4. Select the WPA-2 Enterprise or Both (WPA-2 & WPA) option from the Key management drop-down list.
When any of these encryption types is selected, Opportunistic Key Caching (OKC) is enabled by default.

5. Click Next and then click Finish.

In the CLI

To disable OKC roaming on a WLAN SSID:

(Instant

config)# wlan ssid-profile <name>

AP) (
(Instant AP) (SSID Profile <name>)# opmode {wpa2-aes|wpa-tkip,wpa-aes,wpal2-tkip,wpal-aes}
(

(Instant AP)
(Instant AP) (config)# end
(Instant AP)# commit apply

SSID Profile <name>)# okc-disable

To enable OKC roaming on a WLAN SSID:

(Instant AP)
(Instant AP)
(Instant AP)
(Instant AP) (config)# end

(Instant AP)# commit apply

(config) # wlan ssid-profile <name>
(SSID Profile <name>)# opmode {wpal-aes| wpa-tkip,wpa-aes,wpal-tkip,wpa2-aes}
(SSID Profile <name>)# no okc-disable

Fast BSS Transition (802.11r Roaming)

802.11ris a roaming standard defined by IEEE. When enabled, 802.11r reduces roaming delay by pre-authenticating
clients with multiple target APs before a client roams to an AP. With 802.11r implementation, clients pre-
authenticate with multiple APs in a cluster.

As part of the 802.11rimplementation, AOS-W Instant supports the Fast BSS Transition protocol. The Fast BSS
Transition mechanism reduces client roaming delay when a client transitions from one BSS to another within the
same cluster. This minimizes the time required to resume data connectivity when a BSS transition happens.
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Fast BSS Transition is operational only if the wireless client supports 802.11r standard. If the client does not
support 802.11r standard, it falls back to the normal WPAZ2 authentication method.

Configuring an OAW-IAP for 802.11r support
You can configure 802.11r support fora WLAN SSID by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1.
2. Click the Security tab.

3.

4. Click Next and then click Finish.

Navigate to the WLAN wizard (click Network>New or Network> Select the WLAN SSID>edit).

Under Fast Roaming, select the 802.11r checkbox.

In the CLI
To enable 802.11r roaming on a WLAN SSID:

(
(
(
(

Instant AP) (config)# wlan ssid-profile <name>
Instant AP) (SSID Profile <name>)# dotllr
Instant AP) (config)# end

Instant AP)# commit apply

Example

(
(
(
(

Instant AP) (

Instant AP) (SSID Profile "dotllr-profile")# dotllr
Instant AP) (

Instant AP)# commit apply

config)# wlan ssid-profile dotllr-profile

config)# end

Radio Resource Management (802.11k)

The 802.11k protocol provides mechanisms for APs and clients to dynamically measure the available radio
resources and enables stations to query and manage their radio resources. In an 802.11k enabled network, APs and
clients can share radio and link measurement information, neighbor reports, and beacon reports with each other. This
allows the WLAN network infrastructural elements and clients to assess resources and make optimal mobility
decisions to ensure Quality of Service (QoS) and seamless continuity.

AOS-W Instant supports the following radio resource management information elements with 802.11k support
enabled:

Power Constraint IE-The power constraint element contains the information necessary to allow a client to
determine the local maximum transmit power in the current channel.

AP Channel Report IE-The AP channel report element contains a list of channels in a regulatory class where a
client is likely to find an AP, including the AP transmitting the AP channel report.

RRM Enabled Capabilities IE-The RRM Enabled Capabilities element signals support for radio measurements in
a device. The clients use this IE to specify their radio measurement capabilities.

BSS Load Element. The BSS Load element contains information on the density of clients and traffic levels in the
QBSS.

Transmit Power Control (TPC) Report IE: The TPC IE contains transmit power and link margin information.
Quiet IE: The Quiet IE defines an interval during which no transmission occurs in the current channel. This
interval may be used to assist in making channel measurements without interference from other stations in the
BSS.

Extended Capabilities IE - The extended capabilities |E carries information about the capabilities of an IEEE
802.11 station.
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Beacon Report Requests and Probe Responses

The beacon request frame is sent by an AP to request a client to report the list of beacons heard by the client on all
channels.

e The beacon request is sent using the radio measurement request action frame.

e ltis sent only to those clients that have the capability to generate beacon reports. The clients indicate their
capabilities through the RRM enabled capabilities |E sent in the association request frames.

o By default, the beacon request frames are sent at a periodicity of 60 seconds.

Configuring a WLAN SSID for 802.11k Support
You can enable 802.11k support on a WLAN SSID by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Navigate to the WLAN wizard (click Network>New or Network> Select the WLAN SSID>edit).
2. Click the Security tab.

3. Under Fast Roaming, Select the 802.11k checkbox.

4. Click Next and then click Finish.

To allow the AP and clients to exchange neighbor reports, ensure that the Client match is enabled through RF >
ARM > Client match > Enabled in the Ul or by executing the client-match command in the arm configuration
NOTE sub-mode.

In the CLI
To enable 802.11k profile:

(Instant AP) (config)# wlan ssid-profile <name>
(Instant AP) (SSID Profile <name>)# dotllk
(Instant AP) (config)# end

(Instant AP)# commit apply

To view the beacon report details:

show ap dotllk-beacon-report <mac>
To view the neighbor details:

show ap dotllk-nbrs

Example

(Instant AP) (config)# wlan ssid-profile dotllk-profile
(Instant AP) (SSID Profile "dotllk-profile")# dotllk
(Instant AP) (config)# end

(Instant AP)# commit apply

BSS Transition Management (802.11v)

The 802.11v standard provides Wireless Network Management enhancements to the IEEE 802.11 MAC and PHY. It
extends radio measurements to define mechanisms for wireless network management of stations including BSS
transition management.

OAW-IAPs support the generation of the BSS transition management request frames to the 802.11k clients when a
suitable AP is identified for a client through client match.

Configuring a WLAN SSID for 802.11v Support
You can enable 802.11v support on a WLAN SSID by using the AOS-W Instant Ul or CLI.
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In the AOS-W Instant Ul

1. Navigate to the WLAN wizard (click Network>New or Network> Select the WLAN SSID>edit).
2. Click the Security tab.

3. Under Fast Roaming, Select the 802.11v checkbox.

4. Click Next and then click Finish.

In the CLI
To enable 802.11v profile:

(Instant AP) (config)# wlan ssid-profile <name>
(Instant AP) (SSID Profile <name>)# dotllwv
(Instant AP) (config)# end

(Instant AP)# commit apply

Example

(Instant AP) (config)# wlan ssid-profile dotllv-profile
(Instant AP) (SSID Profile "dotllv-profile")# dotllv
(Instant AP) (config)# end

(Instant AP)# commit apply

Editing Status of a WLAN SSID Profile

You can enable or disable an SSID profile in the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

To modify the status of a WLAN SSID profile:

In the Networks tab, select the network that you want to edit. The edit link is displayed.

Click the edit link. The Edit network window is displayed.

Select or clear the Disable SSID checkbox to disable or enable the SSID. The SSID is enabled by default.
Click Next or the tab name to move to the next tab.

a M D~

Click Finish to save the modifications.

In the CLI
To disable an SSID

(Instant AP) (config)# wlan ssid-profile <name>
(Instant AP) (SSID Profile <name>)# disable
(Instant AP) (SSID Profile <name>)# end
(Instant AP)# commit apply

To enable an SSID:

(Instant AP) (config)# wlan ssid-profile <name>
(Instant AP) (SSID Profile <name>)# enable
(Instant AP) (SSID Profile <name>)# end
(Instant AP)# commit apply

Editing a WLAN SSID Profile
To edit a WLAN SSID profile:
1. Inthe Networks tab, select the network that you want to edit. The edit link is displayed.

2. Click the edit link. The Edit network window is displayed.
3. Modify the required settings. Click Next to move to the next tab.
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4. Click Finish to save the modifications.

Deleting a WLAN SSID Profile
To delete a WLAN SSID profile:

1. Inthe Networks tab, click the network that you want to delete. A x link is displayed against the network to be
deleted.

2. Click x. A delete confirmation window is displayed.

3. Click Delete Now.
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Chapter 9

Wired Profiles

This chapter describes the following procedures:

e Configuring a Wired Profile on page 113

e Assigning a Profile to Ethernet Ports on page 118

e Editing a Wired Profile on page 118

e Deleting a Wired Profile on page 119

e Link Aggregation Control Protocol for OAW-IAP220 Series on page 119
e Understanding Hierarchical Deployment on page 120

Configuring a Wired Profile

The Ethernet ports allow third-party devices such as VolP phones or printers (which support only wired connections)
to connect to the wireless network. You can also configure an Access Control List (ACL) for additional security on
the Ethernet downlink.

The wired profile configuration for employee network involves the following procedures:

Configuring Wired Settings on page 113
Configuring VLAN for a Wired Profile on page 115
Configuring Security Settings for a Wired Profile on page 116

oD =

Configuring Access Rules for a Wired Profile on page 117

For information on creating a wired profile for guest network, see Captive Portal for Guest Access

Configuring Wired Settings

You can configure wired settings for a wired profile by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Click the Wired link under More at the top right corner of the AOS-W Instant main window. The Wired window is
displayed.

2. Click New under Wired Networks. The New Wired Network window is displayed. The following figure shows
the contents of the Wired Settings tab:
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Figure 38 New Wired Network Window: Wired Settings Window

New Wired Network Help

il Wired Settings

Wired Settings
Name:
Primary usage: @ Employee
Guest

Speed/Duplex: Aute =] [Auto [=]
POE: Enabled =
Admin status: Up [==]
Content filtering: [Disabled  [=]
Uplink: Disabled [=]
Spanning tree Disabled [=]

Next Cancel

3. Click the Wired Settings tab and enter the following information:

a.
b.
C.

d.

Name— Specify a name for the profile.
Primary Usage — Select Employee or Guest.

Speed/Duplex — Ensure that appropriate values are selected for Speed/Duplex. Contact your network
administrator if you need to assign speed and duplex parameters.

POE — Set POE to Enabled to enable Power over Ethernet.

The E2

port on OAW-RAP3WNP supports Power Sourcing Equipment (PSE) to supply power to any compliant

802.3af powered (class 0-4) device. OAW-RAP 155P supports PSE for 802.3af powered device (class 0-4) on one
NOTE port (E1 or E2), or 802.3at powered DC IN (Power Socket) on two ports (E1 and E2).

Admin Status — Ensure that an appropriate value is selected. The Admin Status indicates if the port is up or
down.

Content Filtering— To ensure that all DNS requests to non-corporate domains on this wired network are sent
to OpenDNS, select Enabled for Content Filtering.

Uplink — Select Enabled to configure uplink on this wired profile. If Uplink is set to Enabled and this network
profile is assigned to a specific port, the port will be enabled as Uplink port. For more information on assigning
a wired network profile to a port, see Assigning a Profile to Ethernet Ports on page 118.

Spanning Tree—Select the Spanning Tree checkbox to enable Spanning Tree Protocol (STP) on the wired
profile. STP ensures that there are no loops in any bridged Ethernet network and operates on all downlink
ports, regardless of forwarding mode. STP will not operate on the uplink port and is supported only on OAW-
IAPs with three or more ports. By default Spanning Tree is disabled on wired profiles.

4. Click Next. The VLAN tab details are displayed.

5. Configure VLAN for the wired profile. For more information, see Configuring VLAN for a Wired Profile on page
115.

In the

CLI

To configure wired settings for:

(Instant AP) (config)# wired-port-profile <name>

(Instant AP) (wired ap profile <name>)# type {<employee> |<guest>}
(Instant AP) (wired ap profile <name>)# speed {10 [100 |1000 |auto}
(Instant AP) (wired ap profile <name>)# duplex {half|fulll|auto}
(Instant AP) (wired ap profile <name>)# no shutdown

(Instant AP) (wired ap profile <name>)# poe
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Instant AP) (wired ap profile <name>)
Instant AP) (wired ap profile <name>)
) ( )

)

( uplink-enable
(

(Instant AP) (wired ap profile <name>

(

(

#
# content-filtering
# spanning-tree

Instant AP) (wired ap profile <name>)# end

Instant AP)# commit apply

Configuring VLAN for a Wired Profile

If you are creating a new wired profile, complete the Wired Settings procedure before configuring VLAN. For more

NoTA information, see Configuring Wired Settings on page 113.

You can configure VLAN using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To configure VLAN:

1. Inthe VLAN tab, enter the following information.
a. Mode — You can specify any of the following modes:
Access — Select this mode to allow the port to carry a single VLAN specified as the native VLAN.

Trunk — Select this mode to allow the port to carry packets for multiple VLANs specified as allowed
VLANS.

b. Specify any of the following values for Client IP Assignment:

Virtual Controller Assigned: Select this option to allow the Virtual Controller to assign IP addresses to

the wired clients. When the Virtual Controller assignment is used, the source IP address is translated for
all client traffic that goes through this interface. The Virtual Controller can also assign a guest VLAN to a

wired client.

Network Assighed: Select this option to allow the clients to receive an IP address from the network to
which the Virtual Controller is connected. On selecting this option, the New button to create a VLAN is
displayed. Create a new VLAN if required.

c. Ifthe Trunk mode is selected:

Specify the Allowed VLAN, enter a list of comma separated digits or ranges 1,2,5 or 1-4, or all. The
Allowed VLAN refers to the VLANSs carried by the port in Access mode.

If the Client IP Assignment is set to Network Assigned, specify a value for Native VLAN. A VLAN that
does not have a VLAN ID tag in the frames is referred to as Native VLAN. You can specify a value within
the range of 1-4093.

d. If the Access mode is selected:
If the Client IP Assignment is set to Virtual Controller Assigned, proceed to step 2.

If the Client IP Assignment is set to Network Assigned, specify a value for Access VLAN to indicate the
VLAN carried by the port in the Access mode.

2. Click Next. The Security tab details are displayed.

3. Configure security settings for the wired profile. For more information, see Configuring Security Settings fora
Wired Profile on page 116.

In the CLI

To configure VLAN settings for a wired profile:

(Instant AP) (config)# wired-port-profile <name>

(Instant AP) (wired ap profile <name>)# switchport-mode {trunk|access}
(Instant AP) (wired ap profile <name>)# allowed-vlan <vlan>

(Instant AP) (wired ap profile <name>) native-vlan {<guest]1..4095>}

( ) ( )

#
Instant AP) (wired ap profile <name>)# end
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(Instant AP)# commit apply

To configure a new VLAN assignment rule:

(Instant AP) (config)# wired-port-profile <name>
(Instant AP) (wired ap profile <name>)# set-vlan <attribute>{equals| not-equals| starts-with|
ends-with| contains| matches-regular-expression} <operator> <VLAN-ID>| value-of}

(Instant AP) (wired ap profile <name>)# end

(Instant AP)# commit apply

Configuring Security Settings for a Wired Profile

If you are creating a new wired profile, complete the Wired Settings and VLAN procedures before specifying security

settings

. For more information, see Configuring Wired Settings on page 113 and Configuring VLAN Settings for a

HNeTE  \WLAN SSID Profile on page 97.

Configuring Security Settings for a Wired Employee Network

You can configure security parameters for an employee network by using the AOS-W Instant Ul or CLI.

In the

AOS-W Instant Ul

To configure security parameters for an employee network:

1. Configure the following parameters in the Security tab.

MAC authentication — To enable MAC authentication, select Enabled. The MAC authentication is disabled
by default.

802.1X authentication — To enable 802.1X authentication, select Enabled.

MAC authentication fail-thru — To enable authentication fail-thru, select Enabled. When this feature is
enabled, 802.1X authentication is attempted when MAC authentication fails. The MAC authentication fail-
thru checkbox is displayed only when both MAC authentication and 802.1X authentication are Enabled.

Select any of the following options for Authentication server 1:

= New — On selecting this option, an external RADIUS server must be configured to authenticate the users.
For information on configuring an external server, see Configuring an External Server for Authentication on
page 158.Authentication and User Management on page 141

= Internal server— If aninternal server is selected, add the clients that are required to authenticate with the
internal RADIUS server. Click the Users link to add the users. For information on adding a user, see
Managing OAW-IAP Users on page 141.

Reauth interval — Specify the interval at which all associated and authenticated clients must be
reauthenticated.

Load balancing— Set this to Enabled if you are using two RADIUS authentication servers, so that the load
across the two RADIUS servers is balanced. For more information on the dynamic load balancing
mechanism, see Dynamic Load Balancing between Two Authentication Servers on page 155.

2. Click Next. The Access tab details are displayed.

In the

CLI

To configure security settings for an employee network:

(Instant AP)
(Instant AP)
(Instant AP)
(Instant AP)
(Instant AP)
(Instant AP)
(Instant AP)

(config) # wired-port-profile <name>

(wired ap profile <name>)# mac-authentication

(wired ap profile <name>)# 1l2-auth-failthrough

(wired ap profile <name>)# auth-server <name>

(wired ap profile <name>)# server-load-balancing

(wired ap profile <name>)# radius-reauth-interval <Minutes>
(wired ap profile <name>)# end

(Instant AP)# commit apply
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Configuring Access Rules for a Wired Profile

The Ethernet ports allow third-party devices such as VolP phones or printers (that support only wired connections) to
connect to the wireless network. You can also configure an Access Control List (ACL) for additional security on the
Ethernet downlink.

If you are creating a new wired profile, complete the Wired Settings and configure VLAN and security parameters,
before defining access rules. For more information, see Configuring Wired Settings on page 113, Configuring VLAN
NeTE fora Wired Profile on page 115, and Configuring Security Settings for a Wired Profile on page 116.

You can configure access rules by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To configure access rules:

1. Inthe Access tab, configure the following access rule parameters.
a. Select any of the following types of access control:
Role-based— Allows the users to obtain access based on the roles assigned to them.
Unrestricted— Allows the users to obtain unrestricted access on the port.
Network-based— Allows the users to be authenticated based on access rules specified for a network.
b. If the Role-based access control is selected, perform the following steps:

Under Roles, select an existing role for which you want to apply the access rules, or click New and add
the required role. The list of roles defined for all networks is displayed under Roles.

The default role with the same name as the network, is automatically defined for each network. The default roles

cannot be modified or deleted.
HNOTE

Select the access rule associated with a specific role and modify if required. To add a new access rule,
click New in the Access Rules window. You can configure up to 64 access rules. For more information on
configuring access rules, see Configuring Access Rules for Network Services on page 179.

Configure rules to assign roles for an authenticated client. You can also configure rules to derive VLANS
for the wired network profile. For more information on role assignment rules and VLAN derivation rules, see
Configuring Derivation Rules on page 194 and Configuring VLAN Derivation Rules on page 198.

Select the Assign pre-authentication role checkbox to add a pre-authentication role that allows some
access to the users before the client authentication.

Select the Enforce Machine Authentication checkbox, to configure access rights to clients based on
whether the client device supports machine authentication. Select the Machine auth only and User auth
only rules. Machine Authentication is only supported on Windows devices and devices such as iPads.

If Enforce Machine Authentication is enabled, both the device and the user must be authenticated for

- the role assignment rule to apply.

2. Click Finish.

In the CLI

To configure access rules for a wired profile:

(Instant AP) (config)# wired-port-profile <name>

(Instant AP) (wired ap profile <name>)# access-rule-name <name>
(Instant AP) (wired ap profile <name>)# end

(Instant AP)# commit apply

To configure role assignment rules:
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(Instant AP) (config)# wired-port-profile <name>

(Instant AP) (wired ap profile <name>)# set-role <attribute>{{equals| not-equal| starts-with]
ends-with| contains| matches-regular-expression}<operator> <role>| value-of}

(Instant AP) (wired ap profile <name>)# end

(Instant AP)# commit apply

To configure a pre-authentication role:

(Instant AP) (config)# wired-port-profile <name>

(Instant AP) (wired ap profile <name>)# set-role-pre-auth <pre-authentication-role>
(Instant AP) (wired ap profile <name>)# end

(Instant AP)# commit apply

To configure machine and user authentication roles:

(Instant AP) (config)# wired-port-profile <name>

(Instant AP) (wired ap profile <name>)# set-role-machine-auth <machine only> <user-only>
(Instant AP) (wired ap profile <name>)# end

(Instant AP)# commit apply

To configure unrestricted access:

(Instant AP) (config)# wired-port-profile <name>

(Instant AP) (wired ap profile <name>)# set-role-unrestricted
(Instant AP) (wired ap profile <name>)# end

(Instant AP)# commit apply

Assigning a Profile to Ethernet Ports

You can assign profiles to Ethernet ports using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

To assign profiles to Ethernet ports:

1. Click the Wired link under More at the top right corner of the AOS-W Instant main window. The Wired window is
displayed.

2. Toassign an Ethernet downlink profile to Ethernet 0 port:

a. Ensure that the wired bridging on the port is enabled. For more information, see Configuring Wired Bridging on
Ethernet 0 for Mesh Point on page 307.

b. Select and assign a profile from the 0/0 drop down list.
To assign a wired profile to Ethernet 0/1 port, select the profile from the 0/1 drop down list.

. Ifthe OAW-IAP supports E2, E3 and E4 ports, assign profiles to other Ethernet ports by selecting a profile
from the 0/2, 0/3, and 0/4 drop-down list.

In the CLI

To assign profiles to Ethernet ports:

(Instant AP) (config)# enetO-port-profile <name>
(Instant AP) (config)# enetl-port-profile <name>
(Instant AP) (config)# enet2-port-profile <name>
(Instant AP) (config)# enet3-port-profile <name>
(Instant AP) (config)# enetd-port-profile <name>

(Instant AP) (config)# end
(Instant AP)# commit apply

Editing a Wired Profile

To edit a wired profile:
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NOTE

1. Click the Wired link under More at the top right corner of the AOS-W Instant main window. The Wired window is
displayed.

In the Wired window, select the wired profile to modify.
Click Edit. The Edit Wired Network window is displayed.
Modify the required settings.

a M D

Click Finish to save the modifications.

To delete a wired profile:

1. Click the Wired link under More at the top right corner of the AOS-W Instant main window. The Wired window is
displayed.

2. Inthe Wired window, select the wired profile to delete.
3. Click Delete. The wired profile is deleted.

OAW-IAP220 Series supports the IEEE 802.11ac standard for high-performance WLAN. To support maximum
traffic, port aggregation is required as it increases throughput and enhances reliability. To support port aggregation,
AOS-W Instant supports Link Aggregation Control Protocol (LACP) based on the IEEE 802.3ad standard. 802.3ad
standard for Ethernet aggregation uses LACP as a method to manage link configuration and balance traffic among
aggregated ports.

LACP provides a standardized means for exchanging information with partner systems to form a dynamic link
aggregation group. The LACP feature is automatically enabled during OAW-IAP boots and it dynamically detects the
AP if connected to a partner system with LACP capability, by checking if there is any LACP Protocol Data Unit
(PDU) received on either ethO or eth1 port.

If the switch in the cluster has the LACP capability, you can combine ethO and eth1 interfaces into the link
aggregation group to form a single logical interface (port-channel). Port-channels can be used to provide additional
bandwidth or link redundancy between two devices. OAW-IAP220 Series supports link aggregation using either
standard port-channel (configuration based) or Link Aggregation Control Protocol (protocol signaling based). OAW-
IAP220 Series can optionally be deployed with LACP configuration to benefit from the higher (greater than 1 Gbps)
aggregate throughput capabilities of the two radios.

The LACP feature is supported only on OAW-IAP220 Series.

There is no configuration required on the AP for enabling LACP support. However, you can view the status of LACP
on OAW-IAPs by using the following command:

(Instant AP)# show lacp status
AP LACP Status

Up slow 2 17 1 70:81:05:11:3e:80
Slave Interface Status

eth0 6c:£f3:7f:c6:76:6e Up Yes O
ethl 6c:£f3:7f:¢c6:76:6f Up Yes O
Traffic Sent on Enet Ports

AOS-W Instant 6.4.0.2-4.1 | User Guide Wired Profiles |



100

non-wifi 2 17

Understanding Hierarchical Deployment

An OAW-IAP Series or OAW-RAP3WN (with more than one wired port) can be connected to the downlink wired port
of another OAW-IAP (ethX). An OAW-IAP with a single Ethernet port (like OAW-IAP90 or OAW-IAP 100 series
devices) can be provisioned to use Ethernet bridging, so that Ethernet O port is converted to a downlink wired port.

You can also form an OAW-IAP network by connecting the downlink port of an AP to other APs. Only one AP in the
network uses its downlink port to connect to the other APs. This AP (called the root AP) acts as the wired device for
the network, provides DHCP service and an L3 connection to the ISP uplink with NAT. The root AP is always the
master of the Instant network. In a single Ethernet port platform deployment, the root AP must be configured to use
the 3G uplink.

A typical hierarchical deployment consists of the following:

A direct wired ISP connection or a wireless uplink.

One or more DHCP pools for private VLANSs.

One downlink port configured on a private VLAN without authentication for connecting to slave APs. Ensure that
the downlink port configured in a private VLAN is not used for any wired client connection. Other downlink ports
can be used for connecting to the wired clients.

The following figure illustrates a hierarchical deployment scenario:

Figure 39 Hierarchical Deployment
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Chapter 10

Captive Portal for Guest Access

This chapter provides the following information:

e Understanding Captive Portal on page 121

e Configuring a WLAN SSID for Guest Access on page 122

e Configuring Wired Profile for Guest Access on page 126

e Configuring Internal Captive Portal for Guest Network on page 127

e Configuring External Captive Portal for a Guest Network on page 130

e Configuring External Captive Portal Authentication Using ClearPass Guest on page 133
e Configuring Guest Logon Role and Access Rules for Guest Users on page 134

e Configuring Captive Portal Roles for an SSID on page 136

e Configuring Walled Garden Access on page 139

e Disabling Captive Portal Authentication on page 139

Understanding Captive Portal

AOS-W Instant supports the captive portal authentication method, where a Web page is presented to the guest
users when they try to access the Internet whether in hotels, conference centers or Wi-Fi hotspots. The Web page
also prompts the guest users to authenticate or accept the usage policy and terms. captive portals are used at many
Wi-Fi hotspots and can be used to control wired access as well.

The AOS-W Instant captive portal solution consists of the following:

e The captive portal Web login page hosted by an internal or external server.
e The RADIUS authentication or user authentication against OAW-IAP's internal database.
e The SSID broadcast by the OAW-IAP.

With AOS-W Instant, the administrators can create a wired or WLAN guest network based on captive portal
authentication for guests, visitors, contractors, and any non-employee users who can use the enterprise Wi-Fi
network. The administrators can also create guest accounts and customize the captive portal page with
organization-specific logo, terms, and usage policy. With captive portal authentication and guest profiles, the
devices associating with the guest SSID are assigned an initial role and are assigned IP addresses. When a guest
user tries to access a URL through HTTP or HTTPS, the captive portal web page prompting the user to authenticate
with a user name and password is displayed.

Types of Captive Portal

AOS-W Instant supports the following types of captive portal authentication:

o Internal captive portal — For Internal captive portal authentication, an internal server is used for hosting the
captive portal service. It supports the following types of authentication:

= Internal Authenticated— When Internal Authenticated is enabled, a guest user must authenticate in the
captive portal page to access the Internet. The guest users who are required to authenticate must already be
added to the user database.

= Internal Acknowledged— When Internal Acknowledged is enabled, a guest user must accept the terms
and conditions to access the Internet.
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External captive portal— For external captive portal authentication, an external portal on the cloud or on a server
outside the enterprise network is used.

Walled Garden

The administrators can also control the resources that the guest users can access and the amount of bandwidth or
air time they can use at any given time. When an external captive portal is used, the administrators can configure a
walled garden, which determines access to the URLs requested by the guest users. For example, a hotel
environment where the unauthenticated users are allowed to navigate to a designated login page (for example, a
hotel website) and all its contents. The users who do not sign up for the Internet service can view only the “allowed”
websites (typically hotel property websites).

The administrators can allow or block access to specific URLs by creating a whitelist and blacklist. When the users
attempt to navigate to other websites, which are not in the whitelist of the walled garden profile, the users are
redirected to the login page. If the requested URL is on the blacklist, it is blocked. If it appears on neither list, the
request is redirected to the external captive portal.

Configuring a WLAN SSID for Guest Access

You create an SSID for guest access by using the AOS-W Instant Ul or CLI:

In the AOS-W Instant Ul

1. Inthe Networks tab of the AOS-W Instant main window, click the New link. The New WLAN window is
displayed.

Enter a name that uniquely identifies a wireless network in the Name (SSID) text box.
Based on the type of network profile, specify the Primary usage as Guest.
Click the Show advanced options link. The advanced options for configuration are displayed.

a e DN

Enter the required values for the following configuration parameters:

Table 22: WLAS SSID Configuration Parameters for Guest Network

Parameters Description

Broadcast/Multicast Select any of the following values under Broadcast filtering:

All-When set to All, the OAW-IAP drops all broadcast and multicast frames
except DHCP and ARP.

ARP—-When setto ARP, the OAW-IAP converts ARP requests to unicast and
send frames directly to the associated client.

Disabled— When set to Disabled, all broadcast and multicast traffic is
forwarded.

DTIM interval The DTIM interval indicates the delivery traffic indication message (DTIM) period
in beacons, which can be configured for every WLAN SSID profile. The

DTIM interval determines how often the OAW-IAP should deliver the buffered
broadcast and multicast frames to associated clients in the powersave mode.
The default value is 1, which means the client checks for buffered data on the
OAW-IAP at every beacon. You can also configure a higher DTIM value for
power saving.

Multicast transmission Select Enabled if you want the OAW-IAP to select the optimal rate for sending
optimization broadcast and multicast frames based on the lowest of unicast rates across all
associated clients. When this option is enabled, multicast traffic can be sent at up
to 24 Mbps. The default rate for sending frames for 2.4 GHz is 1 Mbps and 5.0
GHz is 6 Mbps. This option is disabled by default.
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Parameters Description

Dynamic multicast optimization Select Enabled to allow OAW-IAP to convert multicast streams into unicast
streams over the wireless link. Enabling Dynamic Multicast Optimization (DMO)
enhances the quality and reliability of streaming video, while preserving the
bandwidth available to the non-video clients.

DMO channel utilization threshold | Specify a value to set a threshold for DMO channel utilization. With DMO, the
OAW-IAP converts multicast streams into unicast streams as long as the channel
utilization does not exceed this threshold. The default value is 90% and the
maximum threshold value is 100%. When the threshold is reached or exceeds
the maximum value, the OAW-IAP sends multicast traffic over the wireless link.
NOTE: When you enable DMO on multicast SSID profiles, ensure that the DMO
feature is enabled on all SSIDs configured in the same VLAN.

Transmit Rates Specify the following parameters:

2.4 GHz-If the 2.4 GHz band is configured on the OAW-IAP, specify the
minimum and maximum transmission rate. The default value for minimum
transmission rate is 1 Mbps and maximum transmission rate is 54 Mbps.

5 GHz-If the 5 GHz band is configured on the OAW-IAP, specify the minimum
and maximum transmission rate. The default value for minimum transmission
rate is 6 Mbps and maximum transmission rate is 54 Mbps.

Zone Specify the zone for the SSID. When the zone is defined in SSID profile and if the
same zone is defined on an OAW-IAP, the SSID is created on that OAW-IAP. For
more information on configuring zone details on an IAP, see Configuring Zone
Settings on an OAW-IAP on page 84.
The following constraints apply to the zone configuration:
An OAW-IAP can belong to only one zone and only one zone can be
configured on an SSID.
If an SSID belongs to a zone, all OAW-IAPs in this zone can broadcast this
SSID. If no OAW-IAP belongs to the zone configured on the SSID, the SSID is
not broadcast.
If an SSID does not belong to any zone, all OAW-IAPs can broadcast this
SSID.

Bandwidth Limits Select any of the following checkboxes to specify the bandwidth limit:
Airtime—Select this checkbox to specify an aggregate amount of airtime that
all clients in this network can use for sending and receiving data. Specify the
airtime percentage.

Each user- Select this checkbox to specify a throughput for any single user
in this network. Specify the throughput value in Kbps.

Each radio— Select this checkbox to specify an aggregate amount of
throughput that each radio is allowed to provide for the connected clients.

Wi-Fi Multimedia (WMM) traffic Configure the following options for WMM traffic management. WMM supports
management voice, video, best effort, and background access categories. To allocate
bandwidth for the following types of traffic, specify a percentage value under
Share. To configure DSCP mapping, specify a value under DSCP Mapping.
Background WMM: For background traffic such as file downloads or print
jobs.
Best effort WMM — For best effort traffic such as traffic from legacy devices or
traffic from applications or devices that do not support QoS.
Video WMM - For video traffic generated from video streaming.
Voice WMM- For voice traffic generated from the incoming and outgoing
voice communication.
For more information on WMM traffic and DSCP mapping, see Wi-Fi Multimedia
Traffic Management on page 253
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Parameters Description

Content filtering Set to Enabled to route all DNS requests for the non-corporate domains to
OpenDNS on this network.

Band Select a value to specify the band at which the network transmits radio signals.
You can set the band to 2.4 GHz, 5 GHz, or All. The All option is selected by
default.

Inactivity timeout Specify a timeout interval. If a client session is inactive for the specified duration,

the session expires and the users are required to log in again. The minimum
value is setto 60 seconds and the default value is 1000 seconds.

Hide SSID Select the checkbox if you do not want the SSID (network name) to be visible to
users

Disable SSID Select to the checkbox to disable the SSID. On selecting this checkbox, the SSID
is disabled, but not removed from the network. By default, all SSIDs are enabled.

Can be used without Uplink Select the checkbox if you do not want the SSID users to use uplink.

Max clients threshold Specify the maximum number of clients that can be configured for each BSSID

on a WLAN in the text box. You can specify a value within the range of 0 to 255.
The default value is 64.

Local probe request threshold Specify a threshold value in the Local probe request threshold text box to limit
the number of incoming probe requests. When a client sends a broadcast probe
request frame to search for all available SSIDs, this option controls system
response for this network profile and ignores probe requests if required. You can
specify a Received signal strength indication (RSSI) value within range of 0 to
100 dB.

6. Click Next to configure VLAN settings. The VLAN tab contents are displayed.
7. Select any for the following options for Client IP assignment:

o Virtual Controller assigned—On selecting this option, the client obtains the IP address from the Virtual
Controller.

o Network assigned—On selecting this option, the IP address is obtained from the network.

8. Based on the type client IP assignment mode selected, you can configure the VLAN assignment for clients as
described in the following table:
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Table 23: /P and VLAN Assignment for WLAN SSID Clients

Client IP Assignment Client VLAN Assignment

Virtual Controller assigned | [f the Virtual Controller assigned is selected for client IP assignment, the Virtual
Controller creates a private subnetand VLAN on the OAW-IAP for the wireless clients.
The network address translation for all client traffic that goes out of this interface is
carried out at the source. This setup eliminates the need for complex VLAN and IP
address management for a multi-site wireless network.

On selecting this option, the following client VLAN assignment options are displayed:

o Default: When selected, the default VLAN as determined by the Virtual Controller is
assigned for clients.

e Custom: When selected, you can specify a custom VLAN assignment option. You can
select an existing DHCP scope for client IP and VLAN assignment or you can create
a new DHCP scope by selecting New. For more information on DHCP scopes, see
Configuring DHCP Scopes on page 203.

Network assigned If the Network assigned is selected, you can specify any of the following options for the

Client VLAN assignment.

o Default— On selecting this option, the client obtains the IP address in the same
subnet as the OAW-IAPs. By default, the client VLAN is assigned to the native VLAN
on the wired network.

o Static— On selecting this option, you need to specify a single VLAN, a comma
separated list of VLANS, or a range of VLANSs for all clients on this network. Select
this option for configuring VLAN pooling.

o Dynamic— On selecting this option, you can assign the VLANs dynamically from a
Dynamic Host Configuration Protocol (DHCP) server. To create VLAN assignment
rules, click New to assign the user to a VLAN. In the New VLAN Assignment Rule
window, enter the following information:

o Attribute— Select an attribute returned by the RADIUS server during
authentication.
Operator— Select an operator for matching the string.
String— Enter the string to match

e VLAN- Enter the VLAN to be assigned.

9. Click Next to configure internal or external captive portal authentication, roles and access rules for the guest
users.

In the CLI
To configure WLAN settings for an SSID profile:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# essid <ESSID-name>

(Instant AP) (SSID Profile <name>)# type <Guest>

(Instant AP) (SSID Profile <name>)# broadcast-filter <type>

(Instant AP) (SSID Profile <name># dtim-period <number-of-beacons>

(Instant AP) (SSID Profile <name>)# multicast-rate-optimization

(Instant AP) (SSID Profile <name>)# dynamic-multicast-optimization

(Instant AP) (SSID Profile <name>)# dmo-channel-utilization-threshold

(Instant AP) (SSID Profile <name>)# a-max-tx-rate <rate>

(Instant AP) (SSID Profile <name>)# a-min-tx-rate <rate>

(Instant AP) (SSID Profile <name>)# g-max-tx-rate <rate>

(Instant AP) (SSID Profile <name>)# g-min-tx-rate <rate>

(Instant AP) (SSID Profile <name>)# zone <zone>

(Instant AP) (SSID Profile <name>)# bandwidth-limit <limit>

(Instant AP) (SSID Profile <name>)# per-user-bandwidth-limit <limit>

(Instant AP) (SSID Profile <name>)# air-time-limit <limit>

(Instant AP) (SSID Profile <name>)# wmm-background-share <percentage-of-traffic share>
(Instant AP) (SSID Profile <name>)# wmm-best-effort-share<percentage-of-traffic-share>
(Instant AP) (SSID Profile <name>)# wmm-video-share <percentage-of-traffic share>
(Instant AP) (SSID Profile <name>)# wmm-voice-share <percentage-of-traffic share>
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SSID Profile <name>
SSID Profile <name>

Instant AP
Instant AP

rf-band {<2.4>|<5.0>|<all>}
content-filtering

( ) ( ) #

( ) ( ) #

(Instant AP) (SSID Profile <name>)# hide-ssid

(Instant AP) (SSID Profile <name>)# inactivity-timeout <interval>

(Instant AP) (SSID Profile <name>)# work-without-uplink

(Instant AP) (SSID Profile <name>)# local-probe-reg-thresh <threshold>
(Instant AP) (SSID Profile <name>)# max-clients-threshold <number-of-clients>

To manually assign VLANs for WLAN SSID users:

(Instant AP) (config)# wlan ssid-profile <name>
(Instant AP) (SSID Profile <name># vlan <vlan-ID>

To enforce DHCP-based VLAN assignment:

(Instant AP) (config)# wlan ssid-profile <name>
(Instant AP) (SSID Profile <name># enforce-dhcp

To create a new VLAN assignment rule:

(Instant AP) (config)# wlan ssid-profile <name>
(Instant AP) (SSID Profile <name>)# set-vlan <attribute>{equals|not-equals| starts-with| ends-
with| contains|matches-regular-expression} <operator> <VLAN-ID>| value-of}

You can configure wired settings for a wired profile by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Click the Wired link under More at the top right corner of the AOS-W Instant main window. The Wired window is
displayed.
Click New under Wired Networks. The New Wired Network window is displayed.
3. Click the Wired Settings tab and enter the following information:
a. Name— Specify a name for the profile.
b. Primary Usage — Select Employee or Guest.

c. Speed/Duplex — Ensure that appropriate values are selected for Speed/Duplex. Contact your network
administrator if you need to assign speed and duplex parameters.

d. POE —Set POE to Enabled to enable Power over Ethernet.

e. Admin Status — Ensure that an appropriate value is selected. The Admin Status indicates if the port is up or
down.

f. Content Filtering— To ensure that all DNS requests to non-corporate domains on this wired network are sent
to OpenDNS, select Enabled for Content Filtering.

g. Uplink — Select Enabled to configure uplink on this wired profile. If Uplink is set to Enabled and this network
profile is assigned to a specific port, the port will be enabled as Uplink port. For more information on assigning
a wired network profile to a port, see Assigning a Profile to Ethernet Ports on page 118.

h. Spanning Tree—Select the Spanning Tree checkbox to enable Spanning Tree Protocol (STP) on the wired
profile. STP ensures that there are no loops in any bridged Ethernet network and operates on all downlink
ports, regardless of forwarding mode. STP will not operate on the uplink port and is supported only on OAW-
IAPs with three or more ports. By default Spanning Tree is disabled on wired profiles.

4. Click Next. The VLAN tab details are displayed.
5. Enter the following information.
a. Mode — You can specify any of the following modes:
Access — Select this mode to allow the port to carry a single VLAN specified as the native VLAN.
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Trunk — Select this mode to allow the port to carry packets for multiple VLANs specified as allowed
VLANS.

b. Specify any of the following values for Client IP Assignment:

Virtual Controller Assigned: Select this option to allow the Virtual Controller to assign IP addresses to

the wired clients. When the Virtual Controller assignment is used, the source IP address is translated for
all client traffic that goes through this interface. The Virtual Controller can also assign a guest VLAN to a

wired client.

Network Assigned: Select this option to allow the clients to receive an IP address from the network to
which the Virtual Controller is connected. On selecting this option, the New button to create a VLAN is
displayed. Create a new VLAN if required.

c. If the Trunk mode is selected:

Specify the Allowed VLAN, enter a list of comma separated digits or ranges 1,2,5 or 1-4, or all. The
Allowed VLAN refers to the VLANSs carried by the port in Access mode.

If the Client IP Assighment is set to Network Assigned, specify a value for Native VLAN. A VLAN that
does not have a VLAN ID tag in the frames is referred to as Native VLAN. You can specify a value within
the range of 1-4093.

d. Ifthe Access mode is selected:
If the Client IP Assignment is set to Virtual Controller Assighed, proceed to step 2.

If the Client IP Assignment is set to Network Assigned, specify a value for Access VLAN to indicate the
VLAN carried by the port in the Access mode.

6. Click Next to configure internal or external captive portal authentication, roles and access rules for the guest
users.

In the CLI

To configure wired settings for:

Instant AP
Instant AP
Instant AP
Instant AP) (wired ap profile <name>

( ) (config) # wired-port-profile <name>
( ) (
( ) (
( ) (
(Instant AP) (wired ap profile <name>
( ) (
( ) (
( ) (
( ) (

wired ap profile <name>)# type <guest>

# speed {10 |100 |1000 |auto}
# duplex {half|full|auto}
# no shutdown

# poe
#
#
#

wired ap profile <name>

Instant AP
Instant AP) (wired ap profile <name> uplink-enable
Instant AP) (wired ap profile <name> content-filtering

)
)
)
wired ap profile <name>)
)
)
)

Instant AP) (wired ap profile <name> spanning-tree

To configure VLAN settings for a wired profile:

(Instant AP
(Instant AP
(
(

) (config) # wired-port-profile <name>

)
Instant AP)

)

wired ap profile <name>)# allowed-vlan <vlan>

wired ap profile <name>)# native-vlan {<guest|1..4095>}

(
(wired ap profile <name>)# switchport-mode {trunk|access}
(

Instant AP) (

To configure a new VLAN assignment rule:

(Instant AP) (config)# wired-port-profile <name>
(Instant AP) (wired ap profile <name>)# set-vlan <attribute>{equals| not-equals| starts-with|
ends-with| contains| matches-regular-expression} <operator> <VLAN-ID>| value-of}

In the Internal Captive Portal type, an internal server is used for hosting the captive portal service. You can configure
internal captive portal authentication when adding or editing a guest network created for wireless or wired profile
through the Instant Ul or CLI.
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In the Instant Ul

1. Navigate to the WLAN wizard or Wired window.

e To configure internal captive portal authentication fora WLAN SSID, in the Network tab, click New to create
a new network profile or edit to modify an existing profile.

e To configure internal captive portal authentication for a wired profile, click More>Wired. In the Wired window,
click New under Wired Networks to create a new network, or click Edit to select an existing profile.

2. Click the Security tab and assign values for the configuration parameters:

Table 24: Internal Captive Portal Configuration Parameters

Parameter Description

Splash page type

Select any of the following from the drop-down list.

o Internal - Authenticated—\When Internal Authenticated is enabled, the guest
users are required to authenticate in the captive portal page to access the
Internet. The guest users who are required to authenticate must already be
added to the user database.

o Internal - Acknowledged— When Internal Acknowledged is enabled, the guest
users are required to accept the terms and conditions to access the Internet.

MAC authentication Select Enabled from the drop-down list to enable the MAC authentication.

WISPr Select Enabled if you want to enable WISPr authentication. For more information on
) WISPr authentication, see Configuring WISPr Authentication on page 171.

(Applicable for WLAN SSIDs

only.)

NOTE: The WISPr authentication is applicable only for Internal-Authenticated splash
pages and is not applicable for wired profiles.

Auth server 1

Auth server 2

Select any one of the following:

o Aserver from the list of servers if the server is already configured.

o Internal Server to authenticate user credentials at run time.

o SelectNew for configuring a new external RADIUS or LDAP server for
authentication.

Load balancing

Select Enabled to enable load balancing if two authentication servers are used.

Reauth interval

Select a value to allow the APs to periodically reauthenticate all associated and
authenticated clients.

Blacklisting

(Applicable for WLAN SSIDs
only.)

If you are configuring a wireless network profile, select Enabled to enable
blacklisting of the clients with a specific number of authentication failures.

Accounting mode

(Applicable for WLAN SSIDs
only.)

Select an accounting mode from Accounting mode for posting accounting
information at the specified Accounting interval. When the accounting mode is set to
Authentication, the accounting starts only after client authentication is successful
and stops when the client logs out of the network. If the accounting mode is set to
Association, the accounting starts when the client associates to the network
successfully and stops when the client is disconnected.
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Parameter Description

Disable if uplink type is To exclude uplink, select an uplink type.

Encryption Select Enabled to configure encryption parameters.

(Applicable for WLAN SSIDs

only.)

Splash Page Design Under Splash Page Visuals, use the editor to specify text and colors for the initial

page that will be displayed to the users connecting to the network. The initial page

asks for user credentials or email, depending on the splash page type (Internal -

Authenticated or Internal -Acknowledged) for which you are customizing the splash

page design. Perform the following steps to customize the splash page design.

e To change the color of the splash page, click the Splash page rectangle and
select the required color from the Background Color palette.

e To change the welcome text, click the first square box in the splash page, type
the required text in the Welcome text box, and click OK. Ensure that the welcome
text does not exceed 127 characters.

o To change the policy text, click the second square in the splash page, type the
required textin the Policy text box, and click OK. Ensure that the policy text does
not exceed 255 characters.

e To upload a custom logo, click Upload your own custom logo Image, browse the
image file, and click upload image. Ensure that the image file size does not
exceed 16 KB.

o To redirectusers to another URL, specify a URL in Redirect URL.

o Click Preview to preview the Captive Portal page.

NOTE: You can customize the captive portal page using double-byte characters.

Traditional Chinese, Simplified Chinese, and Korean are a few languages that use

double-byte characters. Click on the banner, term, or policy in the Splash Page

Visuals to modify the text in the red box. These fields accept double-byte characters

or a combination of English and double-byte characters.

3. Click Next to configure access rules.

In the CLI

To configure internal captive portal authentication:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# essid <ESSID-name>

(Instant AP) (SSID Profile <name>)# type <Guest>

(Instant AP) (SSID Profile <name>)# captive-portal <internal-authenticated> exclude-uplink
{3G|4G|Wifi|Ethernet}

(Instant AP) (SSID Profile <name>
(Instant AP) (SSID Profile <name>
(Instant AP) (SSID Profile <name>
(Instant AP) (SSID Profile <name>
(Instant AP)# commit apply

# mac-authentication

# auth-server <serverl>

# radius-reauth-interval <Minutes>
# end

To configure internal captive portal for a wired profile:

(Instant AP) (config)# wired-port-profile <name>

(Instant AP) (wired ap profile <name>)# type <guest>

(Instant AP) (wired ap profile <name>)# captive-portal {<internal-authenticated>| <internal-
acknowledged>} exclude-uplink {3G|4G|Wifi|Ethernet}

(Instant AP) (wired ap profile <name>)# mac-authentication

(Instant AP) ( )
(Instant AP) (wired ap profile <name>)# radius-reauth-interval <Minutes>
(Instant AP) (wired ap profile <name>)# end

(Instant AP)# commit apply

wired ap profile <name>)# auth-server <serverl>

To customize internal captive portal splash page:
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(Instant AP) (config)# wlan captive-portal
(Instant AP) (Captive Portal)# authenticated
(Instant AP) (Captive Portal)# background-color <color-indicator>
(Instant AP) (Captive Portal)# banner-color <color-indicator>
(Instant AP) (Captive Portal)# banner-text <text>
(Instant AP) (Captive Portal)# decoded-texts <text>
(Instant AP) (Captive Portal)# redirect-url <url>
(Instant AP) (Captive Portal)# terms-of-use <text>
(

(Instant AP) (Captive Portal)# use-policy <text>
(Instant AP) (Captive Portal)# end
(Instant AP)# commit apply

To upload a customized logo from a TFTP server to the OAW-IAP:

(Instant AP)# copy config tftp <ip-address> <filename> portal logo

Configuring External Captive Portal for a Guest Network
This section provides the following information:

e External Captive Portal Profiles on page 130
e Creating a Captive Portal Profile on page 130
e Configuring an SSID or Wired Profile to Use External Captive Portal Authentication on page 132

External Captive Portal Profiles

You can now configure external captive portal profiles and associate these profiles to a user role or SSID. You can
create a set of captive portal profiles in the Security>External Captive Portal window and associate these profiles
with an SSID or a wired profile. You can also create a new captive portal profile under the Security tab of the WLAN
wizard or a Wired Network window. In the current release, you can configure up to eight external captive portal
profiles.

When the captive portal profile is associated to an SSID, it is used before user authentication. If the profile is
associated to arole, it is used only after the user authentication. When a captive portal profile is applied to an SSID
or wired profile, the users connecting to the SSID or wired network are assigned a role with the captive portal rule.
The guest user role allows only DNS and DHCP traffic between the client and network, and directs all HTTP or
HTTPS requests to the captive portal unless explicitly permitted.

Creating a Captive Portal Profile
You can create a captive portal profile using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Click Security>External Captive Portal.
2. Click New. The New pop-up window is displayed.

3. Specify values for the following parameters:
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Table 25: Captive Portal Profile Configuration Parameters

Parameter Description

Name Enter a name for the profile.

Type Select any one of the following types of authentication:

o Radius Authentication - Select this option to enable user authentication againsta RADIUS
server.

o Authentication Text - Select this option to specify an authentication text. The specified text
will be returned by the external server after a successful user authentication.

IP or hostname Enter the IP address or the hostname of the external splash page server.

URL Enter the URL for the external captive portal server.

Port Enter the number of the port to use for communicating with the external captive portal server.
Use https Select Enabled to enforce clients to use HTTPS to communicate with the captive portal server.

(Available only if
RADIUS
Authentication is
selected)

Captive Portal failure | This field allows you to configure Internet access for the guest clients when the external
captive portal server is not available. Select Deny Internet to prevent clients from using the
network, or Allow Internet to allow the guest clients to access Internet when the external
captive portal server is not available.

Automatic URL Select Enabled or Disabled to enable or disable automatic whitelisting of URLs. On selecting
Whitelisting the checkbox for the external captive portal authentication, the URLs that are allowed for the
unauthenticated users to access are automatically whitelisted. The automatic URL whitelisting
is disabled by default.

Auth Text If the External Authentication splash page is selected, specify the authentication text that must

. ) be returned by the external server after successful authentication.
(Available only if

Authentication Textis
selected)

Redirect URL Specify a redirect URL if you want to redirect the users to another URL.

In the CLI

To configure an external Captive Portal profile:

(Instant AP)
(Instant AP)
(Instant AP) (External Captive Portal)# port <port>

(config) # wlan external-captive-portal [profile name]
(
(
(Instant AP) (External Captive Portal)# url <url>
(
(
(
(

External Captive Portal)# server <server>

(Instant AP) (External Captive Portal)# https

(Instant AP) (External Captive Portal)# redirect-url <url>
(Instant AP) (External Captive Portal)# server-fail-through
(Instant AP) (External Captive Portal)# no auto-whitelist-disable
(Instant AP) (External Captive Portal)# end

(Instant AP)# commit apply
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Configuring an SSID or Wired Profile to Use External Captive Portal Authentication

You can configure external captive portal authentication for a network profile when adding or editing a guest network
using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Navigate to the WLAN wizard or Wired window.

e To configure external captive portal authentication fora WLAN SSID, in the Network tab, click New to create a
new network profile or edit to modify an existing profile.

e To configure external captive portal authentication for a wired profile, click More>Wired. In the Wired window,
click New under Wired Networks to create a new network, or click Edit to select an existing profile.

2. Inthe Security tab, select External from the Splash page type drop-down list.

From the captive portal profile drop-down list, select a profile. You can select a default profile, or an already
existing profile, or click New and create a new profile.

4. Configure the following parameters based on the type of splash page you selected.

Table 26: External Captive Portal Configuration Parameters

Parameter Description

WISPr Select Enabled if you want to enable WISPr authentication. For more information on WISPr
authentication, see Configuring WISPr Authentication on page 171.

NOTE: The WISPr authentication is applicable only for the External - RADIUS Server and
Internal-Authenticated splash pages and is not applicable for wired profiles.

MAC authentication Select Enabled if you want to enable MAC authentication. For information on MAC
authentication, see Configuring MAC Authentication for a Network Profile on page 166.

Authentication To configure an authentication server, select any of the following options:

server o Ifthe serveris already configured, select the server from the list.

o To create new external RADIUS server, select New. For more information, see Configuring
an External Server for Authentication on page 158.

Specify a value for the reauthentication interval at which the APs periodically reauthenticate all
Reauth interval associated and authenticated clients.

Accounting mode Select an accounting mode from Accounting mode for posting accounting information at the
specified Accounting interval. When the accounting mode is set to Authentication, the
accounting starts only after client authentication is successful and stops when the clientlogs
out of the network. If the accounting mode is set to Association, the accounting starts when the
client associates to the network successfully and stops when the client is disconnected.

Blacklisting If you are configuring a wireless network profile, select Enabled to enable blacklisting of the
clients with a specific number of authentication failures.

Max authentication If you are configuring a wireless network profile and the Blacklisting is enabled, specify a
failures maximum number of authentication failures after which users who fail to authenticate must be
dynamically blacklisted.
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Table 26: External Captive Portal Configuration Parameters

Parameter Description

Click the link to open the Walled Garden window. The walled garden configuration determines
Walled garden access to the websites. For more information, see Configuring Walled Garden Access on page
139.

Disable if uplink type | Select the type of the uplink to exclude.
is

Encryption Select Enabled to configure encryption settings and specify the encryption parameters.

5. Click Next to continue and then click Finish to apply the changes.

In the CLI

To configure security settings for guest users of the WLAN SSID profile:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# essid <ESSID-name>

(Instant AP) (SSID Profile <name>)# type <Guest>

(Instant AP) (SSID Profile <name>)# captive-portal{<type>|[exclude-uplink <types>]| external
[exclude-uplink <types>| profile <name>[exclude-uplink <types>]]}

(Instant AP) (SSID Profile <name>)# blacklist

(Instant AP) (SSID Profile <name>)# mac-authentication

(Instant AP) (SSID Profile <name>)# max—-authentication-failures <number>

(Instant AP) (SSID Profile <name>)# auth-server <server—-name>

(Instant Access Point (SSID Profile <name>)# radius-accounting

(Instant Access Point (SSID Profile <name>)# radius-interim-accounting-interval

(Instant Access Point (SSID Profile <name>)# radius-accounting-mode {user-association|user-
authentication}

(Instant AP) (SSID Profile <name>)# wpa-passphrase <WPA key>

(Instant AP) (SSID Profile <name>)# wep-key <WEP-key> <WEP-index>

(Instant AP) (SSID Profile <name>)# end

(Instant AP)# commit apply

To configure security settings for guest users of the wired profile:

(Instant AP) (config)# wired-port-profile <name>

(Instant AP) (wired ap profile <name>)# type <Guest>

(Instant AP) (wired ap profile <name>)# captive-portal{<type>[exclude-uplink <types>]| external
[exclude-uplink <types>| profile <name>[exclude-uplink <types>]]}

(Instant AP) (wired ap profile <name>)# mac-authentication

(Instant AP) (wired ap profile <name>)# end

(Instant AP)# commit apply

Configuring External Captive Portal Authentication Using ClearPass Guest

You can configure AOS-W Instant to point to ClearPass Guest as an external Captive Portal server. With this
configuration, the user authentication is performed by matching a string in the server response and RADIUS server
(either ClearPass Guest or a different RADIUS server).
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Creating a Web Login page in ClearPass Guest

The ClearPass Guest Visitor Management Appliance provides a simple and personalized user interface through
which operational staff can quickly and securely manage visitor network access. With ClearPass Guest, the users
can have a controlled access to a dedicated visitor management user database. Through a customizable Web portal,
the administrators can easily create an account, reset a password or set an expiry time for visitors. Visitors can be
registered at reception and provisioned with an individual guest account that defines their visitor profile and the
duration of their visit. By defining a Web login page on the ClearPass Guest Visitor Management Appliance, you are
able to provide a customized graphical login page for visitors accessing the network.

For information on setting up the RADIUS Web Login feature, see the RADIUS Services section in the ClearPass
Guest Deployment Guide.

Configuring RADIUS Server in AOS-W Instant Ul

To configure AOS-W Instant to point to ClearPass Guest as an external Captive Portal server, perform the following
steps:

1. Select the WLAN SSID for which you want to enable external captive portal authentication with CPPM. You can
also configure the RADIUS server when configuring a new SSID profile.

2. Inthe Security tab, select External from the Splash page type.

3. Select New from the Captive portal profile drop-down list and update the following fields:

a. Enterthe IP address of the ClearPass Guest server in the IP or hostname field. Obtain the ClearPass Guest
IP address from your system administrator.

b. Enter/page_name.php inthe URL field. This URL must correspond to the Page Name configured in the
ClearPass Guest RADIUS Web Login page. For example, if the Page Name is Alcatel-Lucent, the URL
should be /Alcatel-Lucent.php in the AOS-W Instant Ul.

c. Enterthe Port number (generally should be 80). The ClearPass Guest server uses this port for HTTP
services.

d. Click OK.

4. To create an external RADIUS server, select New from the Authentication server 1 drop-down list. For
information on authentication server configuration parameters, see Configuring an External Server for
Authentication on page 158.

Click Next and then click Finish.
Click the updated SSID in the Network tab.
Open any browser and type any URL. AOS-W Instant redirects the URL to ClearPass Guest login page.

©® N o v

Log in to the network with the user name and password specified used while configuring the RADIUS server.

For captive portal profile, you can create any the following types of roles:
A pre-authenticated role - This role is assigned before the captive portal authentication. The user can only access
certain destinations with this role.
A guest role - This role is assigned after user authentication.

A captive-portal role - This role can be assigned to any network such as empolyee, voice, or guest. When the
user is assigned with this role, a splash page is displayed after opening a browser and the users may need to
authenticate.

You can configure up to 128 access rules for guest user roles through the AOS-W Instant Ul or CLI.
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In the AOS-W Instant Ul
To configure roles and access rules for the guest network:

1. Inthe Access Rules tab, set the slider to any of the following types of access control:
Unrestricted— Select this to set unrestricted access to the network.

Network-based— Set the slider to Network-based to set common rules for all users in a network. The Allow

any to all destinations access rule is enabled by default. This rule allows traffic to all destinations. To define
an access rule:

a. Click New.

b. Select appropriate options in the New Rule window.
c. Click OK.

Role-based— Select Role-based to enable access based on user roles. For role-based access control:
Create a user role if required. For more information, see Configuring User Roles.

Create access rules for a specific user role. For more information, see Configuring Access Rules for
Network Services on page 179. You can also configure an access rule to enforce captive portal
authentication for an SSID with the 802.1X authentication method. For more information, see Configuring
Captive Portal Roles for an SSID on page 136.

Create arole assignment rule. For more information, see Configuring Derivation Rules on page 194. AOS-
W Instant supports role derivation based on the DHCP option for Captive Portal authentication. When the
Captive Portal authentication is successful, a new user role is assigned to the guest users based on
DHCP option configured for the SSID profile, instead of the pre-authenticated role.

2. Click Finish.

In the CLI

To configure access control rules fora WLAN SSID:

(Instant AP) (config)# wlan access-rule <name>
(Instant AP) (Access Rule <name>)# rule <dest> <mask> <match> {<protocol> <start-port> <end-
port> {permit|deny|src-nat|dst-nat{<IP-address> <port>| <port>}}| app <app> {permit| deny} |

appcategory <appgrp>| webcategory <webgrp> {permit| deny}| webreputation <webrep>
[<optionl....option9>]

(Instant AP) (Access Rule <name>)# end
(Instant AP)# commit apply

To configure access control based on the SSID:

(Instant AP) (config)# wlan ssid-profile <name>
(Instant AP) (SSID Profile <name># set-role-by-ssid
(Instant AP) (SSID Profile <name># end

(Instant AP)# commit apply

To configure role assignment rules:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name># set-role <attribute>{{equals|not-equals|starts-with|ends-
with|contains|matches-regular-expression}<operator><role>|value-of}

(Instant AP) (SSID Profile <name># end

(Instant AP)# commit apply

To configure a pre-authentication role:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name># set-role-pre-auth <pre-authentication-role>
(Instant AP) (SSID Profile <name># end

(Instant AP)# commit apply

To configure machine and user authentication roles
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(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name># set-role-machine-auth <machine-authentication-only> <user-
authentication-only>

(Instant AP) (SSID Profile <name># end

(Instant AP)# commit apply

To configure unrestricted access:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name># set-role-unrestricted
(Instant AP) (SSID Profile <name># end

(Instant AP)# commit apply

Example

The following example configures access rules for the wireless network:

(Instant AP) (config)# wlan access-rule WirelessRule

(Instant AP) (Access Rule "WirelessRule")# rule 192.0.2.2 255.255.255.0 match 6 4343 4343 log
classify-media

(Instant AP) (Access Rule "WirelessRule")# rule any any match app deny throttle-downstream 256
throttle-up 256

(Instant AP) (Access Rule "WirelessRule")# rule any any match appcategory collaboration permit
(Instant AP) (Access Rule "WirelessRule")# rule any any match webcategory gambling deny
(Instant AP) (Access Rule "WirelessRule")# rule any any match webcategory training-and-tools
permit

(Instant AP) (Access Rule "WirelessRule")# rule any any match webreputation well-known-sites
permit

(Instant AP) (Access Rule "WirelessRule")# rule any any match webreputation safe-sites permit
(Instant AP) (Access Rule "WirelessRule")# rule any any match webreputation benign-sites permit
(Instant AP) (Access Rule "WirelessRule")# rule any any match webreputation suspicious-sites
deny

(Instant AP) (Access Rule "WirelessRule")# rule any any match webreputation high-risk-sites
deny

(Instant AP) (Access Rule "WirelessRule")# end

(Instant AP)# commit apply

Configuring Captive Portal Roles for an SSID

You can configure an access rule to enforce captive portal authentication for SSIDs with 802.1X authentication
enabled. You can configure rules to provide access to an external captive portal, internal captive portal, so that some
of the clients using this SSID can derive the captive portal role.

The following conditions apply to the 802.1X and captive portal authentication configuration:

If a user role does not have Captive Portal settings configured, the captive portal settings configured for an SSID
are applied to the client's profile.

If the SSID does not have Captive Portal settings configured, the captive portal settings configured for a user role
are applied to the client's profile.

If captive portal settings are configured for both SSID and user role, the captive portal settings configured for a
user role are applied to the client's profile.

You can create a captive portal role for both Internal-acknowledged and External Authentication Text splash
page types.

To enforce the Captive Portal role, use the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To create a captive portal role:

1. Select an SSID profile from the Networks tab. The Edit <WLAN-Profile> window is displayed.
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In the Access tab, slide to Role-based access control by using the scroll bar.
Select arole or create a new one if required.
Click New to add a new rule. The New Rule window is displayed.

a M D

In the New Rule window, specify the following parameters. The following figures show the parameters for
Captive Portal role configuration:

Figure 40 Captive Portal Rule for Internal Acknowledged Splash Page

New Rule

Rule type: Splash page type:
Captive portal El Internal

Splash Page Visuals

Welcome to Guest Network

Upload vour own custom logo image

Click thumbnail above to edit Preview

Redirect URL:

oK Cancel

Figure 41 Captive Portal Rule for External Captive portal profile

Mew Rule

Rule type: Splash page type: Captive portal profile:

|Capti-..-e portal 3 External |z| -- Select Profile -- 3

OK Cancel

Table 27: New Access Rule Configuration Parameters

Field Description

Rule type Select Captive Portal from the drop-down list.
Splash Page Select any of following attributes:
Type Select Internal to configure a rule for internal captive portal authentication.

Select External to configure a rule for external captive portal authentication.

Internal If Internal is selected as splash page type, perform the following steps:

Under Splash Page Visuals, use the editor to specify text and colors for the initial
page that would be displayed to users connecting to the network. The initial
page asks for user credentials or email, depending on the splash page type
configured

To change the color of the splash page, click the Splash page rectangle and
select the required color from the Background Color palette.
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Field Description

To change the welcome text, click the first square box in the splash page, type
the required text in the Welcome text box, and click OK. Ensure that the
welcome text does not exceed 127 characters.

To change the policy text, click the second square in the splash page, type the
required textin the Policy text box, and click OK. Ensure that the policy text does
not exceed 255 characters.

Specify the URL to which you want to redirect the guest users.

To upload a custom logo, click Upload your own custom logo Image, browse the
image file, and click upload image.

Click Preview to preview the Captive Portal page.

External If External is selected, perform the following steps:
Select a profile from the Captive portal profile drop-down list.
If you want to edit the profile, click Edit and update the following parameters:

Type—Select either Radius Authentication ( to enable user
authentication against a RADIUS server) or Authentication Text
(to specify the authentication text to returned by the external
server after a successful user authentication).

IP or hostname— Enter the IP address or the hostname of the
external splash page server.

URL- Enter the URL for the external splash page server.
Port—Enter the number of the port to use for communicating with
the external splash page server

Redirect URL—Specify a redirect URL if you want to redirect the
users to another URL.

Captive Portal failure—This field allows you to configure Internet
access for the guest clients when the external captive portal
server is not available. Select Deny Internet to prevent clients
from using the network, or Allow Internet to allow the guest
clients to access Internet when the external captive portal server
is not available.

Automatic URL Whitelisting— Select Enabled or Disabled to
enable or disable automatic whitelisting of URLs. On selecting
the checkbox for the external captive portal authentication, the
URLs allowed for the unauthenticated users to access are
automatically whitelisted. The automatic URL whitelisting is
disabled by default.

Auth Text—Indicates the authentication text returned by the
external server after a successful user authentication.

6. Click OK. The enforce captive portal rule is created and listed as an access rule.
7. Create arole assignment rule based on the user role, to which the captive portal access rule is assigned.
8. Click Finish.

The client can connect to this SSID after authenticating with username and password. After a successful user login,
the captive portal role is assigned to the client.

In the CLI

To create a captive portal role:

(Instant AP) (config)# wlan access-rule <Name>

(Instant AP) (Access Rule <Name>)# captive-portal {external [profile <name>] |internal}
(Instant AP) (Access Rule <Name>)# end

(Instant AP)# commit apply
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On the Internet, a walled garden typically controls access to Web content and services. The Walled garden access
is required when an external captive portal is used. For example, a hotel environment where the unauthenticated
users are allowed to navigate to a designated login page (for example, a hotel website) and all its contents.

The users who do not sign up for the Internet service can view the “allowed” websites (typically hotel property
websites). The website names must be DNS-based and support the option to define wildcards. This works for client
devices with or without HTTP proxy settings.

When a user attempts to navigate to other websites, which are not in the whitelist of the walled garden profile, the
user is redirected to the login page. In addition, a blacklisted walled garden profile can also be configured to explicitly
block the unauthenticated users from accessing some websites.

You can create a walled garden access in AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

To create a Walled Garden access:

1. Click the Security link at the top right corner of the AOS-W Instant main window and click Walled Garden. The
Walled Garden tab contents are displayed.

2. Toallow users to access a specific domain, click New and enter the domain name or URL in the Whitelist
section of the window. This allows access to a domain while the user remains unauthenticated. Specify a POSIX
regular expression (regex(7)). For example:

yahoo.com matches various domains such as news.yahoo.com, travel.yahoo.com and finance.yahoo.com
www.apple.com/library/test is a subset of www.apple.com site corresponding to path /library/test/*
favicon.ico allows access to /favicon.ico from all domains.

3. Todeny users access to a domain, click New and enter the domain name or URL in the Blacklist section of the
window. This prevents the unauthenticated users from viewing specific websites. When a URL specified in the
blacklist is accessed by an unauthenticated user, OAW-IAP sends an HTTP 403 response to the client with a
simple error message.

If the requested URL does not appear on the blacklist or whitelist list, the request is redirected to the external
captive portal.

4. Select the domain name/URL and click Edit to modify or Delete to remove the entry from the list.
5. Click OKto apply the changes.

In the CLI

To create a Walled Garden access:

(Instant AP) (config)# wlan walled-garden
(Instant AP) (Walled Garden)# white-list <domain>
(Instant AP) (Walled Garden)# black-list <domain>
(Instant AP) (Walled Garden)# end

(Instant AP)# commit apply

Disabling Captive Portal Authentication
To disable captive portal authentication, perform the following steps:

1. Select an existing wireless or wired profile. Depending on the network profile selected, the Edit <WLAN-Profile>
or Edit Wired Network window is displayed.

Youcan also customize splash page design in the Security tab of New WLAN and New Wired Network windows

when configuring a new profile.
HNOTE g g p
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2. Navigate to the Security tab.
3. Select None from the Splash page type drop-down list.
4. Click Next and then click Finish to apply the changes.
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Chapter 11

Authentication and User Management

This chapter provides the following information:

e Managing OAW-IAP Users on page 141

e Understanding Authentication Methods on page 148

e Supported Authentication Servers on page 151

e Understanding Encryption Types on page 155

e Support for Authentication Survivability on page 157

e Configuring Authentication Servers on page 158

e Configuring 802.1X Authentication for a Network Profile on page 165

e Configuring MAC Authentication for a Network Profile on page 166

e Configuring MAC Authentication with 802.1X Authentication on page 168
e Configuring MAC Authentication with Captive Portal Authentication on page 170
e Configuring WISPr Authentication on page 171

e Blacklisting Clients on page 172

e Uploading Certificates on page 174

Managing OAW-IAP Users

The OAW-IAP users can be classified as follows:

e Administrator— An admin user who creates SSIDs, wired profiles, DHCP server configuration parameters, and
manages the local user database. The admin users can access to the Virtual Controller Management User
Interface.

o Guest administrator— A guest interface management user who manages guest users added in the local user
database.

e Administrator with read-only access— The read-only admin user does not have access to the AOS-W Instant CLI.
The AOS-W Instant Ul will be displayed in the read-only mode for these users.

o Employee users — Employees who use the enterprise network for official tasks.
o Guest users—Visiting users who temporarily use the enterprise network to access the Internet.

The user access privileges are determined by OAW-IAP management settings in the OmniVista Management client,
and the type of the user. The following table outlines the access privileges defined for the admin user, guest
management interface admin, and read-only users.

Table 28: User Privileges

OAWS-IAP in monitor mode or without

User Categor OmniVista in Management Mode o e

gory g OmniVista
administrator Access to local user database only Complete access to the OAW-IAP
read-only No write privileges No write privileges

administrator

guest administrator Access to local user database only Access to local user database only
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Configuring Authentication Parameters for Management Users

AOS-W Instant now allows you to configure a TACACS+ Server as the authentication server to support
authentication and accounting privileges for management users. TACACS+ server allows a remote access server to
communicate with an authentication server to determine if the user has access to the network. In AOS-W Instant,
the users can create several TACACS+ server profiles, out of which one or two of the servers can be specified to
authenticate management users.

TACACS+ supports the following types of authentication for management users in AOS-W Instant:
ASCII
PAP
CHAP
ARAP
MSCHAP

HNOTE

The TACACS+ server cannot be attributed to any SSID or wired profile in general as the authentication server and
is configured only for management users.

You can also enable TACAC S+ accounting when the TACACS+ server is used for authentication.

Configuring a TACACS+ Server Profile for Management User Authentication
To configure a TACACS+ authentication server:

In the AOS-W Instant Ul

1. Navigate to Security>Authentication Servers. The Security window is displayed.

2. Tocreate a new server, click New. A window for configuring server details for the new server is displayed. The
following figure shows the parameters to configure for a new authentication server configuration:

Figure 42 New Authentication Server Window

Mew Authentication Server

RADIUS LODAR ® TACACS Cod only

MName: | | ® Enter a nams
IP address: |
Auth port: 43
Shared key: |
Retype key: |

Timeout: |5 SEC.

Retry count: |3

OK | Cancel

To create a TACACS+ server profile, specify the attributes described in the following table:
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Table 29: TACACS+ Server Configuration Parameters

Parameter Description

IP address Enter the IP address of the TACACS+ server.
Auth Port Enter the TCP IP port used by the server. The default port number is 49.
Shared Key Enter the secret key of your choice to authenticate communication between the TACACS+
clientand server.
Retype Key Re-enter the secret key you have specified as the Shared Key.
Timeout Enter a number between 1 and 30 seconds to indicate the timeout period for TACACS+
requests. The default value is 20 seconds.
Retry Count Enter a number between 1 and 5 to indicate the maximum number of authentication attempts.
The default value is 3.
In the CLI
To configure a TACACS+ server:
(Instant AP) (config)# wlan tacacs-server <profile-name>
(Instant AP) (TACACS Server <profile-name>)# ip <IP-address>
(Instant AP) (TACACS Server <profile-name>)# port <port>
(Instant AP) (TACACS Server <profile-name>)# key <key>
(Instant AP) (TACACS Server <profile-name>)# timeout <seconds>
(Instant AP) (TACACS Server <profile-name>)# retry-count <number>
(Instant AP) (TACACS Server <profile-name>)# deadtime <minutes>
(Instant AP) (TACACS Server <profile-name>)# end

Configuring Administrator Credentials for the Virtual Controller Interface

You can configure authentication parameters for admin users to enable access to the Virtual Controller management
user interface in the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
1. Click the System link at top right corner of the AOS-W Instant main window. The System window is displayed.

2. Click the Admin tab. The Admin tab details are displayed. The following figure shows the contents of the Admin

tab:
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Figure 43 Admin Tab: Management Authentication Parameters

System Help

General | Admin

Local Airwave

Shared key:

Authentication: |Authentication Server ﬂ Organization: \

Auth server 1: test | Edit Airwave server: \
Airwave backup server:
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Load balancing: Disabled ﬂ

Retype:
TACACS accounting: []

View Only

Username: test123
Password: sssase
Retype: LITTTYY

Guest Registration Only

Username: GuestAdmin
Password: sssssnes
Retype: sssssnse

3. Under Local, select any of the following options from the Authentication drop-down list:

¢ Internal- Select this option to specify a single set of user credentials. Enter the Username and Password for
accessing the Virtual Controller Management User Interface.

o Authentication Server— Specify one or two authentication servers to authenticate clients. If two servers are
configured, users can use them in primary or backup mode or load balancing mode. To enable load balancing,
select Enabled from the Load balancing drop-down list. For more information on load balancing, see Dynamic
Load Balancing between Two Authentication Servers on page 155.

You may also specify a RADIUS Server as one of the authentication servers along witha TACACS+ server. If a
TACACS+ server is selected, you can select the TACACS accounting checkbox for reporting management
commands.

The TACACS accounting option is available only when a TACACS+ server is specified as one of the

authentication servers.
HOTE

o Authentication server w/ fallback to internal— Select this option to use both internal and external servers.
When enabled, the authentication switches to Internal if there is no response from the RADIUS server (RADIUS
server timeout). To complete this configuration, perform the following step:

a. Toenable load balancing, select Enabled from the Load balancing drop-down list.
b. Specify a Username and Password.
c. Retype the password to confirm.

4. Click OK.

In the CLI

To configure an admin user:

(Instant AP) (config)# mgmt-user <username> [password]
(Instant AP) (config)# end
(Instant AP)# commit apply

To configure RADIUS or TACACS+ authentication parameters:

(Instant AP) (config)# mgmt-auth-server <authentication serverl>
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(Instant AP) (config)# mgmt-auth-server <authentication server2>
(Instant AP) (config)# mgmt-auth-server-load-balancing

(Instant AP) (config)# mgmt-auth-server-local-backup

(Instant AP) (config)# end

(Instant AP)# commit apply

To configure management authentication settings:

(Instant AP) (config)# mgmt-auth-server <serverl>
(Instant AP) (config)# mgmt-auth-server <server2>
(Instant AP) (config)# mgmt-auth-server-load-balancing
(Instant AP) (config)# mgmt-auth-server-local-backup

(

Instant AP) (config)# end
(Instant AP)# commit apply

Configuring Guest Management Interface Administrator Credentials

You can configure guest administrator credentials in the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
1. Click the System link at top right corner of the AOS-W Instant main window. The System window is displayed.
2. Click the Admin tab. The Admin tab details are displayed.
3. Under Guest Registration Only:
a. Specify a Username and Password.
b. Retype the password to confirm.

4. Click OK. When the guest management administrator logs in with these credentials, the guest management
interface is displayed.

In the CLI
To configure guest management administrator credentials:

(Instant AP) (config)# mgmt-user <username> [password] guest-mgmt
(Instant AP) (config)# end
(Instant AP)# commit apply

Configuring Users for Internal Database of an OAW-IAP

The AOS-W Instant user database consists of a list of guest and employee users. The addition of a user involves
specifying a login credentials for a user. The login credentials for these users are provided outside the AOS-W
Instant system.

A guest user can be a visitor who is temporarily using the enterprise network to access the Internet. However, if you
do not want to allow access to the internal network and the Intranet, you can segregate the guest traffic from the
enterprise traffic by creating a guest WLAN and specifying the required authentication, encryption, and access rules.

An employee user is the employee who is using the enterprise network for official tasks. You can create Employee
WLANS, specify the required authentication, encryption and access rules and allow the employees to use the
enterprise network.

The user database is also used when an OAW-IAP is configured as an internal RADIUS server.

The local user database of APs can support up to 512 user entries except OAW-IAP9x. OAW-IAP9x
moTeE Supports only 256 user entries. If there are already 512 users, OAW-IAP9x will not be able to join the
cluster.
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In the AOS-W Instant Ul

To configure users:

1.

Click the Security at the top right corner of AOS-W Instant main window.

2. Click Users for Internal Server. The following figure shows the contents of the Users for Internal Server tab.

F

igure 44 Adding a User

Security

Authentication Servers | Users for Internal Server  Roles  Blacklisting  Firewall Settings | Walled Garden

Users(0) Type Add new user:

Username: |

Password:

Retype:

Type Guest E

oK

Cancel

N o o b~ w

Enter the username in the Username text box.

Enter the password in the Password text box and reconfirm.
Select a type of network from the Type drop-down list.

Click Add and click OK. The users are listed in the Users list.
To edit user settings:

a. Select the user to modify under Users

b. Click Edit to modify user settings.

c. Click OK.

To delete a user:

a. Inthe Users section, select the username to delete

b. Click Delete.

c. Click OK.

To delete all or multiple users at a time:

a. Select the usernames that you want to delete

b. Click Delete All.

c. Click OK.

NOTE

Deleting a user only removes the user record from the user database, and will not disconnect the online user
associated with the username.
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In the CLI

To configure an employee user:

(Instant AP) (config)# user <username> <password> radius
(Instant AP) (config)# end
(Instant AP)# commit apply

To configure a guest user:

(Instant AP) (config)# user <username> <password> portal
(Instant AP) (config)# end

(Instant AP)# commit apply

Configuring the Read-Only Administrator Credentials

You can assign the read-only privilege to an admin user by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
1. Click the System link at top right corner of the AOS-W Instant main window. The System window is displayed.
2. Click the Admin tab. The Admin tab details are displayed.
3. Under View Only:
a. Specify a Username and Password.
b. Retype the password to confirm.
4. Click OK. When the users log in with these credentials, the Instant Ul is displayed in the read-only mode.

In the CLI

To configure a user with read-only privilege:

(Instant AP) (config)# mgmt-user <username> [password] read-only
(Instant AP) (config)# end
(Instant AP)# commit apply

Adding Guest Users through the Guest Management Interface
To add guest users through the Guest Management interface:

1. Loginto AOS-W Instant Ul with the guest management interface administrator credentials. The guest
management interface is displayed.

Figure 45 Guest Management Interface

Alcatel-Lucent () Instant Guest Users E—

El Guest Users (0 created, 512 available)

Name

English
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ML VIRTUAL CONTROLLER  PowerConnect W-Series

El Guest Users (0 created, 512 available)
Name

. Toadd a user, click New. The New Guest User pop-up window is displayed.

. Retype the password to confirm.

2
3. Specify a Username and Password.
4
5. Click OK.

Understanding Authentication Methods

Authentication is a process of identifying a user by through a valid username and password or based on their MAC
addresses. The following authentication methods are supported in AOS-W Instant:

e 802.1X authentication

e MAC authentication

e MAC authentication with 802.1X authentication

e Captive Portal Authentication

e MAC authentication with Captive Portal authentication

e 802.1X authentication with Captive Portal Role

e WISPrauthentication

802.1X authentication

802.1X is an IEEE standard that provides an authentication framework for WLANs. 802.1x uses the Extensible
Authentication Protocol (EAP) to exchange messages during the authentication process. The authentication
protocols that operate inside the 802.1X framework include EAP-Transport Layer Security (EAP-TLS), Protected
EAP (PEAP), and EAP-Tunneled TLS (EAP-TTLS). These protocols allow the network to authenticate the client
while also allowing the client to authenticate the network. For more information on EAP authentication framework
supported by the OAW-IAP, see Supported EAP Authentication Frameworks on page 150.

802.1X authentication method allows an OAW-IAP to authenticate the identity of a user before providing network
access to the user. The Remote Authentication Dial In User Service (RADIUS) protocol provides centralized
authentication, authorization, and accounting management. For authentication purpose, the wireless client can
associate to a network access server (NAS) or RADIUS client such as a wireless OAW-IAP. The wireless client
can pass data traffic only after successful 802.1X authentication.

For more information on configuring an OAW-IAP to use 802.1X authentication, see Configuring 802.1X
Authentication for a Network Profile on page 165.
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MAC authentication

MAC authentication is used for authenticating devices based on their physical MAC addresses. MAC authentication
requires that the MAC address of a machine matches a manually defined list of addresses. This authentication
method is not recommended for scalable networks and the networks that require stringent security settings. For
more information on configuring an OAW-IAP to use MAC authentication, see Configuring MAC Authentication for a
Network Profile on page 166.

MAC authentication with 802.1X authentication
This authentication method has the following features:

MAC authentication precedes 802.1X authentication - The administrators can enable MAC authentication for
802.1X authentication. MAC authentication shares all the authentication server configurations with 802.1X
authentication. If a wireless or wired client connects to the network, MAC authentication is performed first. If
MAC authentication fails, 802.1X authentication does not trigger. If MAC authentication is successful, 802.1X
authentication is attempted. If 802.1X authentication is successful, the client is assigned an 802.1X
authentication role. If 802.1X authentication fails, the client is assigned a deny-all role or mac-auth-only role.

MAC authentication only role - Allows you to create a mac-auth-only role to allow role-based access rules when
MAC authentication is enabled for 802.1X authentication. The mac-auth-only role is assigned to a client when
the MAC authentication is successful and 802.1X authentication fails. If 802.1X authentication is successful, the
mac-auth-only role is overwritten by the final role. The mac-auth-only role is primarily used for wired clients.

L2 authentication fall-through - Allows you to enable the 12-authentication-fallthrough mode. When this option
is enabled, the 802.1X authentication is allowed even if the MAC authentication fails. If this option is disabled,
802.1X authentication is not allowed. The 12-authentication-fallthrough mode is disabled by default.

For more information on configuring an OAW-IAP to use MAC + 802.1X Authentication, see Configuring MAC
Authentication with 802.1X Authentication on page 168.

Captive Portal Authentication

Captive portal authentication is used for authenticating guest users. For more information on Captive Portal
authentication, see Captive Portal for Guest Access on page 121.

MAC authentication with Captive Portal authentication

This authentication method has the following features:
If the captive portal splash page type is Internal-Authenticated or External-RADIUS Server, MAC
authentication reuses the server configurations.
If the captive portal splash page type is Internal-Acknowledged or External-Authentication Text and MAC
authentication is enabled, a server configuration page is displayed.
If the captive portal splash page type is none, MAC authentication is disabled.

You can configure the mac-auth-only role when MAC authentication is enabled with captive portal
authentication.

For more information configuring an OAW-IAP to use MAC and Captive Portal authentication, see Configuring MAC
Authentication with Captive Portal Authentication on page 170.

802.1X authentication with Captive Portal Role

This authentication mechanism allows you to configure different captive portal settings for clients on the same
SSID. For example, you can configure an 802.1x SSID and create a role for captive portal access, so that some of
the clients using the SSID derive the captive portal role. You can configure rules to indicate access to external or
internal captive portal, or none. For more information on configuring captive portal roles for an SSID with 802.1x
authentication, see Configuring Captive Portal Roles foran SSID on page 136.
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WISPr authentication

Wireless Internet Service Provider roaming (WISPr) authentication allows a smart client to authenticate on the
network when they roam between wireless Internet service providers, even if the wireless hotspot uses an Internet
Service Provider (ISP) with whom the client may not have an account.

If a hotspot is configured to use WISPr authentication in a specific ISP and a client attempts to access the Internet
at that hotspot, the WISPr AAA server configured for the ISP authenticates the client directly and allows the client to
access the network. If the client only has an account with a partner ISP, the WISPr AAA server forwards the client’s
credentials to the partner ISP’s WISPr AAA server for authentication. When the client is authenticated on the partner
ISP, it is also authenticated on your hotspot’s own ISP as per their service agreements. The OAW-IAP assigns the
default WISPr user role to the client when your ISP sends an authentication message to the OAW-IAP. For more
information on WISPr authentication, see Configuring WISPr Authentication on page 171.

The following EAP authentication frameworks are supported in the AOS-W Instant network:

EAP-TLS- The Extensible Authentication Protocol-Transport Layer Security (EAP-TLS) method supports the
termination of EAP-TLS security using the internal RADIUS server . The EAP-TLS requires both server and
certification authority (CA) certificates installed on the OAW-IAP. The client certificate is verified on the Virtual
Controller (the client certificate must be signed by a known CA), before the userame is verified on the
authentication server.

EAP-TTLS (MSCHAPv2)— The Extensible Authentication Protocol-Tunneled Transport Layer Security (EAP-
TTLS) method uses server-side certificates to set up authentication between clients and servers. However, the
actual authentication is performed using passwords.

EAP-PEAP (MSCHAPv2)— EAP-PEAP is an 802.1X authentication method that uses server-side public key
certificates to authenticate clients with server. The PEAP authentication creates an encrypted SSL/ TLS tunnel
between the client and the authentication server. Exchange of information is encrypted and stored in the tunnel
ensuring the user credentials are kept secure.

LEAP- Lightweight Extensible Authentication Protocol (LEAP) uses dynamic WEP keys for authentication
between the client and authentication server.

To use the OAW-IAP’s internal database for user authentication, add the names and passwords of the users to be
authenticated.

Alcatel-Lucent does not recommend the use of LEAP authentication, because it does not provide any resistance to

network attacks.
HOTE

Authentication Termination on OAW-IAP

OAW-IAPs support EAP termination for enterprise WLAN SSIDs. The EAP termination can reduce the number of
exchange packets between the OAW-IAP and the authentication servers. AOS-W Instant allows Extensible
Authentication Protocol (EAP) termination for Protected Extensible Authentication Protocol (PEAP)-Generic Token
Card (PEAP-GTC) and Protected Extensible Authentication Protocol-Microsoft Challenge Authentication Protocol
version 2 (PEAP-MSCHAV2). PEAP-GTC termination allows authorization against an Lightweight Directory Access
Protocol (LDAP) server and external RADIUS server while PEAP-MSCHAV2 allows authorization against an
external RADIUS server.

This allows the users to run PEAP-GTC termination with their username and password to a local Microsoft Active
Directory server with LDAP authentication.

EAP-Generic Token Card (GTC)— This EAP method permits the transfer of unencrypted usemames and
passwords from client to server. The main uses for EAP-GTC are one-time token cards such as SecurelD and
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the use of LDAP or RADIUS as the user authentication server. You can also enable caching of user credentials
on the OAW-IAP to an external authentication server for user data backup.

EAP-Microsoft Challenge Authentication Protocol version 2 (MS-CHAPv2)— This EAP method is widely
supported by Microsoft clients. A RADIUS server must be used as the back-end authentication server.

Based on the security requirements, you can configure internal or external authentication servers. This section
describes the types of servers that can be configured for client authentication:

Internal RADIUS Server on page 151
External RADIUS Server on page 151

Dynamic Load Balancing between Two Authentication Servers on page 155

In 6.4.0.2-4.1 release, you can configure TACACS+ server for authenticating management users. For more
information, on management users and TACACS+ server based authentication, see Configuring Authentication
Parameters for Management Users .

Internal RADIUS Server

Each OAW-IAP has an instance of free RADIUS server operating locally. When you enable the internal RADIUS
server option for the network, the client on the OAW-IAP sends a RADIUS packet to the local IP address. The
internal RADIUS server listens and replies to the RADIUS packet. Instant itself serves as a RADIUS server for
802.1X authentication. However, the internal RADIUS server can also be configured as a backup RADIUS server
for an external RADIUS server.

External RADIUS Server

In the external RADIUS server, the IP address of the Virtual Controller is configured as the NAS IP address. AOS-W
Instant RADIUS is implemented on the Virtual Controller, and this eliminates the need to configure multiple NAS
clients for every OAW-IAP on the RADIUS server for client authentication. AOS-W Instant RADIUS dynamically
forwards all the authentication requests from a NAS to a remote RADIUS server. The RADIUS server responds to
the authentication request with an Access-Accept or Access-Reject message, and the clients are allowed or
denied access to the network depending on the response from the RADIUS server. When you enable an external
RADIUS server for the network, the client on the OAW-IAP sends a RADIUS packet to the local IP address. The
external RADIUS server then responds to the RADIUS packet.

AOS-W Instant supports the following external authentication servers:

RADIUS (Remote Authentication Dial-In User Service)
LDAP (Lightweight Directory Access Protocol)
CPPM Server for AirGroup CoA

To use an LDAP server for user authentication, configure the LDAP server on the Virtual Controller, and configure
user IDs and passwords. To use a RADIUS server for user authentication, configure the RADIUS server on the
Virtual Controller.

RADIUS Server Authentication with VSA

An external RADIUS server authenticates network users and returns to the OAW-IAP the vendor-specific attribute
(VSA) that contains the name of the network role for the user. The authenticated user is placed into the management
role specified by the VSA.

AOS-W Instant supports the following VSAs for user role and VLAN derivation rules:
AP-Group
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AP-Name

ARAP-Features
ARAP-Security
ARAP-Security-Data
ARAP-Zone-Access
Acct-Authentic
Acct-Delay-Time
Acct-Input-Gigawords
Acct-Input-Octets
Acct-Input-Packets
Acct-Interim-Interval
Acct-Link-Count
Acct-Multi-Session-Id
Acct-Output-Gigawords
Acct-Output-Octets
Acct-Output-Packets
Acct-Session-Id
Acct-Session-Time
Acct-Status-Type
Acct-Terminate-Cause
Acct-Tunnel-Packets-Lost
Add-Port-To-IP-Address
Aruba-AP-Group
Aruba-AP-IP-Address
Aruba-AS-Credential-Hash
Aruba-AS-User-Name
Aruba-Admin-Role
Aruba-AirGroup-Device-Type
Aruba-AirGroup-Shared-Group
Aruba-AirGroup-Shared-Role
Aruba-AirGroup-Shared-User
Aruba-AirGroup-User-Name
Aruba-AirGroup-Version
Aruba-Auth-Survivability
Aruba-CPPM-Role
Aruba-Device-Type
Aruba-Essid-Name
Aruba-Framed-IPv6-Address
Aruba-Location-ld
Aruba-Mdps-Device-Iccid
Aruba-Mdps-Device-Imei
Aruba-Mdps-Device-Name
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Aruba-Mdps-Device-Product
Aruba-Mdps-Device-Profile
Aruba-Mdps-Device-Serial
Aruba-Mdps-Device-Udid
Aruba-Mdps-Device-Version
Aruba-Mdps-Max-Devices
Aruba-Mdps-Provisioning-Settings
Aruba-Named-User-Vlan
Aruba-Network-SSO-Token
Aruba-No-DHCP-Fingerprint
Aruba-Port-l1d
Aruba-Priv-Admin-User
Aruba-Template-User
Aruba-User-Group
Aruba-User-Role
Aruba-User-Vlan
Aruba-WorkSpace-App-Name
Authentication-Sub-Type
Authentication-Type
CHAP-Challenge
Callback-Id
Callback-Number
Chargeable-User-Identity
Class

Connect-Info

Connect-Rate
Crypt-Password
DB-Entry-State
Digest-Response
Domain-Name
EAP-Message

Error-Cause
Event-Timestamp
Exec-Program
Exec-Program-Wait
Expiration

Fall-Through

Filter-1d
Framed-AppleTalk-Link
Framed-AppleTalk-Network
Framed-AppleTalk-Zone
Framed-Compression
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Framed-IP-Address
Framed-IP-Netmask
Framed-IPX-Network
Framed-IPv6-Pool
Framed-IPv6-Prefix
Framed-IPv6-Route
Framed-Interface-ld
Framed-MTU
Framed-Protocol
Framed-Route
Framed-Routing
Full-Name

Group

Group-Name

Hint
Huntgroup-Name
Idle-Timeout
Location-Capable
Location-Data
Location-Information
Login-IP-Host
Login-IPv6-Host
Login-LAT-Node
Login-LAT-Port
Login-LAT-Service
Login-Service
Login-TCP-Port
Menu
Message-Auth
NAS-IPv6-Address
NAS-Port-Type
Operator-Name
Password
Password-Retry
Port-Limit

Prefix

Prompt
Rad-Authenticator
Rad-Code

Rad-Id

Rad-Length
Reply-Message
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Requested-Location-Info
Revoke-Text
Server-Group
Server-Name
Service-Type
Session-Timeout
Simultaneous-Use
State

Strip-User-Name

Suffix
Termination-Action
Termination-Menu
Tunnel-Assignment-Id
Tunnel-Client-Auth-Id
Tunnel-Client-Endpoint
Tunnel-Connection-Id
Tunnel-Medium-Type
Tunnel-Preference
Tunnel-Private-Group-Id
Tunnel-Server-Auth-ld
Tunnel-Server-Endpoint
Tunnel-Type
User-Category
User-Name

User-Vlan
Vendor-Specific

Dynamic Load Balancing between Two Authentication Servers

You can configure two authentication servers to serve as a primary and backup RADIUS server and enable load
balancing between these servers. Load balancing of authentication servers ensures that the authentication load is
split across multiple authentication servers and enables the OAW-IAPs to perform load balancing of authentication
requests destined to authentication servers such as RADIUS or LDAP.

The load balancing in OAW-IAP is performed based on outstanding authentication sessions. If there are no
outstanding sessions and if the rate of authentication is low, only primary server will be used. The secondary is used
only if there are outstanding authentication sessions on the primary server. With this, the load balance can be
performed across asymmetric capacity RADIUS servers without the need to obtain inputs about the server
capabilities from the administrators.

Encryption is the process of converting data into a cryptic format or code when it is transmitted on a network.
Encryption prevents unauthorized use of the data.

AOS-W Instant supports the following types of encryption:
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WEP —Wired Equivalent Privacy (WEP) is an authentication method where all users share the same key. WEP
is not secure as other encryption types such as TKIP.

TKIP —Temporal Key Integrity Protocol (TKIP) uses the same encryption algorithm as WEP. However, TKIP is
more secure and has an additional message integrity check (MIC).

AES — The Advanced Encryption Standard (AES) encryption algorithm a widely supported encryption type for all
wireless networks that contain any confidential data. AES in Wi-Fi leverages 802.1X or PSKs to generate per
station keys for all devices. AES provides a high level of security like IP Security (IPsec) clients.

WEP and TKIP are limited to WLAN connection speed of 54 Mbps. The 802.11n connection supports only AES
encryption. Alcatel-Lucent recommends AES encryption. Ensure that all devices that do not support AES are
NOTE  upgraded or replaced with the devices that support AES encryption.

WPA and WPA2

WPA is created based on a draft of 802.11i, which allowed users to create more secure WLANs. WPA2
encompasses the full implementation of the 802.11i standard. WPAZ2 is a superset that encompasses the full WPA
feature set.

The following table summarizes the differences between the two certifications:

Table 30: WPA and WPAZ2 Features

Certification Authentication Encryption

WPA PSK TKIP with message integrity check (MIC)
IEEE 802.1X with
Extensible
Authentication

Protocol (EAP)

WPA2 PSK AES -- Counter Mode with Cipher Block Chaining
IEEE 802.1X with Message Authentication Code (AESCCMP)
EAP

WPA and WPAZ2 can be further classified as follows:

Personal — Personal is also called Pre-Shared Key (PSK). In this type, a unique key is shared with each client in
the network. Users have to use this key to securely log in to the network. The key remains the same until it is
changed by authorized personnel. You can also configure key change intervals .

Enterprise — Enterprise is more secure than WPA Personal. In this type, every client automatically receives a
unigue encryption key after securely logging on to the network. This key is automatically updated at regular
intervals. WPA uses TKIP and WPAZ2 uses the AES algorithm.

Recommended Authentication and Encryption Combinations

The following table summarizes the recommendations for authentication and encryption combinations for the Wi-Fi
networks.
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Table 31: Recommended Authentication and Encryption Combinations

Network Type Authentication Encryption

Employee 802.1X AES

Guest Network Captive Portal None

Voice Network or Handheld | 802.1X or PSK as AES if possible, TKIP or WEP if

devices supported by the device necessary (combine with security
settings assigned for a user role).

Support for Authentication Survivability

The authentication survivability feature supports a survivable authentication framework against the remote link
failure when working with the external authentication servers. When enabled, this feature allows the OAW-IAPs to
authenticate the previously connected clients against the cached credentials if the connection to the authentication
server is temporarily lost.

AOS-W Instant supports the following EAP standards for authentication survivability:

EAP-PEAP: The Protected Extensible Authentication Protocol also known as Protected EAP or PEAP is a
protocol that encapsulates EAP within a potentially encrypted and authenticated Transport Layer Security (TLS)
tunnel. The EAP-PEAP supports the MSCHAPv2 and GTC methods.

EAP-TLS: EAP-Transport Layer Security (EAP-TLS) is an IETF open standard that uses the Transport Layer
Security (TLS) protocol.
When the authentication survivability feature is enabled, the following authentication process is used:

1. The client associates to an OAW-IAP and authenticates to the external authentication server. The external
authentication server can be either CPPM (for EAP-PEAP) or RADIUS server (EAP-TLS).

2. Upon successful authentication, the associated OAW-IAP caches the authentication credentials of the
connected users for the configured duration. The cache expiry duration for authentication survivability can be set
within the range of 1-99 hours, with 24 hours being the default cache timeout duration.

3. If the client roams or tries to reconnect to the OAW-IAP and the remote link fails due to the unavailability of the
authentication server, the OAW-IAP uses the cached credentials in the internal authentication server to
authenticate the user. However, if the user tries to reconnect after the cache expiry, the authentication fails.

4. When the authentication server is available and if the client tries to reconnect, the OAW-IAP detects the
availability of server and allows the client to authenticate to the server. Upon successful authentication, the
OAW-IAP cache details are refreshed.

Configuring Authentication Survivability

You can enable authentication survivability for a wireless network profile through the Ul or CLI.

In the AOS-W Instant Ul
To configure authentication survivability for a wireless network:

1. Inthe Network tab, click New to create a new network profile or select an existing profile for which you want to
enable authentication survivability and click edit.

2. Inthe Edit <profile-name> or New WLAN window, ensure that all required WLAN and VLAN attributes are
defined, and then click Next.
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6.

In the Security tab, under Enterprise security settings, select an existing authentication server or create a new
server by clicking New.

To enable authentication survivability, select Enabled from the Authentication survivability drop-down. On
enabling this, the OAW-IAP authenticates the previously connected clients using EAP-PEAP and EAP-TLS
authentication when connection to the external authentication server is temporarily lost.

Specify the cache timeout duration, after which the cached details of the previously authenticated clients expire.
You can specify a value within the range of 1-99 hours and the default cache timeout duration is 24 hours.

Click Next and then click Finish to apply the changes.

Important Points to Remember

Any client connected through CPPM and authenticated through OAW-IAP remains authenticated with the OAW-
IAP even if the client is removed from the CPPM server during the CPPM downtime.

Do not make any changes to the authentication survivability cache timeout duration when the authentication
server is down.

For EAP-PEAP authentication, ensure that the CPPM 6.0.2 or later version is used for authentication. For EAP-
TLS authentication, any external or third-party server can be used.

For EAP-TLS authentication, ensure that the server and CA certificates from the authentication servers are
uploaded on OAW-IAP. For more information, see Uploading Certificates on page 174.

In the CLI

To configure authentication survivability for a wireless network:

NOTE

158 | Authentication and User Management

P
P

Instant config)# wlan ssid-profile <name>

(
(Instant SSID Profile <name>)# type {<Employee> | <Voice>| <Guest>}
(

(

AP) (
AP) (
Instant AP) (SSID Profile <name>)# auth-server <server-namel>
Instant AP) (SSID Profile <name>)# auth-survivability
(Instant AP) (SSID Profile <name>)# exit
(Instant AP) (config)# auth-survivability cache-time-out <hours>

(Instant AP) (config)# end
(Instant AP)# commit apply

To view the cache expiry duration:

(Instant AP)# show auth-survivability time-out

To view the information cached by the OAW-IAP:

(Instant AP)# show auth-survivability cached-info

To view logs for debugging:

(Instant AP)# show auth-survivability debug-log

Configuring Authentication Servers
This section describes the following procedures:

Configuring an External Server for Authentication on page 158

Configuring Dynamic RADIUS Proxy Parameters on page 163

Configuring an External Server for Authentication

You can add an external RADIUS server, LDAP server, CPPM server for AirGroup or CoA through the AOS-W
Instant Ul or CLI.

In6.4.0.2-4.1 release, you can configure TACACS+ server for authenticating management users. For more
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information, on management users and TACACS+ server based authentication, see Configuring Authentication
Parameters for Management Users ..

In the AOS-W Instant Ul
To configure an authentication server:

1. Navigate to Security>Authentication Servers. The Security window is displayed.

2. Tocreate anew server, click New. A window for specifying details for the new server is displayed. The following
figure shows the parameters to configure for a new RADIUS authentication server configuration:

Figure 46 New Authentication Server Window

Mew Authentication Server

* RADIUS LDAP TACACS CoA only
Name:

IF address:

Auth port: 1812

Accounting port:  |1813

Shared key:

Retype key:

Timeout: 5 Sec.

Retry count: 3

RFC 3576: | Disabled v
NAS IP address: | .
MAS identifier:

Dead time: 5 min.
DRP IP;

DRP Mask:

DRP VLAN:

DRP Gateway!

0K | Cancel

3. Configure any of the following types of server:
o RADIUS Server — To configure a RADIUS server, specify the attributes described in the following table:

Table 32: RADIUS Server Configuration Parameters

Parameter Description

Name Enter the name of the new external RADIUS server.
IP address Enter the IP address of the external RADIUS server.
Auth port Enter the authorization port number of the external RADIUS server. The default port

numberis 1812.

Accounting port Enter the accounting port number. This portis used for sending accounting records
to the RADIUS server. The default port numberis 1813.
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Parameter Description

Shared key Enter a shared key for communicating with the external RADIUS server.
Retype key Re-enter the shared key.
Timeout Specify a timeout value in seconds. The value determines the timeout for one

RADIUS request. The OAW-IAP retries to send the request several times (as
configured in the Retry count), before the user gets disconnected. For example, if
the Timeout is 5 seconds, Retry counter is 3, user is disconnected after 20
seconds. The default value is 5 seconds.

Retry count Specify a number between 1 and 5. Indicates the maximum number of
authentication requests that are sent to the server group, and the default value is 3
requests.

RFC 3576 Select Enabled to allow the APs to process RFC 3576-compliant Change of

Authorization (CoA) and disconnect messages from the RADIUS server.
Disconnect messages cause a user session to be terminated immediately,
whereas the CoA messages modify session authorization attributes such as data
filters.

NAS IP address Enter the Virtual Controller IP address. The NAS IP address is the Virtual Controller
IP address that is sentin data packets.

NOTE: If you do not enter the IP address, the Virtual Controller IP address is used
by default when Dynamic RADIUS Proxy is enabled.

NAS identifier Use this to configure strings for RADIUS attribute 32, NAS Identifier, to be sent with
RADIUS requests to the RADIUS server.

Dead Time Specify a dead time for authentication server in minutes.

When two or more authentication servers are configured on the OAW-IAP and a
server is unavailable, the dead time configuration determines the duration for
which the authentication server would be available if the server is marked as
unavailable.

Dynamic RADIUS Specify the following dynamic RADIUS proxy parameters:

proxy parameters DRP IP- IP address to be used as source IP for RADIUS packets

DRP Mask—Subnet mask of the DRP IP address.

DRP VLAN-VLAN in which the RADIUS packets are sent.

DRP Gateway—Gateway IP address of the DRP VLAN.

For more information on dynamic RADIUS proxy parameters and configuration
procedure, see Configuring Dynamic RADIUS Proxy Parameters on page 163.

o LDAP Server —To configure an LDAP server, select the LDAP option and specify the attributes described in the
following table:
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Table 33: LDAP Server Configuration Parameters

Parameter Description

Name Enter the name of the LDAP server.

IP address Enter the IP address of the LDAP server.

Auth port Enter the authorization port number of the LDAP server. The default port number is
389.

Admin-DN Enter a distinguished name for the admin user with read/search privileges across

all the entries in the LDAP database (the user need not have write privileges, but
the user must be able to search the database, and read attributes of other users in
the database).

Admin password Enter a password for administrator.
Base-DN Enter a distinguished name for the node that contains the entire user database.
Filter Specify the filter to apply when searching for a user in the LDAP database. The

default filter string is (objectclass=*).

Key Attribute Specify the attribute to use as a key while searching for the LDAP server. For Active
Directory, the value is sAMAccountName

Timeout Enter a value between 1 and 30 seconds. The default value is 5.
Retry count Enter a value between 1 and 5. The default value is 3.
Dead Time Specify a dead time for authentication server in minutes within the range of 1-1440

minutes. The default dead time interval is 5 minutes.

When two or more authentication servers are configured on the OAW-IAP and a
server is unavailable, the dead time configuration determines the duration for
which the authentication server would be available if the server is marked as
unavailable.

o CPPM Server for AirGroup CoA — To configure a CPPM server used for AirGroup CoA (Change of
Authorization), select the CoA only checkbox. The RADIUS server is automatically selected.

Table 34: CPPM Server Configuration Parameters for AirGroup CoA

Parameter Description

Name Enter the name of the server.

IP address Enter the IP address of the server.

Air Group CoA port | Enter a port number for sending AirGroup CoA on a different port than on the
standard CoA port. The default value is 5999.

Shared key Enter a shared key for communicating with the external RADIUS server.
Retype key Re-enter the shared key.
4. Click OK.
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L)

NOTE

The CPPM server acts as a RADIUS server and asynchronously provides the AirGroup parameters for
the client device including shared user, role, and location.

To assign the RADIUS authentication server to a network profile, select the newly added server when configuring
security settings for a wireless or wired network profile.

You can also add an external RADIUS server by selecting the New option when configuring a WLAN or
wired profile. For more information, see Configuring Security Settings fora WLAN SSID Profile on page

NOTE

100 and Configuring Security Settings for a Wired Profile on page 116.

In the CLI

To configure a RADIUS server:

(Instant AP)
(Instant AP)
(Instant AP)
(Instant AP) (Auth Server
(Instant AP) (Auth Server

(
(Auth Server
(
(
(
(Instant AP) (Auth Server
(
(
(
(
(

Auth Server

(Instant AP) (Auth Server
(Instant AP)
(Instant AP)
(Instant AP)
(Instant AP) (Auth Server
(Instant AP) (Auth Server
<gateway-IP-address)

(Instant AP) (Auth Server

Auth Server
Auth Server
Auth Server

<profile-name>) #
<profile-name>
<profile-name>
<profile-name>
<profile-name>
<profile-name>

) #

) #
) #
) #
) #
<profile-name>) #
<profile-name>) #
<profile-name>) #
<profile-name>) #
<profile-name>) #

<profile-name>) #

(Instant AP)# commit apply

(Instant AP)# commit apply

To configure an LDAP server:

(Instant AP) (
(Instant AP) (LDAP Server
(Instant AP) (LDAP Server
(Instant AP) (LDAP Server
(Instant AP) (LDAP Server
(Instant AP) (LDAP Server
(Instant AP) (LDAP Server
(Instant AP) (LDAP Server
(Instant AP) (LDAP Server
(Instant AP) (LDAP Server
(

(Instant AP) (LDAP Server
(Instant AP) (LDAP Server

<profile-name>) #
<profile-name>) #
<profile-name>) #
<profile-name>) #
<profile-name>) #
<profile-name>) #
<profile-name>) #
<profile-name>) #
<profile-name>) #
<profile-name>) #

) #

<profile-name>

(Instant AP)# commit apply

To configure a CPPM server used for AirGroup CoA (Change of Authorization):

(Instant AP) (

(Instant AP) (Auth Server
(Instant AP) (Auth Server
(Instant AP) (Auth Server
(Instant AP) (Auth Server

(Instant AP) (Auth Server

<profile-name>) #
<profile-name>) #
<profile-name> #
<profile-name>) #
<profile-name>) #

(Instant AP)# commit apply

config)# wlan auth-server <profile-name>

ip <IP-address>
key <key>

port <port>
acctport <port>
nas-id <NAS-ID>

nas-ip <NAS-IP-address>

timeout <seconds>

retry-count <number>

rfc3576
deadtime <minutes>

drp-ip <IP-address> <mask> vlan <vlan> gateway

end

config)# wlan ldap-server <profile-name>

ip <IP-address>
port <port>
admin-dn <name>

admin-password <password>

base-dn <name>
filter <filter>

key-attribute <key>

timeout <seconds>

retry-count <number>

deadtime <minutes>
end

config)# wlan auth-server <profile-name>

ip <IP-address>
key <key>

cppm-rfc3576-port <port>

cppm-rfc3576-only
end
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Configuring Dynamic RADIUS Proxy Parameters

The RADIUS server can be deployed at different locations and VLANSs. In most cases, a centralized RADIUS or
local server is used to authenticate users. However, some user networks can use a local RADIUS server for
employee authentication and a centralized RADIUS based captive portal server for guest authentication. To ensure
that the RADIUS traffic is routed to the required RADIUS server, the dynamic RADIUS proxy feature must be
enabled.

If the OAW-IAP clients need to authenticate to the RADIUS servers through a different IP address and VLAN,
ensure that the following steps are completed:

1. Enable dynamic RADIUS proxy.
2. Configure dynamic RADIUS proxy IP, VLAN. netmask, gateway for each authentication server.

3. Associate the authentication servers to SSID or a wired profile to which the clients connect.

After completing the above-mentioned configuration steps, you can authenticate the SSID users against the
configured dynamic RADIUS proxy parameters.

Enabling Dynamic RADIUS Proxy

You can enable RADIUS Server Support using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To enable RADIUS server support:

1. Inthe AOS-W Instant main window, click the System link. The System window is displayed.
2. Inthe General tab of System window, select Enabled from the Dynamic RADIUS Proxy drop-down list.
3. Click OK.

When dynamic RADIUS proxy is enabled, ensure that a static Virtual Controller IP is configured. For more
information on configuring Virtual Controller IP address, see Configuring Virtual Controller [P Address on page 76.

HNOTE

When dynamic RADIUS proxy is enabled, the Virtual Controller network uses the IP Address of the Virtual
Controller for communication with external RADIUS servers. Ensure that the Virtual Controller IP Address is set as
a NAS IP when configuring RADIUS server attributes with dynamic RADIUS proxy enabled. For more information
on configuring RADIUS server attributes, see Configuring an External Server for Authentication on page 158.

In the CLI
To enable the dynamic RADIUS proxy feature:

(Instant AP) (config)# dynamic-radius-proxy
(Instant AP) (config)# end
(Instant AP)# commit apply

Configuring Dynamic RADIUS Proxy Parameters for Authentication Servers

You can configure DRP parameters for the authentication server by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Click the Security>Authentication Servers.

2. Tocreate a new server, click New and configure the required RADIUS server parameters as described in Table
32.

3. Ensure that the following dynamic RADIUS proxy parameters are configured:
o DRP IP-IP address to be used as source IP for RADIUS packets
o DRP Mask—Subnet mask of the DRP IP address.
e DRP VLAN-VLAN inwhich the RADIUS packets are sent.
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DRP Gateway—Gateway IP address of the DRP VLAN.
4. Click OK.

In the CLI

To configure dynamic RADIUS proxy parameters:

(Instant AP
(Instant AP
(Instant AP
(Instant AP

) (config)# wlan auth-server <profile-name>

)

)

)
(Instant AP)

)

)

)

)

)

(
(Auth Server <profile-name>)# ip <IP-address>
(Auth Server <profile-name>)# key <key>
(Auth Server <profile-name>)# port <port>
(Auth Server <profile-name>)# acctport <port>
(Auth Server <profile-name>)# nas-id <NAS-ID>
(Auth Server <profile-name>)# nas-ip <NAS-IP-address>
( )
( )
( )

)

#
#
(Instant AP #
#
Auth Server <profile-name>)# timeout <seconds>
#
#
#

(Instant AP
(Instant AP
(Instant AP) (Auth Server <profile-name> retry-count <number>
(Instant AP) (Auth Server <profile-name>
(Instant AP) (Auth Server <profile-name>
<gateway-IP-address>

(Instant AP) (Auth Server <profile-name>)# end
(Instant AP)# commit apply

deadtime <minutes>
drp-ip <IP-address> <mask> vlan <vlan> gateway

Associate the Authentication Servers with an SSID or Wired Profile

1. Access the WLAN wizard or Wired Settings window.
To open the WLAN wizard, select an existing SSID in the Network tab, and click edit.
To open the wired settings window, click More > Wired. In the Wired window, select a profile and click Edit.
You can also associate the authentication servers when creating a new WLAN or wired profile.
2. Click the Security tab.

If you are configuring the authentication server fora WLAN SSID, under Security tab, slide to Enterprise
security level.

Ensure that an authentication type is enabled.

5. From the Authentication Server 1 drop-down list, select the server name on which dynamic RADIUS proxy
parameters are enabled. You can also create a new server with RADIUS and RADIUS proxy parameters by
selecting New.

Click Next and then click Finish.

7. Toassign the RADIUS authentication server to a network profile, select the newly added server when configuring
security settings for a wireless or wired network profile.

You can also add an external RADIUS server by selecting New for Authentication Server when
configuring a WLAN or wired profile. For more information, see Configuring Security Settings fora WLAN
HeTE  SSID Profile on page 100 and Configuring Security Settings for a Wired Profile on page 116.

In the CLI

To associate an authentication server to a WLAN SSID:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name># auth-server <server-name>
(Instant AP) (SSID Profile <name># end

((Instant AP)# commit apply

To associate an authentication server to a wired profile:

(Instant AP) (config)# wired-port-profile <name>

(Instant AP) (wired ap profile <name>)# auth-server <name>
(Instant AP) (wired ap profile <name>)# end

(Instant AP)# commit apply
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The AOS-W Instant network supports internal RADIUS server and external RADIUS server for 802.1X
authentication.

The steps involved in 802.1X authentication are as follows:

1.

The NAS requests authentication credentials from a wireless client.

2. The wireless client sends authentication credentials to the NAS.
3.
4. The RADIUS server checks the user identity and authenticates the client if the user details are available in its

The NAS sends these credentials to a RADIUS server.

database. The RADIUS server sends an Access-Accept message to the NAS. If the RADIUS server cannot
identify the user, it stops the authentication process and sends an Access-Reject message to the NAS. The
NAS forwards this message to the client and the client must re-authenticate with appropriate credentials.

After the client is authenticated, the RADIUS server forwards the encryption key to the NAS. The encryption key
is used for encrypting or decrypting traffic sent to and from the client.

The NAS acts as a gateway to guard access to a protected resource. A client connecting to the wireless network first
connects to the NAS.

HNOTE

Configuring 802.1X Authentication for a Wireless Network Profile

You can configure 802.1X authentication for a wireless network profile in the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

To enable 802.1X authentication for a wireless network:

1.

In the Network tab, click New to create a new network profile or select an existing profile for which you want to
enable 802.1X authentication and click edit.

In the Edit <profile-name> or New WLAN window, ensure that all required WLAN and VLAN attributes are
defined, and then click Next.

In the Security tab, specify the following parameters for the Enterprise security level:
a. Select any of the following options from the Key management drop-down list.
WPA-2 Enterprise
WPA Enterprise
Both (WPA-2 & WPA)
Dynamic WEP with 802.1X

If you do not want to use a session key from the RADIUS Server to derive pair wise unicast keys, set Session
Key for LEAP to Enabled.

To terminate the EAP portion of 802.1X authentication on the OAW-IAP instead of the RADIUS server, set
Termination to Enabled.

By default, for 802.1X authorization, the client conducts an EAP exchange with the RADIUS server, and the AP
acts as a relay for this exchange. When Termination is enabled, the OAW-IAP by itself acts as an authentication
server and terminates the outer layers of the EAP protocol, only relaying the innermost layer to the external
RADIUS server.

Specify the type of authentication server to use and configure other required parameters. You can also configure
two different authentication servers to function as primary and backup servers when termination is enabled. For
more information on RADIUS authentication configuration parameters, see Configuring an External Server for
Authentication on page 158.

Click Next to define access rules, and then click Finish to apply the changes.
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In the CLI
To configure 802.1X authentication for a wireless network:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# type {<Employee>|<Voice>}

(Instant AP) (SSID Profile <name>)# opmode {wpa2-aes|wpa-tkip|wpa-tkip,wpa2-aes|dynamic-wep}
(Instant AP) (SSID Profile <name> leap-use-session-key

(Instant AP) (SSID Profile <name> termination

SSID Profile <name> auth-server <server2>
SSID Profile <name>
SSID Profile <name> auth-survivability

(Instant AP) (SSID Profile <name>)# exit

(Instant AP) (config)# auth-survivability cache-time-out <hours>
(Instant AP) (config)# end

(Instant AP)# commit apply

(Instant AP
(Instant AP
(Instant AP

)
)
)
)
)
(Instant AP)
)
) radius-reauth-interval <minutes>
)
)

(

(

( )
( ) #
( ) #
(SSID Profile <name>)# auth-server <serverl>
( ) #
( ) #
( ) #
(

(

Configuring 802.1X Authentication for Wired Profiles
You can configure 802.1X authentication for a wired profile in the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To enable 802.1X authentication for a wired profile:

1. Click the Wired link under More at the top right corner of the main window. The Wired window is displayed.

2. Click New under Wired Networks to create a new network or select an existing profile for which you want to
enable 802.1X authentication and then click Edit.

3. Inthe New Wired Network or the Edit Wired Network window, ensure that all the required Wired and VLAN
attributes are defined, and then click Next.

In the Security tab, select Enabled from the 802.1X authentication drop-down list.

5. Specify the type of authentication server to use and configure other required parameters. For more information on
configuration parameters, see Configuring Security Settings for a Wired Profile on page 116.

6. Click Next to define access rules, and then click Finish to apply the changes.

7. Assign the profile to an Ethernet port. For more information, see Assigning a Profile to Ethernet Ports on page
118.

In the CLI

To enable 802.1X authentication for a wired profile:

(Instant AP) (config)# wired-port-profile <name>
(Instant AP) (wired ap profile <name>)# type {<employee> |[<guest>}
(Instant AP) (wired ap profile <name>)# dotlx

(Instant AP) auth-server <serverl>

(

(

(

(wired ap profile <name>
(Instant AP) (wired ap profile <name>

(

(

(

auth-server <server2>
(Instant AP)
(Instant AP) (wired ap profile <name>
(Instant AP) (wired ap profile <name>
(Instant AP)# commit apply

radius-reauth-interval <Minutes>

#
#
# server-load-balancing
#
# end

)
)
)
wired ap profile <name>)
)
)

Configuring MAC Authentication for a Network Profile

MAC authentication can be used alone or it can be combined with other forms of authentication such as WEP
authentication. However, it is recommended that you do not use the MAC-based authentication.

This section describes the following procedures:

e Configuring MAC Authentication for Wireless Network Profiles on page 167
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Configuring MAC Authentication for Wired Profiles on page 168

Configuring MAC Authentication for Wireless Network Profiles

You can configure MAC authentication for a wired profile in the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

To enable MAC Authentication for a wireless network:

1. Inthe Network tab, click New to create a new network profile or select an existing profile for which you want to
enable MAC authentication and click edit.

2. Inthe Edit <profile-name> or New WLAN window, ensure that all required WLAN and VLAN attributes are
defined, and then click Next.

3. Inthe Security tab, select Enabled from the MAC authentication drop-down list, for Personal or Open
security level.

Specify the type of authentication server to use.

5. If the internal authentication server is used, perform the following steps to allow MAC address based
authentication:

Click the Users link against the Internal server field. The Users window is displayed.
Specify the client MAC address as the user name and password.

Specify the type of the user (employee or guest).

Click Add.

Repeat the steps to add more users.

Click OK.

6. Toallow the OAW-IAP to use a delimiter in the MAC authentication request, specify a character ( for example,
colon or dash) as a delimiter for the MAC address string. For example, if you specify the colon as a delimiter,
MAC addresses in the xx:xx:xx:xx:xx:xx format are used. If the delimiter is not specified, the MAC address in
the xxxxxxxxxxxx format is used.

-~ 0o o0 T o

7. Toallow the OAW-IAP to use uppercase letters in the MAC address string, set Uppercase support to Enabled.
Configure other parameters as required.
9. Click Next to define access rules, and then click Finish to apply the changes.

In the CLI

To configure MAC-address based authentication with external server:

Instant AP) (config)# wlan ssid-profile <name>
Instant AP) (SSID Profile <name>)# type {<Employee> | <Voice>| <Guest>}
Instant AP) (SSID Profile <name>)# mac-authentication

(

(

(

(SSID Profile <name>
(SSID Profile <name>
(SSID Profile <name>
(
(
(
(

)

Instant AP )
)

)

SSID Profile <name>)
)

)

)

)

)

)

)

) mac-authentication-delimiter <delim>
Instant AP) mac-authentication-upper-case
Instant AP)

)

)

)

Instant AP

external-server
auth-server <server-namel>

Instant AP) (SSID Profile <name>
Instant AP) (SSID Profile <name> server-load-balancing
Instant AP) (SSID Profile <name> radius-reauth-interval <minutes>

#
#
#
#
# auth-server <server-name2>
#
#
#

Instant AP) (SSID Profile <name> end

(
(
(
(
(
(
(
(
(
(
(
(Instant AP)# commit apply

To add users for MAC authentication based on internal authentication server:

(Instant AP) (config)# user <username> [<password>] [portal| radius]
(Instant AP) (config)# end
(Instant AP)# commit apply
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Configuring MAC Authentication for Wired Profiles

You can configure MAC authentication for a wired profile in the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To enable MAC authentication for a wired profile:

1. Click the Wired link under More at the top right corner of the main window. The Wired window is displayed.

2. Click New under Wired Networks to create a new network or select an existing profile for which you want to
enable MAC authentication and then click Edit.

3. Inthe New Wired Network or the Edit Wired Network window, ensure that all the required Wired and VLAN
attributes are defined, and then click Next.

In the Security tab, select Enabled from the MAC authentication drop-down list.
5. Specify the type of authentication server to use.

6. If the internal authentication server is used, perform the following steps to allow MAC address based
authentication:

Click the Users link against the Internal server field. The Users window is displayed.
Specify the client MAC address as the user name and password.

Specify the type of the user (employee or guest).

Click Add.

Repeat the steps to add more users.

Click OK.

7. Configure other parameters as required.

-~ 0o a0 T o

8. Click Next to define access rules, and then click Finish to apply the changes.

In the CLI

To configure MAC-address based authentication with external server:

(Instant AP
(Instant AP
(Instant AP

) (config) # wired-port-profile <name>

)

)
(Instant AP)

)

)

wired ap profile <name>)# type {<employee> |<guest>}
wired ap profile <name>)# mac-authentication

(Instant AP
(Instant AP
(Instant AP)
(Instant AP) (wired ap profile <name>)# end
(Instant AP)# commit apply

wired ap profile <name>)# auth-server <server-2>
wired ap profile <name>)# server-load-balancing

(

(

(

(wired ap profile <name>)# auth-server <server-1>

(

(

(wired ap profile <name>)# radius-reauth-interval <Minutes>

To add users for MAC authentication based on internal authentication server:

(Instant AP) (config)# user <username> [<password>] [portal| radius]
(Instant AP) (config)# end
(Instant AP)# commit apply

Configuring MAC Authentication with 802.1X Authentication

This section describes the following procedures:

e Configuring MAC and 802.1X Authentication for a Wireless Network Profile on page 169
e Configuring MAC and 802.1X Authentication for Wired Profiles on page 169
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Configuring MAC and 802.1X Authentication for a Wireless Network Profile

You can configure MAC authentication with 802.1X authentication for wireless network profile using the AOS-W
Instant Ul or CLI.

In the AOS-W Instant Ul

To configure both MAC and 802.1X authentication for a wireless network:

1. Inthe Network tab, click New to create a new network profile or select an existing profile for which you want to
enable MAC and 802.1X authentication and click edit.

2. Inthe Edit <profile-name> or New WLAN window, ensure that all required WLAN and VLAN attributes are
defined, and then click Next.

3. Inthe Security tab, ensure that the required parameters for MAC authentication and 802.1X authentication are
configured.

4. Select the Perform MAC authentication before 802.1X checkbox to use 802.1X authentication only when the
MAC authentication is successful.

5. Select the checkbox MAC authentication fail-thru to use 802.1X authentication even when the MAC
authentication fails.

6. Click Next and then click Finish to apply the changes.

In the CLI

To configure both MAC and 802.1X authentication for a wireless network:

Instant AP) (config)# end
Instant AP)# commit apply

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# type {<Employee> | <Voice>| <Guest>}
(Instant AP) (SSID Profile <name>)# mac-authentication

(Instant AP) (SSID Profile <name>)# l1l2-auth-failthrough

(Instant AP) (SSID Profile <name>)# auth-server <server-namel>
(Instant AP) (SSID Profile <name>)# radius-reauth-interval <minutes>
(Instant AP) (SSID Profile <name>)# auth-survivability

(Instant AP) (SSID Profile <name>)# exit

(Instant AP) (config)# auth-survivability cache-time-out <hours>

(

(

Configuring MAC and 802.1X Authentication for Wired Profiles
You can configure MAC and 802.1X authentication for a wired profile in the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To enable MAC and 802.1X authentication for a wired profile:

1. Click the Wired link under More at the top right corner of the main window. The Wired window is displayed.

2. Click New under Wired Networks to create a new network or select an existing profile for which you want to
enable MAC authentication and then click Edit.

3. Inthe New Wired Network or the Edit Wired Network window, ensure that all the required Wired and VLAN
attributes are defined, and then click Next.

4. Inthe Security tab, enable the following options:
Select Enabled from the MAC authentication drop-down list.
Select Enabled from the 802.1X authentication drop-down list.
Select Enabled from the MAC authentication fail-thru drop-down list.

5. Specify the type of authentication server to use and configure other required parameters. For more information on
configuration parameters, see Configuring Security Settings for a Wired Profile on page 116
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6. Click Next to define access rules, and then click Finish to apply the changes.

In the CLI
To enable MAC and 802.1X authentication for a wired profile:

(Instant AP
Instant AP
Instant AP

) (config) # wired-port-profile <name>

)

)
Instant AP)

)

)

)

( wired ap profile "<name>")# type {<employee> |<guest>}
( wired ap profile "<name>")# mac-authentication
( dotlx

( 12-auth-failthrough

Instant AP

(
(
(
(wired ap profile "<name>"
(wired ap profile "<name>"
(
(
(

(Instant AP auth-server <name>
(Instant AP) (wired ap profile "<name>"
(Instant AP) (wired ap profile "<name>" radius-reauth-interval <Minutes>

)
) #
) #

wired ap profile "<name>")#
) # server-load-balancing
) #
) #

(Instant AP) (wired ap profile "<name>" end

(Instant AP)# commit apply

Configuring MAC Authentication with Captive Portal Authentication
This authentication method has the following features:
If the captive portal splash page type is Internal-Authenticated or External-RADIUS Server, MAC
authentication reuses the server configurations.

If the captive portal splash page type is Internal-Acknowledged or External-Authentication Text and MAC
authentication is enabled, a server configuration page is displayed.

If the captive portal splash page type is none, MAC authentication is disabled.

MAC authentication only role— You can use the WLAN wizard to configure the mac-auth-only role in the role-
based access rule configuration section when MAC authentication is enabled with captive portal authentication.

Configuring MAC Authentication with Captive Portal Authentication

You can configure the MAC authentication with Captive Portal authentication for a network profile using the AOS-W
Instant Ul or CLI.

In the AOS-W Instant Ul

1. Select an existing wireless or wired profile for which you want to enable MAC with Captive Portal authentication.
Depending on the network profile selected, the Edit <WLAN-Profile> or Edit Wired Network window is
displayed.

Youcan configure MAC authentication with Captive Portal authentication, in the Access tab of the New WLAN and

R— New Wired Network windows when configuring a new profile.

2. Inthe Access tab, specify the following parameters for a network with Role-Based rules:

a. Selectthe Enforce Machine Authentication checkbox when MAC authentication is enabled for Captive
Portal. If the MAC authentication fails, the Captive Portal authentication role is assigned to the client.

b. Forwireless network profile, select Enforce MAC Auth Only Role checkbox when MAC authentication is
enabled for Captive Portal. After successful MAC authentication, MAC auth only role is assigned to the client.

3. Click Next and then click Finish to apply the changes.

In the CLI

To configure MAC authentication with Captive Portal authentication for a wireless profile:

(Instant AP) (config)# wlan ssid-profile <name>
(Instant AP) (SSID Profile <name>)# type <Guest>
(Instant AP) (SSID Profile <name>)# mac-authentication
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NOTE

(Instant AP) (SSID Profile <name>)# captive-portal <type> exclude-uplink <type>

(Instant AP) (SSID Profile <name>)# set-role-machine-auth <machine-authentication> <user-
authentication>

(Instant AP) (SSID Profile <name>)# set-role-mac-auth <MAC-authentication-only>

(Instant AP) (SSID Profile <name>)# end

(Instant AP)# commit apply

To configure MAC authentication with Captive Portal authentication for a wired profile:

(Instant AP

) (config)# wired-port-profile <name>
(Instant AP)
)

(
(wired ap profile <name>)# type <guest>
(Instant AP) (wired ap profile <name>)# mac-authentication

(Instant AP) (wired ap profile <name>)# captive-portal <type>

(Instant AP) (wired ap profile <name>)# captive-portal <type> exclude-uplink {<3G>| <4G>|
<Wifi> | Ethernet}

(Instant AP) (wired ap profile <name>)# set-role-machine-auth <machine-only> <user-only>
(Instant AP) (wired ap profile <name>)# set-role-mac-auth <mac-only>

(Instant AP) (wired ap profile <name>)# end

(Instant AP)# commit apply

Configuring WISPr Authentication
AOS-W Instant supports the following smart clients:

= jPass

= Boingo

These smart clients enable client authentication and roaming between hotspots by embedding iPass Generic
Interface Specification (GIS) redirect, authentication, and logoff messages within HTML messages that are sent to
the OAW-IAP.

WISPr authentication is supported only for the Internal - Authenticated and External - RADIUS Server captive
portal authentication. Select the Internal - Authenticated or the External - RADIUS Server option from the
Splash page type drop-down list to configure WISPr authentication for a WLAN profile.

You can configure WISPr authentication using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Click the System link at the top-right corner of the AOS-W Instant main window. The System window is
displayed.

2. Click Show advanced options.

3. Click WISPr tab. The WISPr tab contents are displayed. The following figure shows the WISPr tab contents:

Figure 47 Configuring WISPr Authentication

150 country code: E.164 country code:
E.164 area code: SSID/Zone:
Operator name: Location name:

4. Enterthe ISO Country Code for the WISPr Location ID in the ISO Country Code text box.
5. Enterthe E.164 Area Code for the WISPr Location ID in the E.164 Area Code text box.
6. Enter the operator name of the Hotspot in the Operator Name text box.
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7. Enterthe E.164 Country Code for the WISPr Location ID in the E.164 Country Code text box.

8. Enterthe SSID/Zone section for the WISPr Location ID in the SSID/Zone text box.

9. Enter the name of the Hotspot location in the Location Name text box. If no name is defined, the name of the
OAW-IAP to which the user is associated is used.

10. Click OK to apply the changes.

The WISPrRADIUS attributes and configuration parameters are specific to the RADIUS server used by your ISP for

the WISPr authentication. Contact your ISP to determine these values. You can find a list of ISO and ITU country
and area codes at the ISO and ITU websites (www.iso.org and http://www.itu.int).

A Boingo smairt client uses a NAS identifier in the format <CarrierID>_<VenuelD> for location identification. To
support Boingo clients, ensure that you configure the NAS identifier parameter in the Radius server profile for the
NeTE  WISPrserver.

In the CLI

(Instant AP) (config)# wlan wispr-profile

(Instant AP) (WISPr)# wispr-location-id-ac

(Instant AP) (WISPr)# wispr-location-id-cc

(Instant AP) (WISPr)# wispr-location-id-isocc

(Instant AP) (WISPr)# wispr-location-id-network
(Instant AP) (WISPr)# wispr-location-name-location
(Instant AP) (WISPr)# wispr-location-name-operator-name
(Instant AP) (WISPr)# end

(Instant AP)# commit apply

Blacklisting Clients

The client blacklisting denies connection to the blacklisted clients. When a client is blacklisted, it is not allowed to
associate with an OAW-IAP in the network. If a client is connected to the network when it is blacklisted, a
deauthentication message is sent to force client disconnection.

This section describes the following procedures:

Blacklisting Clients Manually on page 172
Blacklisting Users Dynamically on page 173

Blacklisting Clients Manually

Manual blacklisting adds the MAC address of a client to the blacklist. These clients are added into a permanent
blacklist. These clients are not allowed to connect to the network unless they are removed from the blackilist.

Adding a Client to the Blacklist
You can add a client to the blacklist manually using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

Click the Security link from the top right corner of the AOS-W Instant main window.

Click the Blacklisting tab.

Under the Manual Blacklisting, click New.

Enter the MAC address of the client to be blacklisted in the MAC address to add text box.

Click OK. The Blacklisted Since tab displays the time at which the current blacklisting has started for the client.

© g kM D~

To delete a client from the manual blacklist, select the MAC Address of the client under the Manual Blacklisting,
and then click Delete.
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In the CLI

To blacklist a client:

(Instant AP) (config)# blacklist-client <MAC-Address>
(Instant AP) (config)# end
(Instant AP)# commit apply

To view the blacklisted clients:
(Instant AP)# show blacklist-client

Blacklisted Clients

MAC Reason Timestamp Remaining time (sec) AP name

00:1c:b3:09:85:15 user-defined 17:21:29 Permanent -

Blacklisting Users Dynamically

The clients can be blacklisted dynamically when they exceed the authentication failure threshold or when a
blacklisting rule is triggered as part of the authentication process.

Authentication Failure Blacklisting

When a client takes time to authenticate and exceeds the configured failure threshold, it is automatically blacklisted
by an OAW-IAP.

Session Firewall Based Blacklisting

In session firewall based blacklisting, an ACL rule is used to enable the option for automation blacklisting. When the
ACL rule is triggered, it sends out blacklist information and the client is blacklisted.

Configuring Blacklist Duration
You can set the blacklist duration using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

To set a blacklist duration:

1. Click the Security link from the top right corner of the AOS-W Instant main window.
2. Click the Blacklisting tab.

3. Under Dynamic Blacklisting:

4

For Auth failure blacklist time, the duration in seconds after which the clients that exceed the authentication
failure threshold must be blacklisted.

5. For PEF rule blacklisted time, enter the duration in seconds after which the clients can be blacklisted due to an
ACL rule trigger.

You can configure a maximum number of authentication failures by the clients, after which a client must
be blacklisted. For more information on configuring maximum authentication failure attempts, see
E Configuring Security Settings fora WLAN SSID Profile on page 100

MOTE T4 enable session firewall based blacklisting, click New and navigate to WLAN Settings > VLAN >
Security > Access window, and enable the Blacklist option of the corresponding ACL rule.
In the CLI

To dynamically blacklist clients:

(Instant AP) (config)# auth-failure-blacklist-time <seconds>
(Instant AP) (config)# blacklist-time <seconds>

(Instant AP) (config)# end
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(Instant AP)# commit apply
To view the blacklisted clients:

(Instant AP)# show blacklist-client config

Blacklist Time :60
Auth Failure Blacklist Time :60
Manually Blacklisted Clients

MAC Reason Timestamp Remaining time (sec) AP IP

Dyn Blacklist Count :0

Uploading Certificates

A certificate is a digital file that certifies the identity of the organization or products of the organization. It is also used

to establish your credentials for any Web transactions. It contains the organization name, a serial number, expiration

date, a copy of the certificate-holder's public key, and the digital signature of the certificate-issuing authority so that a
recipient can ensure that the certificate is real.

AOS-W Instant supports the following certificate files:
Auth server or captive portal server certificate: PEM format with passphrase (PSK)
CA certificate: PEM or DER format

In the current release, OAW-IAP supports uploading of a customized certificate for internal captive portal server.

This section describes the following procedures:

Loading Certificates through AOS-W Instant Ul on page 174
Loading Certificates through AOS-W Instant CLI
Loading Certificates through OmniVista on page 175

Loading Certificates through AOS-W Instant Ul
To load a certificate in the AOS-W Instant Ul:

1. Click the Maintenance link at the top right corner of the AOS-W Instant main window.

2. Click the Certificates tab. The Certificates tab contents are displayed. The following figure shows the
Certificates window:
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Figure 48 Maintenance Window: Certificates Tab

Maintenance Help

About | Configuration | Certificates | Firmware | Reboot | Caonvert

Default Server Certificate:
Version 3

Serial number 01:DA:52 E

Issuer C=US, O=GeoTrust Inc., OU=Domain Validated S5L,

Subject Ox05=|LUga2fRPkWela7bolSVdsKOFKBWVIMF, C=US

Issued On 2011-05-11 01:22:10

Expires On 2017-08-11 04:40:59

Signed Using SHAL

RSA Key size 2048 bits

4 T S
New Certificate

| cCertificate file to upload: | Browse

Certificate type: CA ;

Cartificate format: Auth Server
Captive portal server

Cancel

3. Toupload a certificate, click Upload New Certificate. The New Certificate window is displayed.

Browse and select the file to upload.
5. Select any of the following types of certificates from the Certificate type drop-down list:

CA—CA certificates validate the client’s certificate.

Auth Server—The authentication server certificate verifies the server's identity to the client.

Captive portal server—Captive portal server certificate verifies internal captive portal server's identity to the client.
6. Select the certificate format from the Certificate format drop-down list.

If you have selected Auth Server or Captive portal server type, enter a passphrase in Passphrase and
reconfirm. The default password is whatever. If the certificate does not include a passphrase, there is no
passphrase required.

8. Click Browse and select the appropriate certificate file, and click Upload Certificate. The Certificate
Successfully Installed message is displayed.

Loading Certificates through AOS-W Instant CLI

To upload a certificate:

(Instant AP)# copy tftp {<ip-address> <filename> cpserver cert <password> format {pl2|pem}
|system {lxca [format {der|pem}]|lxcert <passsword>[format {pl2|pem}]}

Loading Certificates through OmniVista

You can manage certificates using the OmniVista. The AMP directly provisions the certificates and performs basic
certificate verification (such as certificate type, format, version, serial number and so on), before accepting the
certificate and uploading to an OAW-IAP network. The AMP packages the text of the certificate intoan HTTPS
message and sends it to the Virtual Controller. After the VC receives this message, it draws the certificate content
from the message, converts it to the right format, and saves it on the RADIUS server.

To load a certificate in OmniVista:

1. Navigate to Device Setup > Certificate and then click Add to add a new certificate. The Certificate window is
displayed.
2. Enterthe certificate Name, and click Choose File to browse and upload the certificate.
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Figure 49 Loading Certificate via OmniVista

Clients

Discower Add Communication Upload Firmware & Files

Home  Groups APs/Devices Reports

System AMP Setup

Certificate

Certificate
Mame: |
Certificate Fila: Mo file chosen
passphrase: -
Confirm passphrase:
Format: DER [v]
Type: Server Cert [se]

I Add ] I Cancel ]

3. Select the appropriate Format that matches the certificate file name. Select Server Cert for certificate Type,
and provide the passphrase if you want to upload a Server certificate. Select either Intermediate CA or Trusted
CA certificate Type, if you want to upload a CA certificate.

Figure 50 Server Certificate

Home  Groups APs/Devices Clients Reports System

Discover Add Communication Upload Firmware & Files Certificate

Certificate

Marme: .Tes-;_l

Certificate File: Server.plz
passphrase: r—

Confirm passphrase: R

Farmat; PRIC5212 [+]
Type: ]

[ Add J I Cancel ]

4. Afteryou upload the certificate, navigate to Groups, click the Instant Group and then select Basic. The Group
name is displayed only if you have entered the Organization name in the AOS-W Instant Ul. For more
information, see Configuring Organization String on page 279 for further information.
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Figure 51 Selecting the Group
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The Virtual Controller Certificate section displays the certificates (CA cert and Server).

5. Click Save to apply the changes only to OmniVista. Click Save and Apply to apply the changes to the OAW-
IAP.

6. To clearthe certificate options, click Revert.
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NOTE

Chapter 12

Roles and Policies

This chapter describes the procedures for configuring user roles, role assignment, and firewall policies.

e Firewall Policies on page 178

e Content Filtering on page 188

e Configuring User Roles on page 192

e Configuring Derivation Rules on page 194

Firewall Policies

AOS-W Instant firewall provides identity-based controls to enforce application-layer security, prioritization, traffic
forwarding, and network performance policies for wired and wireless networks. Using AOS-W Instant firewall, you
can enforce network access policies that define access to the network, areas of the network that users may access,
and the performance thresholds of various applications.

AOS-W Instant supports a role-based stateful firewall. AOS-W Instant firewall recognizes flows in a network and
keeps track of the state of sessions. Instant firewall manages packets according to the first rule that matches
packet. The firewall logs on the OAW-IAPs are generated as syslog messages.

Access Control List Rules

You can use Access Control List (ACL) rules to either permit or deny data packets passing through the OAW-IAP.
You can also limit packets or bandwidth available to a set of user roles by defining access rules. By adding custom
rules, you can block or allow access based on the service or application, source or destination IP addresses.

You can create access rules to allow or block data packets that match the criteria defined in an access rule. You can
create rules for either inbound traffic or outbound traffic. Inbound rules explicitly allow or block the inbound network
traffic that matches the criteria in the rule. Outbound rules explicitly allow or block the network traffic that matches
the criteria in the rule. For example, you can configure a rule to explicitly block outbound traffic to an IP address
through the firewall.

The OAW-IAP clients are associated with user roles, which determine the client’s network privileges and the
frequency at which clients re-authenticate.

AOS-W Instant supports the following types of ACLs:
e ACLs that permit or deny traffic based on the source IP address of the packet.

o ACLs that permit or deny traffic based on source or destination IP address, source or destination port number.

e ACLs that permit or deny traffic based on network services, application, application categories, web categories,
and security ratings.

You can configure up to 128 access control entries in an ACL for a user role.

For more information on configuring firewall rules, see:

e Configuring Access Rules for Network Services on page 179.

e Configuring Network Address Translation Rules on page 181

e Configuring Inbound Firewall Rules on page 185

e Configuring Access Rules for Application and Application Categories on page 248
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Configuring Web Policy Enforcement on page 251

Configuring Access Rules for Network Services

This section describes the procedure for configuring ACLs to control access to network services. For information on:

Configuring access rules based on application and application categories, see Configuring Access Rules for
Application and Application Categories on page 248.

Configuring access rules based on web categories and web reputation, see Configuring Web Policy Enforcement
on page 251.

In the AOS-W Instant Ul

To configure ACL rules for a user role:

1.

a e DN

Navigate to Security > Roles tab. The Roles tab contents are displayed.

You can also configure access rules for a wired or wireless client through the WLAN wizard (Network
tab>WLAN SSID> Edit>Edit WLAN > Access ) or the Wired profile (More > Wired>Edit> Edit Wired
Network> Access) window.

Select the role for which you want to configure access rules.
In Access rules section, click New to add a new rule. The New Rule window is displayed.
Ensure that the rule type is set to Access Control

To configure a rule to control access to network services, select Network under service category and specify the
following parameters:

Table 35: Access Rule Configuration Parameters

Service Description

Category

Network Select a service from the list of available services. You can allow or deny access to any or all
of the following services based on your requirement:
e any-Access is allowed or denied to all services.

e custom—Available options are TCP, UDP, and Other. If you select the TCP or UDP options,
enter appropriate port numbers. If you select the Other option, enter the appropriate ID.
NOTE: If TCP and UDP uses the same port, ensure that you configure separate access rules

to permit or deny access.

Action Select any of following actions:

o Select Allow to allow access users based on the access rule.

o Select Deny to deny access to users based on the access rule.

o Select Destination-NAT to allow changes to destination IP address.

o Select Source-NAT to allow changes to the source IP address.

The destination-nat and source-nat actions apply only to the network services rules.

Destination Select a destination option for the access rules for network services, applications, and
application categories. You can allow or deny access to any the following destinations based
on your requirements.

o to all destinations— Access is allowed or denied to all destinations.

e to a particular server—Access is allowed or denied to a particular server. After selecting
this option, specify the IP address of the destination server.

o except to a particular server—Access is allowed or denied to servers other than the
specified server. After selecting this option, specify the IP address of the destination
server.

o toa network—Access is allowed or denied to a network. After selecting this option, specify
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Table 35: Access Rule Configuration Parameters

Service

Category

Description

the IP address and netmask for the destination network.

o except to a network—Access is allowed or denied to networks other than the specified
network. After selecting this option, specify the IP address and netmask of the destination
network.

e to domain name—Access is allowed or denied to the specified domains. After selecting
this option, specify the domain name in the Domain Name text box.

Log Select this checkbox if you want a log entry to be created when this rule is triggered. AOS-W
Instant supports firewall based logging function. Firewall logs on the OAW-IAPs are
generated as security logs.

Blacklist Select the Blacklist checkbox to blacklist the client when this rule is triggered. The blacklisting

lasts for the duration specified as Auth failure blacklist time on the Blacklisting tab of the
Security window. For more information, see Blacklisting Clients on page 172.

Classify media

Select the Classify media checkbox to prioritize video and voice traffic. When enabled, a
packet inspection is performed on all non-NAT traffic and the traffic is marked as follows:
o Video: Priority 5 (Critical)

e Voice: Priority 6 (Internetwork Control)

Disable scanning

Select Disable scanning checkbox to disable ARM scanning when this rule is triggered.
The selection of the Disable scanning applies only if ARM scanning is enabled, For more
information, see Configuring Radio Settings for an OAW-IAP on page 240.

DSCP tag

Select the DSCP tag checkbox to specify a DSCP value to prioritize traffic when this rule is
triggered. Specify a value within the range of 0 to 63. To assign a higher priority, specify a
higher value.

802.1p priority

Select the 802.1p priority checkbox to specify an 802.1p priority. Specify a value between 0
and 7. To assign a higher priority, specify a higher value.

6. Click OK and then click Finish.

In the CLI

To configure access rules:

(Instant AP) (config)# wlan access-rule <access-rule-name>

(Instant AP) (Access Rule <Name>)#rule <dest> <mask> <match/invert> {<protocol> <start-port>
<end-port> {permit|deny|src-nat|dst-nat{<IP-address> <port>| <port>}} [<optionl....option9>]
(Instant AP) (Access Rule <Name>)# end

(Instant AP)# commit apply

Example

(Instant AP) (config)# wlan access-rule employee
(Instant AP) (Access Rule "employee")# rule 10.17.88.59 255.255.255.255 match 6 4343 4343 log

classify-media

(Instant AP) (Access Rule "employee")# rule 192.0.2.8 255.255.255.255 invert 6 110 110 permit
(Instant AP) (Access Rule "employee")# rule 192.0.2.2 255.255.255.0 192.0.2.7 255.255.255.0
match tcp 21 21 deny

(Instant AP) (Access Rule "employee")# rule 192.0.2.2 255.255.255.0 192.0.2.7 255.255.255.0
match udp 21 21 deny

(Instant AP)

(Instant AP)

(Access Rule "employee")# rule 192.0.2.2 255.255.255.0 match 6 631 631 permit
(Instant AP) (Access Rule "employee")# rule 192.
(

o
N
[oe]

255.255.255.255 invert 6 21 21 deny

Access Rule "employee")# rule 192.0.2.1 255.255.255.0 invert 17 67 69 deny

(Instant AP) (Access Rule "employee")# end
(Instant AP)# commit apply
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Configuring Network Address Translation Rules

Network Address Translation (NAT) is the process of modifying network address information when packets pass
through a routing device. The routing device acts as an agent between the public (the Internet) and private (local
network), which allows translation of private network IP addresses to a public address space.

AOS-W Instant supports the NAT mechanism to allow a routing device to use the translation tables to map the
private addresses into a single IP address and packets are sent from this address, so that they appear to originate
from the routing device. Similarly, if the packets are sent to the private IP address, the destination address is
translated as per the information stored in the translation tables of the routing device.

Configuring a Source NAT Access Rule

The source NAT action in access rules allows the user to override the routing profile entries. For example, when a
routing profile is configured to use 0.0.0.0/0, the client traffic in L3 mode access on an SSID destined to the
corporate network is sent to the tunnel. When an access rule is configured with Source NAT action, the users can
specify the service, protocol, or destination to which the source NAT is applied.

You can also configure source based routing to allow client traffic on one SSID to reach the Internet through the
corporate network, while the other SSID can be used as an alternate uplink. You can create an access rule to
perform source NAT by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To configure a source NAT access rule:

1. Navigate to the WLAN wizard or Wired settings window:

To configure access rules fora WLAN SSID, in the Network tab, click New to create a new network profile or
edit to modify an existing profile.

To configure access rules for a wired profile, More > Wired. In the Wired window, click New under Wired
Networks to create a new network or click Edit to select an existing profile.

2. Click the Access tab.

3. To configure access rules for the network, slide to Network-based. To configure access rules for user roles,
slide to Role-based.

4. To create a new rule for the network, click New. To create an access rule for a user role, select the user role and
then click New. The New Rule window is displayed.

In the New Rule window:

Select Access control from the Rule type drop-down list.

Select Source-NAT from the Action drop-down list, to allow changes to the source IP address.
Select a service from the list of available services.

Select the required option from the Destination drop-down list.

= © © N o o

0. If required, enable other parameters such as Log, Blacklist, Classify media, Disable scanning, DSCP tag, and
802.1p priority.

11. Click OK and then click Finish.

In the CLI

To configure source NAT access rule:

(Instant AP) (config)# wlan access-rule <access rule>

(Instant AP) (Access Rule "<access rule>")# rule <dest> <mask> <match> <protocol> <sport>
<eport> src-nat -

(Instant AP) (Access Rule "<access rule>")# end

(Instant AP)# commit apply
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Configuring Source-Based Routing

To allow different forwarding policies for different SSIDs, you can configure source-based routing. The source-based
routing configuration overrides the routing profile configuration and allows any destination or service to be configured
to have direct access to the Internet (bypassing VPN tunnel) based on the ACL rule definition. When source-based
routing is enabled, the Virtual Controller performs source NAT by using its uplink IP address.

To configure source-based routing:

1. Ensure that an L3 subnet with the netmask, gateway, VLAN, and IP address is configured. For more information
on configuring L3 subnet, see Configuring L3-Mobility on page 310.
2. Ensure that the source IP address is associated with the IP address configured for the L3 subnet.

3. Create an access rule for the SSID profile with Source NAT action as described in Configuring Source-Based
Routing on page 182. The source NAT pool is configured and source based routing entry is created.

Configuring a Destination NAT Access Rule

Instant supports configuration of the destination NAT rule, which can be used to redirect traffic to the specified IP
address and destination port. Destination-NAT configuration is supported only in the bridge mode without VPN.

You can configure a destination-NAT access rule by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To configure a destination NAT access rule:

1. Navigate to the WLAN wizard or Wired settings window:

To configure access rules fora WLAN SSID, in the Network tab, click New to create a new network profile or
edit to modify an existing profile.

To configure access rules for a wired profile, More > Wired. In the Wired window, click New under Wired
Networks to create a new network or click Edit to select an existing profile.

2. Click the Access tab.

3. To configure access rules for the network, slide to Network-based. To configure access rules for user roles,
slide to Role-based .

4. To create a new rule for the network, click New. To create an access rule for a user role, select the user role and
then click New. The New Rule window is displayed.

In the New Rule window:

Select Access control from the Rule type drop-down list.

Select destination-NAT from the Action drop-down list, to allow changes to the source IP address.
Specify the IP address and port details.

© ©® N oo

Select a service from the list of available services.
10. Select the required option from the Destination drop-down list.

11. If required, enable other parameters such as Log, Blacklist, Classify media, Disable scanning, DSCP tag, and
802.1p priority.

12. Click OK and then click Finish.

In the CLI

To configure destination NAT access rule:

(Instant AP) (config)# wlan access-rule <access_rule>

(Instant AP) (Access Rule "<access rule>")# rule <dest> <mask> <match> <protocol> <sport>
<eport> dst-nat ip <IP-address> [zport>]

(Instant AP) (Access Rule "<access rule>")# end

(Instant AP)# commit apply
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Configuring ALG Protocols

You can enable or disable protocols for Application Layer Gateway (ALG) using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

To configure protocols for ALG:

1. Click the Security link at the top right corner of AOS-W Instant main window.

2. Click the Firewall Settings tab. The Firewall Settings tab contents are displayed. The following figure shows

the contents of the Firewall Settings tab:

Figure 52 Firewall Settings—ALG Protocols

Application Layer Gateway (ALG) Algorithms

1P [Enabled  [+]
Vocera: m
Alcatel NOE: [Enabled  [+]
Cisco Skinny: m

Protection against wired attacks

Drop bad ARP: Disabled :
Fix malformed DHCP: | Disabled :
ARP poison check: Dizabled :

3. Select Enabled from the corresponding drop-down lists to enable SIP, VOCERA, Alcatel NOE, and Cisco

skinny protocols.
4. Click OK.

HNOTE

When the protocols for ALG are Disabled the changes do not take effect affect until the existing user sessions are
expired. Reboot the OAW-IAP and the client, or wait for few minutes for changes to affect.

In the CLI

To configure protocols for ALG:

(Instant AP) (config)# alg

(Instant AP) (ALG)# sccp-disable
(Instant AP) (ALG)# no sip-disable
(Instant AP) (ALG) # no ua-disable
(Instant AP) (ALG)# no vocera-disable
(Instant AP) (ALG)# end

(Instant AP)# commit apply

To view the ALG configuration:
(Instant AP)# show alg

Current ALG

sccp Disabled
sip Enabled

ua Enabled
vocera Enabled

Configuring Firewall Settings for Protection from ARP Attacks

You can configure firewall settings to protect the network against attacks using the AOS-W Instant Ul or CLI.
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In the AOS-W Instant Ul

To configure firewall settings:

1. Click the Security link at the top right corer of AOS-W Instant main window.

2. Click the Firewall Settings tab. The Firewall Settings tab contents are displayed.

3. To configure protection against security attacks, select the following checkboxes:
Select Drop bad ARP to enable the OAW-IAP to drop the fake ARP packets.
Select Fix malformed DHCP to the OAW-IAP to fix the malformed DHCP packets.

Select ARP poison check to enable the OAW-IAP to trigger an alert notifying the user about the ARP

poisoning that may have been caused by the rogue APs.

Figure 53 Firewall Settings —Protection Against Wired Attacks

Application Layer Gateway (ALG) Algorithms Protection against wired attacks

S1P: [Enabled  [«] Drop bad ARP: [Enabled  [+]
Vocera! [Enabled  [<] Fix malformed DHCP: |Enabled  [w]
Alcatel NOE: | Enabled (=] ARP poison check: [Disabled  [+]
Cisco Skinny: |E|‘|aIJIed m

4. Click OK.

In the CLI

To configure firewall settings to prevent attacks
(Instant AP) (config)# attack

(Instant
(Instant
(Instant
(Instant
(Instant

AP) (ATTACK) # drop-bad-arp-enable
AP) (ATTACK) # fix-dhcp-enable

AP) (ATTACK) # poison-check-enable
AP) (ATTACK) # end

AP)# commit apply

To view the configuration status:
(Instant AP)# show attack config

Current Attack

drop-bad-arp Enabled
fix-dhcp Enabled
poison-check Enabled

To view the attack statistics
(Instant AP)# show attack stats

attack counters

arp packet counter 0

drop bad arp packet counter 0
dhcp response packet counter 0
fixed bad dhcp packet counter 0
send arp attack alert counter 0
send dhcp attack alert counter 0
arp poison check counter 0

garp send check counter 0
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HNOTE

185 Roles and Policies

Managing Inbound Traffic

AOS-W Instant now supports an enhanced inbound firewall by allowing the configuration of firewall rules and
management subnets, and restricting corporate access through an uplink switch.

To allow flexibility in firewall configuration, AOS-W Instant supports the following features:

Inbound firewall rules
Configurable management subnets
Restricted corporate access

Configuring Inbound Firewall Rules

You can now configure firewall rules for the inbound traffic coming through the uplink ports of an OAW-IAP. The rules
defined for the inbound traffic are applied if the destination is not a user connected to the OAW-IAP. If the destination
already has a user role assigned, the user role overrides the actions or options specified in inbound firewall
configuration. However, if a deny rule is defined for the inbound traffic, it is applied irrespective of the destination and
user role. Unlike the ACL rules in a WLAN SSID or wired profile, the inbound firewall rules can be configured based
on the source subnet.

For all subnets, a deny rule is created by default as the last rule. If at least one rule is configured, the deny all rule is
applied to the upstream traffic by default.

Management access to the AP is allowed irrespective of the inbound firewall rule. For more information on
configuring restricted management access, see Configuring Management Subnets on page 187.

The inbound firewall is not applied to traffic coming through GRE tunnel.

You can configure inbound firewall rules through the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Navigate to Security > Inbound Firewall tab. The Inbound Firewall tab contents are displayed.
2. Under Inbound Firewall Rules, click New. The New Rule window is displayed.

Figure 54 Inbound Firewall Rules - New Rule Window

New Rule

Action: Service! Source: Destination:

Allow v any v from all sources v to all destinations v
Options: Log Classify media DSCP tag

Blacklist Disable scanning 802.1p priority

oK Cancel

3. Configure the following parameters:
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Table 36: /nbound Firewall Rule Configuration Parameters

Parameter Description

Action Select any of following actions:
Select Allow to allow access users based on the access rule.
Select Deny to deny access to users based on the access rule.
Select Destination-NAT to allow changes to destination IP address.
Select Source-NAT to allow changes to the source IP address.
The destination-nat and source-nat actions apply only to the network services rules.

Service Select a service from the list of available services. You can allow or deny access to any or all
of the following services based on your requirement:
any—Access is allowed or denied to all services.
custom—Available options are TCP, UDP, and Other. If you select the TCP or UDP options,
enter appropriate port numbers. If the Other option is selected, ensure enter the
appropriate ID is entered.

Source Select any of the following options:

from all sources— Traffic from all sources is either allowed, denied, or the IP address is
translated at the source or destination as defined in the rule.

from a host—Traffic from a particular host is either allowed, denied, or the IP address is
translated at the source or destination as defined in the rule. After selecting this option,
specify the IP address of the host.

from a network—Traffic from a particular network is either allowed, denied, or the IP
address is translated at the source or destination as defined in the rule. After selecting this
option, specify the IP address and netmask of the source network.

Destination Select a destination option for the access rules for network services, applications, and
application categories. You can allow or deny access to any the following destinations based
on your requirements.
to all destinations— Traffic for all destinations is allowed, denied, or the IP address is
translated at the source or destination as defined in the rule.
to a particular server—Traffic to a specific server is allowed, denied, or the IP address is
translated at the source or destination as defined in the rule. After selecting this option,
specify the IP address of the destination server.
except to a particular server—Access is allowed or denied to servers other than the
specified server. After selecting this option, specify the IP address of the destination
server.
to a network—Traffic to the specified network is allowed, denied, or the IP address is
translated at the source or destination as defined in the rule. After selecting this option,
specify the IP address and netmask for the destination network.
except to a network—Access is allowed or denied to networks other than the specified
network. After selecting this option, specify the IP address and netmask of the destination
network.
to domain name—Traffic to the specified domain is allowed, denied, or the IP address is
translated at the source or destination as defined in the rule. After selecting this option,
specify the domain name in the Domain Name text box.

Log Select this checkbox if you want a log entry to be created when this rule is triggered. AOS-W
Instant supports firewall based logging function. Firewall logs on the OAW-IAPs are
generated as security logs.

Blacklist Select the Blacklist checkbox to blacklist the client when this rule is triggered. The blacklisting
lasts for the duration specified as Auth failure blacklist time on the Blacklisting tab of the
Security window. For more information, see Blacklisting Clients on page 172.

Classify media Select the Classify media checkbox to prioritize video and voice traffic. When enabled, a
packet inspection is performed on all non-NAT traffic and the traffic is marked as follows:
Video: Priority 5 (Critical)
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Table 36: /nbound Firewall Rule Configuration Parameters

Parameter Description

e Voice: Priority 6 (Internetwork Control)

Disable scanning Select Disable scanning checkbox to disable ARM scanning when this rule is triggered.
The selection of the Disable scanning applies only if ARM scanning is enabled, For more
information, see Configuring Radio Settings for an OAW-IAP on page 240.

DSCP tag Select the DSCP tag checkbox to specify a DSCP value to prioritize traffic when this rule is
triggered. Specify a value within the range of 0 to 63. To assign a higher priority, specify a
higher value.

802.1p priority Select the 802.1p priority checkbox to specify an 802.1p priority. Specify a value between 0

and 7. To assign a higher priority, specify a higher value.

4. Click OK and then click Finish.

In the CLI

To configure inbound firewall rules:

(Instant AP) (config)# inbound-firewall

(Instant AP) (inbound-firewall)# rule <subnet> <smask> <dest> <mask> <protocol> <sport> <eport>
{permit|deny|src-nat|dst-nat <IP-address> <port>} [<optionl....option9>]

(Instant AP) (inbound-firewall)# end

(Instant AP)# commit apply

Example

(Instant AP) (config)# inbound-firewall

(Instant AP) (inbound-firewall)# rule 192.0.2.1 255.255.255.255 any any match 6 631 631 permit
(Instant AP) (inbound-firewall)# end

(Instant AP)# commit apply

Configuring Management Subnets

You can configure subnets to ensure that the OAW-IAP management is carried out only from these subnets. When
the management subnets are configured, Telnet, SSH, and Ul access is restricted to these subnets only.

You can configure management subnets by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

To configure management subnets:
1. Navigate to Security > Inbound Firewall. The Inbound Firewall tab contents are displayed.
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Figure 55 Firewall Settings—Management Subnets

Inbound Firewall Rules

New

Inbound Firewall Configuration

Management Subnets Add new management subnet:

Subnet Maslk Subnet:
Mask:

Add

Restrict Corporate Access: Disabled v

Delete Al

2. Toadd a new management subnet:
Enter the subnet address in Subnet.
Enter the subnet mask in Mask.
Click Add.

3. Toadd multiple subnets, repeat step 2.

4. Click OK.

In the CLI

To configure a management subnet:

(Instant AP) (config) # restricted-mgmt-access <subnet-IP-address> <subnet-mask>
(Instant AP) (config) # end

(Instant AP)# commit apply

Configuring Restricted Access to Corporate Network

You can configure restricted corporate access to block unauthorized users from accessing the corporate network.
When restricted corporate access is enabled, corporate access is blocked from the uplink port of master OAW-IAP,
including clients connected to a slave OAW-IAP. You can configure restricted corporate access by using the AOS-
W Instant Ul or CLI.

In the AOS-W Instant Ul

To configure restricted corporate access:

1. Navigate to Security > Inbound Firewall. The Inbound Firewall (see Figure 55) tab contents are displayed.
2. Select Enabled from the Restrict Corporate Access.

3. Click OK.

In the CLI

To configure restricted management access:

(Instant AP) (config) # restrict-corp-access
(Instant AP) (config) # end
(Instant AP)# commit apply

Content Filtering

The content filtering feature allows you to route DNS request to the OpenDNS platform and create content filtering
policies.
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With content filter, you can:

o Allow all DNS requests to the non-corporate domains on a wireless or wired network to be sent to the open DNS
server. When the OpenDNS credentials are configured, the OAW-IAP uses these credentials to access
OpenDNS to provide enterprise-level content filtering. For more information, see Configuring OpenDNS
Credentials on page 268

o Block certain categories of websites based on your organization policy. For example, if you block the web-
based-email category, clients who are assigned this policy will not be able to visit email-based websites such as
mail.yahoo.com.

o Prevent known malware hosts from accessing your wireless network.
o Improve employee productivity by limiting access to certain websites.

e Reduce bandwidth consumption significantly.

HOTE

Regardless of whether content filtering is disabled or enabled, the DNS requests to http://instant.alcatel-
lucentnetworks.com are always resolved internally on AOS-W Instant.

The content filtering configuration applies to all OAW-IAPs in the network and the service is enabled or disabled
globally across the wireless or wired network profiles.

Enabling Content Filtering

This section describes the following procedures:

e Enabling Content Filtering for a Wireless Profile on page 189
e Enabling Content Filtering for a Wired Profile

Enabling Content Filtering for a Wireless Profile

To enable content filtering for a wireless SSID, perform the following steps:

In the AOS-W Instant Ul

1. Select a wireless profile in the Networks tab and then click the edit link. The window for editing the WLAN SSID
profile is displayed.

2. Click Show advanced options.

3. Select Enabled from the Content Filtering drop-down list, and click Next to continue.

You can also enable content filtering while adding a new wireless profile. For more information, see Configuring

WLAN Settings for an SSID Profile on page 93.

In the CLI
To enable content filtering on a WLAN SSID:

(Instant AP) (config)# wlan ssid-profile <name>
(Instant AP) (SSID Profile <name>)# content-filtering
(Instant AP) (SSID Profile <name>)# end

(Instant AP)# commit apply

Enabling Content Filtering for a Wired Profile
To enable content filtering for a wired profile, perform the following steps:

In the AOS-W Instant Ul

1. Click the Wired link under More at the top right corner of the main window. The Wired window is displayed.

2. Inthe Wired window, select the wired profile to modify.
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3. Click Edit. The Edit Wired Network window is displayed.
4. Inthe Wired Settings tab, select Enabled from the Content Filtering drop-down list and click Next to continue.

In the CLI

To enable content filtering for a wired profile in the CLI:

(Instant AP) (config)# wired-port-profile test

(Instant AP) (wired ap profile <name>)# content-filtering
(Instant AP) (

(Instant AP)# commit apply

wired ap profile <name>)# end

Configuring Enterprise Domains

The enterprise domain names list displays the DNS domain nhames that are valid on the enterprise network. This list
is used to determine how client DNS requests must be routed. When Content Filtering is enabled, the DNS request
of the clients is verified and the domain names that do not match the names in the list are sent to the open DNS
server.

You can configure an enterprise domain through the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To manually add a domain:
1. Navigate to System > General, click Show advanced options > Enterprise Domains. The Enterprise

Domain tab contents are displayed.

2. Click New and enter a New Domain Name. Using “*” as an enterprise domain causes all DNS traffic to go
through the tunnel to the original DNS server of clients. If you are configuring routing profile with split-tunnel
disabled, you need add “*” to the enterprise domain list.

3. Click OKto apply the changes.

To delete a domain, select the domain and click Delete to remove the domain name from the list.

In the CLI

To configure an enterprise domain:

(Instant AP) (config)# internal-domains
(Instant AP) (domain)# domain-name <name>
(Instant AP) (domain)# end

(Instant AP)# commit apply

Configuring URL Filtering Policies

You can configure URL filtering policies to block certain categories of websites based on your organization
specifications by defining ACL rules either through the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Navigate to Security >Roles.

2. Select any WLAN SSID or wired profile role, and click New in the Access Rules section. The New Rule window
appears.

3. Select the rule type as Access Control.
4. Toset anaccess policy based on the web category:
a. Under Services, select Web category and expand the Web categories drop-down.
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Figure 56

New Rule

Options:

Rule type: Service: Action:
Access control v MNetwork | il Allow v

Application |

Application category real-estate

.

Web category computer-and-internet-security
financial-services

Web reputation
business-and-economy

. computer-and-internet-info
Application Throttling X
auctions
oo shopping
Blacklist cult-and-occult
travel

abused-drugs oK Cancel

adult-and-pernography

home-and-garden -

OK

b. Select the categories to which you want to deny or allow access. You can also search for a web category and
select the required option.

c. From the Action drop-down, select Allow or Deny as required.
d. Click OK.
5. Tofilter access based on the security ratings of the website:

a. Select Web reputation under Services.

b. Move the slider to the required security rating level.

c. From the Action drop-down, select Allow or Deny as required.

6. To set a bandwidth limit based on web category or web reputation score, select Application Throttling checkbox
and specify the downstream and upstream rates in Kbps. For example, you can set a higher bandwidth for trusted
sites and a low bandwidth rate for high risk sites.

7. Click OK to save the rules.
Click OKin Roles tab to save the changes to the role for which you defined ACL rules.

In the CLI

To control access based on web categories and security ratings:

(Instant
(Instant
{permit|
(Instant

{permit |deny}

(Instant
(Instant

Example

(Instant
(Instant
(Instant
permit
(Instant
permit
(Instant
(Instant
(Instant
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AP) (config) # wlan access-rule <access rule>

AP) (Access Rule "<access-rule>")# rule <dest> <mask> <match> webcategory <webgrp>
deny} [<optionl....option9>]

AP) (Access Rule "<access-rule>")# rule <dest> <mask> <match> webreputation <webrep>
[<optionl....option9>]

AP) (Access Rule "<access-rule>")# end

AP)# commit apply

AP) (config)# wlan access-rule URLFilter
AP) (Access Rule "URLFilter")# rule any any match webcategory gambling deny
AP) (Access Rule "URLFilter")# rule any any match webcategory training-and-tools

AP) (Access Rule "URLFilter")# rule any any match webreputation trustworthy-sites
AP) (Access Rule "URLFilter")# rule any any match webreputation suspicious-sites deny

AP) (Access Rule "URLFilter")# end
AP)# commit apply
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Configuring User Roles

Every client in the AOS-W Instant network is associated with a user role, which determines the client’s network
privileges, the frequency of reauthentication, and the applicable bandwidth contracts.

| i AOS-W Instant allows you to configuration of up to 32 user roles. If the number of roles exceed 32, an error

- message is displayed.

The user role configuration on an OAW-|AP involves the following procedures:

e Creating a User Role on page 192
e Assigning Bandwidth Contracts to User Roles on page 192
e Configuring Machine and User Authentication Roles on page 193

Creating a User Role

You can create a user role by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

To create a user role:

Click the Security at the top right corer of AOS-W Instant main window. The Security window is displayed.
Click Roles tab. The Roles tab contents are displayed.
Under Roles, click New.

> e =

Enter a name for the new role and click OK.

You can also create a user role when configuring wireless or wired network profiles. For more information, see
G Configuring Access Rules for a WLAN SSID Profile on page 105 and Configuring Access Rules for a Wired Profile

NeTE  onpage 117

In the CLI

To configure user roles and access rules:

(Instant AP) (config)# wlan access-rule <access-rule-name>
(Instant AP) (Access Rule <Name>)# rule <dest> <mask> <match> <protocol> <start-port> <end-
port> {permit |deny | src-nat | dst-nat {<IP-address> <port> | <port>}} [<optionl..option9>]

Assigning Bandwidth Contracts to User Roles

The administrators can manage bandwidth utilization by assigning maximum bandwidth rates, or bandwidth
contracts to user roles. The administrator can assign a bandwidth contract configured in Kbps to upstream (client to
the OAW-IAP) or downstream (OAW-IAP to clients) traffic for a user role. The bandwidth contract will not be
applicable to the user traffic on the bridged out (same subnet) destinations. For example, if clients are connected to
an SSID, you can restrict the upstream bandwidth rate allowed for each user to 512 Kbps.

By default, all users that belong to the same role share a configured bandwidth rate for upstream or downstream
traffic. The assigned bandwidth will be served and shared among all the users. You can also assign bandwidth per
user to provide every user a specific bandwidth within a range of 1 to 65535 Kbps. If there is no bandwidth contract
specified for a traffic direction, unlimited bandwidth is allowed.

In the earlier releases, bandwidth contract could be assigned per SSID. In the current release, the bandwidth
contract can also be assigned for each SSID user. If the bandwidth contract is assigned for an SSID in the AOS-W
Instant 6.2.1.0-3.4.0.0 image, and when the OAW-IAP is upgraded to 6.4.0.2-4.1 release version, the bandwidth

HOTE
configuration per SSID will be treated as a per-user downstream bandwidth contract for that SSID.
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In the AOS-W Instant Ul
1. Click the Security at the top right corner of AOS-W Instant main window. The Security window is displayed.

2. Click the Roles tab. The Roles tab contents are displayed.
3. Create a new role or select an existing role.
4. Under Access Rules, click New. The New Rule window is displayed.
5. Select Bandwidth Contract from the Rule Type drop-down list.
New Rule
Rule type:
Bandwidth Contr:[v|  Downstream: kbps Peruser

Upstream: kbps Peruser

oK Cancel

6. Specify the downstream and upstream rates in Kbps. If the assignment is specific for each user, select the
Peruser checkbox.

7. Click OK.
8. Associate the user role to a WLAN SSID or wired profile.

You can also create a user role and assign bandwidth contracts while configuring an SSID or wired profile.

In the CLI:

To assign a bandwidth contract in the CLI:

(Instant AP) (config)# wlan access-rule <name>

(Instant AP) (Access Rule <name>)# bandwidth-limit {downstream <kbps>| upstream <kbps>|peruser
{downstream <kbps>| upstream <kbps>}}

(Instant AP) (Access Rule <name>)# end

(Instant AP) # commit apply

To associate the access rule to a wired profile:

(Instant AP) (config)# wired-port-profile <name>

(Instant AP) (wired ap profile <name>)# access-rule-name <access-rule-name>
(Instant AP) (wired ap profile <name>)# end

(Instant AP) # commit apply

Configuring Machine and User Authentication Roles

You can assign different rights to clients based on whether their hardware device supports machine authentication.
Machine Authentication is only supported on Windows devices, so this can be used to distinguish between Windows
devices and other devices such as iPads.

You can create any of the following types of rules:

Machine Auth only role - This indicates a Windows machine with no user logged in. The device supports machine
authentication and has a valid RADIUS account, but a user has not yet logged in and authenticated.

User Auth only role - This indicates a known user or a non-Windows device. The device does not support
machine auth or does not have a RADIUS account, but the user is logged in and authenticated.

When a device does both machine and user authentication, the user obtains the default role or the derived role based
on the RADIUS attribute.

You can configure machine authentication with role-based access control using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

To configure machine authentication with role-based access control, perform the following steps:

| Roles and Policies AOS-W Instant 6.4.0.2-4.1 | User Guide



1. Inthe Access tab of the WLAN (New WLAN or Edit <WLAN-profile>) or Wired Network configuration (New
Wired Network or Edit Wired Network) window, under Roles, create Machine auth only and User auth
only roles.

2. Configure access rules for these roles by selecting the role, and applying the rule. For more information on
configuring access rules, see Configuring Access Rules for Network Services on page 179.

3. Select Enforce Machine Authentication and select the Machine auth only and User auth only roles.
4. Click Finish to apply these changes.

In the CLI

To configure machine and user authentication roles for a WLAN SSID:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name># set-role-machine-auth <machine-authentication-only> <user-
authentication-only>

(Instant AP) (SSID Profile <name># end

(Instant AP)# commit apply

To configure machine and user authentication roles for wired profile:

(Instant AP) (config)# wired-port-profile <name>

(Instant AP) (wired ap profile <name>)# set-role-machine-auth <machine-authentication-only>
<user-authentication-only>

(Instant AP) (wired ap profile <name>)# end

(Instant AP)# commit apply

AOS-W Instant allows you to configure role and VLAN derivation-rules. You can configure these rules to assign a
user role or VLAN to the clients connecting to an SSID or a wired profile.

Understanding Role Assignment Rule

When an SSID or wired profile is created, a default role for the clients connecting this SSID or wired profile is
assigned. You can assign a user role to the clients connecting to an SSID by any of the following methods. The role
assigned by some methods may take precedence over the roles assigned by the other methods.

RADIUS VSA Attributes

The user role can be derived from Alcatel-Lucent Vendor-Specific Attributes (VSA) for RADIUS server
authentication. The role derived from an Alcatel-Lucent VSA takes precedence over roles defined by other methods.

MAC-Address Attribute

The first three octets in a MAC address are known as Organizationally Unique Identifier (OUI), and are purchased
from the Institute of Electrical and Electronics Engineers, Incorporated (IEEE) Registration Authority. This identifier
uniquely identifies a vendor, manufacturer, or other organization (referred to by the IEEE as the “assignee”) globally
and effectively reserves a block of each possible type of derivative identifier (such as MAC addresses) for the
exclusive use of the assignee.

OAW-IAPs use the OUI part of a MAC address to identify the device manufacturer and can be configures to assign a
desired role for users who have completed 802.1X authentication and MAC authentication. The user role can be
derived from the user attributes after a client associates with an AP. You can configure rules that assign a user role
to clients that match a MAC address based criteria. For example, you can assign a voice role to any client with a
MAC address starting a0:al:a2.

AOS-W Instant 6.4.0.2-4.1 | User Guide Roles and Policies |



Roles Based on Client Authentication

The user role can be the default user role configured for an authentication method, such as 802.1x authentication. For
each authentication method, you can configure a default role for clients who are successfully authenticated using
that method.

DHCP Option and DHCP Fingerprinting

The DHCP fingerprinting allows you to identify the operating system of a device by looking at the options in the
DHCP frame. Based on the operating system type, a role can be assigned to the device.

For example, to create a role assignment rule with the DHCP option, select equals from the Operator drop-down
list and enter 370103060F77FC in the String text box. Since 370103060F77FC is the fingerprint for Apple iOS
devices such as iPad and iPhone, OAW-IAP assigns Apple iOS devices to the role that you choose.

Table 37: Validated DHCP Fingerprint

Device DHCP Option DHCP Fingerprint

Apple i0OS Option 55 370103060F77FC

Android Option 60 3C64686370636420342E302E3135

Blackberry Option 60 3C426C61636B4265727279

Windows 7/Vista Desktop Option 55 37010f03062c2e2f1f2179f92b

Windows XP(SP3, Home, Option 55 37010f03062c2e2f1f21f92b

Professional)

Windows Mobile Option 60 3c4d6963726f736f66742057696e646f777320434500
Windows 7 Phone Option 55 370103060f2c2e2f

Apple Mac OSX Option 55 370103060f775ffc2c2e2f

Creating a Role Derivation Rule

You can configure rules for determining the role that is assigned for each authenticated client.

When creating more than one role assignment rule, the first matching rule in the rule list is applied.

HMOTE
You can create a role assignment rules by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
1. Navigate to the WLAN wizard or Wired settings window:

e To configure access rules fora WLAN SSID, in the Network tab, click New to create a new network profile or
edit to modify an existing profile.

o To configure access rules for a wired profile, More > Wired. In the Wired window, click New under Wired
Networks to create a new network or click Edit to select an existing profile.

2. Click the Access tab.

3. Under Role Assignment Rules, click New. The New Role Assignment window allows you to define a match
method by which the string in Operandis matched with the attribute value returned by the authentication server.
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4. Select the attribute from the Attribute drop-down list that the rule it matches against. The list of supported
attributes includes RADIUS attributes, dhcp-option, dot1x-authentication-type, mac-address, and mac-address-
and-dhcp-options. For information on a list of RADIUS attributes, see RADIUS Server Authentication with VSA
on page 151.

5. Select the operator from the Operator drop-down list. The following types of operators are supported:
contains— The rule is applied only if the attribute value contains the string specified in Operand.
Is the role— The rule is applied if the attribute value is the role.
equals— The rule is applied only if the attribute value is equal to the string specified in Operand.
not-equals— The rule is applied only if the attribute value is not equal to the string specified in Operand.
starts-with— The rule is applied only if the attribute value starts with the string specified in Operand.
ends-with— The rule is applied only if the attribute value ends with string specified in Operand.

matches-regular-expression— The rule is applied only if the attribute value matches the regular expression
pattern specified in Operand. This operator is available only if the mac-address-and-dhcp-options attribute
is selected in the Attribute drop-down. The mac-address-and-dhcp-options attribute and matches-
regular-expression are applicable only for the WLAN clients.

6. Enterthe string to match in the String text box.

7. Select the appropriate role from the Role drop-down list.

8. Click OK.

HNOTE

When Enforce Machine Authentication is enabled, both the device and the user must be authenticated for the role
assignment rule to apply.

In the CLI

To configure role assignment rules for a WLAN SSID:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# set-role <attribute>{{equals|not-equals|starts-with|ends-
with|contains|matches-regular-expression} <operator><role>|value-of}

(Instant AP) (SSID Profile <name># end

(Instant AP)# commit apply

To configure role assignment rules for a wired profile:

(Instant AP) (config)# wired-port-profile <name>

(Instant AP) (wired ap profile <name>)# set-role <attribute>{{equals| not-equal| starts-with]
ends-with|contains}<operator> <role>| value-of}

(Instant AP) (wired ap profile <name>)# end

(Instant AP)# commit apply

Example

(Instant AP) (config)# wlan ssid-profile Profilel

(Instant AP) (SSID Profile "Profilel")# set-role mac-address-and-dhcp-options matches-regular-
expression \bring\b Profilel

(Instant AP) (SSID Profile"Profilel")# end

(Instant AP)# commit apply

Understanding VLAN Assignment
You can assign VLANSs to a client based on the following configuration conditions:

The default VLAN configured for the WLAN can be assigned to a client.

If VLANSs are configured fora WLAN SSID or an Ethernet port profile, the VLAN for the client can be derived
before the authentication, from the rules configured for these profiles.

If a rule derives a specific VLAN, it is prioritized over the user roles that may have a VLAN configured.
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e The user VLANSs can be derived from the default roles configured for 802.1X authentication or MAC
authentication.

o After client authentication, the VLAN can be derived from Vendor Specific Attributes (VSA) for RADIUS server
authentication.

e The DHCP-based VLANSs can be derived for Captive Portal authentication.

AOS-W Instant supports role derivation based on the DHCP option for Captive Portal authentication. When the
Captive Portal authentication is successful, the role derivation based on the DHCP option assigns a new user role
HoTE  tothe guest users, instead of the pre-authenticated role.

Vendor Specific Attributes

When an external RADIUS server is used, the user VLAN can be derived from the Alcatel-Lucent-User-Vlan VSA.
The VSA is then carried in an Access-Accept packet from the RADIUS server. The OAW-IAP can analyze the return
message and derive the value of the VLAN which it assigns to the user.

Figure 57 RADIUS Access-Accept packets with VSA
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VLAN Assignment Based on Derivation Rules

When an external RADIUS server is used for authentication, the RADIUS server may return a reply message for
authentication. If the RADIUS server supports return attributes, and sets an attribute value to the reply message, the
OAW-IAP can analyze the return message and match attributes with a user pre-defined VLAN derivation rule. If the
rule is matched, the VLAN value defined by the rule is assigned to the user. For a complete list of RADIUS server
attributes, see RADIUS Server Authentication with VSA on page 151.

Figure 59 Configuring RADIUS Attributes on the RADIUS Server
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User Role

If the VSA and VLAN derivation rules are not matching, then the user VLAN can be derived by a user role.

VLANSs Created for an SSID

If the VSA and VLAN derivation rules are not matching, and the User Role does not contain a VLAN, the user VLAN
can be derived by VLANSs configured for an SSID or Ethemnet port profile.

Configuring VLAN Derivation Rules

The users are assigned to a VLAN based on the attributes returned by the RADIUS server after the users
authenticate.

You can configure VLAN derivation rules for an SSID profile by using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Perform the following steps:
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To configure VLAN derivation rule fora WLAN SSID profile, Click Network > New > New WLAN > VLAN or
Network > edit > Edit <WLAN-profile> > VLAN. Select the Dynamic option under the Client VLAN
assignment.
To configure VLAN derivation rule for a wired network profile, click Wired > New > New Wired Network >
VLAN or Wired > Edit > Edit Wired Network > VLAN.
2. Click New to create a VLAN assignment rule. The New VLAN Assighment Rule window is displayed. In this
window, you can define a match method by which the string in Operandis matched with the attribute values
returned by the authentication server.

Figure 60 VLAN Assignment Rule Window
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3. Select the attribute from the Attribute drop-down list. The list of supported attributes includes RADIUS
attributes, dhcp-option, dot1x-authentication-type, mac-address, and mac-address-and-dhcp-options. For
information on a list of RADIUS attributes, see RADIUS Server Authentication with VSA on page 151.

4. Select the operator from the Operator drop-down list. The following types of operators are supported:
contains— The rule is applied only if the attribute value contains the string specified in Operand.
equals— The rule is applied only if the attribute value is equal to the string specified in Operand.
not-equals — The rule is applied only if the attribute value is not equal to the string specified in Operand.
starts-with — The rule is applied only if the attribute value starts with the string specified in Operand.
ends-with — The rule is applied only if the attribute value ends with string specified in Operand.

matches-regular-expression — The rule is applied only if the attribute value matches the regular expression
pattern specified in Operand. This operator is available only if the mac-address-and-dhcp-options attribute
is selected in the Attribute drop-down. The mac-address-and-dhcp-options attribute and matches-
regular-expression are applicable only for the WLAN clients.

Enter the string to match in the String field.
Select the appropriate VLAN ID from the VLAN drop-down list.
Click OK.

Ensure that all other required parameters are configured.

© ©® N oo

Click Finish to apply the changes.

In the CLI
To create a VLAN assignment rule for WLAN SSID:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# set-vlan <attribute>{equals|not-equals|starts-with|ends-
with|contains|matches-regular-expression}<operator><VLAN-ID>|value-of}

(Instant AP) (SSID Profile <name>)# end

(Instant AP)# commit apply
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To configure a VLAN assignment rule for a wired profile:

(Instant AP) (config)# wired-port-profile <nname>

(Instant AP) (wired ap profile <name>)# set-vlan <attribute>{equals|not-equals|starts-
with|ends-with|contains}<operator><VLAN-ID>|value-of}

(Instant AP) (wired ap profile <name>)# end

(Instant AP)# commit apply

Example

(Instant AP) (config)# wlan ssid-profile Profilel

(Instant AP) (SSID Profile "Profilel")# set-vlan mac-address-and-dhcp-options matches-regular-
expression ..link 100

(Instant AP) (SSID Profile "Profilel")# end

(Instant AP)# commit apply

Using Advanced Expressions in Role and VLAN Derivation Rules

For complex policies of role and VLAN derivation using device DHCP fingerprints, you can use a regular expression
to match against the combined string of the MAC address and the DHCP options. The combined string is formed by
concatenating the hexadecimal presentation of the MAC address and all of the DHCP options sent by a particular
device. The regular expression is a powerful pattern description language that can be used to perform advanced
pattern matching of the above string.

If the combined device fingerprint string matches the specified regular expression, the role or vlan can be set to the
WLAN client.

The following table lists some of the most commonly used regular expressions, which can be used in user role and
user VLAN derivation rules:

Operator | Description

Matches any character. For example, I..k matches lack, lark, link, lock, look, Lync and so on.

\ Matches the character that follows the backslash. For example, \192.\.0\.. matches IP addresses ranges
that starting with 192.0, such as 192.0.1.1. The expression looks only for the single characters that
match.

[1 Matches any one character listed between the brackets. For example, [bc]lock matches block and clock.

\b Matches the words that begin and end with the given expression. For example, \bdown matches

downlink, linkdown, shutdown.

\B Matches the middle of a word. For example, \Bvice matches services, devices, servicelD, devicelD, and
so on.

A Matches the characters at starting position in a string. For example, “bcd matches bede or bedf, but not
abcd.

"1 Matches any characters that are not listed between the brackets. For example, [*u]link matches

downlink, link, but not uplink.

? Matches any one occurrence of the pattern. For example, ?est matches best, nest, rest, test and so on.
$ Matches the end of an input string. For example, eth$ matches Eth, but not Ethernet.
* Matches the declared element multiple times if it exists. For example, eth* matches all occurrences of

eth, such as Eth, Ethernet, EthO and so on.
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Operator | Description

+ Matches the declared element one or more times. For example, aa+ matches occurrences of aa and
aaa.
() Matches nested characters. For example, (192)* matches any number of the character string 192.

| Matches the character patterns on either side of the vertical bar. You can use this expression to construct
a series of options.

\< Matches the beginning of the word. For example, \<wire matches wired, wireless and so on.
\> Matches the end of the word. For example, \>list matches blacklist, whitelist, and so on.
{n} Where n is an integer" Matches the declared element exactly the n times. For example, {2}link matches

uplink, but not downlink.

{n} Where n is an integer" Matches the declared element at n times. For example, {2,}ink matches downlink,
but not uplink.

For information on how to use regular expressions in role and VLAN derivation rules, see the following topics:

e Configuring VLAN Derivation Rules on page 198

e Creating a Role Derivation Rule on page 195

Configuring a User Role for VLAN Derivation
This section describes the following procedures:

e Creating a User VLAN Role on page 201
e Assigning User VLAN Roles to a Network Profile on page 202

Creating a User VLAN Role

You can create a user role for VLAN derivation using the AOS-W Instant Ul or CLI

In the AOS-W Instant Ul
To configure a user role for VLAN derivation:

Click the Security at the top right corner of AOS-W Instant main window.
Click the Roles tab. The Roles tab contents are displayed.

Under Roles, click New.

Enter a name for the new role and click OK.

Under the Access rules, click New.

Select the Rule type as VLAN assignment.

Enter the ID of the VLAN in the VLAN ID text box.

Click OK.

©® N o g s~ wbd =

In the CLI

To create a VLAN role:

(Instant AP) (config)# wlan access-rule <rule-name>
(Instant AP) (Access Rule <rule-name>)# vlan 200
(Instant AP) (Access Rule <rule-name>)# end
(Instant AP)# commit apply
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Assigning User VLAN Roles to a Network Profile

You can configure user VLAN roles for a network profile using AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

To assign a user VLAN role:

1. Click Network > New > New WLAN > Access or Network > edit > Edit <WLAN-profile> > Access.

2. Ensure that the slider is at the Role-based option.
3. Click New under the New Role Assignment and configure the following parameters:
a. Select the attribute from the Attribute drop-down list.
b. Select the operator to match from the Operator drop-down list.
c. Enterthe string to match in the String text box.
d

Select the role to be assigned from the Role text box. The following figure shows an example for the VLAN

role assignment:

Figure 61 User VLAN Role Assignment
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4. Click OK.

In the CLI
To assign VLAN role to a WLAN profile:

(Instant AP) (config)# wlan ssid-profile <name>

(Instant AP) (SSID Profile <name>)# set-role <attribute>{{equals <operator> <role>| not-equals

<operator> <role>| starts-with <operator> <role>| ends-with <operator> <role>|
<operator> <role>} |value-of}

(Instant AP) (SSID Profile <name>)# end

(Instant AP)# commit apply

AOS-W Instant6.4.0.2-4.1 | User Guide

contains

Roles and Policies | 202



Chapter 13

DHCP Configuration

This chapter provides the following information:

e Configuring DHCP Scopes on page 203
e Configuring the Default DHCP Scope for Client IP Assignment on page 210

Configuring DHCP Scopes

The virtual controller supports different modes of DHCP address assignment. With each DHCP address assignment
mode, various client traffic forwarding modes are associated. For more information on client traffic forwarding modes
for IAP-VPN, see |IAP-VPN Forwarding Modes on page 226.

You can configure the default DHCP scope for virtual controller assigned networks, Distributed L2, Distributed L3,
Local or NAT DHCP, Local L3, and Centralized DHCP scopes through the AOS-W Instant Ul or CLI.

This section describes the following procedures:

e Configuring the Default DHCP Scope for Client IP Assignment on page 210
e Configuring Distributed DHCP Scopes on page 203

e Configuring a Centralized DHCP Scope on page 206

e Configuring Local and Local,L3 DHCP Scopes on page 208

Configuring Distributed DHCP Scopes

AOS-W Instant allows you to configure the DHCP address assignment for the branches connected to the corporate
network through VPN. You can configure the range of DHCP IP addresses used in the branches and the number of
client addresses allowed per branch. You can also specify the IP addresses that must be excluded from those
assigned to clients, so that they are assigned statically.

AOS-W Instant supports the following distributed DHCP scopes:

o Distributed, L2 — In this mode, the Virtual Controller acts as the DHCP server, but the default gateway is in the
data center. Based on the number of clients specified for each branch, the range of IP addresses is divided.
Based on the IP address range and client count configuration, the DHCP server in the Virtual Controller controls a
scope that is a subset of the complete IP Address range for the subnet distributed across all the branches. This
DHCP Assignment mode is used with the L2 forwarding mode.

o Distributed, L3 — In this mode, the Virtual Controller acts as the DHCP server and the default gateway. Based
on the number of clients specified for each branch, the range of IP addresses is divided. Based on the IP address
range and client count configuration, the DHCP server in the Virtual Controller is configured with a unique subnet
and a corresponding scope.

You can configure distributed DHCP scopes such as Distributed, L2 or Distributed,L3 by using the AOS-W Instant
Ul or CLI.

In the AOS-W Instant Ul
To configure distributed DHCP scopes such as Distributed,L2 or Distributed,L3:
1. Click More > DHCP Server. The DHCP Server window is displayed.

2. To configure a distributed DHCP mode, click New under Distributed DHCP Scopes. The New DHCP Scope
window is displayed. The following figure shows the contents of the New DHCP Scope window.
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Figure 62 New DHCP Scope: Distributed DHCP Mode

New DHCP Scope

MName:

Type:

WVLAN:
Netmask:
Default router:
DNS server:
Domain name:

Lease time:

0l Network |

Network Settings

Distributed, L2 EI

Help
IP Address Range
to | +
Option
Type value | +
Next Cancel

3. Based on the type of distributed DHCP scope, configure the following parameters:

Table 38: Distributed DHCP Mode: Configuration Parameters

Name Description

Name Enter a name for the DHCP scope.
Type Select any of the following options:
o Distributed, L2— On selecting Distributed, L2, the Virtual Controller acts as the
DHCP Server but the default gateway is in the data center. Traffic is bridged into
VPN tunnel.
o Distributed, L3— On selecting Distributed, L3, the Virtual Controller acts as both
DHCP Server and default gateway. Traffic is routed into the VPN tunnel.
VLAN Specify a VLAN ID. To use this subnet, ensure that the VLAN ID specified here is
assigned to an SSID profile. For more information on SSID profile configuration, see
Configuring VLAN Settings for a WLAN SSID Profile on page 97 and Configuring
VLAN for a Wired Profile on page 115
Netmask If Distributed, L2 is selected for type of DHCP scope, specify the subnet mask. The

subnet mask and the network determine the size of subnet.

Default router

If Distributed, L2 is selected for type of DHCP scope, specify the IP address of the
default router.

DNS Server

If required, specify the IP address of a DNS server.

Domain Name

If required, specify the domain name.
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Table 38: Distributed DHCP Mode: Configuration Parameters

Name Description

Lease Time Specify a lease time for the clientin minutes.

IP Address Range Specify a range of IP addresses to use. To add another range, click the + icon. You can
specify up to four different ranges of IP addresses.
For Distributed, L2 mode, ensure that all IP ranges are in the same subnet as the
default router. On specifying the IP address ranges, a subnet validation is
performed to ensure that the specified ranges of IP address are in the same subnet
as the default router and subnet mask. The configured IP range is divided into
blocks based on the configured client count.
For Distributed,L3 mode, you can configure any discontiguous IP ranges. The
configured IP range is divided into multiple IP subnets that are sufficient to
accommodate the configured client count.

NOTE: You can allocate multiple branch IDs (BID) per subnet. The OAW-IAP
generates a subnet name from the DHCP IP configuration, which the switch can use as
a subnetidentifier. If static subnets are configured in each branch, all of them are
assigned the with BID 0, which is mapped directly to the configured static subnet.

Option Specify the type and a value for the DHCP option. You can configure the organization-
specific DHCP options supported by the DHCP server. For example, 176, 242, 161,
and so on. To add multiple DHCP options, click the + icon. You can add up to eight
DHCP options.

4. Click Next.

5. Specify the number of clients to use per branch. The client count configured for a branch determines the use of IP
addresses from the IP address range defined for a DHCP scope. For example, if 20 IP addresses are available in
an IP address range configured fora DHCP scope and a client count of 9 is configured, only a few IP addresses
(in this example, 9) from this range will be used and allocated to a branch. The OAW-IAP does not allow the
administrators to assign the remaining IP addresses to another branch, although a lower value is configured for
the client count.

6. Click Next. The Static IP tab is displayed. Specify the number of first and last IP addresses to reserve in the
subnet.

7. Click Finish.

In the CLI
To configure Distributed,L.2 DHCP scope:

(Instant AP) (config)# ip dhcp <profile-name>

(Instant AP) (DHCP Profile <profile-name>)# ip dhcp server-type <Distributed,L2>
(Instant AP) (DHCP Profile <profile-name>)# server-vlan <vlan-ID>
(Instant AP) (DHCP Profile <profile-name>)# subnet-mask <subnet-mask>
(Instant AP) (DHCP Profile <profile-name>)# default-router <IP-address>
(Instant AP) (DHCP Profile <profile-name>)# client-count <number>
(Instant AP) (DHCP Profile <profile-name>)# dns-server <name>

(Instant AP) (DHCP Profile <profile-name>)# domain-name <domain-name>
(Instant AP) (DHCP Profile <profile-name>)# lease-time <minutes>
(Instant AP) (DHCP Profile <profile-name>)# ip-range <start-IP> <end-IP>
(Instant AP) (DHCP Profile <profile-name>)# reserve {first|last} <count>
(Instant AP) (DHCP Profile <profile-name>)# option <type> <value>
(Instant AP) (DHCP Profile <profile-name>)# end

(Instant AP)# commit apply

To configure Distributed,L3 DHCP scope:

(Instant AP) (config)# ip dhcp <profile-name>
(Instant AP) (DHCP Profile <profile-name>)# ip dhcp server-type <Distributed, L3>
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(Instant AP server-vlan <vlan-ID>
(Instant AP

(Instant AP

DHCP Profile <profile-name>
DHCP Profile <profile-name>
DHCP Profile <profile-name>

client-count <number>
dns-server <name>

(Instant AP) (DHCP Profile <profile-name> domain-name <domain-name>
(Instant AP
ip-range <start-IP> <end-IP>

reserve {first | last} <count>
option <type> <value>

(Instant AP
(Instant AP
(Instant AP
(Instant AP

DHCP Profile <profile-name>
DHCP Profile <profile-name>

DHCP Profile <profile-name>
commit apply

( ) #
( ) #
( ) #
( ) #
(DHCP Profile <profile-name>)# lease-time <minutes>
(DHCP Profile <profile-name>)#
( ) #
( ) #
( ) #
#

)
)
)
)
)

(Instant AP)
)
)
) end
)

Configuring a Centralized DHCP Scope
You can configure centralized,L2 and centralized,L3 DHCP profiles. When a centralized DHCP scope is configured:
e The Virtual Controller does not assign an IP address to the client and the DHCP traffic is directly forwarded to the

DHCP Server.

e For Centralized, L2 clients, the Virtual Controller bridges the DHCP traffic to the switch over the VPN/GRE
tunnel. The IP address is obtained from the DHCP server behind the switch serving the VLAN/GRE of the client.
This DHCP assignment mode also allows you to add the DHCP option 82 to the DHCP traffic forwarded to the
controller.

e ForCentralized, L3 clients, the Virtual Controller acts as a DHCP relay agent that forwards the DHCP traffic to
the DHCP server located either in the corporate or local network. The centralized L3 VLAN IP is used as the
source IP. The IP address is obtained from the DHCP server.

You can configure a centralized DHCP scope through the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To configure a centralized DHCP scope:

1. Click More > DHCP Server. The DHCP Server window is displayed.

2. To configure a centralized DHCP scopes, click New under Centralized DHCP Scopes. The New DHCP
Scope window is displayed.

3. To configure centralized,L2 profile, select the profile type as Centralized,L2 or Centralized,L3 and configure
the following parameters.

Table 39: Centralized DHCP Mode: Configuration Parameters

Name Description

Name Enter a name for the DHCP scope.

Type Set the type as follows:
o Centralized,L2 for the centralized,L2 profile
o Centralized,L3 for the centralized,L3 profile

VLAN Specify a VLAN ID. To use this subnet, ensure that the VLAN ID specified here is assigned
to an SSID profile. For more information on SSID profile configuration, see Configuring
VLAN Settings for a WLAN SSID Profile on page 97 and Configuring VLAN for a Wired
Profile on page 115.

Split tunnel Set this to Enabled or Disabled for split tunnel functionality for the centralized,L2 subnet.
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Table 39: Centralized DHCP Mode: Configuration Parameters

Name Description

Enabling split tunnel allows a VPN user to access a public network and a local LAN or
WAN network at the same time through the same physical network connection. For
example, a user can use a remote access VPN software client connecting to a corporate
network using a home wireless network. The user with splittunneling enabled is able to
connect to file servers, database servers, mail servers and other servers on the corporate
network through the VPN connection. When the user connects to Internet resources (Web
sites, FTP sites and so on), the connection request goes directly out the gateway provided
by the home network. The split-DNS functionality intercepts DNS requests from clients for
non-corporate domains (as configured in Enterprise Domains list) and forwards to AP's
own DNS server.

When split-tunnel is disabled, all the traffic including the corporate and Internet traffic is
tunneled irrespective of the routing profile specifications. If the GRE tunnel is down and
when the corporate network is not reachable, the client traffic is dropped.

DHCP relay If you are configuring a Centralized, L2 DHCP profile, you can select Enabled to allow the
OAW-IAPs to intercept the broadcast packets and relay DHCP requests to centralized
DHCP server.

NOTE: The DHCP relay option is not available for centralized,L3 profile configuration.

Helper address Specify the IP address of the DHCP server.

NOTE: For Centralized, L2 DHCP profiles, the Helper address option is displayed only
when DHCP relay is enabled.

VLAN IP Specify the Centralized L3 DHCP subnet gateway IP.
VLAN Mask Specify the subnet mask of the Centralized L3 DHCP subnet gateway IP.
Option82 Select Alcatel to enable DHCP Option 82 to allow clients to send DHCP packets with the

Option 82 string. The Option 82 string is available only in the Alcatel (ALU) format. The ALU
format for the Option 82 string consists of the following:

o Remote Circuit ID; X AP-MAC; SSID; SSID-Type

o Remote Agent; X IDUE-MAC

NOTE: The Option 82 string is specific to Alcatel and is not configurable.

4. Click OK.
The following table describes the behavior of the DHCP Relay Agent and Option 82 in the OAW-IAP.

Table 40: DHCP Relay and Option 82

DHCP Relay Option 82 | Behavior

Enabled Enabled DHCP packet relayed with the ALU-specific Option 82 string
Enabled Disabled DHCP packet relayed without the ALU-specific Option 82 string
Disabled Enabled DHCP packet not relayed, but broadcast with the ALU-specific Option 82 string
Disabled Disabled DHCP packet not relayed, but broadcast without the ALU-specific Option 82
string
In the CLI

To configure a centralized,L.2 DHCP profile:

(Instant AP) (config)# ip dhcp <profile-name>
(Instant AP) (DHCP Profile <profile-name>)# server-type <centralized>
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Instant DHCP Profile <profile-name> server-vlan <vlan-ID>

AP) (
Instant AP) (DHCP Profile <profile-name>
AP) (

(

( option82 alu
(Instant DHCP Profile <profile-name>

(

(

#
#
# disable-split-tunnel
#

)
)
)
) # end

Instant AP) (DHCP Profile <profile-name>
Instant AP)# commit apply

To configure a centralized,L3 DHCP profile:

Instant AP)
Instant AP)
Instant AP)
)
)
)

( config)# ip dhcp <profile-name>
(

(

(Instant AP

(

(

(

(

(

(DHCP Profile <profile-name>)# server-type <centralized>

(DHCP Profile <profile-name>)# server-vlan <vlan-ID>

(DHCP Profile <profile-name>)# dhcp-relay

Instant AP) (DHCP Profile <profile-name>)# dhcp-server <DHCP-relay-server>

Instant AP) (DHCP Profile <profile-name>)# vlan-ip <DHCP IP address> mask <VLAN mask>
Instant AP) (DHCP Profile <profile-name>)# end

Instant AP)# commit apply

Configuring Local and Local,L3 DHCP Scopes
You can configure Local and Local,L3 DHCP scopes through the AOS-W Instant Ul or CLI.

Local — In this mode, the Virtual Controller acts as both the DHCP Server and the default gateway. The
configured subnet and the corresponding DHCP scope are independent of subnets configured in other OAW-IAP
clusters. The Virtual Controller assigns an IP address from a local subnet and forwards traffic to both corporate
and non-corporate destinations. The network address is translated appropriately and the packet is forwarded
through the IPSec tunnel or through the uplink. This DHCP assignment mode is used for the NAT forwarding
mode.

Local, L3— This DHCP assignment mode is used with the L3 forwarding mode. In this mode, the Virtual
Controller acts as a DHCP server and the gateway, and assigns an IP address from the local subnet. The OAW-
IAP routes the packets sent by clients on its uplink. The Local, L3 subnets can now access corporate network
through the IPsec tunnel. The network address for all traffic generated by clients in Local, L3 subnets are
translated at the source by using the tunnel inner IP to the corporate subnet. However, if corporate access to
Local, L3 is not required, you can configure ACL rules to deny access.

In the AOS-W Instant Ul
To configure a Local or Local,L3 DHCP scope:

Click More > DHCP Server. The DHCP Server window is displayed.

2. Toconfigure a Local or Local,L3 DHCP scopes, click New under Local DHCP Scopes. The New DHCP
Scope window is displayed.

3. Based on type of DHCP scope selected, configure the following parameters:
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Table 41: DHCP Mode: Configuration Parameters

Name Description

Name Enter a name for the DHCP scope.

Type Select any of the following options:

o Local- On selecting Local, the DHCP server for local branch network is used for
keeping the scope of the subnet local to the OAW-IAP. In the NAT mode, the traffic
is forwarded through the IPSec tunnel or the uplink.

e Local, L3-On selecting Local, L3, the Virtual Controller acts as a DHCP server and
gateway. In this mode, the OAW-IAP routes the packets sent by clients and also
adds a route on the switch, after the VPN tunnel is set up during the registration of
the subnet.

VLAN Specify a VLAN ID. To use this subnet, ensure that the VLAN ID specified here is
assigned to an SSID profile. For more information on SSID profile configuration, see
Configuring VLAN Settings for a WLAN SSID Profile on page 97 and Configuring
VLAN for a Wired Profile on page 115

Network Specify the network to use.

Netmask If Local or Local,L3 is selected, specify the subnet mask. The subnet mask and the
network determine the size of subnet.

Excluded address If Local,L3 is selected, specify the IP address to exclude. The value entered in the field
determines the exclusion range of the subnet. Based on the size of the subnet, the IP
addresses that come before or after the IP address value specified in this field are

excluded.
DNS Server If required, specify the IP address of a DNS server for the Local and Local,L3 scopes.
Domain Name If required, specify the domain name for the Local and Local,L3 scopes.
Lease Time Specify a lease time for the client in minutes.
Option Specify the type and a value for the DHCP option. You can configure the organization-

specific DHCP options supported by the DHCP server. For example, 176, 242, and
161. To add multiple DHCP options, click the + icon.

4. Click OK.

In the CLI

To configure Local DHCP scope:

(Instant AP
(Instant AP
(Instant AP
(Instant AP

) (config)# ip dhcp <profile-name>

)

)

)
(Instant AP)

)

)

)

(

(DHCP Profile <profile-name>)# server-type <Local>
(DHCP Profile <profile-name>)# server-vlan <vlan-ID>
(DHCP Profile <profile-name> subnet <IP-address>
(DHCP Profile <profile-name>
(
(
(
(

)

)

) # subnet-mask <subnet-mask>
DHCP Profile <profile-name>)

)

)

)

)

(Instant AP dns-server <name>
(Instant AP) (DHCP Profile <profile-name>
(Instant AP) (DHCP Profile <profile-name>
(Instant AP) (DHCP Profile <profile-name>
(Instant AP) (DHCP Profile <profile-name>

(Instant AP)# commit apply

lease-time <minutes>
option <type> <value>

#
#
#
# domain-name <domain-name>
#
#
# end

To configure Local,L3 DHCP scope:

(Instant AP) (config)# ip dhcp <profile-name>
(Instant AP) (DHCP Profile <profile-name>)# server-type <Local, L3>
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server-vlan <vlan-ID>
subnet <IP-address>

(Instant AP
(Instant AP

DHCP Profile <profile-name>
DHCP Profile <profile-name>

(Instant AP) (DHCP Profile <profile-name> subnet-mask <subnet-mask>
exclude-address <IP-address>

(Instant AP

(Instant AP) (DHCP Profile <profile-name> domain-name <domain-name>

)
)
)
(Instant AP)
)
)
)

(Instant AP) (DHCP Profile <profile-name> lease-time <minutes>
(Instant AP) (DHCP Profile <profile-name>
(Instant AP) (DHCP Profile <profile-name>

(Instant AP)# commit apply

( ) #
( ) #
( ) #
(DHCP Profile <profile-name>) #
(DHCP Profile <profile-name>)# dns-server <name>
( ) #
( ) #
( ) #
) #

option <type> <value>
end

Configuring the Default DHCP Scope for Client IP Assignment

The DHCP server is a built-in server, used for networks in which clients are assigned IP address by the Virtual
Controller. You can customize the DHCP pool subnet and address range to provide simultaneous access to more
number of clients. The largest address pool supported is 2048. The default size of the IP address pool is 512.

When the DHCP server is configured and if the Client IP assignment parameter for an SSID profile is set to
Virtual Controller Assigned, the Virtual Controller assigns the IP addresses to the WLAN or wired clients. By
default, the OAW-IAP automatically determines a suitable DHCP pool for Virtual Controller Assigned networks.
In the current release, the OAW-IAP typically selects the 172.31.98.0/23 subnet. If the IP address of the OAW-
E IAP is within the 172.31.98.0/23 subnet, the OAW-IAP selects the 10.254.98.0/23 subnet. However, this
NOTE mechanism does not guarantee that it would avoid all possible conflicts with the wired network. If your wired
network uses either 172.31.98.0/23 or 10.254.98.0/23, and you experience problems with the Virtual Controller
Assigned networks after upgrading to AOS-W Instant 6.2.1.0-3.4 or later, manually configure the DHCP pool by
following the steps described in this section.

You can configure a domain name, DNS server, and DHCP server for client IP assignment using the AOS-W Instant
Ul or CLI.

In the AOS-W Instant Ul
1. Navigate to More > DHCP Server tab. The DHCP Server tab contents are displayed.

Figure 63 DHCP Servers Window

DHCP Servers Help

Virtual Controller Assigned Networks - Default DHCP Scope

Domain name: i

DNS Server(s): | Lease time: | Minutes v
Network: Mask:

Distributed DHCP Scopes
Distributed DHCP Scopes (0)

MName Type VLAN Branch Subnet
New
Centralized DHCP Scopes

Centralized DHCP Scopes (0)

Name Type VLAN

New
Local DHCP Scopes

Local DHCP Scopes (0)

Name Type VLAN  Network

New

oK Cancel

2. Enter the domain name of the client in the Domain nhame text box.
3. Enterthe IP addresses of the DNS servers separated by a comma(,) in the DNS server (s) text box.
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Enter the duration of the DHCP lease in the Lease time text box.

5. Select Minutes, Hours, or Days for the lease time from the drop-down list next to Lease time. The default lease
timeis 0.

6. Enterthe network range for the client IP addresses in the Network field. The system generates a network range
automatically that is sufficient for 254 addresses. If you want to provide simultaneous access to more number of
clients, specify a larger range.

7. Specify the subnet mask details for the network range in the Mask text box.

E The DNS cache function is only enabled when content-filtering is disabled.
HOTE

8. Click OK to apply the changes.

In the CLI
To configure a DHCP pool:

(Instant AP)
Instant AP)
Instant AP)
)
)
)

( DHCP) # domain-name <domain>
(

(Instant AP

(

(

DHCP) # dns-server <DNS-IP-address>

)
)# lease-time <lease-time>
Instant AP) (DHCP)# subnet <IP-address>
Instant AP) (DHCP)# subnet-mask <subnet-mask>
To view the DHCP database:

(Instant AP)# show ip dhcp database

DHCP Subnet :192.0.2.0

DHCP Netmask :255.255.255.0
DHCP Lease Time (m) :20

DHCP Domain Name :example.com
DHCP DNS Server :192.0.2.1
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Chapter 14

VPN Configuration

This chapter describes the following VPN configuration procedures:

e Understanding VPN Features on page 212

e Configuring a Tunnel from an OAW-IAP to Alcatel-Lucent OmniAccess WLAN Switch on page 212
e Configuring Routing Profiles on page 223

Understanding VPN Features

As OAW-IAPs use a Virtual Controller architecture, the OAW-IAP network does not require a physical controller to
provide the configured WLAN services. However, a physical switch is required for terminating Virtual Private
Networks (VPN) tunnels from the OAW-IAP networks at branch locations to datacenters, where the Alcatel-Lucent
switch acts as a VPN concentrator.

When the VPN is configured, the OAW-IAP acting as the Virtual Controller creates a VPN tunnel to an OmniAccess
WLAN Switch in your corporate office. The switch acts as a VPN end-point and does not supply the OAW-IAP with
any configuration.

The VPN features are recommended for:

o Enterprises with many branches that do not have a dedicated VPN connection to the corporate office.
e Branch offices that require multiple APs.
¢ Individuals working from home, connecting to the VPN.

The survivability feature of OAW-IAPs with the VPN connectivity of OAW-IAPs allows you to provide corporate
connectivity on non-corporate networks.

Configuring a Tunnel from an OAW-IAP to Alcatel-Lucent OmniAccess
WLAN Switch

OAW-IAP supports the configuration of tunneling protocols such as Generic Routing Encapsulation (GRE), IPsec,
and L2TPv3. This section describes the procedure for configuring VPN host settings on an OAW-IAP to enable
communication with a switch in a remote location:

e Configuring an IPSec Tunnel on page 212

e Enabling Automatic Configuration of GRE Tunnel on page 214
e Manually Configuring a GRE Tunnel on page 216

e Configuring an L2TPv3 Tunnel on page 217

Configuring an IPSec Tunnel

An IPsec tunnel is configured to ensure that the data flow between the networks is encrypted. When configured, the
IPSec tunnel to the switch secures corporate data.

You can configure an IPSec tunnel from Virtual Controller using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To configure a tunnel using the IPSec protocol:

1. Click the More > VPN link at the top right corner of the AOS-W Instant Ul. The Tunneling window is displayed.
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2. Select Aruba IPSec from the Protocol drop-down list.

3. Enterthe IP address or fully qualified domain name (FQDN) for the primary VPN/IPSec endpoint in the Primary
host field.

4. Enterthe IP address or FQDN for the backup VPN/IPSec endpoint in the Backup host field. This entry is
optional. When you specify the primary and backup host details, the other fields are displayed.

5. Specify the following parameters. A sample configuration is shown in Figure 64.

a.

To allow the VPN tunnel to switch back to the primary host when it becomes available again, select Enabled
from the Preemption drop-down list. This step is optional.

If Preemption is enabled, specify a value in seconds for Hold time. When preemption is enabled and the
primary host comes up, the VPN tunnel switches back to the primary host after the specified hold-time. The
default value for Hold time is 600 seconds.

To allow the OAW-IAP to create a backup VPN tunnel to the switch along with the primary tunnel, and
maintain both the primary and backup tunnels separately, select Enabled from the Fast failover drop-down
list. When fast failover is enabled and if the primary tunnel fails, the OAW-IAP can switch the data stream to
the backup tunnel. This reduces the total failover time to less than one minute.

To disconnect all wired and wireless users when the system switches during VPN tunnel transition from
primary to backup and backup to primary, set Reconnect user on failover to Enabled.

To configure an interval during which the wired and wireless users are disconnected during a VPN tunnel
switch, specify a value in seconds for Reconnect time on failover within a range of 30—900 seconds. By
default, the reconnection duration is set to 60 seconds.

Specify a value in seconds for Secs between test packets. Based on the configured frequency, the OAW-
IAP can verify if an active VPN connection is available. The default value is 5 seconds, which means that the
OAW-IAP sends one packet to the switch every 5 seconds.

Enter a value for Max allowed test packet loss, to define a number for lost packets, after which the OAW-
IAP can determine that the VPN connection is unavailable. The default value is 2.

Figure 64 |PSec Configuration

Tunneling Help
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Next Cancel

6. Click Next to create routing profiles. When the IPsec tunnel configuration is completed, the packets that are sent
from and received by an OAW-IAP are encrypted.

In the CLI

To configure an IPSec VPN tunnel:

(Instant AP) (config)# vpn primary <name>

(Instant AP) (config)# vpn backup <name>

(Instant AP) (config)# vpn fast-failover

(Instant AP) (config)# vpn hold-time <seconds>

(Instant AP) (config)# vpn preemption

(Instant AP) (config)# vpn monitor-pkt-send-freqg <frequency>
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Instant AP) (config)# vpn monitor-pkt-lost-cnt <count>

Instant AP) (config)# vpn reconnect-user-on-failover

Instant AP) (config)# vpn reconnect-time-on-failover <down time>
Instant AP) (config)# end

(Instant AP)# commit apply

(
(
(
(

Example

(Instant AP) (config)# vpn primary 192.0.2.18

(Instant AP) (config)# vpn backup 192.0.2.18

(Instant AP) (config)# vpn fast-failover

(Instant AP) (config)# vpn preemption

(Instant AP) (config)# ip dhcp distl2

(Instant AP) (DHCP Profile "distL2")# server-type Distributed, L2
(Instant AP) (DHCP Profile "distL2")# server-vlan 2

(

(

(

(DHCP Profile "distL2"
(DHCP Profile "distL2"
(
(
(
(
(

)

(Instant AP )
)

DHCP Profile "distL2")
)

)

)

)

)
)
)
) ip-range 10.15.205.0 10.15.205.255
(Instant AP) subnet-mask 255.255.255.0

) lease-time 86400

)

)

)

)

#
#
(Instant AP #
# default-router 10.15.205.254
#
#
#

(Instant AP) (DHCP Profile "distL2"

(Instant AP) (DHCP Profile "distL2" dns-server 10.13.6.110,10.1.1.50
(Instant AP) (DHCP Profile "distL2" domain-name alcatel-lucent.com
(Instant AP) (DHCP Profile "distL2" client-count 5

Instant AP
Instant AP
Instant AP

config)# ip dhcp local
DHCP Profile "local")# server-type Local

DHCP Profile "local")# server-vlan 200

(
(
(
(

) (

) (

) ( )
Instant AP) (DHCP Profile "local")# subnet 172.16.200.1
(Instant AP) (DHCP Profile "local")# subnet-mask 255.255.255.0
(Instant AP) (DHCP Profile "local")# lease-time 86400
(Instant AP) (DHCP Profile "local")# dns-server 10.13.6.110,10.1.1.50
(Instant AP) (DHCP Profile "local")# domain-name alcatel-lucent.com

To view VPN configuration:

Instant Access Point# show vpn config

Enabling Automatic Configuration of GRE Tunnel

GRE is a tunnel protocol for encapsulating multicast, broadcast, and L2 packets between a switch and the OAW-
IAPs. The automatic GRE feature uses the IPSec connection between the OAW-IAP and switch to send the control
information for setting up a GRE tunnel. When automatic GRE configuration is enabled, a single IPSec tunnel
between the OAW-IAP cluster and the switch and one or several GRE tunnels are created based on the Per-AP
tunnel configuration on the OAW-IAP. When this feature is enabled on the OAW-IAP, no manual configuration is
required on the switch to create the GRE tunnel.

NOTE

Automatic configuration of the GRE tunnel is supported only on Alcatel-Lucent switches. This feature is not
supported on switches running AOS-W Instant 6.3.x.x or lower versions.

You can configure an OAW-IAP to automatically set up a GRE tunnel from the OAW-IAP to Switch by using the
AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. Click the More > VPN link at the top right corner of the AOS-W Instant Ul. The Tunneling window is displayed.
2. Select Aruba GRE from the Protocol drop-down list.

3. Enterthe IP address or FQDN for the main VPN/IPSec endpoint in the Primary host field.

4

Enter the IP address or FQDN for the backup VPN/IPSec endpoint in the Backup host field. This entry is
optional. When you enter the primary host IP address and backup host IP address, other fields are displayed.

5. Specify the following parameters. A sample configuration is shown in Figure 65.
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a. Toallow the VPN tunnel to switch back to the primary host when it becomes available again, select Enabled
from the Preemption drop-down list. This step is optional.

b. If Preemption is enabled, specify a value in seconds for Hold time. When preemption is enabled and the
primary host comes up, the VPN tunnel switches to the primary host after the specified hold time. The default
value for Hold time is 600 seconds.

c. Toallow the OAW-IAP to create a backup VPN tunnel to the switch along with the primary tunnel, and
maintain both the primary and backup tunnels separately, select Enabled or Disabled from the Fast failover
drop-down list. If the primary tunnel fails, the OAW-IAP can switch the data stream to the backup tunnel. This
reduces the total failover time to less than one minute.

d. Todisconnect all wired and wireless users when the system switches during VPN tunnel transition from
primary to backup and backup to primary, set Reconnect user on failover to Enabled.

e. To configure an interval for which wired and wireless users are disconnected during a VPN tunnel switch,
specify a value in seconds for Reconnect time on failover within the range of 30—900 seconds. By default,
the reconnection duration is set to 60 seconds.

f. Specify a value in seconds for Secs between test packets. Based on the configured frequency, the OAW-
IAP can verify if an active VPN connection is available. The default value is 5 seconds, which means that the
OAW-IAP sends one packet to the controller every 5 seconds.

g. Enteravalue for Max allowed test packet loss, to define a number for lost packets, after which the OAW-
IAP can determine that the VPN connection is unavailable. The default value is 2.

h. Select Enabled or Disabled from the Per-AP tunnel drop-down list. The administrator can enable this option
to create a GRE tunnel from each OAW-IAP to the VPN/GRE Endpoint rather than the tunnels created just
from the master OAW-IAP. When enabled, the traffic to the corporate network is sent through a Layer-2 GRE
tunnel from the OAW-IAP itself and need not be forwarded through the master OAW-IAP.

Figure 65 Alcatel-Lucent GRE Configuration

Tunneling Help
il Controller

Controller

Protocol: Aruba GRE :

Primary host: [192.0.2.2

Backup host: [192.0.2.4

Freemption: Enabled :

Hold time: 600 SEC.

Fast failover: Enabled :
Reconnect user on failover: | Enabled :

Reconnect time on failover: |60 SEC.

Secs between test packets: |5

Max allowed test packet
loss:

Per-4F tunnel: Enabled :

Mext Cancel

6. Click Next to continue.
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In the CLI

To enable automatic configuration of the GRE tunnel:

Instant AP) (config)# end
Instant AP)# commit apply

(Instant AP) (config)# vpn gre-outside

(Instant AP) (config)# vpn primary <name/IP-address>
(Instant AP) (config)# vpn backup <<name/IP-address>>
(Instant AP) (config)# vpn fast-failover

(Instant AP) (config)# vpn hold-time <seconds>

(Instant AP) (config)# vpn preemption

(Instant AP) (config)# vpn monitor-pkt-send-freq <frequency>
(Instant AP) (config)# vpn monitor-pkt-lost-cnt <count>
(Instant AP) (config)# vpn reconnect-user-on-failover
(Instant AP) (config)# vpn reconnect-time-on-failover <down time>
(

(

To view VPN configuration details:

(Instant AP)# show vpn config

Manually Configuring a GRE Tunnel

You can also manually configure a GRE tunnel by configuring the GRE tunnel parameters on the OAW-IAP and
switch. This procedure describes the steps involved in the manual configuration of a GRE tunnel from Virtual
Controller by using the AOS-W Instant Ul or CLI.

During the manual GRE setup, you can either use the Virtual Controller IP or the OAW-IAP IP to create the GRE
tunnel at the controller side depending upon the following OAW-IAP settings:

If a Virtual Controller IP is configured and if Per-AP tunnel is disabled, the Virtual Controller IP is used to create
the GRE tunnel.

If a Virtual Controller IP is not configured or if Per-AP tunnel is enabled, the OAW-IAP IP is used to create the
GRE tunnel.

For information on the GRE tunnel configuration on switch, see AOS-W Instant User Guide.

In the AOS-W Instant Ul
1. Click the More > VPN link at the top right corner of the AOS-W Instant Ul. The Tunneling window is displayed.
2. Select Manual GRE from the Protocol drop-down list.
3. Specify the following parameters. A sample configuration is shown in Figure 66.
a. EnteranIP address or the FQDN for the main VPN/GRE endpoint.
b. Enter a value for the GRE type parameter.

c. Select Enabled or Disabled from the Per-AP tunnel drop-down list. The administrator can enable this option
to create a GRE tunnel from each OAW-IAP to the VPN/GRE Endpoint rather than the tunnels created just
from the master OAW-IAP. When enabled, the traffic to the corporate network is sent through a Layer-2 GRE
tunnel from the OAW-IAP itself and need not be forwarded through the master OAW-IAP.

D By default, the Per-AP tunnel option is disabled.

HNOTE
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Figure 66 Manual GRE Configuration

Tunneling Help
il Controller
Controller

Protocol: Manual GRE

Host: 192.0.2.15
GRE type: 1
Per-AP tunnel: Enabled :

Next Cancel

4. Click Next to continue. When the GRE tunnel configuration is completed on both the OAW-IAP and Switch, the
packets sent from and received by an OAW-IAP are encapsulated, but not encrypted.

In the CLI

To configure a manual GRE VPN tunnel:

(config) # gre primary <name>
(Instant (config)# gre type <type>
(Instant AP) (config)# gre per-ap-tunnel
(Instant AP) (config)# end
(Instant AP)# commit apply

(Instant AP)
AP)

To view VPN configuration details:
Instant Access Point# show vpn config

To configure GRE tunnel on the switch:

(host) (config) # interface tunnel <Number>
(host) (config-tunnel)# description <Description>
(host) (config-tunnel) # tunnel mode gre <ID>

) (
) (
) (
(host) (config-tunnel) # tunnel source <controller-IP>
) (
) (
) (

(host) (config-tunnel)# tunnel destination <AP-IP>
(host) (config-tunnel)# trusted
(host) (config-tunnel)# tunnel vlan <allowed-VLAN>

Configuring an L2TPv3 Tunnel

The Layer 2 Tunneling Protocol version 3 (L2TPv3) feature allows OAW-IAP to act as L2TP Access Concentrator
(LAC) and tunnel all wireless clients L2 traffic from AP to L2TP Network Server (LNS). In a centralized L2 model, the
VLAN on the corporate side are extended to remote branch sites. Wireless clients associated with OAW-IAP gets
the IP address from the DHCP server running on LNS. For this, AP has to transparently allow DHCP transactions
through the L2TPv3 tunnel. In this release, L2TPv3 supports the following:

e AOS-W Instant supports tunnel and session configuration, and uses Control Message Authentication (RFC
3931) for tunnel and session establishment. Each L2TPv3 tunnel supports one data connection and this
connection is termed as an L2TPv3 session.

e Each OAW-IAP supports tunneling over UDP only.

o Ifthe primary LNS is down, it fails over to the backup LNS. L2TPv3 has one tunnel profile and under this, one
primary peer and a backup peer are configured. If the primary tunnel creation fails or if the primary tunnel gets
deleted, the backup starts. The following two failover modes are supported:
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= Preemptive: In this mode, if the primary comes up when the backup is active, the backup tunnel is deleted and
the primary tunnel resumes as an active tunnel. If you configure the tunnel to be preemptive, and when the
primary tunnel goes down, it starts the persistence timer which tries to bring up the primary tunnel.

= Non-Preemptive: In this mode, when the back tunnel is established after the primary tunnel goes down, it
does not make the primary tunnel active again.

e L2TPV3 configuration is supported on the following OAW-IAPs:
= OAW-RAP108
= OAW-RAP109
= OAW-IAP135

You can configure an L2TPv3 tunnel and session profiles through the AOS-W Instant Ul or CLI.
In the AOS-W Instant Ul

1. Click the More > VPN link at the top right corner of the AOS-W Instant Ul. The Tunneling window is displayed.
Figure 67 L3TPv3 Tunneling

Tunneling Help
1

Controller

Protocol: ’mlz[

Tunnel profile: New

Session profile:

Show advanced options Next Cancel

2. Select L2TPv3 from the Protocol drop-down list.
3. Configure the tunnel profile:

a. Enter the tunnel name to be used for tunnel creation.
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Figure 68 Tunnel Configuration

Tunnel Configuration

Primary Peer address: |lU.U.D.63

Backup Peer address: |10.D.D.65

Peer UDP port: [z000

Local UDP port: 1701

Hello interval: |150 sec,
Message digest type: | MDS El
Shared key: |nuun

Checksum: | Dizabled El
Failover mode: | nan-Preemptive El
Failover retry interval: |80 =ec.

Failover retry count: |5

MTU: 1570

0K Cancel

b. Enterthe primary server IP address.

c. Enterthe remote end backup tunnel IP address. This is an optional field and is required only when backup
server is configured.

d. Enterthe remote end UDP port number. The default value is 1701.

e. Enterthe interval at which the hello packets are sent through the tunnel. The default value is 60 seconds.

f. Select the message digest as MD5 or SHA used for message authentication.

g. Enter ashared key for the message digest. This key should match with the tunnel end point shared key.

h. If required, select the failover mode as Primary or Backup (when the backup server is available).

i. Specify a value for the tunnel MTU value if required. The default value is 1460.
j- Click OK.

4. Configure the session profile:
a. Enterthe session name to be used for session creation.

Figure 69 Session Configuration

Session Configuration

Profile name:

Tunnel profile name: test hd
Tunnel IF address:

Tunnel Netmask:

Tunnel VLAN:

Cookie Len: 0 v
Cookie:

Remote end ID:

Default 12 specific sublayer:

OK | Cancel

b. Enterthe tunnel profile name where the session will be associated.

c. Configure the tunnel IP address with the corresponding network mask and VLAN ID. This is required to reach
an AP from a corporate network. For example, SNMP polling.
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not set.
e. Specify the remote end ID.
f.
g. Click OK.

5. Click Next to continue.

In the CLI

To configure an L2TPv3 VPN tunnel profile:

(Instant AP) (config)# 12tpv3 tunnel

(Instant AP) (L2TPv3
addr_ tunnel>
(Instant AP) (L2TPv3
addr_ tunnel>
(Instant AP) (L2TPv3
(Instant AP) (L2TPv3
(Instant AP) (L2TPv3
count>

(Instant AP) (L2TPv3
<interval in sec>
(Instant AP) (L2TPv3
(Instant AP) (L2TPv3
(Instant AP) (L2TPv3
(Instant AP) (L2TPv3
algo>

(Instant AP) (L2TPv3
(Instant AP) (L2TPv3
(Instant AP) (L2TPv3
(Instant AP)# commit

Tunnel
Tunnel

Tunnel
Tunnel
Tunnel

Tunnel

Tunnel
Tunnel
Tunnel
Tunnel

Tunnel
Tunnel
Tunnel

apply

Profile

Profile

Profile
Profile
Profile

Profile

Profile
Profile
Profile
Profile

Profile
Profile
Profile

To configure an L2TPv3 session profile:

Select the cookie length and enter a cookie value corresponding to the length. By default, the cookie length is

If required, enable default 12 specific sublayer in the L2TP session.

<12tpv3 tunnel profile>

<12tpv3 tunnel profile>)#
<12tpv3_tunnel profile>)#

<12tpv3_tunnel profile>)#
<12tpv3_tunnel profile>)#
<12tpv3 tunnel profile>)#

<12tpv3_tunnel profile>)#

<12tpv3_tunnel profile>)#
<12tpv3_tunnel profile>)#
<12tpv3 tunnel profile>)#
<12tpv3 tunnel profile>)#

<12tpv3_tunnel profile>)#
<12tpv3_tunnel profile>)#
<12tpv3_tunnel profile>)#

primary peer-address <peer ip
backup peer-address <peer ip

checksum
failover-mode <mode>
failover-retry-count <retry

failover-retry-interval

hello-timeout <interval in sec>
local-port <local udp port>
peer-port <peer udp port>
message-digest-type <digest

secret-key <key>
mtu <tunnel MTU>
end

(Instant AP) (config)# 12tpv3 session <12tpv3 session profile>

(Instant
value <co
(Instant
name _to a
(Instant

AP)
okie val>
AP)
ssociate>
AP)

(L2TPv3 Tunnel Profile <12tpv3 session profile>)#
(L2TPv3 Tunnel Profile <12tpv3 session profile>)#

(L2TPv3 Tunnel Profile <12tpv3 session profile>)#

tunnel> mask <tunnel mask> vlan <tunnel mgmt vlan>

(Instant
(Instant

AP)
AP)

(Instant AP)# commit apply

Example

(Instant
(Instant
(Instant
(Instant
(Instant
(Instant
(Instant
(Instant
(Instant
(Instant
(Instant
(Instant
(Instant

AP) (config)# 12tpv3 tunnel test tunnel

(
AP) (L2TPv3
AP) (L2TPv3
AP) (L2TPv3
AP) (L2TPv3
AP) (L2TPv3
AP) (L2TPv3
AP) (L2TPv3
AP) (L2TPv3
AP) (L2TPv3
AP) (L2TPv3
AP) (L2TPv3

AP) # commi

Tunnel
Tunnel
Tunnel
Tunnel
Tunnel
Tunnel
Tunnel
Tunnel
Tunnel
Tunnel
Tunnel

t apply

Profile
Profile
Profile
Profile
Profile
Profile
Profile
Profile
Profile
Profile
Profile

"test tunnel”
"test tunnel"
"test tunnel"
"test tunnel"
"test tunnel"
"test tunnel”
"test tunnel”
"test tunnel”
"test tunnel”
"test tunnel"
"test tunnel"

(L2TPv3 Tunnel Profile <12tpv3 session profile>)#
(L2TPv3 Tunnel Profile <12tpv3 session profile>)#

cookie len <len of cookie>
12tpv3 tunnel <12tpv3 tunnel
tunnel-ip <local ip addr

default-12-specific-sublayer
end

primary peer-address 10.0.0.65
backup peer-address 10.0.0.63
no checksum

failover-mode non-preemptive
failover-retry-count 5
failover-retry-interval 80
hello-timeout 150

mtu 1570

peer-port 3000

secret-key testl23

end
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(Instant AP) (config) # 12tpv3 session test session

(Instant AP) (L2TPv3 Session Profile "test session")# cookie len 4 value 12345678

(Instant AP) (L2TPv3 Session Profile "test session")# 12tpv3 tunnel test tunnel

(Instant AP) (L2TPv3 Session Profile "test session")# tunnel-ip 1.1.1.1 mask 255.255.255.0 vlan
5

(Instant AP) (L2TPv3 Tunnel Profile "test tunnel")# end

(Instant AP)# commit apply

To view L2TPv3 configuration:

(Instant AP)# show 12tpv3 config

L2TPV3 Tunnel configuration

Tunnel Profile Primary Peer Backup Peer Peer UDP Port Local UDP Port Hello Interval Host Name
MTU Message Digest Type secret Key Failover Mode Failover Retry Count Retry Interval Checksum

test tunnel 10.0.0.63 10.0.0.65 3000 1701 150 Instant-C4:42:98 1570 MD5
625beed39fadff3424edb3082eded48fa non-preemptive 5 80 Disabled

L2TPV3 Session configuration

Session Name Tunnel Name Local tunnel IP Tunnel Mask Tunnel Vlan Session Cookie Length Session
Cookie Session Remote End ID

test session 1.1.1.1 255.255.255.0 5 0 0 O

To view L2TPv3 global configuration:

(Instant AP)# show 12tpv3 global parameter

L2TPV3 Global configuration

Instant-C4:42:98

To view L2TPV3 session status:

(Instant AP)# show 12tpv3 session status

Session 1821009927 on tunnel 858508253:-

type: LAC Incoming Call, state: ESTABLISHED
created at: Jul 2 04:58:45 2013

administrative name: 'test session' (primary)
created by admin: YES, peer session id: 12382
session profile name: test session primary

data sequencing required: OFF

use data sequence numbers: OFF

Peer configuration data:-

data sequencing required: OFF

framing types:

data rx packets: 16, rx bytes: 1560, rx errors: 0 rx cookie error 0
data tx packets: 6, tx bytes: 588, tx errors: 0

To view L2TPV3 tunnel status:
(Instant AP)# show 12tpv3 tunnel status
Tunnel 858508253, from 10.13.11.29 to 10.13.11.157:-

state: ESTABLISHED
created at: Jul 2 04:58:25 2013
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administrative name: 'test tunnel' (primary)
created by admin: YES, tunnel mode: LAC, persist: YES
local host name: Instant-C4:42:98

peer tunnel id: 1842732147, host name: arubal600pop636635.hsbtst2.aus

UDP ports: local 1701, peer 3000

session limit: 0, session count: 1

tunnel profile: test tunnel primary, peer profile: default
session profile: default

hello timeout: 150, retry timeout: 80, idle timeout: 0

rx window size: 10, tx window size: 10, max retries: 5

use udp checksums: OFF

do pmtu discovery: OFF, mtu: 1460

trace flags: PROTOCOL FSM API AVPDATA FUNC XPRT DATA SYSTEM CLI

peer vendor name: Katalix Systems Ltd. Linux-2.6.32-358.2.1.el6.x86 64

peer protocol version: 1.0, firmware O

peer rx window size: 10

Transport status:-

ns/nr: 98/97, peer 98/96

cwnd: 10, ssthresh: 10, congpkt acc: 9
Transport statistics:-

out-of-sequence control/data discards: 0/0

ACKs tx/txfail/rx: 0/0/96

retransmits: 0, duplicate pkt discards: 0, data pkt discards:
hellos tx/txfail/rx: 94/0/95

control rx packets: 193, rx bytes: 8506

control tx packets: 195, tx bytes: 8625

data rx packets: 0, rx bytes: 0, rx errors: 0
data tx packets: 6, tx bytes: 588, tx errors: 0
establish retries: O

To view L2TPv3 tunnel config:

(Instant AP)# show 12tpv3 tunnel config

Tunnel profile test tunnel primary

12tp host name: Instant-C4:42:98

local UDP port: 1701

peer IP address: 10.0.0.65

peer UDP port: 3000

hello timeout 150, retry timeout 80, idle timeout O
rx window size 10, tx window size 10, max retries 5
use UDP checksums: OFF

do pmtu discovery: OFF, mtu: 1570

framing capability: SYNC ASYNC

bearer capability: DIGITAL ANALOG

use tiebreaker: OFF

peer profile: NOT SET

session profile: NOT SET

0

trace flags: PROTOCOL FSM API AVPDATA FUNC XPRT DATA SYSTEM CLI

Tunnel profile test tunnel backup

12tp host name: arubal600pop658509.hsb-dev4.aus
local UDP port: 1701

peer IP address: 10.13.11.157

peer UDP port: 1701

hello timeout 60, retry timeout 1, idle timeout O
rx window size 10, tx window size 10, max retries 5
use UDP checksums: OFF

do pmtu discovery: OFF, mtu: 1460

framing capability: SYNC ASYNC

bearer capability: DIGITAL ANALOG

(x86_64)
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use tiebreaker: OFF

peer profile: NOT SET

session profile: NOT SET

trace flags: PROTOCOL FSM API AVPDATA FUNC XPRT DATA SYSTEM CLI

To view L2TPv3 system statistics:

(Instant AP)# show 12tpv3 system statistics

L2TP counters:-—

Total messages sent: 99, received: 194, retransmitted: 0
illegal: 0, unsupported: 0, ignored AVPs: 0, vendor AVPs: 0
Setup failures: tunnels: 0, sessions: 0

Resource failures: control frames: 0, peers: 0

tunnels: 0, sessions: 0

Limit exceeded errors: tunnels: 0, sessions: 0

Frame errors: short frames: 0, wrong version frames: 0O
unexpected data frames: 0, bad frames: 0

Internal: authentication failures: 0, message encode failures: 0
no matching tunnel discards: 0, mismatched tunnel ids: 0

no matching session discards: 0, mismatched session ids: 0

total control frame send failures: 0, event queue fulls: 0
Message counters:-—

Message RX Good RX Bad TX

ILLEGAL 0

SCCRQ 0
SCCRP 1
SCCCN 0
STOPCCN
RESERVED1
HELLO 95
OCRQ
OCRP
OCCN
ICRQ
ICRP
ICCN 0 O
RESERVED2 0 0 O
CDN 0 0 O

WEN O 0 O

SLI 0 0 O

= O O O O
O O O O O
O O O Fr O
e
o O O

o O O O O
H O RFr OO o o

Configuring Routing Profiles

OAW-IAPs can terminate a single VPN connection on an OmniAccess WLAN Switch. The routing profile defines the
corporate subnets which need to be tunneled through IPSec. You can configure routing profiles to specify a policy
based on routing into the VPN tunnel using the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul
To configure a routing profile:

1. Click Routing in the Tunneling window. The routing details are displayed.
2. Click New. The route parameters to configure are displayed.
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Figure 70 Tunneling— Routing

Tunneling

| Controller pa Routing
Routing Table

Routes (0)
Destination MNetmask Gateway

Route

Destination: l

Netmask: |
Gateway: |

0K  Cancel

3. Update the following parameters:

o Destination— Specify the destination network that is reachable through the VPN tunnel. This defines the IP or

subnet that must reach through the IPsec tunnel. Traffic to the IP or subnet defined here will be forwarded
through the IPsec tunnel.

o Netmask— Specify the subnet mask to the destination defined for Destination.

o Gateway— Specify the gateway to which traffic must be routed. This IP address must be the switch IP
address on which the VPN connection is terminated. If you have a primary and backup host, configure two
routes with the same destination and netmask, but ensure that the gateway is the primary switch IP for one
route and the backup switch IP for the second route.

4. Repeat step 3 to create the required number of routing profiles.
5. Click OK.

6. Click Finish.

In the CLI

(Instant AP) (config)# routing-profile

(Instant AP) (Routing-profile)# route <destination> <mask> <gateway>
(Instant AP) (Routing-profile)# end

(Instant AP)# commit apply
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Chapter 15

IAP-VPN Deployment

This section provides the following information:

e Understanding IAP-VPN Architecture on page 225
e Configuring OAW-IAP and Switch for IAP-VPN Operations on page 227

Understanding IAP-VPN Architecture

The IAP-VPN architecture includes the following two components:

o OAW-IAPs at branch sites
e Switch at the datacenter

The master OAW-IAP at the branch acts as the VPN endpoint and the switch at the datacenter acts as the VPN
concentrator. When an OAW-IAP is set up for VPN, it forms an IPsec tunnel to the switch to secure sensitive
corporate data. IPsec authentication and authorization between the switch and the OAW-IAPs is based on the RAP
whitelist configured on the switch.

Only the master AP in an OAW-IAP cluster forms the VPN tunnel.

From the switch perspective, the master OAW-IAPs that form the VPN tunnel are considered as VPN clients. The
switch terminates VPN tunnels and routes or switches VPN traffic. The OAW-IAP cluster creates an IPSec or GRE
VPN tunnel from the Virtual Controller to a OmniAccess WLAN Switch in a branch office. The switch only acts an
IPSec or GRE VPN end-point and it does not configure the OAW-IAP.

IAP-VPN Scalability Limits

The switch scalability in IAP-VPN architecture depends on factors such as IPsec tunnel limit, Branch ID limit and
datapath route table limit. The following table provides the IAP-VPN scalability information for various switch
platforms:

Table 42: /AP-VPN Scalability

Platforms Branches Routes L3 Mode Users NAT Users Total L2 Users
3200 1000 1000 64000

3400 2000 2000 64000

3600 8000 8000 64000

M3 8000 8000 64000

7210 8000 8000 64000

7220 16000 16000 128000

N/A N/A
7240 32000 32000 128000

o Branches—The number of IAP-VPN branches that can be terminated on a given switch platform.
e Routes—The number of L3 routes supported on the switch.
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L3 mode and NAT mode users—The number of trusted users supported on the switch. There is no scale impact
on the switch. They are limited only by the number of clients supported per OAW-IAP.

L2 mode users—The number of L2 mode users are limited to 128000 for 7220/7240 and 64000 across all
platforms.

IAP-VPN Forwarding Modes
The following forwarding modes are supported in the IAP-VPN scenario.

Local mode

Centralized L2 mode
Distributed L2 mode
Distributed L3 mode

The forwarding modes determine whether the DHCP server and default gateway for clients reside in the branch or at
the datacenter. These modes do not determine the firewall processing or traffic forwarding behavior. The Virtual
Controller enables different DHCP pools (various assignment modes) in addition to allocating IP subnets for each
branch. The Virtual Controller allows different modes of forwarding of traffic from the clients on a VLAN with a VPN
tunnel. The forwarding modes are associated with various modes of DHCP address assignment modes.

Local or NAT Mode

In this mode, the OAW-IAP cluster at that branch has a local subnet and the master OAW-IAP of the cluster acts as
the DHCP server and gateway for clients. The local mode provides VPN capabilities using the inner IP of the IAP-
VPN IPsec tunnel. The source IP for all client traffic is translated and the traffic destined for the corporate network is
translated using the VPN tunnel IP address of the OAW-IAP, and is forwarded through the IPsec VPN tunnel. The
traffic destined for the non-corporate network is translated using the IP address of the IAP and is forwarded through
the uplink.

HNOTE

When the local mode is used for forwarding client traffic, hosts on the corporate network cannot establish
connections to the clients on the OAW-IAP, because the source address of the clients is translated.

L2 Switching Mode

In this mode, the traffic destined for the corporate network is bridged through the VPN tunnel to the switch. The
traffic destined for the non-corporate network is translated using the IP address of the OAW-IAP and is forwarded
through the uplink.

When an OAW-IAP registers with the switch, and is configured to use the L2 DHCP scope, the switch automatically
adds the VPN tunnel associated to this OAW-IAP into the VLAN multicast table. This allows the clients connecting
to the L2 mode VLAN to be part of the same L2 broadcast domain on the switch.

Distributed L2 Mode

In this mode, the OAW-IAP assigns an |IP address from the configured subnet and forwards traffic to both corporate
and non-corporate destinations. Clients receive the corporate IP with Virtual Controller as the DHCP server. The
default gateway for the client still resides in the datacenter and hence this mode is an L2 extension of corporate
VLAN to remote site. Either the controller or an upstream router can be the gateway for the clients. Client traffic
destined to datacenter resources is forwarded by the Master AP (through the IPSec tunnel) to the client's default
gateway in the datacenter.

Centralized L2 Mode

The centralized L2 mode extends the corporate VLAN or broadcast domain to remote branches. The DHCP server
and the gateway for the clients reside in the datacenter. Either the switch or an upstream router can be the gateway
for the clients. For DHCP services in centralized L2 mode, Alcatel-Lucent recommends using an external DHCP

| IAP-VPN Deployment AOS-W Instant 6.4.0.2-4.1 | User Guide



server and not the DHCP server on the switch. Client traffic destined to datacenter resources is forwarded by the
master OAW-IAP (through the IPsec tunnel) to the client's default gateway in the datacenter.

L3 Routing Mode

In this mode, the traffic destined for the corporate network is routed through the VPN tunnel to the switch. The traffic
destined for the non-corporate network is translated using the IP address of the OAW-IAP and is forwarded through
the uplink.

When an OAW-IAP registers with the switch and is configured to use the L3 DHCP scope, the Switch adds a route
to enable the routing of traffic from the corporate network to clients on this subnet in the branch.

Distributed L3 mode

The distributed L3 mode contains all broadcast and multicast traffic to a branch. The distributed L3 mode reduces the
cost and eliminates the complexity associated with the classic site-site VPN. However, this mode is very similar to
a classic site-site IPsec VPN where two VPN endpoints connect individual networks together over a public network.

In distributed L3 mode, each branch location is assigned a dedicated subnet. The master AP in the branch manages
the dedicated subnet and acts as the DHCP server and gateway for clients. Client traffic destined to datacenter
resources is routed to the Alcatel-Lucent controller through the IPsec tunnel which then routes the traffic to the
appropriate corporate destinations.

Centralized L3 Mode

For centralized L3 clients, the virtual controller acts as a DHCP relay agent that forwards the DHCP traffic to the
DHCP server located behind the controller in the corporate network and reachable through the IPSec tunnel. The
centralized L3 VLAN IP is used as the source IP. The IP address is obtained from the DHCP server.

Configuring OAW-IAP and Switch for IAP-VPN Operations

This section describes the configuration procedures to perform on the OAW-IAP and switch for generic use cases.
For information on specific deployment scenarios, see |AP-VPN Deployment Scenarios on page 359.

Configuring an OAW-IAP network for IAP-VPN operations

HOTE

This section describes the configuration procedures to perform on the OAW-IAP for generic use cases. For
information on specific deployment scenarios, see IAP-VPN Deployment Scenarios on page 359.

An OAW-IAP network requires the following configuration for IAP-VPN operations.

Defining the VPN host settings
Configuring Routing Profiles
Configuring DHCP Profiles
Configuring an SSID or Wired Port
Enabling Dynamic RADIUS Proxy

Configuring Enterprise Domains

IZEE L

Defining the VPN host settings

The VPN endpoint on which a master OAW-IAP terminates its VPN tunnel is considered as the host. A master AP in
an OAW-IAP network can be configured with a primary and backup host to provide VPN redundancy. You can define
VPN host settings through More>VPN>Controller in the Ul.

You can configure the following VPN profiles for the IAP-VPN operations. For more information, see Configuring a
Tunnel from an OAW-IAP to Alcatel-Lucent OmniAccess WLAN Switch on page 212.
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e |PSec
e Aruba GRE
e Manual GRE

Configuring Routing Profiles

The routing profile on the OAW-IAP determines whether the traffic destined to a subnet must be tunneled through
IPSec or bridged locally. If the routing profile is empty, the client traffic will always be bridged locally. For example, if
the routing profile is configured to tunnel 10.0.0.0 /8, traffic destined to 10.0.0.0 /8 will be forwarded through the
IPsec tunnel and the traffic to all other destinations is bridged locally.

You can also configure a routing profile with 0.0.0.0 as gateway to allow both client and IAP traffic to be routed
through a non-tunnel route. If the gateway is in the same subnet as uplink IP address, it is used as a static gateway
entry. A static route can be added on all master and slave OAW-IAPs for these destinations. The VPN traffic from
the local subnet of OAW-IAP or the virtual controller IP address in the local subnet is not routed to tunnel, but will be
switched to the relevant VLAN. For example, when a 0.0.0.0/0.0.0.0 routing profile is defined, to bypass certain IPs,
you can add a route to the IP by defining 0.0.0.0 as the destination, thereby forcing the traffic to be routed through the
default gateway of the OAW-IAP.

You can configure routing profiles through More>VPN>Controller Ul. For step-by-step procedural information on
configuring routing profile, see Configuring Routing Profiles on page 223.

HNOTE

HNOTE

The OAW-IAP network has only one active tunnel even when fast failover enabled. At any given time, traffic can
be tunneled only to one VPN host.

Configuring DHCP Profiles

You can create DHCP profiles to determine the IAP-VPN mode of operation. An OAW-IAP network can have
multiple DHCP profiles configured for different modes of IAP-VPN. You can configure up to eight DHCP profiles. For
more information on the IAP-VPN modes of operation, see |IAP-VPN Forwarding Modes on page 226.

You can create any of the following types of DHCP profiles for the IAP-VPN operations:

e Local

e Local L3

o Distributed L2
o Distributed L3
e Centralized

For more information on configuring DHCP profiles, see Configuring DHCP Scopes on page 203..

A centralized L2 or distributed L2 VLAN or subnet cannot be used to serve APs in a hierarchical mode of
deployment. Ensure that the physical IP of the APs connecting to the master AP in hierarchical mode of
deployment is not on a VLAN or subnet that is in centralized or distributed L2 mode of operation. For information on
hierarchical mode of deployment, see Understanding Hierarchical Deployment on page 120.

Configuring an SSID or Wired Port

For a client to connect to the IAP-VPN network, an SSID or wired port profile on an OAW-IAP must be configured
with appropriate IAP-VPN mode of operation. The VLAN configuration in an SSID or wired port profile determines
whether an SSID or wired port is configured for the IAP-VPN operations.

To configure an SSID or wired port for a specific IAP-VPN mode, the VLAN ID defined in the SSID or wired port
profile must match the VLAN ID defined in the DHCP profile configuration. If the VLAN assignment for an SSID or
wired port profile is set to Virtual controller assigned, default, or a static VLAN ID that does not match the VLAN 1D
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configured in the DHCP profiles, the IAP-VPN operations are affected. For example, if alocal DHCP profile is
configured with a VLAN ID of 200, the VLAN configuration on the SSID must be set to a static VLAN ID 200.

For information on how to configure an SSID or wired port profile, seeWireless Network Profiles on page 93 and
Configuring a Wired Profile on page 113 respectively.

Enabling Dynamic RADIUS Proxy

The RADIUS server can be deployed at different locations and VLANSs. In most cases, a centralized RADIUS or
local server is used to authenticate users. However, some user networks can use a local RADIUS server for
employee authentication and a centralized RADIUS based captive portal server for guest authentication. To ensure
that the RADIUS traffic is routed to the required RADIUS server, the dynamic RADIUS proxy feature must be
enabled. When enabled, dynamic RADIUS proxy ensures that all the RADIUS traffic is sourced from the Virtual
Controller IP orinner IP of the OAW-IAP IPsec tunnel depending on the RADIUS server IP and routing profile.

Ensure that a static Virtual Controller IP is configured before enabling dynamic RADIUS proxy, in order to tunnel
the RADIUS traffic to the central RADIUS server in the datacenter.

NOTE
For information on enabling dynamic RADIUS proxy, see Configuring Dynamic RADIUS Proxy Parameters on page
163.
Configuring Enterprise Domains
By default, all the DNS requests from a client are forwarded to the clients DNS server. In a typical OAW-IAP
deployment without VPN configuration, client DNS requests are resolved by the DNS server of clients. For the IAP-
VPN scenario, the enterprise domain settings on the OAW-IAP are used for determining how client DNS requests
are routed. For information on how to configure enterprise domains, see Configuring Enterprise Domains on page
190.
Configuring a Switch for IAP-VPN Operations
Alcatel-Lucent switches provide an ability to terminate the IPSec and GRE VPN tunnels from the OAW-IAP and
provide corporate connectivity to the branch network. For IAP-VPN operations, ensure that the following
configuration and verification procedures are completed on the switch:
e OSPF Configuration
e VPN Configuration
e Branch-ID Allocation
e Branch Status Verification
This section describes the configuration procedures to perform on the switch for generic use cases. For

R information on specific deployment scenarios, see IAP-VPN Deployment Scenarios on page 359.

NOTE

AOS-W Instant 6.3 or later is the recommended version to run on the switches for the IAP-VPN configuration. The
IAP-VPN configuration is not supported on OAW-4306 Series switches.

OSPF Configuration

Open Shortest Path First (OSPF) is a dynamic Interior Gateway routing Protocol (IGP) based on IETF RFC 2328.
The premise of OSPF is that the shortest or fastest routing path is used. The implementation of OSPFv2 allows
switches to deploy effectively in a Layer 3 topology. The switches can act as the default gateway for all clients and
forward user packets to the upstream router.
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Each IAP-VPN can be defined a separate subnet derived from the corporate intranet pool to allow IAP-VPN devices
to work independently. For sample topology and configuration, see AOS-W Instant User Guide.

To redistribute IAP-VPN routes into the OSPF process, use the following command :

(host) (config)

To verify if the redistribution of the IAP-VPN is enabled, use following command:
(host)

# router ospf redistribute rapng-vpn

Redistribute RAPNG

To configure aggregate route for IAP-VPN routes, use the following command:
(host)
To view the aggregated routes for IAP-VPN routes, use the following command:
(host)

(config)

#show ip ospf redistribute

# router ospf aggregate-route rapng-vpn

#show ip ospf rapng-vpn aggregate-routes

RAPNG VPN aggregate routes

201.201.200.0 255.255.252.0 5 268779624
100.100.2.0 255.255.255.0 1 10

To verify the details of configured aggregated route, use the following command:

(host)
(host)

# show ip ospf rapng-vpn aggregated-routes <net> <mask>

Contributing routes of RAPNG VPN aggregate route

100.100.2.64 255.255.255.224 5.5.0.10 10

To view all the redistributed routes:

(host)

OSPF Database Table

#show ip ospf database

ROUTER 9.9.9.9 9.9.9.9 159 0x80000016 Oxee92

O O O O O O o o o o
O O O O OO oo oo

=z
NG
B

N/A
N/A
N/A
N/A
N/A
N/A

O O O O O O o o o

.15
.15
.15
.15
.15
.15
.15
.15
.15
0.15

ROUTER 10.15.148.12 10.15.148.12 166 0x80000016 0x4cOd

NETWORK

NSSA
NSSA
NSSA
NSSA
NSSA
NSSA
NSSA

12.
12.
12.
50.
51.
53.
. 54.
AS EXTERNAL

AS EXTERNAL
AS EXTERNAL
AS EXTERNAL
AS EXTERNAL
AS EXTERNAL
AS EXTERNAL

10

12.
12.
12.
50.
51.
53.
54.

.15.148.12 10.15.148.12 167 0x80000001 0x9674
12.2.0 9.9.9.9 29 0x80000003 0x7b54
12.
12.
40.
41.
43.
44,

12
12

12.
12.
40.
41.
43.
44.

40.
41.
43.
44.

.0
.3
0
1

=W

12

12.
40.
41.
43.
44,

9.9.9.9 164 0x80000008 0Ox63a
2 9.9.9.9 164 0x80000008 0x7b8
9.9.9.9 164 0x80000007 0x8ed4
28 9.9.9.9 164 0x80000007 0x68f6
2 9.9.9.9 164 0x80000007 0x2633
9.9.9.9 164 0x80000007 0x353
9.9.9.9 29 0x80000003 0x8c06

.0 9.9.9.9 169 0x80000001 0x25e4
32 9.9.9.9 169 0x80000001 0x2663
0 9.9.9.9 169 0x80000001 0Oxab80
128 9.9.9.9 169 0x80000001 0x85a2
32 9.9.9.9 169 0x80000001 0x43de
16 9.9.9.9 169 0x80000001 0x20fe

To verify if the redistributed routes are installed or not:

(host)
Codes:
M - mgmt, U - route usable,

#show ip route
C - connected, O - OSPF, R - RIP, S - static
* - candidate default, V - RAPNG VPN

#show ip ospf rapng-vpn aggregate-routes 100.100.2.0 255.255.255.0

Gateway of last resort is Imported from DHCP to network 0.0.0.0 at cost 10

Gateway of last resort is Imported from CELL to network 0.0.0.0 at cost 10
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Gateway of last resort is Imported from PPPOE to network 0.0.0.0 at cost 10
Gateway of last resort is 10.15.148.254 to network 0.0.0.0 at cost 1
S* 0.0.0.0/0 [1/0] via 10.15.148.254%*

Vv 12.12.2.0/24 [10/0] ipsec map

12.12.12.0/25 [10/0] ipsec map

12.12.12.32/27 [10/0] ipsec map

50.40.40.0/24 [10/0] ipsec map

51.41.41.128/25 [10/0] ipsec map

53.43.43.32/27 [10/0] ipsec map

54.44.44.16/28 [10/0] ipsec map

9.9.9.0/24 is directly connected, VLAN9

10.15.148.0/24 is directly connected, VLAN1

43.43.43.0/24 is directly connected, VLAN132

42.42.42.0/24 is directly connected, VLAN123

44.44.44.0/24 is directly connected, VLAN125

182.82.82.12/32 is an ipsec map 10.15.149.69-182.82.82.12
182.82.82.14/32 is an ipsec map 10.17.87.126-182.82.82.14

OO0 << <<

VPN Configuration

The following VPN configuration steps on the switch enable the OAW-IAPs to terminate their VPN connection on the
switch:

Whitelist Database Configuration

The whitelist database is a list of the MAC addresses of the OAW-IAPs that are allowed to establish VPN
connections with the switch. This list can be either stored in the switch database or on an external server.

You can use the following CLI command to configure the whitelist database entry if the switch is acting as the
whitelist database:

(host) # whitelist-db rap add mac-address 00:11:22:33:44:55 ap-group test

The ap-group parameter is not used for any configuration, but needs to be configured. The parameter can be any
valid string.

If an external server is used as the location for the whitelist database, add the MAC addresses of the valid OAW-
IAPs in the external database or external directory server and then configure a RADIUS server to authenticate the
OAW-IAPs using the entries in the external database or external directory server.

If you are using the Windows 2003 server, perform the following steps to configure the external whitelist database on
it. There are equivalent steps available for the Windows Server 2008 and other RADIUS servers.
1. Addthe MAC addresses for all the OAW-IAPs in the Active Directory of the RADIUS server:

a. Open the Active Directory and Computers window, add a new user and specify the MAC address (without
the colon delimiter) of the OAW-IAP for the user name and password.

b. Right-click the user that you have just created and click Properties.
c. Inthe Dial-in tab, select Allow access in the Remote Access Permission section and click OK.
d. Repeat Step a through Step b for all OAW-IAPs.
2. Define the remote access policy in the Intemet Authentication Service:
a. Inthe Internet Authentication Service window, select Remote Access Policies.
Launch the wizard to configure a new remote access policy.
Define filters and select grant remote access permission in the Permissions window.
Right-click the policy that you have just created and select Properties.
In the Settings tab, select the policy condition, and Edit Profile....
In the Advanced tab, select Vendor Specific, and click Add to add new vendor specific attributes.

@ =0 a0 T

Add new vendor specific attributes and click OK.
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h. Inthe IP tab, provide the IP address of the OAW-IAP and click OK.

VPN Local Pool Configuration

The VPN local pool is used to assign an IP Address to the OAW-IAP after successful XAUTH VPN.
(host) # ip local pool "rapngpool" <startip> <endip>

Role Assignment for the Authenticated OAW-IAPs

Define a role that includes a src-nat rule to allow connections to the RADIUS server and for the Dynamic Radius
Proxy in the OAW-IAP to work. This role is assigned to OAW-IAPs after successful authentication.

(host (config) #ip access-list session iaprole
(host) (config-sess-iaprole)#any host <radius-server-ip> any src-nat
(host) (config-sess-iaprole)#any any any permit

(host
(host

)
)
)
(host) (config-sess-iaprole) #!
) (config) #user-role iaprole
)

(config-role) #session-acl iaprole

VPN Profile Configuration
The VPN profile configuration defines the server used to authenticate the OAW-IAP (internal or an external server)
and the role assigned to the IAP after successful authentication.

(host) (config) #aaa authentication vpn default-iap
(host) (VPN Authentication Profile "default-iap") #server-group default
(host) (VPN Authentication Profile "default-iap") #default-role iaprole

Branch-ID Allocation

For branches deployed in distributed L3 and distributed L2 mode, the master AP in the branch and the switch should
agree upon a subnet/IP addresses to be used for DHCP services in the branch. The process or protocol used by the
master AP and the controller to determine the subnet/IP addresses used in a branch is called BID allocation. The
BID allocation process is not essential for branches deployed in local or centralized L2 mode. The following are some
of the key functions of the BID allocation process:

Determines the IP addresses used in a branch for distributed L2 mode
Determines the subnet used in a branch for distributed L3 mode
Avoids IP address or subnet overlap (that is, avoids IP conflict)

Ensures that a branch is allocated the same subnet or range of IP addresses irrespective of which AP in the
branch becomes the master in the IAP cluster

Branch Status Verification

To view the details of the branch information connected to the switch, execute the show iap table command.

Example

This example shows the details of the branches connected to the switch:

(host) #show iap table long

IAP Branch Table

Tokyo-CB:D3:16 6c:£3:7f:cc:42:£8 DOWN 0.0.0.0

Paris-CB:D3:16 6c¢c:f3:7f:cc:3d:04 UP 10.15.207.140 10.15.206.99/29 2
LA 6¢c:f3:7f:cc:42:25 UP 10.15.207.111 10.15.206.24/29 2

Munich d8:c7:c8:cb:d3:16 DOWN 0.0.0.0

London-c0:el 6¢:£f3:7f:cO0:el:bl UP 10.15.207.120 10.15.206.64/29 2
Instant-CB:D3 6c¢c:£f3:7f:cc:42:1e DOWN 0.0.0.0

Delhi 6c¢c:f3:7f:cc:42:ca DOWN 0.0.0.0
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Singapore 6c¢c:f3:7f:cc:42:cb UP 10.15.207.122 10.15.206.120/29 2

Key Bid (Subnet Name)

b3c6e5c. ..

b3c6e5c. ..

b3c65c... 2(10.15.205.0-10.15.205.250,5),1(10.15.206.1-10.15.206.252,5)
aza65c... 0

b3c65c... 7(10.15.205.0-10.15.205.250,5),8(10.15.206.1-10.15.206.252,5)
b3c6e5c. ..

b3c65c... 1(10.15.205.0-10.15.205.250,5),2(10.15.206.1-10.15.206.252,5)
b3c65c... 14(10.15.205.0-10.15.205.250,5),15(10.15.206.1-10.15.206.252,5)

The output of this command provides the following information:

Table 43: Branch Details

Parameter Description

Name Displays the name of the branch.

VC MAC Displays the MAC address of the Virtual Controller of the branch.

Address

Status Displays the current status of the branch (UP/DOWN).

Inner IP Displays the internal VPN IP of the branch.

Assigned Displays the subnet mask assigned to the branch.

Subnet

Assigned Displays the VLAN ID assigned to the branch.

Vlan

Key Displays the key for the branch, which is unique to each branch.

Bid (Subnet Displays the Branch ID (BID) of the subnet.

Name) e Inthe example above, the switch displays bid-per-subnet-per-branch i.e., for "LA" branch,
BID "2" for the ip-range "10.15.205.0-10.15.205.250" with client count per branch "5"). Ifa
branch has multiple subnets, it can have multiple BIDs.

e Ifabranchisin UP state and does not have a Bid(Subnet Name), it means that the OAW-
IAP is connected to a switch, which did not assign any BID for any subnet. In the above
example, "Paris-CB:D3:16" branch is UP and does not have a Bid (Subnet Name). This
means that either the OAW-IAP is connected to a backup switch or itis connected to a
primary switch without any distributed L2 or L3 subnets.

E The show iap table command output does not display the Key and Bid(Subnet Name) details.
NOTE

AOS-W Instant6.4.0.2-4.1 | User Guide IAP-VPN Deployment | 233



Chapter 16

Adaptive Radio Management

This chapter provides the following information:

e ARM Overview on page 234
e Configuring ARM Features on an OAW-IAP on page 235
e Configuring Radio Settings for an OAW-IAP on page 240

ARM Overview

Adaptive Radio Management (ARM) is a radio frequency management technology that optimizes WLAN
performance even in the networks with highest traffic by dynamically and intelligently choosing the best 802.11
channel and transmitting power for each OAW-IAP in its current RF environment. ARM works with all standard
clients, across all operating systems, while remaining in compliance with the IEEE 802.11 standards. It does not
require any proprietary client software to achieve its performance goals. ARM ensures low-latency roaming,
consistently high performance, and maximum client compatibility in a multi-channel environment. By ensuring the
fair distribution of available Wi-Fi bandwidth to mobile devices, ARM ensures that data, voice, and video applications
have sufficient network resources at all times. ARM allows mixed 802.11a, b, g, n, and ac client types to inter
operate at the highest performance levels.

Channel or Power Assignment

The channel or power assignment feature automatically assigns channel and power settings for all the OAW-IAPs in
the network according to changes in the RF environment. This feature automates many setup tasks during network
installation and the ongoing operations when RF conditions change.

Voice Aware Scanning

The Voice Aware scanning feature prevents an OAW-IAP supporting an active voice call from scanning for other
channels in the RF spectrum and allows an OAW-IAP to resume scanning when there are no active voice calls. This
significantly improves the voice quality when a call is in progress and simultaneously delivers the automated RF
management functions. By default, this feature is enabled.

Load Aware Scanning

The Load Aware Scanning feature dynamically adjusts scanning behavior to maintain uninterrupted data transfer on
resource intensive systems when the network traffic exceeds a predefined threshold. The OAW-IAPs resume
complete monitoring scans when the traffic drops to the normal levels. By default, this feature is enabled.

Monitoring the Network with ARM

When ARM is enabled, an OAW-IAP dynamically scans all 802.11 channels within its 802.11 regulatory domain at
regular intervals and sends reports to a Virtual Controller on network (WLAN) coverage, interference, and intrusion
detection.

ARM Metrics

ARM computes coverage and interference metrics for each valid channel and chooses the best performing channel
and transmit power settings for each OAW-IAP RF environment. Each OAW-IAP gathers other metrics on its ARM-
assigned channel to provide a snapshot of the current RF health state.
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Configuring ARM Features on an OAW-IAP

This section describes the following procedures for configuring ARM features:

e Band Steering on page 235
e Airtime Fairness Mode on page 235
e Client Match on page 236

e Access Point Control on page 238

Band Steering

The band steering feature assigns the dual-band capable clients to the 5 GHz band on dual-band OAW-IAPs. This
feature reduces co-channel interference and increases available bandwidth for dual-band clients, because there are
more channels on the 5 GHz band than on the 2.4 GHz band. You can configure band steering parameters through
the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

To configure band steering:

1. Inthe RF > ARM >Show advanced options view, configure the following parameters:

Table 44: Band Steering Mode - Configuration Parameters

Parameter Description

Prefer 5 GHz Select this option to use band steering in the 5 GHz mode. On selecting this, the
OAW-IAP steers the client to the 5 GHz band (if the clientis 5 GHz capable), but
allows the client connection on the 2.4 GHz band if the client persistently attempts
for 2.4 GHz association.

Force 5 GHz Select this option to enforce 5 GHz band steering mode on the OAW-IAPs.

Balance Bands Select this option to allow the OAW-IAP to balance the clients across the two radios
to best utilize the available 2.4 GHz bandwidth. This feature takes into account the
fact that the 5 GHz band has more channels than the 2.4 GHz band, and thatthe 5
GHz channels operate in 40MHz, while the 2.5 GHz band operates in 20MHz.

Disabled Select this option if you want to allow the clients to select the band to use.

2. Click OK.

In the CLI

To configure band steering:

(Instant AP) (config)# arm

(Instant AP) (ARM) # band-steering-mode {<Prefer 5 GHz>| <Force 5 GHz>|<Balance
Bands>|<Disabled>}

(Instant AP) (ARM)# end

(Instant AP)# commit apply

Airtime Fairness Mode

The airtime fairess feature provides equal access to all clients on the wireless medium, regardless of client type,
capability, or operating system, thus delivering uniform performance to all clients. This feature prevents the clients
from monopolizing resources. You can configure airtime fairness mode parameters through the AOS-W Instant Ul or
CLI.
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HOTE

In the AOS-W Instant Ul

1. For Airtime fairness mode configuration, specify any of the following values in the RF > ARM >Show
advanced options tab:

Table 45: Airtime Faimess Mode - Configuration Parameters

Parameter Description

Default Access Select this option to provide access based on client requests. When Air Time
Faimess is set to default access, per user and per SSID bandwidth limits are not
enforced.

Fair Access Select this option to allocate Airtime evenly across all the clients.

Preferred Access Select this option to set a preference where 11n clients are assigned more airtime
than 11a/11g. The 11a/11g clients get more airtime than 11b. The ratio is 16:4:1.

2. Click OK.

In the CLI

(Instant AP) (config)# arm
(Instant AP) (ARM)# air-time-fairness-mode {<Default Access>| <Fair Access> | <Preferred

Access>
(Instant AP) (ARM) # end
(Instant AP)# commit apply

Client Match

The ARM client match feature continually monitors a client's RF neighborhood to provide ongoing client band
steering and load balancing, and enhanced AP reassignment for roaming mobile clients. This feature supersedes the
legacy band steering and spectrum load balancing features, which, unlike client match, do not trigger OAW-IAP
changes for clients already associated to an OAW-IAP.

Legacy 802.11a/b/g access points do not support the client match feature. When client match is enabled on
802.11n capable access points, the client match feature overrides any settings configured for the legacy band
steering, station hand off assist or load balancing features. 802.11ac-capable access points do not support the
legacy band steering, station hand off or load balancing settings, so these access points must be managed using
client match.

When the client match feature is enabled on an OAW-IAP, the OAW-IAP measures the RF health of its associated
clients. In the current release, the client match feature is supported only within an OAW-IAP cluster. If any of the
following trigger conditions is met, clients are moved from one AP to another for better performance and client
experience:

o Dynamic Load Balancing: Client match balances clients across OAW-IAPs on different channels, based on the
client load on the OAW-IAPs and the SNR levels the client detects from an underutilized OAW-IAP. If an OAW-
IAP radio can support additional clients, the OAW-IAP will participate in client match load balancing and clients
can be directed to that OAW-IAP radio, subject to the predefined SNR thresholds. For better load balancing,
clients are steered from busy channels to idle channels.

o Sticky Clients: The client match feature also helps mobile clients that tend to stay associated to an OAW-IAP
despite low signal levels. OAW-IAPs using client match continually monitor the client's RSSI as it roams
between OAW-IAPs, and move the client to an OAW-IAP when a better radio match can be found. This prevents
mobile clients from remaining associated to an APs with less than ideal RSSI, which can cause poor connectivity
and reduce performance for other clients associated with that OAW-IAP.
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NOTE

o Band Steering: OAW-IAPs using the client match feature monitor the RSSI for clients that advertise a dual-band
capability. If a client is currently associated to a 2.4 GHz radio and the AP detects that the client has a good
RSSI from the 5 GHz radio, the OAW-IAP steers the client to the 5 GHz radio, as long as the 5 GHz RSSl is not
significantly worse than the 2.4 GHz RSSI, and the OAW-IAP retains a suitable distribution of clients on each of
its radios.

e Channel Utilization: Based on the percentage of channel utilization, clients are steered from a busy channel to
an idle channel.

o Client Capability Match: Based on the client capability match, clients are steered to appropriate channel, for
example, HT20, HT40, or VHT80.

Inthe Instant 6.3.1.1-4.0 release, spectrum load balancing is integrated with the client match feature. Client match
allows the APs in a cluster to be divided into several logical AP RF neighborhood called domains, which share the
same clients. The Virtual Controller determines the distribution of clients and balances client load across channels,
regardless of whether the AP is responding to the probe requests of wireless clients.

You can configure client match parameters in AOS-W Instant Ul or CLI. When client match is enabled, the
dashboard in the main window displays the Client Match link on selecting an AP in the Access Points tab or a client
in the Clients tab. Clicking this link provides a graphical representation of radio map view of an AP and the client
distribution on an AP radio. For more information, see Client Match on page 66.

In the AOS-W Instant Ul

1. For client match configuration, specify the following parameters the RF > ARM >Show advanced options tab:

Table 46: Client Match Configuration Parameters

Parameter Description

Client match Select Enabled to enable the Client match feature on APs. When enabled, client
count will be balanced among all the channels in the same band. For more
information, see ARM Overview on page 234. By default, the client match feature is
disabled.

NOTE: When client match is enabled, ensure that Scanning is enabled.

CM calculating Specify a value for the calculating interval of Client match. The value specified for
interval CM calculating interval determines the interval at which client match is calculated.
The interval is specified in seconds and the default value is 30 seconds. You can
specify a value within the range of 10-600.

CM neighbor Specify a value for CM neighbor matching %. This number takes into account the
matching % least similarity percentage to be considered as in the same virtual RF
neighborhood of client match. You can specify a percentage value within the range
of 20-100. The default value is 75%.

CM threshold Specify a value for CM threshold. This number takes acceptance client count
difference among all the channels of Client match into account. When the client
load on an AP reaches or exceeds the threshold in comparison, client match is
enabled on that AP.

You can specify a value within range of 1-255. The default value is 2.

SLB mode Select a mode from the SLB mode drop-down list. The SLB mode determines the
balancing strategy for client match. The following options are available:

e Channel
e Radio
e Channel + Radio

2. Click OK.
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In the CLI

(Instant AP) (config)# arm

(Instant AP) (ARM)# client-match calc-interval <seconds>
(Instant AP) (ARM)# client-match calc-threshold <threshold>
(Instant AP) (ARM)# client-match nb-matching <percentage>
(Instant AP) (ARM)# client-match slb-mode 1

(Instant AP) (ARM)# end
(Instant AP)# commit apply
Access Point Control

You can configure access point control parameters through the AOS-W Instant Ul or CLI.

In the AOS-W Instant Ul

1. For Access Point Control, specify the following parameters in the RF > ARM >Show advanced options tab:

Table 47: Access Point Control - Configuration Parameters

Parameter Description

Customize Valid Select this checkbox to customize valid channels for 2,4 GHz and 5 GHz. By default,
Channels the AP uses valid channels as defined by the Country Code (regulatory domain). On
selecting the Customize Valid Channels checkbox, a list of valid channels for both
2.4.GHz and 5 GHz are displayed. The valid channel customization feature is
disabled by default..

Minimum Specify the minimum transmission power. The value specified for Minimum Transmit
Transmit Power Power indicates the minimum Effective Isotropic Radiated Power (EIRP) from 3 to 33
dBm in 3 dBm increments. If the minimum transmission EIRP setting configured on
an AP is not supported by the AP model, this value is reduced to the highest
supported power setting. The default value is for minimum transmit power is 18 dBm.

Maximum Specify the maximum transmission power. The value specified for Maximum
Transmit Power Transmit Power indicates the maximum Effective Isotropic Radiated Power (EIRP)
from 3 to 33 dBm in 3 dBm increments. If the maximum transmission EIRP configured
on an AP is not supported by the AP model, the value is reduced to the highest
supported power setting. The default value for maximum transmit power is 127 dBm.

Client aware When Enabled, ARM does not change channels for the APs with active clients,
except for high priority events such as radar or excessive noise. This feature must be
enabled in most deployments for a stable WLAN. If the Client Aware mode is
Disabled, the OAW-IAP may change to a more optimal channel, which change may
disrupt current client traffic for a while. The Client aware option is Enabled by default.
NOTE: When Client aware is